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Chapter 1. Overview: Scenarios and methodology
IBM® InfoSphere® Information Analyzer evaluates the content and structure of
your data for consistency and quality. InfoSphere Information Analyzer also helps
you to improve the accuracy of your data by making inferences and identifying
anomalies.
Understanding the actual quality, content, and structure of your data is an
important first step when you need to make critical business decisions. The quality
of your data depends on many factors. For example, correct data types, consistent
formatting, retrievability, and usability are just a few of the criteria that define data
of good quality. If the structure and content of your data is poor, the information
that you need is difficult to access. As a consequence, the design, development, or
testing activities that use the data can be significantly impaired.
InfoSphere Information Analyzer helps you to assess the quality of your data by
identifying inconsistencies, redundancies, and anomalies in your data at the
column, table, and cross-table level. InfoSphere Information Analyzer also makes
inferences about the best choices regarding data structure. Inferences help you to
learn more about the optimal structure of your data and what you can do to
improve the quality of your data.
To create a data profiling project in InfoSphere Information Analyzer, you must
follow a few steps. First, an administrator configures data source connections,
creates a project, adds metadata to the project, and then configures security options
for the project. After the project is configured, you can run analysis tasks. After an
analysis completes, you can review the results and inferences and then make
decisions based on the evaluation. You can choose to have your review and
inference decisions delivered to other authorized users within the user interface.
For example, you can create a report that displays a summary of analysis results or
you can share your results with other suite components. The results are saved in
the metadata repository and are available to all authorized suite users.

Architecture that supports information analysis
InfoSphere Information Analyzer is supported by a broad range of shared suite
components in InfoSphere Information Server. Standard services are provided for
data source connectivity, system access and security, logging, and job scheduling.
InfoSphere Information Analyzer shares discrete services with other InfoSphere
Information Server components. You have the flexibility to configure suite
components to match varied environments and tiered architectures.
Common core services
Provide general security services such as administrative roles and logging.
Workbench
Provides an interactive and flexible user interface where you access
analysis tasks and organize results.
Metadata repository
Holds the metadata that is shared by all suite components. The metadata
repository also stores analysis results and reports.

© Copyright IBM Corp. 2006, 2012
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Metadata services
Provide query and analysis tasks by accessing the metadata repository.
Connectors
Provide common connectivity to external resources and access to the
metadata repository from processing engines.
Parallel processing engine
Provides a scalable engine with the processing power to analyze large
volumes of data.

Scenarios for information analysis
You can create projects that assess the quality of your data, profile data for
integration and migration, and verify external data sources. Scenarios are provided
to show the end-to-end process for different types of information analysis projects.

Data quality assessment project
To determine whether your data is of good quality, you can create a project that is
focused on quality assessment and use data profiling to identify anomalies in the
data. Evaluating your data for quality also helps you to understand the structure
and content of your data.

About this task
The data profiling process consists of five analyses that work together to evaluate
your data. After column analysis completes, a frequency distribution for each
column is generated and then used as the input for the subsequent analyses.
During analysis, inferences are made about your data. The inferences often
represent areas that might offer the opportunity to improve the quality of your
data. When an analysis completes, you can review the inferences and accept or
reject them.

What to do next
After you have completed a quality assessment of your data, you can use the
results in other suite components such as IBM InfoSphere DataStage® or IBM
InfoSphere QualityStage®. For example, the results from your data profiling project
can help you to determine whether you need to complete data cleansing tasks on
your data by using IBM InfoSphere QualityStage.

Assessing data quality
After you create a project, import metadata into the metadata repository, and then
register the metadata to the project, you can use data profiling to evaluate your
data for quality. To profile your data, you run column analysis, key and
cross-domain analysis, and baseline analysis to evaluate the content and structure
of the data.
Prerequisites:
Chapter 2, “Setting up your system,” on page 7
To perform a typical quality assessment on your data, you use all of the data
profiling tasks:
1. “Running a column analysis job” on page 58

2
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To determine the structure and content of your data and identify anomalies and
inconsistencies in your data, you can analyze columns. Column analysis results
are used as the foundation for all other data profiling tasks.
2. “Identifying a single column primary key” on page 83
To identify a primary key for a table or file, you locate a column whose values
uniquely identify the rows in the selected table. Additionally, you can verify
that a primary key defined in the data source is the true primary key.
3. “Running a key and cross-domain analysis job to identify foreign keys” on
page 93
To identify the foreign key candidates in one or multiple tables, you can run a
key and cross-domain analysis job. Key and cross-domain analysis jobs
compare the primary key of one table to the columns of another table to
determine if there is a relationship between the two tables.
4. Chapter 7, “Locating overlapping data across domains,” on page 97
To determine if columns contain overlapping or redundant data, you can run a
key and cross-domain analysis job across columns in one or multiple tables or
sources.
5. Chapter 8, “Identifying changes in your data over time,” on page 101
To determine whether the content and structure of your data has changed over
time, you can use baseline analysis to compare a saved analysis result of your
table to a current analysis result of the same table.

Data integration and migration project
To move data between sources, you must know how your data is structured so
that you can determine which information you want to move and how much space
will be needed on the new system. You can create a data profiling project to help
you understand the structure of your data and identify anomalies.

About this task
The data profiling process consists of five analyses that work together to evaluate
your data. After column analysis completes, a frequency distribution for each
column is generated and then used as the input for the subsequent analyses.
During analysis, inferences are made about your data. The inferences often
represent the best choices that you can make to improve the quality of your data.
When an analysis completes, you can review the inferences and accept or reject
them.
When you profile your data for an integration or migration project, there are
certain analysis results that might contain the most relevant information about
your data. For example, after column analysis, you can view inferences about data
classes in a frequency distribution. Data must be classified correctly so that it can
be evaluated consistently across multiple sources. You can also review the
frequency distribution for more information about anomalies and redundant data.
Incorrect and redundant data take up space on a system and might slow down the
processes that are associated with the data.
If you are transferring non-relational data to a relational data source, you need to
know whether there are any primary keys in the data. Primary keys are unique
columns that identify rows in tables and create relationships between tables. After
you run a key and cross-domain analysis and review primary key candidates, you
can accept or reject primary key candidates or find defined keys that already exist
in the data. You might also want to assess whether there are any foreign keys in
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your data. Foreign keys are columns that link to columns that contain the same
values in other tables. You can run a key and cross-domain analysis to identify
any foreign key candidates and cross-table relationships.

Profiling for data integration and migration
After you create a project, import metadata into the metadata repository, and then
register the metadata to the project, you can use data profiling to evaluate your
data in preparation of an integration or migration project. To profile your data, you
run column analysis and key and cross-domain analysis to evaluate the content
and structure of the data.
Prerequisites:
Chapter 2, “Setting up your system,” on page 7
To profile your data for a data integration or migration project, you use all of the
data profiling tasks:
1. “Running a column analysis job” on page 58
To determine the structure and content of your data and identify anomalies and
inconsistencies in your data, you can analyze columns. Column analysis results
are used as the foundation for all other data profiling tasks.
2. “Identifying a single column primary key” on page 83
To identify a primary key for a table or file, you locate a column whose values
uniquely identify the rows in the selected table. Additionally, you can verify
that a primary key defined in the data source is the true primary key.
3. “Running a key and cross-domain analysis job to identify foreign keys” on
page 93
To identify the foreign key candidates in one or multiple tables, you can run a
key and cross-domain analysis job. A key and cross-domain analysis
job compares the primary key of one table to the columns of another table to
determine if there is a relationship between the two tables.
4. Chapter 7, “Locating overlapping data across domains,” on page 97
To determine if columns contain overlapping or redundant data, you can run a
key and cross-domain analysis job across columns in one or multiple tables or
sources.

External data source verification project
The structure of data can change over time. You might want to monitor the data in
an external data source to ensure that it continues to support the processes that it
is associated with. To find out whether your data has changed, you can create a
data profiling project to evaluate the structure and content of the data and then use
baseline analysis to monitor for any changes.

About this task
The data profiling process consists of three analyses that work together to evaluate
your data. After column analysis completes, a frequency distribution for each
column is generated and then used as the input for the subsequent analyses.
During analysis, inferences are made about your data. The inferences often
represent the best choices that you can make to improve the quality of your data.
When an analysis completes, you can review the inferences and accept or reject
them.
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When you want to know if your data has changed, you can use baseline analysis
to compare the column analysis results for two versions of the same data source.
First, you choose the analysis results that you want to set as the baseline version.
You use the baseline version to compare all subsequent analysis results of the same
data source. For example, if you ran column analysis on data source A on Tuesday,
you could then set the column analysis results of source A as the baseline and save
the baseline in the repository. On Wednesday, when you run column analysis on
data source A again, you can then compare the current analysis results of data
source A with the baseline results of data source A.

Verifying an external data source
After you create a project, import metadata into the metadata repository, and then
register the metadata to the project, you can use data profiling to evaluate data on
external data sources to see whether the data has changed. To profile your data,
you run column analysis, primary key analysis, foreign key analysis, cross-domain
analysis, and baseline analysis to evaluate the content and structure of the data.
Prerequisites:
Chapter 2, “Setting up your system,” on page 7
To monitor your data, you create a data profiling project and then use baseline
analysis to compare the results for two versions of the same data source:
1. “Running a column analysis job” on page 58
To determine the structure and content of your data and identify anomalies and
inconsistencies in your data, you can analyze columns. Column analysis results
are used as the foundation for all other data profiling tasks.
2. “Identifying a single column primary key” on page 83
To identify a primary key for a table or file, you locate a column whose values
uniquely identify the rows in the selected table. Additionally, you can verify
that a primary key defined in the data source is the true primary key.
3. “Running a key and cross-domain analysis job to identify foreign keys” on
page 93
To identify the foreign key candidates in one or multiple tables, you can run a
foreign key analysis job. Foreign key analysis compares the primary key of one
table to the columns of another table to determine if there is a relationship
between the two tables.
4. Chapter 7, “Locating overlapping data across domains,” on page 97
To determine if columns contain overlapping or redundant data, you can run a
cross-domain analysis job across columns in one or multiple tables or sources.
5. Chapter 8, “Identifying changes in your data over time,” on page 101
To determine whether the content and structure of your data has changed over
time, you can use baseline analysis to compare a saved analysis result of your
table to a current analysis result of the same table.

Chapter 1. Overview: Scenarios and methodology
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Chapter 2. Setting up your system
After you successfully install the IBM InfoSphere Information Server, which
includes the IBM InfoSphere Information Analyzer module, you must set up your
system before you or other users can begin analyzing data.

Configuration steps
The IBM InfoSphere Information Server administrator, IBM InfoSphere Information
Analyzer data administrator, and the InfoSphere Information Analyzer project
administrator complete steps to configure system resources, establish connectivity,
configure analysis settings, import metadata, create a project, set up security, and
customize the project dashboard.
To learn more about using the InfoSphere Information Server consoles to create
projects, set up security, and customize the dashboard, see Getting started with the
consoles.
Table 1 shows the recommended steps for setting up your system. The table lists
configuration tasks in the order that you perform them, specifies the access level
that you must have to complete the tasks, and directs you to information about
how to complete the configuration tasks.
Table 1. Recommended steps for setting up your system
Step

Set-up task

Access level required to
perform the task

Link to task steps

®

1

Assigning security roles
At a minimum, assign the WebSphere Information
Server suite administrator to a user in the console
Information Analyzer
authority
Data Administrator role
to the suite administrator.
Assign one or more suite
and suite component roles
to a user.

2

Create data source names InfoSphere Information
Analyzer data
(DSNs) for Windows or
UNIX on the computer on administrator authority
which the parallel
processing engine is
installed. You must create
a DSN for the Information
Analyzer database (IADB)
and one or more DSNs
for the data sources that
you will use.

“Creating a data source
name (DSN) for
Windows” on page 14

3

Verify your analysis
configuration details.

“Verifying analysis
settings” on page 19

4

Define the host computer. InfoSphere Information
Analyzer data
administrator authority

Defining a host computer

5

Identify one or more data
stores.

Identifying one or more
data stores

© Copyright IBM Corp. 2006, 2012

InfoSphere Information
Analyzer data
administrator authority

InfoSphere Information
Analyzer Data
Administrator authority

“Creating a data source
name (DSN) for UNIX or
Linux” on page 15
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Table 1. Recommended steps for setting up your system (continued)
Step

Set-up task

Access level required to
perform the task

6

Identify metadata to
import into the metadata
repository.

InfoSphere Information
Analyzer data
administrator authority

Identifying metadata to
import

7

Import metadata into the
metadata repository

InfoSphere Information
Analyzer data
administrator authority

Importing metadata

8

Create a project and
provide basic project
details.

InfoSphere Information
Analyzer project
administrator authority

Creating a project

9

Associate imported
metadata with a project.

InfoSphere Information
Analyzer project
administrator authority

“Associating imported
metadata with your
project” on page 30

10

Modify the project and
data source analysis
settings.

InfoSphere Information
Analyzer project
administrator authority

Modifying project
properties

11

Set up security for the
project.

InfoSphere Information
Analyzer project
administrator authority

Assigning users to a
project and assigning
roles

12

Customize the project
dashboard.

InfoSphere Information
Analyzer Data
Administrator authority

Customizing the project
dashboard

Link to task steps

Defining role-based security
To create a secure project environment, you can define a security policy that is
based on user authentication and role identification. Users derive authority from
the combination of their individual and group roles. You can grant users greater
responsibility by assigning multiple roles.
First you create a user and specify which product that user can access. Then, you
specify which project that user can work in and what role the user has within the
project. You can set this last level of security to secure sensitive information, such
as identification numbers, and ensure that only the appropriate users have access
to that data.
For information about configuring the user registry, controlling access levels,
creating or updating users and groups, and mapping credentials for IBM
InfoSphere DataStage and IBM InfoSphere QualityStage users, refer to the IBM
InfoSphere Information Server Administration Guide.

Security roles
IBM InfoSphere Information Server supports role-based authentication of users. By
using the InfoSphere Information Server Web console, administrators can add users
and groups. By using the InfoSphere Information Server console, project
administrators can assign the users and groups to projects and assign roles to those
users and groups.
Users derive authority from the union of their role in InfoSphere Information
Server (the suite role), their role in the suite component (for example, IBM
InfoSphere Information Analyzer or IBM InfoSphere FastTrack), and the role that
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they perform in an assigned project (the project role). The administrator creates a
security policy by performing the following tasks:
v Creating a user ID for each person who needs to access the suite
v Assigning suite and suite component roles to each user
v Assigning each user to specific projects within the suite component
v Assigning each user roles in that project
Roles are complementary and you can grant users greater responsibility by
assigning multiple roles.

Suite roles
Suite Administrator
Provides maximum administration privileges throughout the suite.
Suite User
Provides access to the suite and to suite components. If you assign a user
the role of suite administrator and not that of suite user, the user cannot
log on to any of the suite tools or component tools. This role is the default
role.

Suite component roles
Information Analyzer Data Administrator
Can import metadata, modify analysis settings, and add or modify system
sources.
Information Analyzer Project Administrator
Can administer projects including creating, deleting, and modifying
information analysis projects.
Information Analyzer User
Can log on to InfoSphere Information Analyzer, view the dashboard, and
open a project.
FastTrack Administrator
Can create and manage projects, and manage user and group access to
projects.
FastTrack User
Can use IBM InfoSphere FastTrack functions. A user must be authorized to
projects before using functions for creating, managing and viewing
mapping specifications.

Project roles
Information Analyzer Business Analyst
Reviews analysis results. This role can set baselines and checkpoints for
baseline analysis, publish analysis results, delete analysis results, and view
the results of analysis jobs.
Information Analyzer Data Operator
Manages data analyses and logs. This role can run or schedule all analysis
jobs.
Information Analyzer Data Steward
Provides read-only views of analysis results. This role can also view the
results of all analysis jobs.

Chapter 2. Setting up your system
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Required security roles for information analysis tasks
Before a user can do certain information analysis tasks, the administrator must
assign the required suite component and project security roles to the user.

Suite component security roles
The following tables show the suite component security roles that are required to
perform information analysis tasks. The User role is the basic suite component role
that you assign to a user. You can also assign the Project Administrator role or
Data Administrator role to grant additional rights to the user.
Table 2. Suite component roles that can do project and data tasks
Tasks

Project
Administrator role

Data Administrator
role

User
role

Configure My Home workspace

X

X

X

Configure reports to display on My
Home workspace

X

X

X

View the Dashboard workspace

X

X

X

Modify the project dashboard

X

X

X

Open a project

X

X

X

Create a project

X

Delete a project

X

Modify project properties

X

Import metadata
Apply metadata to schemas, tables,
or columns

X
X

X

Add sources

X

Modify analysis settings

X

Export a table from table
management

X

Delete a table from table
management

X

Create or view notes

X

X

X

X

Project security roles for running analysis jobs and viewing
results
In addition to assigning a suite component role to a user, you must add a project
role. Project roles specify the level of access that a user has within a specific
project. For example, the Data Steward and Data Operator project roles are added
to the suite component roles to either grant or restrict access rights. A User role
might be granted Business Analyst and Data Operator project roles to be able to
view analysis results and run analysis jobs.
Note: The Drill Down User role is only required if the Project Properties are set to
indicate that the role is required.
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Table 3. Project security roles that are required to run and review analysis
Business
Analyst role

Data Steward
role

Data Operator Drill Down
role
User role

View Column Analysis
workspace

X

Can only read
results

X

Open column analysis
results

X

Can only read
results

Tasks

Run or schedule a
column analysis job

X

View Primary Key
Analysis workspace

X

Can only read
results

Open primary key
analysis results

X

Can only read
results

Run or schedule a
primary key analysis
job

X

View Cross-Domain
Analysis workspace

X

Can only read
results

Open cross-domain
analysis results

X

Can only read
results

X

X

Run or schedule a
cross-domain analysis
job
View Foreign Key
Analysis workspace

X

Can only read
results

Open foreign key
analysis results

X

Can only read
results

Run or schedule a
foreign key analysis job

X

View Baseline Analysis
workspace and open
analysis results

X

Set the checkpoint or
baseline

X

View Publish Analysis
Results workspace and
open analysis results

X

Publish analysis results

X

Delete analysis results

X

View Table
Management
workspace

Can only read
results

Create or view reports

X

Drill down into source
data

X

Can only read
results

Can only read
results

Can only read
results

X
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Project security roles for creating and managing data quality
controls
In addition to analysis project roles, you must add project roles for the data quality
controls, which include data rules, rule sets, and metrics.
Table 4. Project security roles that are required to create and manage data quality rules,
rule sets, and metrics
Rule manager
role

Rule
administrator
role

Rule author
role

Rule user role

View business rules or
the business rule
results

X

X

X

X

Create and edit
business definitions
(rules, rule sets, and
metrics)

X

X

X

Can only read
results

Test definitions and
metrics and view
results

X

X

X

X

Task

Set or remove baselines
and remove runs

X
X

Define security related
parameters around
business rules and
control the deployment
Move rules into the
states Accepted,
Standard, or
Deprecated

X

Edit rules that are in
the states Accepted,
Standard, or
Deprecated

X

Import and export
components

X

Manage folders

X

Delete any component

X

Delete author-created
component

X

X

Project roles for viewing IBM InfoSphere Business Glossary
terms
The following tables show the security roles that are required to view InfoSphere
Business Glossary terms.
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Table 5. Project roles that are required to view and work with InfoSphere Business Glossary
terms.

Task

InfoSphere
Business
Glossary
Author role

InfoSphere
Business
Glossary User
role

View terms

X

X

Create terms

X

Delete terms

X

View terms

X

X

Assign assets to terms

X

X

View data rule
definitions that include
terms

Rule Author
Rule User role role

X

Create data rule
definitions that include
terms

X

X

View Related Terms in
column analysis results

X

X

X

X

Assigning security roles to a user in the IBM InfoSphere
Information Server console
All users require authorization to access components and features of the IBM
InfoSphere Information Server. You can assign one or more suite and suite
component roles to a user.

Before you begin
You must have suite administrator authority.

About this task
Changing the roles that are assigned to a user does not affect any currently active
sessions for that user. The new role assignments will only be available the next
time the user logs in. You can use session administration to disconnect the user
and force the user to log in again.

Procedure
1. On the Home navigator menu, select Configuration > Users.
2. In the Users workspace, select a user.
3. In the Task pane, click Assign Roles.
4. In the Roles pane, select a suite role to assign to the user.
5. In the Suite Component pane, select one or more suite component roles to
assign to the user.
6. Click Save > Save and Close to save the authorizations in the metadata
repository.
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What to do next
Certain suite components, such as IBM InfoSphere DataStage and IBM InfoSphere
Information Analyzer, also require that you assign additional user roles in the
clients or projects.

Configuring your system resources
Before you can import metadata into the metadata repository or associate it with
your project, you must locate and define the host computers and the data stores in
your organization.

About this task
The metadata repository stores key metadata about objects such as data schemas,
tables, and columns. This repository ensures that two distinct objects (such as two
tables named Customer in two distinct systems) are not inappropriately linked or
overlaid. You create the high-level and logical hierarchy of objects (source objects)
to provide an inventory of hardware assets that you can use to access your data.
You identify the data sources by defining the locations and access methods to these
sources. For example, you define the host computer on which the data source is
stored, identify the database system that contains the data source, and set up a
connection to that data source.

Configuring a data source name (DSN)
After you install your suite component, you must create a data source name (DSN)
for each source database that you want to use. For IBM InfoSphere Information
Analyzer, you must also create a data source name for the analysis database. You
then associate the data source with your server.

About this task
The data source name for the analysis database and the source database must be
created on the computer on which the parallel processing engine is installed.

Creating a data source name (DSN) for Windows
After you install your suite component, you must create a data source name (DSN)
for the analysis database (IADB) and for each source database that you want to
use. The DSN for the analysis database and the source database must be created on
the computer on which the parallel processing engine is installed.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have InfoSphere Information Analyzer Data Administrator
authority.

About this task
You must create a DSN for the Information Analyzer database (IADB) and one or
more DSNs for the data sources that you will use.

Procedure
1. From the Microsoft Windows Start menu, click Start > Control Panel >
Administrative Tools > Data Sources (ODBC).
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2. Click the System DSN tab and click Add.
3. Select the driver that corresponds to your database (for example, Oracle, DB2®,
SQL Server) and click Finish.
4. In the Data source name field, type a data source name.
5. Select the same data source name, that you just typed, from the list to register
for ODBC. Click OK.
6. Select the row containing the data source name that you just created and click
Configure.
7. Type the database user name and password for your computer.
8. Click Connect. The following message is displayed: Connection tested
successfully.
9. Click OK on all of the open Control Panel windows.

What to do next
You associate the data source with your domain component.

Creating a data source name (DSN) for UNIX or Linux
After you install your suite component, you must create a data source name (DSN)
for the analysis database (IADB) and for each source database that you want to
use. The DSN for the analysis database and the source database must be created on
the computer on which the parallel processing engine is installed.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have InfoSphere Information Analyzer Data Administrator
authority.

About this task
You must create a DSN for the Information Analyzer database (IADB) and one or
more DSNs for the data sources that you will use.

Procedure
1. Open the odbc.ini file.
2. From the following example code, copy the template that uses the driver that
you want to use so that it is easy to edit. The following code is an example of
an odbc.ini file:
[ODBC Data Sources]
IADBDB2=DataDirect DB2 Wire Protocol Driver
IADBOracle =DataDirect Oracle Wire Protocol Driver
IADBSQLServer =DataDirect SQL Server Wire Protocol Driver
[IADBDB2]
Driver=/opt/IBM/InformationServer/Server/branded_odbc/lib/VMdb222.so
Description=DataDirect DB2 Wire Protocol Driver
AddStringToCreateTable=
AlternateID=
Database=IADB
DynamicSections=100
GrantAuthid=PUBLIC
GrantExecute=1
IpAddress=db2hostname
IsolationLevel=CURSOR_STABILITY
LogonID=uid
Chapter 2. Setting up your system
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Password=pwd
Package=DB2 package name
PackageOwner=
TcpPort=50000
WithHold=1
[IADBOracle]
Driver=/opt/IBM/InformationServer/Server/branded_odbc/lib/VMora22.so
Description=DataDirect Oracle Wire Protocol driver
ApplicationUsingThreads=1
ArraySize=60000
CachedCursorLimit=32
CachedDescLimit=0
CatalogIncludesSynonyms=1
CatalogOptions=0
DefaultLongDataBuffLen=1024
DescribeAtPrepare=0
EnableDescribeParam=0
EnableNcharSupport=1
EnableScrollableCursors=1
EnableStaticCursorsForLongData=0
EnableTimestampWithTimeZone=1
HostName=Oracle server
LocalTimeZoneOffset=
LockTimeOut=-1
LogonID=
Password=
PortNumber=Oracle server port
ProcedureRetResults=0
SID=OracleSID
UseCurrentSchema=1
[IADBSQLServer]
Driver=/opt/IBM/InformationServer/Server/branded_odbc/lib/VMmsss22.so
Description=DataDirect SQL Server Wire Protocol driver
Database=iadb
LogonID=uid
Password=pwd
Address= sqlserverhost,1433
QuotedId=No
AnsiNPW=No
[ODBC]
IANAAppCodePage=4
InstallDir=/opt/IBM/InformationServer/Server/branded_odbc
Trace=0
TraceDll=/opt/IBM/InformationServer/Server/branded_odbc/lib/odbctrac.so
TraceFile=odbctrace.out
UseCursorLib=0

3. Paste the data source template in the file. You might also need to change the
path for the driver.
4. Change the name of the DSN. The name should be the first line and between
square brackets.
5. Complete the lines that do not have values such as LogonID and Password.
6. Add a line to the start of the DSN section and enter the name of the DSN, for
example DSN=<description>.
7. Save the odbc.ini file.

What to do next
You associate the data source with your domain component.
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Defining a host computer
To import metadata into the metadata repository, you must first define one or
more host computers that the data sources are stored on.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have Information Analyzer Data Administrator authority.

About this task
The host computer can be a physical server name, WW-GLOBALCo for example,
or a logical name, MYHOST for example. You can run analysis only on metadata
that is referenced and imported from a host computer.

Procedure
1. On the Home navigator menu in the console, select Configuration > Sources.
2. In the Sources workspace, click New Host Computer.
3. On the New Host pane, specify information about the host. The Name field is
required.
4. Click Save > Save and Close.

What to do next
You can now add a data store to the host and define a connection to that data
source.

Identifying one or more data stores
After you define a host computer, you identify one or more data stores that are on
that host computer. Data stores are the logical containers for differing schemas and
directories.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have Information Analyzer Data Administrator authority. Also,
you also must complete the following tasks:
v “Defining a host computer”
v “Configuring a data source name (DSN)” on page 14

About this task
You also define a data connection to specify a connector and a connection string.
The data connection links the logical metadata hierarchy to a real physical schema
or directory. Data stores can be a specific database type, DB2 Database for example.
Or they can be a logical system name, SalesSystem for example.

Procedure
1. On the New Host Computer pane in the console, click Add.
v Or in the Sources workspace, select the host computer that you want to add
a data store to and click New Data Store.
2. On the New Data Store pane, define the data store. The Name field is required.
Chapter 2. Setting up your system
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3. Define the data connection:
a. In the Name field, type a user defined name for the connection.
b. Optional: In the Description field, type a description for the connection.
c. From the Connector menu, select the type of connector.
d. In the Connection String field, type the string or URL that is used to access
the connector. For example, type the ODBC DSN defined in the ODBC.INI
file or ODBC Administrator.
e. In the User Name and Password fields, type the user credentials, if
required, to access the connector.
f. Click Connect to test the connection. If the connection is successful,
information about the data store appears in the Data Store Information
fields.
g. Ensure that the Store Type is correct.
4. Click Save > Save and Close.

Results
If the connection does not succeed, the Connection window lists the configuration
details that caused the error. Modify the configuration details and then test the
connection again.

What to do next
You can now import metadata into the metadata repository.

Using source objects to import metadata
A source object is a hierarchical set of objects that defines the location of data and
the method that is used to connect to that data.
IBM InfoSphere Information Analyzer uses the common metadata repository that is
shared by all of the suite components in IBM InfoSphere Information Server.
InfoSphere Information Analyzer organizes data from schemas, files, and other
sources into a hierarchy of objects (a source object). You use these source objects to
import metadata from the schemas, directories, tables, files, and columns into the
metadata repository. After creation, these source objects are available for use in
suite components. Results that are generated by InfoSphere Information Analyzer
can be shared with other client programs, such as IBM InfoSphere FastTrack, IBM
InfoSphere DataStage and InfoSphere QualityStage, through their respective service
layers.
For example, you might have a host computer that you identify as ww-sales-data.
On that host computer there is a data store for DB2 Database. In that DB2 data
store, there is a schema called United States sales. And within that schema there
is a table called Address_ShipTo. You create an object that references this hierarchy
and provides the information needed to connect to the table data. You can then
import the table metadata, associate it with a project, and perform analysis and
other functions on the metadata.
Using the shared metadata repository and source objects within multiple suite
components, you can share information between those components. For example,
you might reference the Address_ShipTo table in an IBM InfoSphere FastTrack
mapping specification that is then used in an IBM InfoSphere DataStage job and in
an information analysis job. A data analyst might review analysis results and create
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annotations and notes in the metadata of the table. Then, an InfoSphere
Information Analyzer Project Administrator might publish the analysis results for
an IBM InfoSphere DataStage user to review. An IBM InfoSphere DataStage
developer can then go into an IBM InfoSphere DataStage job, look at the
Address_ShipTo table, look at the analysis results for that table. The developer can
also view any notes or annotations that are created by the data analyst. The
developer can then work with the data analyst who, in turn, makes changes to the
mapping specification. Or, the developers can design or modify their jobs based on
those results and notes.
For example, the data analyst might suggest that the data type of a particular
column in the table must be changed, that a table must have a foreign key
established, or that a table has non-valid values that the job must eliminate. Or, as
another example, the developer views the notes from the data analyst and sees that
the data analyst created a mapping specification in IBM InfoSphere FastTrack that
mapped columns and terms in the Address_ShipTo table to columns and terms in
two other tables to extend and transform the data. The developer retrieves the job
generated in IBM InfoSphere FastTrack and uses the generated job to extend the
existing job that is associated with the Address_ShipTo table. The hierarchy of
objects remains intact.

Editing a source object
After you create a source object, you can edit any of the details of that object.

Before you begin
You must have Information Analyzer Data Administrator authority and complete
the following task:
Identifying one or more data stores

Procedure
1.
2.
3.
4.
5.

On the Home navigator menu, select Configuration > Sources.
In the Sources workspace, select the sources object that you want to modify.
Click Open Details on the Tasks pane.
Make any modifications required.
Click Save.

Verifying analysis settings
Verify the analysis settings that are used to connect to the IBM InfoSphere
Information Server engine.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have InfoSphere Information Analyzer Data Administrator
authority.

Procedure
1. From the InfoSphere Information Analyzer client Home icon, select
Configuration > Analysis Settings.
2. On the Analysis Engine tab:
a. Select the Use static DataStage credentials option.
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b. The default username and password must be replaced. Enter the InfoSphere
DataStage username and password in the DataStage Username and
DataStage Password fields.
Important: The InfoSphere DataStage username must be the username of
the InfoSphere DataStage operating system user on the computer that is
running the InfoSphere DataStage engine.
c. Click Validate Settings to ensure that you can successfully validate the
DataStage credential settings before you proceed. The message Analysis
Engine settings are valid indicates a successful connection.
3. Click the Analysis Database tab and validate your connections.
a. Click Validate Client Connection. If the connection fails, verify that the
values on the Analysis Database tab are correct and that the database is
running and is accessible.
b. Click Validate Engine Connection. If the connection fails, verify that the
values on the Analysis Database tab are correct and that the database is
running and is accessible.
4. Click Save All.

What to do next
You can now define one or more host computers where the data sources are stored.

Importing metadata into the metadata repository
You import metadata into the metadata repository for use in projects. You must
import metadata and associate it with a particular project before performing
functions such as running information analysis jobs or mapping source-to-target
columns.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have Information Analyzer Data Administrator authority. Also,
you also must complete the following task:
v “Configuring a data source name (DSN)” on page 14

About this task
The metadata repository is where information such as analysis results, glossary
terms, and mapping specifications are stored. When you import metadata into the
metadata repository, that metadata is available to all InfoSphere Information Server
capabilities.
You can import all or some of the tables, files, or columns in a schema or directory.

Metadata import process
The import process consists of multiple steps that you complete to import
metadata into the metadata repository.
Metadata is data that describes the content, structure, and other characteristics of
an original data set. You can access information in the metadata repository from
any component in the suite, which means that metadata can be shared by multiple
suite components. You use metadata in all your analysis projects to describe the
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data that you want to analyze and to use as a foundation to access inferences. You
also use metadata to create source-to-target mapping specifications.
Data store
To begin the import process, you select a host computer and a data store
that contains the metadata. You defined the host computer or data store
when you configured the resources that you want to work with. You must
configure resources before you can import metadata.
Identify
After you select a data store, you need to identify the metadata that it
contains. When you identify metadata, the system connects to the data
store and then displays a hierarchy of the objects within the data store
such as directories, tables, or files. A hierarchy is a list of objects that are
displayed at specific levels depending on the size of the object. For
example, you select a data store to view a schema within the data store. To
view a table, you then select the schema to view the tables within the
schema. You must identify down to the column level in order to import
metadata.
Import
After you identify the metadata in a data store, you select the objects that
you want and then import the objects into the repository. For example, you
might want to import specific tables rather than all of the tables in the data
store.
Metadata repository
The metadata repository contains imported metadata, analysis results, and
system configurations, and can be accessed by authorized users from any
component in the suite.

Metadata repository
The metadata repository stores imported metadata, project configurations, reports,
and results for all components of IBM InfoSphere Information Server.
You can access information in the metadata repository from any of the suite
components, which means that metadata can be shared by multiple suite
components. For example, after you import metadata into the repository, an
authorized user can then use the same metadata to projects in any suite component
such as IBM InfoSphere FastTrack, and InfoSphere DataStage or InfoSphere
QualityStage.

Identifying metadata to import
Before you import metadata into the metadata repository, you must identify the
schemas and tables that are in the data store.

Before you begin
For InfoSphere Information Analyzer, you must have Information Analyzer Data
Administrator authority. For InfoSphere FastTrack, you must have FastTrack Data
Administrator authority. Also, you must complete the following tasks:
v “Defining a host computer” on page 17
v “Identifying one or more data stores” on page 17

About this task
The Import Metadata workspace displays a hierarchy of the defined host
computers and data stores. For each data store, if you have already discovered the
Chapter 2. Setting up your system
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metadata, the hierarchy contains the discovered schemas (or directories) and tables
(or files). The new information displayed after running one of the identify options
will persist beyond the completion of your session only if you complete the import
step. Otherwise, each time you open the Import Metadata workspace, you must
again identify the schemas and tables that have not been previously imported.

Figure 1. Data Source hierarchy/levels illustration

Exploring the Data Sources hierarchy: You can explore the data sources hierarchy
by selecting and expanding nodes at the data store and schema hierarchy levels. To
expand a given data store node or schema node, you must first discover existing
schemas (in the data store) or tables (in the schema) by running either the Identify
Next Level or Identify All Levels operation on the selected node.
Collapsed and expanded states of data store and schema nodes:
v Data store and/or schema nodes are initially in a collapsed state before any
Identify operations are done at a given hierarchy level. This indicates that a
discovery operation has not yet been performed on that node.
v If a schema or data store node is in an expanded state, this indicates that a
discovery operation (Identify All or Identify Next) has been performed on that
node, and the discovered schemas or tables should be displayed under the
expanded node.
v You have the option of manually expanding and collapsing data store and
schema nodes once metadata discovery has been performed.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Import Metadata.
2. On the Import Metadata workspace, select the host computer that you want to
identify schemas and tables in.
3. Perform Identify Next Level or Identify All Levels operations on the data
stores of the host computer.
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Option

Description

To identify all schemas and tables on the
host computer at once, select a data store.
Note: If you want to identify all levels
(schemas and tables) in a data source, do not
expand the source before clicking Identify
All Levels.

Click Identify All Levels on the Tasks pane.

To identify each level of the schemas and
tables progressively, select and collapse the
data store or schema level.

Click Identify Next Level on the Tasks pane.

This option discovers all of the items in the
selected node. For schemas with thousands
of tables, this step might take a long time to
complete.

This option provides a direct discovery
process that focuses only on the paths of
interest to you. To import metadata, you
must continue to progressively identify data
stores to the table level.

Troubleshooting: Additional schemas are not discovered when the data store
node is in an expanded state: If you imported metadata in a previous
Information Analyzer client session, you will see only the schemas for which
there are imported tables in the current Information Analyzer client session. If
you wish to identify additional schemas in a given data store, the data store
node must be in a collapsed state when Identify Next Level or Identify All
Levels operations is performed.

What to do next
You can now import metadata from the schemas and tables that you identified.

Importing metadata
You import metadata into the metadata repository for use in projects. You can
import metadata from one or more schemas, directories, tables, files, or columns on
a host computer.

Before you begin
You must have suite administrator authority. For IBM InfoSphere Information
Analyzer, you must have Information Analyzer Data Administrator authority. Also,
you also must complete the following task:
v “Identifying metadata to import” on page 21

About this task
The Import Metadata workspace shows a hierarchy of the defined host computers
and data stores. You can import metadata at any level of the hierarchy, from all
data stores on the host computer to an individual table within a specific schema.

Procedure
1. In the Import Metadata workspace, select one or more schemas, directories,
tables, files, or columns that you want to import.
2. On the Tasks pane, click Import.
3. Click OK to confirm that you want to import metadata from the selected
schemas, directories, tables, files, or columns.

What to do next
You can now view the imported metadata by selecting it and clicking View in the
Tasks pane. Or you can register interest in the metadata through a project.

Deleting metadata
You can delete metadata from the metadata repository after you import it in to or
export it from the Import Metadata workspace.

Before you begin
You must have Suite Administrator authority. For IBM InfoSphere Information
Analyzer, you must have Information Analyzer Data Administrator authority.
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About this task
You can delete metadata from the Import Metadata workspace. You can delete the
metadata at the table level of the data store hierarchy in the metadata repository.

Procedure
1. Click Metadata Management > Import Metadata from the Home navigator
menu.
2. In the Import Metadata workspace, select one or more tables, files, or columns
that you want to delete.
3. On the Tasks pane, click Delete, or right-click and select Delete.
4. Review all items affected by the table that you want to delete. The items are
organized by project.
5. Click OK to confirm that you want to delete metadata from the selected tables,
files, or columns.
6. Click OK to close the Delete Metadata window.
Note: Deleting metadata does not remove the data store and connection from
the repository. Data stores can be deleted by going to the Home navigator
menu and clicking Configuration > Sources, and then deleting data stores by
selecting the delete option from the tasks menu.

Importing data from a flat file
You can import data from flat files into your projects using the Identify Flat File
and Import wizards in the Import Metadata workspace.
You can use the Identify Flat File functions if you want to import a flat file, and
you have not updated an entry for your flat file in the QETXT.INI configuration
file on your system. If the data file you want to import already has a valid
QETXT.INI entry then you do not need to use the wizard. You can use the use the
Import button.
You can use the Identify Flat File wizard to specify the format of the data in your
flat file, which allows you to import your flat file data into your projects. When
you use the Identify Flat File wizard, you specify either the fixed-widths of the
data in your flat file, or you specify the delimiter that your data is separated by,
such as commas, spaces, and colons. You can then preview the way the wizard will
parse your data. After previewing how the data in your text file is parsed, and
how it will look when it is uploaded into a table in your data source, the wizard
automatically saves these settings in the QETXT.INI configuration file on your
system. Once the QETXT.INI file is configured by the wizard, you can import the
data by using the Import button in the Import Metadata workspace.

Preparing to import data from a flat file
You can import metadata from a flat file into a table in IBM InfoSphere
Information Analyzer by specifying the parameters in your flat file, such as the
formats that exist in your flat file and the delimiters that separate your data.

About this task
Before you import data from a flat file into table, you must specify the format of
the file, and the delimiters that separate your data. When you finish specifying the
format by using the wizard in the Identify flat file workspace, you can import the
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content of the flat file by using the Import feature.

Procedure
1. Go to the Home menu, select Metadata Management, and then select Import
Metadata.
2. In the Data Sources field, highlight the data source that you want to upload
the flat file to. The data source must contain at least one schema.
3. Click Identify Flat File from the task list on the right side of the workspace.
After you click Identify Flat File, a wizard is displayed. Follow the Steps to
Complete task list on the left side of the screen.
4. Locate the file you want to import in the Select Flat File to Identify
workspace or click Add if you want to add a new flat file from a directory on
your system.
5. If you are adding a new file, after clicking Add, specify the file path to the
directory that contains the flat file you want to import.
6. Highlight the file you want to import and click Next.
7. Select one of the following field separators on the Specify File Layout screen:
v

Delimited
Select the character that is used to separate the data in your flat file.
You can choose from the following options:
– , (Comma)
– Tab
– | (Pipe)
– Space
– Other

v Fixed Width
Select this option if each column's data has the same width. Each
column individually might have a different width. You can create a
list of your column widths, separated by commas.
8. Optional: Select the First line is column names check box if your column
names are in the first line of the text file.
9. Optional: Click Update Preview when you are done specifying the delimiters
used to separate your data to preview how the columns will be parsed. The
preview displays the first few rows of data based on the settings you specified
in the Field Separation area. Make sure the preview looks correct, and make
appropriate changes until your data preview looks accurate.
10. Click Next when you are finished specifying your flat file layout.
11. Click Preview in the Edit Column Details workspace to verify that your
setting selections are showing up correctly. The preview lists the first few rows
of data, divided into columns as specified by the options on the page. You can
resize columns in this view. You can change the column width values, and
view the changes in the preview view.
12. Click Next in the bottom right corner of the screen.
13. Specify the table name, or logical file name, that you want to assign to the flat
file in the Name field in the Save File Definition workspace.
14. Click Finish in the bottom right corner of the screen when you have entered
all of your flat file information.
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What to do next
The format of the flat file that you want to import is now saved in the QETXT.INI
file for the data source that you want to import your flat file to. Import the
contents of the flat file into a table in your data source by highlighting the data
source that you want to work with and clicking Import in the Tasks menu.

Project overview
A project is an object that contains all the information that you need to build and
run an analysis job and view analysis results. Each project is unique, depending on
the analytical settings that were configured in the project when it was created.
However, multiple projects can access the same metadata that is stored in the
repository and share the same users and data sources across suite components.
Typically, a project administrator or a user with administrative rights creates a
project and configures all of the data source connections and security options that
are associated with the project. After a connection to a data store is created, the
administrator imports metadata and registers it to the project. Only the
administrator has access to connection information and security options. An
administrator uses the security options to assign user roles to authorized users. A
user can then access certain project tasks depending on the role that they were
assigned.
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The following diagram shows the project creation process.

Creating a project
You must first create a project. A project is a logical container for all of the tasks
that can be performed in a product module.

Before you begin
You must have permissions to create a project. If you do not, all project creation
menus and tasks are disabled.

Procedure
1. On the File menu in the IBM InfoSphere Information Server console, select
New Project.
2. In the New Project window, select the type of project that you want to create.
The Type field is displayed only if more than one product module is installed.
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3. Type a name for the project.
4. Click OK to open the Project Properties workspace.

What to do next
v “Modifying project properties” on page 29
v “Assigning users to a project and assigning roles”

Opening an existing project in the IBM InfoSphere Information
Server console
You can open an existing project to perform tasks that are associated with the
project's product module, such as information analysis or information services
enablement.

Before you begin
You or your administrator must create and set up a project.

Procedure
1. In the Projects pane of the My Home workspace, select a project from the list.
2. Click Open Project to open the Dashboard workspace.

Assigning users to a project and assigning roles
When you create a project, you can specify which users can access that project. You
can also specify which actions users can perform in that project.

About this task
To add users to a project and assign roles, you use different tools. The tool you use
depends upon the product module in which you are working:
v For IBM InfoSphere Information Analyzer and IBM InfoSphere Information
Services Director, use the IBM InfoSphere Information Server console as
described in this procedure.
v For IBM InfoSphere DataStage and IBM InfoSphere QualityStage, use the IBM
InfoSphere DataStage and QualityStage Administrator. See the IBM InfoSphere
DataStage and QualityStage Administrator Client Guide.
v For IBM InfoSphere FastTrack, use the IBM InfoSphere FastTrack console. See the
IBM InfoSphere FastTrack Tutorial.

Procedure
1. In the IBM InfoSphere Information Server console, open the project that you
want to assign users and roles to.
2. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
3. On the Project Properties workspace, select the Users tab.
4. In the Users pane, click Browse to add users to the project.
5. On the Add Users window, select the users that you want to add to the project,
click Add, then click OK.
6. On the Project Roles pane, select a project role to assign to the selected user. A
user can be assigned one or more roles in a project.
7. Click Save All.
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Assigning groups to a project and specifying roles
When you create a project, you can specify which groups can access that project.
You can also specify which actions they can perform in that project.

About this task
To assign groups to a project and select roles, you use different tools. The tool you
use depends on the product module in which you are working:
v For IBM InfoSphere Information Analyzer and IBM InfoSphere Information
Services Director, use the IBM InfoSphere Information Server console as
described in this procedure.
v For IBM InfoSphere DataStage and IBM InfoSphere QualityStage, use the IBM
InfoSphere DataStage and QualityStage Administrator. See the IBM InfoSphere
DataStage and QualityStage Administrator Client Guide.
v For IBM InfoSphere FastTrack, use the IBM InfoSphere FastTrack console. See the
IBM InfoSphere FastTrack Tutorial.

Procedure
1. In the IBM InfoSphere Information Server console, open the project that you
want to assign groups to.
2. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
3. On the Project Properties workspace, select the Groups tab.
4. In the Groups pane, click Browse to add groups to the project.
5. On the Add Groups window, select the groups that you want to add to the
project, click Add, then click OK.
6. On the Project Roles pane, select a role to assign to the selected group. A group
can be assigned one or more roles in a project.
7. Click Save All.

Multiple user support in projects
Projects provide a collaborative environment that help users to understand the
meaning, structure, and content of information across a wide variety of sources.
Multiple users can contribute to a project and view the status of a project over
time.
In IBM InfoSphere Information Analyzer, multiple users can access a project at one
time. Users can view project data, review analysis results, enter annotations and
notes, and run analysis jobs. When multiple analysis jobs are sent for processing,
they are processed in a queue.
If you are adding annotations, modifying analysis results, or modifying project
details, be aware that other users might also be modifying that information. Before
you edit or add information, click
the latest information.

(Refresh) to ensure that you are viewing

Modifying project properties
You can view and modify the properties of your project.
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Before you begin
You must have project administrator authority.

Procedure
1. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
2. Specify information about the project.
3. Click Save All.

Associating imported metadata with your project
You can associate imported metadata with your project. The metadata that you
associate with the project determines which data sources you can analyze.

Before you begin
You must have InfoSphere Information Analyzer Project Administrator authority.
An InfoSphere Information Analyzer Data Administrator must have completed the
following task:
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/
com.ibm.swg.im.iis.found.moz.common.doc/topics/t_configure_dsn.html

About this task
The metadata repository is an enterprise-wide repository and might contain a large
number of data stores. Many of those data stores might not be relevant to your
project. You associate metadata with your project at the data store, schema, table,
file, or column level. You can create multiple analysis projects for each object and
register interest in data sources on different host computers or multiple data stores
on the same host computer.

Procedure
1. On the Overview navigator menu in the console, select Project Properties.
2. Select the Data Sources tab.
3. Click Add to identify data sources that you want to associate with your project.
4. In the Select Data Sources window, expand the hierarchical tree to view
schemas, directories, tables, files, and columns.
5. Select one or more schemas, tables, files, or columns that you want to associate
with this project. You can select multiple items by clicking Shift+Click or
Ctrl+Click.
6. Click OK to associate the selected data sources with the project.
7. In the Data Sources tab, click Save All.

Metadata in your project
After you import metadata into the metadata repository, you must register the
metadata to the project that you want to use it in. When you associate metadata
with your project, you choose the information that you need to create analysis jobs,
to run analysis jobs, and to subsequently review analytical results.
You register metadata to your project at the data store, schema, table, or file level.
This creates a second environment for analysis as well as allowing you to reduce
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or control the amount of data presented to other project users. Metadata can be
registered to multiple projects by authorized users.

Modifying project analysis settings
You can fine-tune the parameters, settings, and thresholds for analysis jobs. When
you modify the project analysis settings, you override the default system settings.
All new analysis jobs that are created in the project inherit the new settings.

Before you begin
You must have IBM InfoSphere Information Analyzer Product Administrator
authority.

About this task
Analysis options determine how the system performs analysis. You can modify the
individual settings for each piece of analysis. By modifying analysis options, you
are typically tightening or loosening the capability of the system to make its
analytical inferences.

Procedure
1. On the Overview navigator menu in the console, select Project Properties.
2. Select the Analysis Settings tab.
3. Select Project on the Select View pane.
4. Modify the analysis settings.
5. In the Analysis Settings tab, click Save All.

Modifying data source settings
You can fine-tune the parameters, settings, and thresholds that are used in analysis
jobs at the data source level. When you modify the data source settings, you
override the system settings.

Before you begin
You must have InfoSphere Information Analyzer Project Administrator authority.

About this task
Analysis options determine how the system performs analysis. You can modify the
individual settings for each piece of analysis. By modifying analysis options, you
can tighten or loosen the capability of the system to make its analytical inferences.

Procedure
1.
2.
3.
4.
5.

On the Overview navigator menu in the console, select Project Properties.
Select the Analysis Settings tab.
On the Select View pane, select Data Sources.
Click the data source that you want to modify.
Click Modify.

6. In the Analysis Settings window, specify the new value.
7. Click OK.
8. In the Analysis Settings tab, click Save All.
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Modifying project analysis engine settings
You can customize the analysis engine settings at the project level. When you
modify the project level analysis engine settings, you override the default system
settings. All new analysis jobs that are created in the project inherit the new
settings.

Before you begin
You must have InfoSphere Information Analyzer Product Administrator authority.

About this task
Analysis engine settings determine which analysis engine you want to use at the
project level. By modifying the analysis engine settings, you are specifying which
engines you want to run your analyses with.

Procedure
1. Open an InfoSphere Information Analyzer project.
2. On the Overview navigator menu in the console, select Project Properties.
3. Select the Analysis Engine tab.
4. Select the host name for the computer that hosts the InfoSphere DataStage
server in the Host field.
5. Specify the port number to connect to InfoSphere DataStage in the Port field.
The default port number is 31538.
6. Enter the InfoSphere DataStage project name in the DataStage Project field.
7. Enter the array size in the Array Size field.
8. Enter your InfoSphere DataStage credentials in the DataStage Credentials
field.
a. Select Use Static DataStage Credentials to connect to InfoSphere
DataStage directly by using the operating system level credentials. If you
select this option, the setting is for all users who run analyses in this
project. If you do not select Use Static DataStage Credentials, then
InfoSphere Information Analyzer will use the mapped InfoSphere
DataStage credentials of the user who has logged into InfoSphere
Information Analyzer.
9. Click Validate Settings to verify your settings. Click Restore System Settings
to reset all the fields on the Analysis Engine tab to the system settings.
10. Click Yes in the Retain Scripts field if you want to keep the scripts for all jobs
that run, or click No if you do not want to save the scripts. The retained
scripts are located on the InfoSphere DataStage engine tier in the InfoSphere
DataStage project created for InfoSphere Information Analyzer.

Modifying project analysis database settings
You can customize the analysis database settings at the project level. When you
modify the project-level analysis database settings, you override the default system
settings. All new analysis jobs that are created in the project inherit the new
settings.

Before you begin
You must have InfoSphere Information Analyzer Product Administrator authority.
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About this task
Analysis database settings determine which analysis database you want to use at
the project level. By modifying the analysis database, you are specifying which
databases you want to run your analyses with.

Procedure
1.
2.
3.
4.

Open an InfoSphere Information Analyzer project.
On the Overview navigator menu in the console, select Project Properties.
Select the Analysis Database tab.
Select the database to use for the analysis database in the Database Type field.

5. Confirm the host computer where the analysis database exists in the Host
Name field.
6. Confirm the database name in the Database Name field.
7. Specify the port number to connect to the analysis database in the Port field.
Table 6. Default port numbers for connecting to the analysis database
Database type

Default port number

DB2 database

50000

Microsoft SQL Server

1433

Oracle

1521

8. Enter the user ID and password to connect to the analysis database.
9. Select DB2 for z/OS if you want to connect to a DB2 for z/OS® database, and
then enter a location name and collection name.
10. Verify that the default driver for the selected database type is automatically
entered into the Database Driver field. If you use a different driver, such as
ODBC DataConnect, you must specify the driver that you require.
a. Click Restore System Settings to restore the settings at the InfoSphere
Information Analyzer system level.
b. Click Validate Client Connection to verify that the connection is valid.
11. If you do not use the native database drivers to connect to the analysis
database, specify the URL for your driver in the following format:
connType:databaseDriver://hostName:portNumber;databaseName=databaseName
Where:
connType
The type of connection, for example JDBC or ODBC.
databaseDriver
The database driver to connect to the analysis database.
hostName
The host name of the computer where the analysis database is
installed.
portNumber
The port number to connect to the analysis database.
databaseName
The name of the analysis database.
12. Select the DSN name for the InfoSphere Information Analyzer analysis
database in the Analysis ODBC DSN field.
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Note: The DSN represents the specific DSN that is configured on the machine
that runs InfoSphere DataStage where the analysis operations will run. That
DSN needs to be set up and configured to access the InfoSphere Information
Analyzer analysis database.
a. Click Restore System Settings to restore the settings at the InfoSphere
Information Analyzer system level.
b. Click Validate Engine Connection to verify that the connection is valid.
13. Click Save All after you specify your analysis database settings.

Modifying a data connection
You can modify the connector you want to use to connect with your data store.
IBM InfoSphere Information Analyzer connects to data sources and imports
metadata using any of the common connectors that are available. You specify the
common connectors that you want InfoSphere Information Analyzer to use to
access and read data from a data source. You can reduce the time it takes
InfoSphere Information Analyzer to access data in your data store by selecting the
appropriate connector for that data source.

Before you begin
You must have InfoSphere Information Analyzer Data Administrator authority.

Procedure
1. On the Home navigator menu in the console, select Configuration > Sources.
2. Select the data source that you want to modify the connector for and click
Open Details from the Tasks menu on the right.
3. Modify the name of the connection in the Define a Data Connection field.
4. Optional: Enter a short description in the Short Description field.
5. Optional: Enter a long description in the Long Description field.
6. Select the type of connector you want to use to connect to the data source
from the Connector menu.
7. In the Connection String field, type the string or URL that is used to access
the connector. For example, type the ODBC DSN defined in the ODBC.INI file
or ODBC Administrator for the ODBC connector, or specify an IP address or
host name of a the server for the Teradata connector.
8. Enter a server name for the connector you select.
9. Type the user name and password used to connect to the data source.
10. Click Connect to verify that the connection to the database is valid.
11. Verify the information in the Data Store Information section.
12. Click Save and Close.

Assigning drill down security privileges for a project
You can specify the users who have permission to drill down to view the source
data in your project.

Before you begin
You must have InfoSphere Information Analyzer Product Administrator authority.
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About this task
You can protect the security of your data by providing only a select number of
users with InfoSphere Information Analyzer drill down security privileges and
enabling drill down security. When you enable the drill down security setting, you
limit the number of people who can view the source data. Only people with
Information Analyzer Drill Down User project roles will be able to drill down into
your source data if drill down security is enabled.

Procedure
1. On the Overview navigator menu in the console, select Project Properties.
2. Select the Users tab and select the Information Analyzer Drill Down User
project role for all users that you want to allow to drill down into project data.
3. Click Save All.

Enabling drill down security for a project
You can restrict access to the source data referenced in your project to users who
have specific drill down role permissions.

Before you begin
You must have InfoSphere Information Analyzer Product Administrator authority.

About this task
You can protect the security of your data by enabling drill down security. When
you enable the drill down security setting, you limit the number of people who
can view the source data. Only people with InfoSphere Information Analyzer drill
down project roles will be able to drill down into your source data if drill down
security is enabled.

Procedure
1.
2.
3.
4.

On the Overview navigator menu in the console, select Project Properties.
Select the Details tab.
Select Enable Drill Down Security.
In the Analysis Settings tab, click Save All.

Results
Once drill down security is enabled for a project, only users with the InfoSphere
Information Analyzer drill down project role can drill down into data.

Customizing the project dashboard
You can customize the Dashboard workspace in the IBM InfoSphere Information
Server console to add or remove content panes. For some product modules, you
can also configure the dashboard to show a set of charts and graphs that are based
on underlying project information.

Procedure
1. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Dashboard.
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2. In the Dashboard workspace, click Configure
3. Optional: Click Add to add content panes to the Content list. The available
content panes depend on the product modules that are installed.
4. In the Configure Dashboard window, select the content pane that you want to
modify.
5. For each content pane, you can modify the label of the pane and select whether
it is displayed on the workspace. Some content panes have additional
configuration properties.
6. Click OK to save your changes.

Project dashboard
In the project dashboard, you can view charts and graphs that summarize statistics
about your data.
You can view the project dashboard to see the status of any analysis performed on
sources in the project and find any anomalies that were found during analysis.
You or your project administrator can configure the dashboard to display one or
more of the following panes.
Getting Started pane
Provides an information analysis workflow that describes the available
profiling tasks and their prerequisite steps.
Data Sources Summary pane
Shows the column analysis status of the entire project, a table, or a data
source.
Data Sources pane
Shows the column analysis status of multiple data sources side-by-side.
Completeness and Validity Summary pane
Shows the total number of invalid, incomplete, and null values that were
found in the data store. An incomplete value is a data value that does not
provide any meaningful data, such as a record in a city column that has a
value of n/a. An invalid value is a data value that does not meet the
user-defined requirements for that field. A null value is a data field that is
empty.
Format Summary pane
Shows the total number of data sources that are associated with the project
that do not conform to the inferred format. For example, if a column has
an inferred format of date (YYMMDD) and the data value has a format of
AA11, the data format is flagged as nonconforming.
Property Summary pane
Shows the total number of columns that contain rows that have data type,
length, nullability, precision, or scale anomalies.
Aggregated Anomalies Summary pane
Shows an overview of the anomalies that were found during column
analysis jobs that ran in the project. An anomaly represents the difference
between an original value and an inferred value. For example, if the
Aggregated Summary chart displays 20 properties anomalies, 20 values
might have an inferred length value that is different than the original
value.
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Analysis statistics
In the Analysis tab, you can view the analysis status of each data source that is
associated with your project.
Status information is conveyed by colored bars called status indicators. The
shading of the indicator changes to where a data source is in the analysis or review
process.
Complete
Shows a green bar that indicates that the source has been analyzed and
reviewed.
Partial Shows a green striped bar that indicates that the source is in the process of
being analyzed or reviewed. A percentage shows how much of the source
is analyzed.
None

Shows a gray bar that indicates that the data source has not been analyzed
or reviewed.

Analysis/Review
Shows a split bar that indicates the status of the analysis (on the right) and
the status of the review (on the left).
From this tab, you can select one of the analysis buttons to open the corresponding
workspaces.
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Chapter 3. Managing metadata
After you import metadata into the metadata repository, you can add or modify
information about the metadata such as the description of a table. You can also
add information such as contacts, policies, and IBM InfoSphere Business Glossary
terms to the imported schemas, directories, tables, files, and data fields.

Metadata management
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
IBM InfoSphere Business Glossary provides the foundation for creating
business-driven semantics, including categories and terms. Using IBM InfoSphere
Information Analyzer, you can enhance and extend the semantic information.
For example, you might want to manage information about metadata when you
need to create a policy or contact, or clarify the meaning of a table, file, or other
data source. InfoSphere Information Analyzer allows you to see the actual data
content and validate that the metadata descriptions are correct. When you clarify
the meaning of a data source, you make the analytical terms in your metadata
easier for users to understand. For example, the field CUST_NBR_1 does not have
an explicit definition. To define the meaning of this field, you can add a definition
to the field in your metadata. In this example, the CUST_NBR_1 field contains
information about customer numbers. To clarify the meaning of the field, you can
add a definition that explains that the field contains customer numbers.
You can manage metadata to store corporate-standard business terms and
descriptions that reflect the language of the business users. Organizations
institutionalizing formal data management or data governance can publish these
terms as a way to ensure that all business users have a consistent mental model of
the organization's available information based on standard business definitions.
You can change information in multiple data sources:
Database
A database is the source from which your metadata is imported into the
metadata repository. A database contains tables, files, directories, and data
fields.
Tables or files
A table or file contains metadata that you can import into the metadata
repository.
Data fields
A data field or column is an individual piece of data such as a name, order
number, or address.
You can create and add contacts, policies, and terms.
Contacts
A contact contains personal information such as names, addresses, and
telephone numbers of users. Creating a contact does not create a user
account in the system. However, the project administrator might use
contact information to make decisions when assigning user roles to the
project. A contact might also be a person who is associated with specific
data. For example, one user might be the contact for account information
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while another user might be the contact for customer information such as
names and addresses. You can add contacts to a database, table, file, and
data field.
Policies
A policy is typically a document that defines business guidelines or
standards such as security regulations. You can add policy references to a
database, table, file, and data field.
Terms A term is a business definition that becomes a part of the InfoSphere
Business Glossary vocabulary and classification system. For example, if
your data contains information about a bank, you might create a term
called Bank Customer that describes the data about customers. You can
create terms to assign to assets that are physical data resources. You can
assign a term to a database, database table, database column, data file, or
data file field. Terms that are defined in InfoSphere Business Glossary are
available in InfoSphere Information Analyzer and vice versa. Terms are
visible only if you have InfoSphere Business Glossary Author or User roles.
Related tasks
“Adding metadata to a database” on page 46
You can add metadata such as a name alias, description, terms, contacts, and
policies to a database. You might want to add metadata to a database to clarify
what that instance of the database means.
“Adding metadata to a table or file” on page 46
You can add metadata to a table or file, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to clarify what any one
instance of a table or file means.
“Adding metadata to a data field” on page 47
You can add metadata to a data field, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to a data field to clarify
what that one instance of the data field means.

Creating, editing, or deleting InfoSphere Business Glossary terms
IBM InfoSphere Business Glossary Author users can create a term, edit the
properties of an existing term, or delete a term by using the IBM InfoSphere
Information Analyzer client.

Before you begin
You must have the InfoSphere Business Glossary Author role to create, edit, or
delete a term.
Note: You must have InfoSphere Business Glossary User privileges to view the
Terms option in the Navigator menu.

Procedure
1. On the Home Navigator menu in the InfoSphere Information Analyzer console,
select Metadata Management > Terms.
2. Optional: To create a term:
a. Click New on the Tasks menu.
b. Specify information about the term.
Note: In any text entry field, you can include hypertext links to additional
information. The hypertext links are displayed in the InfoSphere Business
Glossary browser.
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3. Optional: To edit a term:
a. Select a term and click Open Term in the Tasks menu.
b. Change information about the term.
4. Optional: To delete a term:
a. Select the term that you want to delete from the list of all terms.
b. Click Delete Term in the Tasks menu.
5. Click View in InfoSphere Business Glossary to open the term in the
InfoSphere Business Glossary client.
6. Click Save or Save and Close.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Assigning assets to a term”
IBM InfoSphere Business Glossary Author users can assign assets in the metadata
repository through the IBM InfoSphere Information Analyzer client.
“Adding metadata to a database” on page 46
You can add metadata such as a name alias, description, terms, contacts, and
policies to a database. You might want to add metadata to a database to clarify
what that instance of the database means.
“Adding metadata to a table or file” on page 46
You can add metadata to a table or file, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to clarify what any one
instance of a table or file means.
“Adding metadata to a data field” on page 47
You can add metadata to a data field, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to a data field to clarify
what that one instance of the data field means.

Assigning assets to a term
IBM InfoSphere Business Glossary Author users can assign assets in the metadata
repository through the IBM InfoSphere Information Analyzer client.

Before you begin
You must have the InfoSphere Business Glossary Author role.

About this task
You can assign assets when you create a term from the Create Term workspace or
by opening a term and assigning assets.

Procedure
1. On the Home Navigator menu in the InfoSphere Information Analyzer console,
select Metadata Management > Terms.
Note: You must have InfoSphere Business Glossary User privileges to view the
Terms option in the Navigator menu.
2. Select a term from the list of all terms and click Open Term in the Tasks menu.
3. On the Open Term page, click Assigned Assets.
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4. Click Assign New Asset to assign a new asset.
5. Select an asset in the Select Assets window, and then click Add.
6. Click Save and Close.

Creating a policy
You can create a policy to define business guidelines such as security regulations.
You can add policies to a database, table, file, and data field.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Policies.
2. In the Policies workspace, click New.
3. In the Create Policy pane, provide information for the policy.
4. In the Authors table, click Add to select users and assign authority to modify
the policy.
5. Click Save.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Modifying the details of a policy”
You can modify the details of a policy.
“Adding metadata to a database” on page 46
You can add metadata such as a name alias, description, terms, contacts, and
policies to a database. You might want to add metadata to a database to clarify
what that instance of the database means.
“Adding metadata to a table or file” on page 46
You can add metadata to a table or file, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to clarify what any one
instance of a table or file means.
“Adding metadata to a data field” on page 47
You can add metadata to a data field, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to a data field to clarify
what that one instance of the data field means.

Modifying the details of a policy
You can modify the details of a policy.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Policies.
2. In the Policies workspace, select the policy that you want to modify.
3. In the Tasks pane, click Open.
4. In the Open Policy pane, modify any details for the policy.
5. Click Save.
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Related tasks
“Creating a policy” on page 42
You can create a policy to define business guidelines such as security regulations.
You can add policies to a database, table, file, and data field.

Creating a contact
You can create and add contacts to a database, table, file, and data field. A contact
contains personal information such as names, addresses, and telephone numbers of
users.

About this task
A contact might also be a person who is associated with specific data. For example,
a user might be the contact for account information while another user might be
the contact for customer information such as names and addresses. A contact can
also be a group of people.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Contacts.
2. In the Contacts workspace, click New.
3. In the Create Contact pane, type details for the contact. The Last Name (Family
Name) and the First Name (Given Name) fields are required.
4. Click Save.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Modifying the details of a contact”
You can modify the details of a contact.
“Adding metadata to a database” on page 46
You can add metadata such as a name alias, description, terms, contacts, and
policies to a database. You might want to add metadata to a database to clarify
what that instance of the database means.
“Adding metadata to a table or file” on page 46
You can add metadata to a table or file, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to clarify what any one
instance of a table or file means.
“Adding metadata to a data field” on page 47
You can add metadata to a data field, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to a data field to clarify
what that one instance of the data field means.

Modifying the details of a contact
You can modify the details of a contact.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Contacts.
2. In the Contacts workspace, select the contact that you want to modify.
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3. In the Tasks pane, click Open.
4. In the Open Contact pane, modify any details for the contact.
5. Click Save.
Related tasks
“Creating a contact” on page 43
You can create and add contacts to a database, table, file, and data field. A contact
contains personal information such as names, addresses, and telephone numbers of
users.

Adding a new data class
You can add a new data class to extend data classification and analysis capabilities.

About this task
You can add defined data subclasses to the system-provided data classes. For
example, you might classify an Indicator class as a Gender class or Flag class. A
Text classification might be further defined as a Name, Address, or Other class.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Data Classes.
2. Click New in the Tasks menu.
3. Enter the name of a data class in the Title field.
4. Optional: Enter the code name of the data class in the Code field. For example,
if the title of your data class is "Personal Identification Information," then the
code name might be "PII." The code name does not have to be an acronym, but
it must be unique.
5. Optional: Enter a short description and a long description of the data class in
the Short Description and Description fields.
6. Optional: Click Add in the Sub Classes field to add a subclass to your data
class. For example, you can add the subclass "address" to the data class
"Personal Identification Information."
a. Select the category in which you want to put the subclass.
b. Enter a subclass title, subclass code and description, and then click OK.
c. Click Save.
7. Click Save.

What to do next
You can enable the extended classification for the new data class you just added by
going to the Home navigator menu in the console and selecting Configuration >
Analysis Settings. You can enable the classification settings and set the
classification order. When you run a column analysis, you can enable these
classification settings and see the classification results after you run a column
analysis and view the details of the analysis results.

Modifying the details of a data subclass
You can modify the details of a data subclass.
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Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Data Classes.
2. In the Data Classes workspace, select the subclass that you want to modify.
3. In the Tasks pane, click Open.
4. In the Data Class pane, modify any details for the subclass.
5. Click Save.

Creating a user class
You might want to create a user class to extend the base set of data classes that
come with IBM InfoSphere Information Analyzer. A user classification is an
organizationally defined method of classifying a specific type of data.

About this task
For example, the code NAME might be used to classify any data such as a
customer name, contact, or employee.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
User Classes.
2. In the User Classes workspace, click New.
3. In the Create User Class pane, provide information for the user class.
4. Click Save.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Modifying the details of a user class”
You can modify the details of a user class.

Modifying the details of a user class
You can modify the details of a user class.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
User Classes.
2. In the User Classes workspace, select the user class that you want to modify.
3. In the Tasks pane, click Open.
4. In the Open User Class pane, modify any details for the user class.
5. Click Save.
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Related tasks
“Creating a user class” on page 45
You might want to create a user class to extend the base set of data classes that
come with IBM InfoSphere Information Analyzer. A user classification is an
organizationally defined method of classifying a specific type of data.

Adding metadata to a database
You can add metadata such as a name alias, description, terms, contacts, and
policies to a database. You might want to add metadata to a database to clarify
what that instance of the database means.

About this task
The metadata is stored in the metadata repository and is available in suite
components such as IBM InfoSphere Business Glossary.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Data Stores.
2. In the Databases workspace, select the database that you want to add metadata
to.
3. In the Tasks pane, click Open Details.
4. In the Open Details Database pane, click Add in the table for the type of item
that you want to add to the database.
5. Select the metadata that you want to add to the database and click OK.
6. Click Save.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Creating, editing, or deleting InfoSphere Business Glossary terms” on page 40
IBM InfoSphere Business Glossary Author users can create a term, edit the
properties of an existing term, or delete a term by using the IBM InfoSphere
Information Analyzer client.
“Creating a policy” on page 42
You can create a policy to define business guidelines such as security regulations.
You can add policies to a database, table, file, and data field.
“Creating a contact” on page 43
You can create and add contacts to a database, table, file, and data field. A contact
contains personal information such as names, addresses, and telephone numbers of
users.

Adding metadata to a table or file
You can add metadata to a table or file, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to clarify what any one
instance of a table or file means.
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About this task
The metadata is stored in the metadata repository and is available in suite
components such as IBM InfoSphere Business Glossary.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Tables or Files.
2. In the Tables or Files workspace, select the table or file that you want to add
metadata to.
3. In the Tasks pane, click Open Details.
4. In the Open Details Tables or Files pane, click Add in the table for the type of
item that you want to add to the table or file.
5. Select the metadata that you want to add to the table or file and click OK.
6. Click Save.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Creating, editing, or deleting InfoSphere Business Glossary terms” on page 40
IBM InfoSphere Business Glossary Author users can create a term, edit the
properties of an existing term, or delete a term by using the IBM InfoSphere
Information Analyzer client.
“Creating a policy” on page 42
You can create a policy to define business guidelines such as security regulations.
You can add policies to a database, table, file, and data field.
“Creating a contact” on page 43
You can create and add contacts to a database, table, file, and data field. A contact
contains personal information such as names, addresses, and telephone numbers of
users.

Adding metadata to a data field
You can add metadata to a data field, such as a name alias, description, terms,
contacts, and policies. You might want to add metadata to a data field to clarify
what that one instance of the data field means.

About this task
For example, the field CUST_NBR_01 has no explicit meaning. You can add a
definition to that data field to explain that it is an automatically generated
customer number. The metadata is stored in the metadata repository and is
available in suite components such as IBM InfoSphere Business Glossary.

Procedure
1. On the Home navigator menu in the console, select Metadata Management >
Data Fields.
2. In the Data Fields workspace, select the data field that you want to add
metadata to.
3. In the Tasks pane, click Open Details.
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4. In the Open Details Data Fields pane, provide information to add metadata to
the data field.
5. Click Add in the table for the type of item that you want to add to the data
field.
6. Select the metadata that you want to add to the data field and click OK.
7. Click Save.
Related concepts
“Metadata management” on page 39
IBM InfoSphere Information Analyzer provides the data-driven creation of
metadata and a way to link the metadata to physical objects.
Related tasks
“Creating, editing, or deleting InfoSphere Business Glossary terms” on page 40
IBM InfoSphere Business Glossary Author users can create a term, edit the
properties of an existing term, or delete a term by using the IBM InfoSphere
Information Analyzer client.
“Creating a policy” on page 42
You can create a policy to define business guidelines such as security regulations.
You can add policies to a database, table, file, and data field.
“Creating a contact” on page 43
You can create and add contacts to a database, table, file, and data field. A contact
contains personal information such as names, addresses, and telephone numbers of
users.
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Chapter 4. Getting started with analysis
Before you can being analyzing data, you must understand the project
environment, open a project, review the dashboard, and decide which analysis jobs
or analysis reviews you want to conduct.

Defining analysis settings
Analysis settings apply to column analysis, table analysis, and cross-table analysis.
Each threshold option is a percentage that controls the fraction of values that are
required to meet this threshold before making the inference.

Analysis threshold settings
Analysis threshold settings specify how the InfoSphere Information Analyzer
performs analysis. You can modify the individual settings for column analysis,
table analysis, and cross-table analysis. Each threshold option is a percentage that
controls the fraction of values that are required to meet this threshold before
making the inference.
A threshold setting is a percentage that controls the total number of data values
that are required to meet the threshold before an inference is made by the system.
For example, if the threshold setting ConstantThreshold equals 99%, then almost
all of the values in a column must be the same for that column to be inferred as a
constant. If 100% of the values in a column are the same, then the column will be
inferred as a constant. If 99.1% of the values in the column are the same, the
column will also be inferred as a constant. However, in a table of one million rows,
this value indicates that there are 9000 non-constant values. This means that there
is a possibility that the inference might be wrong. When you review the results in
the frequency distribution of a column, you can examine the values and determine
whether 0.9% of the values are inconsistent or invalid. You can then change the
inference in the frequency distribution if you choose.

Column analysis settings
The following table shows the column analysis settings that you can modify. Note
that the default values listed are the system defaults. If you modified the default
system settings in the Analysis Settings workspace, then the modified settings are
displayed. View column analysis settings by going to the Home navigator menu
and selecting Configuration > Analysis Settings.
Table 7. Column analysis settings
Setting

Description

Nullability threshold

Infers whether a column allows null values.
If a column has null values with a frequency
percentage equal to or greater than the
nullability threshold, the system determines
that the column allows null values. If null
values do not exist in the column or the
frequency percent is less than the threshold,
the system determines that the column does
not allow null values. The default is 1.0%.
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Table 7. Column analysis settings (continued)
Setting

Description

Uniqueness threshold

Infers whether a column is considered
unique. If a column has a percentage of
unique values equal to or greater than the
uniqueness threshold, the system determines
that the column is unique. The default is
99.0%.

Constant threshold

Infers whether a column contains constant
values. If a column has a single distinct
value with a frequency percentage equal to
or greater than the constant threshold, the
system determines that the column is
constant. The default is 99.0%.

Classification order of preference settings
The following table shows the classification order settings that you can enable
based on your column analysis preferences. You can enable an additional level of
data classification such as credit card number or name by clicking Enable. You can
change the order of the classification settings that you have enabled by using the
arrows to the right of the Classification Order of Preference section.
Table 8. Classification order of preference settings
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Data class

Description

Account Number

Infers whether a column can be considered
an account number.

Addresses

Infers whether a column can be considered
an address.

AMEX

Infers whether a column can be considered
an American Express credit card number.

Bank Account Number

Infers whether a column can be considered a
bank account.

Canadian SIN

Infers whether a column can be considered a
Canadian social insurance number (SIN).

Code

A column that contains code values that
represent a specific meaning. For example, a
column with the class of Code might contain
data about the area code in a telephone
number.

Company Name

Infers whether a column can be considered a
company name.

Computer Addresses

Infers whether a column can be considered a
computer address.

Country Code

Infers whether a column can be considered a
country or region code.

Credit Card Number

Infers whether a column can be considered a
credit card number.

Date

Infers whether a column can be considered a
chronological data. For example, a column
with the class of Date might contain data
such as 10/10/07.

Table 8. Classification order of preference settings (continued)
Data class

Description

Date of Birth

Infers whether a column can be considered a
date of birth.

Diners Club

Infers whether a column can be considered a
Diners Club credit card number.

Discover

Infers whether a column can be considered a
Discover credit card number.

Drivers License

Infers whether a column can be considered a
drivers license number.

Email Address

Infers whether a column can be considered
an e-mail address.

France INSEE

Infers whether a column can be considered a
French National Institute for Statistics and
Economic Studies (INSEE) number.

Gender

Infers whether the column is a gender code,
such as Male/Female or M/F.

Host Name

Infers whether a column can be considered a
host name.

Identification Number

Infers whether a column can be considered
an identification number.

Identifier

A data value that is used to reference a
unique entity. For example, a column with
the class of Identifier might be a primary
key or contain unique information such as a
customer number.

Indicator

Infers whether a column contains binary
values such as M/F, 0/1, True/False,
Yes/No.

International Securities Identification
Number

Infers whether a column can be considered
an international securities identification
number.

International Standard Book Number

Infers whether a column can be considered
an international standard book number.

IP Address

Infers whether a column can be considered
an IP address.

Italy Fiscal Code

Infers whether a column can be considered
an Italian fiscal code.

Japan CB

Infers whether a column can be considered a
Japanese CB number.

Large Object

A large object is a column whose length is
greater than the length threshold. A column
defined as a large object will not be
explicitly profiled. Large Object is assigned
to columns that have a BLOB data type.

MasterCard

Infers whether a column can be considered a
MasterCard credit card number.

Names

Infers whether a column can be considered a
name.

Notes Email Address

Infers whether a column can be considered
an IBM Lotus Notes® e-mail address.
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Table 8. Classification order of preference settings (continued)
Data class

Description

Passport Number

Infers whether a column can be considered a
passport number.

Personal Addresses

Infers whether a column can be considered a
personal address.

Personal Identification Information

Infers whether a column can be considered
personal identification information.

Personal Identification Numbers

Infers whether a column can be considered a
personal identification number.

Personal Name

Infers whether a column can be considered
an individual's personal name.

Quantity

A column that contains data about a
numerical value. For example, a column
with the class of Quantity might contain
data about the price of an object.

Spanish NIF

Infers whether a column can be considered a
Spanish identification number (número de
identificación or NIF).

Text

A column that contains unformatted
alphanumeric data and special character
data.

UK NINO

Infers whether a column can be considered a
UK national insurance number (NINO).

Universal Product Code

Infers whether a column can be considered a
universal product code.

Unknown

Columns that cannot be classified by the
system are defined as Unknown. The
Unknown class is applied temporarily
during analysis.

URL

Infers whether a column can be considered a
Web address.

US Phone Number

Infers whether a column can be considered a
U.S. telephone number.

US SSN

Infers whether a column can be considered a
U.S. Social Security number (SSN).

US State Code

Infers whether a column can be considered a
U.S. state code or abbreviation.

US Zip

Infers whether a column can be considered a
U.S. postal code.

US Zip+4

Infers whether a column can be considered
an extended U.S. ZIP Code.

Visa

Infers whether a column can be considered a
Visa credit card number.

Table analysis settings
The following table shows the table analysis settings that you can modify for
primary key analysis and foreign key analysis. Note that the default values listed
are the system defaults. If you modified the default system settings in the Analysis
Settings workspace, then the revised settings are displayed.
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Table 9. Table analysis settings
Setting

Description

Primary key threshold

Infers whether a column, either a single
column or multiple column concatenation,
can be considered a primary key candidate.

Data sample size

Controls the number of records that are
included when a data sample of the table or
file is created. The default is 2,000 records.

Data sample method

Determines which type of method is used to
create a data sample: sequential, random, or
every nth value.

Data sample parameter

Specifies the n value for the n data sampling
method. The default is 10.

Composite key maximum

Determines the maximum number of
columns that can be combined when you
search for primary key candidates. The
default is 2.

Cross-table analysis settings
You can modify the default cross-table analysis settings. If you modified the
default system settings in the Analysis Settings workspace, those defaults are
displayed.
Common domain threshold setting
Determines the percentage of distinct values in the frequency distribution
of one column that match distinct values in the frequency distribution of
another column. If the percentage of matching distinct values is equal to or
greater than the threshold, then the two columns are inferred to have a
common domain. The default is 98%.

Project environment overview
Your project environment consists of one or more clients, a server, a metadata
repository, and a connector.
The client is connected to a metadata repository that stores all analysis work,
configuration options, and analysis results. The client is the interface that you use
to complete tasks. The repository is connected to data stores on a host computer
through a connector. Before you can profile your data, the metadata for your
source data must be imported into the repository. During project set up, your
administrator imports selected metadata into the repository and registers interest in
that metadata through your project. The metadata repository resides on the server
computer and holds the metadata that is shared by multiple projects in multiple
suite components.

Opening an existing project in the IBM InfoSphere Information Server
console
You can open an existing project to perform tasks that are associated with the
project's product module, such as information analysis or information services
enablement.
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Before you begin
You or your administrator must create and set up a project.

Procedure
1. In the Projects pane of the My Home workspace, select a project from the list.
2. Click Open Project to open the Dashboard workspace.

Identifying status by viewing the dashboard
You can view the status of all the data sources that are associated with the project
and drill down into an individual analysis to complete analysis or review the
results.

About this task
You can view the analysis results summary to see the status of a data source.
Status indicators identify whether or not a data source has been analyzed and
reviewed. The indicators change color to reflect the current status of a data source
as it is analyzed.

Procedure
1. On the Overview navigator menu in the console, select Dashboard.
2. On the Dashboard workspace, select the Analysis tab.

What to do next
You can now conduct an analysis review.

Conducting an analysis review
To understand the current quality of the data, identify inconsistencies between
defined values and inferred values, identify incomplete data, and determine which
additional analytical functions you should perform, you can review analysis
results.

Before you begin
You must be an IBM InfoSphere Information Analyzer User with Business Analyst
or Data Steward privileges.

Procedure
1. On the Overview navigator menu, select Dashboard.
2. On the Dashboard workspace, select the Analysis tab.
3. Select the table, column, or file that you want to review.
4. Click the analysis button that corresponds to the review that you want to
conduct.
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Chapter 5. Analyzing columns
To understand your data at the lowest level, including its contents, quality, and the
accuracy of its metadata, you can analyze columns to examine the properties and
characteristics of these columns or fields to find inconsistencies and anomalies.

About this task
Inferences and analysis results help you to make decisions about how you want to
manage data. When you complete a column analysis job, you review the results
and system inferences and save the metadata. You can examine the summary data
for the data fields, change the results that are inferred by the system, and drill
down into individual data fields for a detailed view of the data. When you
complete your review, you can create reference tables to use information that is
gathered during the analysis outside of the column analysis job, add notes during
the review, and mark the review as complete.

Column analysis
Column analysis is a data profiling process that examines the content of columns
in your data. You run a column analysis job to understand the structure of your
data and to find anomalies that might be affecting the quality of your data.
During a column analysis job, the characteristics of your data are evaluated by
analyzing a frequency distribution of the data values in each column. After the
frequency distribution is analyzed, inferences are made by the system. Inferences
often represent the best choice that you can make about a specific element in your
data. For example, when your data is analyzed, data classes are inferred for each
column. A data field is classified into a data class based on the semantic business
use and physical properties of the data field. You can accept the inferences or make
another choice when you review the results of the column analysis in the
frequency distribution.
You run a column analysis job to evaluate the following characteristics of columns
in your data:
Minimum, maximum, and average field length
If a field is too short, you can lose data. If the field is too large, it uses
memory that might be needed elsewhere.
Precision and scale of numeric values
Precision refers to the total length of a numeric field. The scale of a
numeric value is the total length of the decimal component of a numeric
field.
Basic data types, including date and time formats
Basic data types, such as numeric and alphabetic types, are evaluated for
incorrect typing.
Count of distinct values (cardinality)
Cardinality refers to the number of distinct values in a column including
blanks and nulls.
Empty values and null values
Empty values use space and can be removed.
During a column analysis job, the following inferences are made about the content
and structure of columns in your data:
© Copyright IBM Corp. 2006, 2012
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Data type, length, precision, and scale
Type, length, precision, and scale values are inferred.
Data class
A data class is inferred. There are eight predefined data classes: Identifier,
Code, Indicator, Quantity, Date, Text, Large Object, and Unknown.
Field value uniqueness
Unique values are inferred. Unique values identify whether a column
contains mostly unique data values.

Data profiling process
You use the data profiling process to evaluate the quality of your data. The data
profiling process consists of multiple analyses that investigate the structure and
content of your data, and make inferences about your data. After an analysis
completes, you can review the results and accept or reject the inferences.
The data profiling process consists of multiple analyses that work together to
evaluate your data:

Column analysis
Column analysis is a prerequisite to all other analyses except for cross-domain
analysis. During a column analysis job, the column or field data is evaluated in a
table or file and a frequency distribution is created. A frequency distribution
summarizes the results for each column such as statistics and inferences about the
characteristics of your data. You review the frequency distribution to find
anomalies in your data. When you want to remove the anomalies in your data,
you can use a data cleansing tool such as IBM InfoSphere QualityStage to remove
the values.
A frequency distribution is also used as the input for subsequent analyses such as
primary key analysis and baseline analysis.
The column analysis process incorporates four analyses:
Domain analysis
Identifies invalid and incomplete data values. Invalid and incomplete
values impact the quality of your data by making the data difficult to
access and use. You can use the results from domain analysis when you
want to use a data cleansing tool to remove the anomalies.
Data classification analysis
Infers a data class for each column in your data. Data classes categorize
data. If your data is classified incorrectly, it is difficult to compare the data
with other domains of data. You compare domains of data when you want
to find data that contains similar values.
Format analysis
Creates a format expression for the values in your data. A format
expression is a pattern that contains a character symbol for each distinct
character in a column. For example, each alphabetic character might have a
character symbol of A and numeric characters might have a character
symbol of 9. Accurate formats ensure that your data is consistent with
defined standards.
Data properties analysis
Data properties analysis compares the accuracy of defined properties about
your data before analysis to the system-inferred properties that are made
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during analysis. Data properties define the characteristics of data such as
field length or data type. Consistent and well-defined properties help to
ensure that data is used efficiently.

Key and cross-domain analysis
During a key and cross-domain analysis job, your data is assessed for relationships
between tables. The values in your data are evaluated for foreign key candidates,
and defined foreign keys. A column might be inferred as a candidate for a foreign
key when the values in the column match the values of an associated primary or
natural key. If a foreign key is incorrect, the relationship that it has with a primary
or natural key in another table is lost.
After a key and cross-domain analysis job completes, you can run a referential
integrity analysis job on your data. Referential integrity analysis is an analysis that
you use to fully identify violations between foreign key and primary or natural
key relationships. During a referential integrity analysis job, foreign key candidates
are investigated at a concise level to ensure that they match the values of an
associated primary key or natural key.
A key and cross-domain analysis job will also help you to determine whether
multiple columns share a common domain. A common domain exists when
multiple columns contain overlapping data. Columns that share a common domain
might signal the relationship between a foreign key and a primary key, which you
can investigate further during a foreign key analysis job. However, most common
domains represent redundancies between columns. If there are redundancies in
your data, you might want to use a data cleansing tool to remove them because
redundant data can take up memory and slow down the processes that are
associated with them.

Baseline analysis
You run a baseline analysis job to compare a prior version of analysis results with
the current analysis results for the same data source. If differences between both
versions are found, you can assess the significance of the change, such as whether
the quality has improved.
The following figure shows how data profiling analyses work together:

Chapter 5. Analyzing columns

57

Key analysis
Single column primary key
Multiple column primary key
Natural keys

Foreign key analysis

Key and
relationship analysis
Column Analysis
Cross-domain
Analysis
Baseline Analysis

Figure 2. Data profiling analyses

Note: You do not need to run a column analysis job before you run a
cross-domain analysis job.

Running a column analysis job
To determine the structure and content of your data and identify anomalies and
inconsistencies in your data, you can analyze columns. Column analysis results are
used as the foundation for all other data profiling tasks.

Before you begin
You must have IBM InfoSphere Information Analyzer Data Operator privileges.
The following task must have been completed by an InfoSphere Information
Analyzer Data Administrator.
Associating metadata with the project

About this task
You can analyze columns now or you can schedule a column analysis job to run at
a set date and time.

Procedure
1. On the Investigate navigator menu in the console, select Column Analysis.
2. On the Column Analysis workspace, select the columns that you want to
analyze.
3. In the Tasks pane, click Run Column Analysis.
4. On the Run Column Analysis pane, type a new name for this analysis job in
the Job Name field.
5. Optional: In the Job Description field, type a description for this job. For
example, you might want to provide the purpose of the job.
6. Optional: Select Enable Enhanced Data Classification if you want to enable the
classification settings, such as a credit card or social security number
classification, that you specified in your analysis settings or project analysis
settings.
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7. Optional: Click the Connections tab and configure the connections for the data
source that you are using for the column analysis job.
a. Highlight the data store you want to configure in the Configure
Connections section and then select the connector you want to use from the
Connector drop-down menu.
b. Enter your User ID and password for the connector in the Connection
Settings section and click Test Connection. You can enter a different set of
user credentials for the connector that you select from the drop-down menu.
For example, the system level connector settings might use a administrator's
credentials, but at the project level you might want to use your personal
User ID and password for the same connector.
c. Click Submit after you successfully test the connection.
8. On the Scheduler tab, select Run Now.
9. Click Submit > Submit and Close to run the analysis job.

What to do next
After the column analysis job completes, you can click Open Column Analysis in
the Tasks pane to drill down into the results of the column analysis job and accept
or alter the inferred results.

Scheduling column analysis
If you need to analyze a large amount of data or if you want to repeat the analysis
on a daily, weekly, or monthly basis, you can schedule a column analysis job to
run at a set date and time.

Before you begin
You must have IBM InfoSphere Information Analyzer Data Operator privileges.
The following task must have been completed by an InfoSphere Information
Analyzer Data Administrator.
v “Associating imported metadata with your project” on page 30

Procedure
1. On the Investigate navigator menu in the console, select Column Analysis.
2. On the Column Analysis workspace, select the columns that you want to
analyze.
3. In the Tasks pane, click Run Column Analysis.
4. On the Scheduler tab, select Schedule.
5. In the Schedule Description field, type a description for this job. For example,
you might want to provide the purpose of the job.
6. In the Start Date field, specify the time and date that you want to first run the
job.
7. In the End Date field, specify the time and date that you want to end the job.
8. In the Frequency menu, select how often you want the column analysis job to
run.
9. Click Submit > Submit and Close.
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What to do next
After the first scheduled column analysis job completes, you can view the
summary information and accept or modify the inferred results.

Creating a virtual table
You create a virtual table to segment data from one of more tables. Such
segmentation can be vertical (either a subset or superset of columns based on a
selection of chosen columns) or horizontal (an explicit set of rows or records based
on a conditional expression) or both. You can then run subsequent analysis (for
example, column or cross-domain) on this virtual table.

Procedure
1. On the Column Analysis workspace of the console, select the base table from
which to create virtual table and click Create Virtual Table.
2. In the Name field, type a name for the virtual table.
3. In the Short Description field, type a short description. For example, you
might want to provide a reason for the specific view.
4. In the Long Description field, type a longer description.
5. Select one or more columns from the Available Columns list.
6. Click the arrow button to move the selected columns into the Selected
Columns list.
7. Optional: Modify the order of the selected columns by using the up and down
arrows.
8. Optional: To define filters for the selected columns, click Add Condition to
select the following 'where' clause parameters: open parenthesis, a column
name, an operator, a value, close parenthesis, and an And or Or Boolean
operator.
9. Click Save.

What to do next
You can analyze the new virtual table by running a column analysis job.

Creating a virtual column
A virtual column is the concatenation of data from one or more columns into one
column. You can then run subsequent analysis jobs on this concatenated column.

About this task
For example, you can combine a First Name column and a Last Name column into
one column called Name. You could then analyze this concatenated column, which
contains the data in both the First Name column and the Last Name column. A
virtual column might also be used to assess potential multicolumn primary keys or
validate a value pair combination from several fields. You can also create a virtual
column on a single column to truncate or pad the data in that column.

Procedure
1. On the Column Analysis workspace of the console, click Manage Virtual
Columns.
2. Click Create New to create a virtual column.
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3. In the Name field, type a name for the virtual column.
4. In the Definition field, type a description. For example, you might want to
provide a reason for the concatenation.
5. Select one or more columns from the Available Columns list.
6. Click the arrow button to move the selected columns into the Selected
Columns list.
7. Optional: Modify the order of the selected columns.
8. Optional: Add the following parameters: a fixed width for the column, a field
separator, or quotation marks around the column values.
9. Click Save.

What to do next
You can analyze the new virtual column by running a column analysis job.

Virtual columns
You create a virtual column when you want to run a column analysis job on
multiple columns. You might analyze virtual columns when you want to use the
results in analyses that evaluate multiple columns such as multiple column
primary key analysis or foreign key analysis.
You create a virtual column by concatenating the data values from multiple
columns in the same table. For example, if there are separate first_name and
last_name columns, you can create a virtual column called full_name that
encompasses both of the original columns and use it when you run a column
analysis job.
When you run a column analysis job, a frequency distribution is generated for the
virtual column. The results from a column analysis job using virtual columns is
similar to the results of a column analysis job for a single column except that no
inferences are made about data classes for virtual columns.

Removing a virtual column
You can remove the concatenation that forms a virtual column.

About this task
If you created a virtual column and no longer want to run analysis on the column,
you can delete the virtual column.

Procedure
1. On the Column Analysis workspace of the console, select Manage Virtual
Columns.
2. Select the virtual column that you want to remove in the Virtual Columns
object list.
3. Click Delete.
4. Click OK to confirm that you want to delete the virtual column.
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Viewing and verifying column analysis results
You can view the results of a column analysis job to understand the current quality
of the data, identify inconsistencies between values and attributes, identify
incomplete data, and determine which additional analytical functions you should
perform.

Before you begin
You must be an IBM InfoSphere Information Analyzer User with Business Analyst
or Data Steward privileges.

About this task
By viewing the results of a column analysis job, you can view key results and
begin the review process. Each step in the review process is supported with a
detailed review screen that contains or has access to all of the relevant data for that
function.

Procedure
1. On the Investigate navigator menu of the console, select Column Analysis.
2. On the Column Analysis workspace, select the columns that you want to view
results for.
3. On the Tasks pane, click Open Column Analysis.
4. In the View Analysis Summary pane, review the summary of the column
analysis job. Note columns where flags appear. These flags indicate that there is
a change or an inconsistency in the data.

What to do next
Click View Details to view additional details of the analysis, add notes to the
analysis, modify inferred results, or run additional analyses.

Frequency distribution
A frequency distribution shows a frequency count and characteristics for the
distinct values in a column. When you run a column analysis job, a frequency
distribution is generated for each column that you analyze.
You can use a frequency distribution to learn about the content of your data and
make decisions about how your data is structured. For example, when you want to
learn about how your data is categorized, you can examine the data classes that
were inferred during analysis. If you do not agree with the inferences, you can
select another data class when you review the frequency distribution.
A frequency distribution is also the foundation on which you run other analyses
when you profile data. For example, during a primary key analysis job, a
frequency distribution for a column is evaluated for unique values. If a column is
unique, it might be inferred as a candidate for the primary key.
When a frequency distribution is created during analysis, statistics about the
column are generated. The statistics include information such as the length of the
characters in a column, nulls, and data properties.
A frequency distribution lists the characteristics of the columns in your data:
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Inferences about the data type of each value in the column
A data type describes the structural format of data in a column. For
example, columns that contain numeric data are type N (numeric), and
columns that contain alphabetic data are type A (alphabetic).
Inferences about the data class of the column
A class is a variable that categorizes a column according to how the data in
the column is used. For example, if a column contains data such as
10/04/07, the Date class is assigned to the column because 10/04/07 is an
expression for a date.
The length calculation for each value in the column
Shows the total length of the values in a column.
The number of nulls in the column
Shows the total number of empty values in a column.
The number of valid and invalid values in the column
Shows whether a value has been inferred as valid or invalid.
The format expression for each value in the column
A format expression is a pattern that describes the type of data in a
column according to the type of the column. For example, if a column is of
the class Date, a format expression such as YYMMDD might be assigned to
the column (year, month, and day.)
The analysis also develops statistics about the columns in your data:
The cardinality count of the column
A cardinality count is the total number of distinct values in a column.
The cardinality percentage of the column
A cardinality percentage is a calculation of the total number of distinct
values in a column divided by the total number of values in the same
column.
Minimum, maximum, and average length of values in the column
Shows the average length of values and then calculates the minimum and
maximum lengths of values in the same column.
Distribution of inferred data types
Shows a distribution of all the data types that were inferred during
analysis.
Distribution of inferred format expressions
Shows a distribution of all of the format expressions that were inferred
during analysis.

Column analysis result reference
The following table describes the properties, attributes, and values that are
returned after a column analysis job runs.
Table 10. Column analysis result reference
Attribute

Description

Table Totals

Shows a total count of the records and the
columns in the selected data sources.

Column Attributes Reviewed

Shows the number of columns that have
been marked as reviewed.
Indicates that there is an anomaly between a
defined value and an inferred value. A red
indicator also appears in the analysis
column where the anomaly was found. The
indicator is removed after the column has
been marked reviewed.
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Table 10. Column analysis result reference (continued)
Attribute

Description
Indicates that the analyzed column was a
virtual column. A virtual column is a
concatenation of one or more columns for
analysis.
Indicates that a note is attached to the
column. Notes flag issues for further
investigation and can be attached to a data
source to provide notes and annotations.
Double-click the image to read the attached
note.
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Name

Shows the name of the column.

Position

Shows the logical sequence number of the
column in the order of columns.

Definition

Shows the description of the column that is
stored in the metadata.

Cardinality

Shows the number of distinct values that are
found and the percent of distinct values in
the total number of records.

Data Class

Shows the inferred and selected data classes.
A data field is classified into a data class
based on the semantic business use and
physical properties of the data field.

Data Type

Shows the defined, inferred, and selected
data types. A data type is a classification
that indicates what type of data is stored in
the data field. Number, character, floating
point, date, and integer are examples of data
types.

Length

Shows the defined, inferred, and selected
length of the data values in the column.

Precision

Shows the defined, inferred, and selected
maximum number of digits needed (both to
the left and right of the decimal place) to
hold all values that are present in a numeric
column. Precision is not applicable to
non-numeric columns.

Scale

Shows the defined, inferred, and selected
maximum number of digits that are needed
to the right of the decimal place to hold all
values that are present in a numeric column.
Scale is not applicable to non-numeric
columns.

Nullability

Shows the defined, inferred, and selected
results of whether the column allows null
values.

Cardinality Threshold

Shows the cardinality type and whether the
data is constant or unique.

Format

Shows the most frequent inferred format for
that column and the percent of records in
which that most frequent format occurs.

Table 10. Column analysis result reference (continued)
Attribute

Description

Review Status

Shows whether the detailed analyses have
been reviewed.

Verifying data classes for accurate data classification
When viewing and verifying column analysis results, you can accept or override
the system-inferred data class for the selected column. You can also specify a data
subclass or a user class. By classifying columns, you gain a better understanding of
the type of data in the columns and how often that data occurs.

Before you begin
You must have IBM InfoSphere Information Analyzer Data Steward privileges or
InfoSphere Information Analyzer Business Analyst privileges to view analysis
results. You must have InfoSphere Information Analyzer Business Analyst
privileges to modify analysis results. An InfoSphere Information Analyzer Data
Operator must have performed the following task.
You must have InfoSphere Business Glossary Author or User roles to view the
terms.
v “Running a column analysis job” on page 58

About this task
Data classification helps data analysts understand the interrelationship of data
within their environment, as well as understand the semantic meaning of
individual columns. Data classification identifies the purpose of a particular
column.
You can add defined data subclasses to the system-provided data classes. For
example, you might classify an Indicator class as a Gender class or Flag class. A
Text classification might be further defined as a Name, Address, or Other class.

Procedure
1. In the View Analysis Summary pane, click View Details.
2. In the Select View pane, select the column that you want to verify the data
class of.
3. Select the Data Class tab. Review the inferred data class.
4. Optional: Review the IBM InfoSphere Business Glossary terms that are related
to the data class in the Related Terms field, and click Term Properties to view
the properties of the related terms.
5. Highlight the data class that you want to change the status of, click Status, and
then set the status to Valid or Invalid. Mark the inferred data class as Valid if
you think that the inferred data class accurately defines your data. Mark the
inferred data class as Invalid if the inferred data class inaccurately classifies
your data. To view additional information about the data class, highlight the
data class and click View Class Details.
6. Optional: If the inferred data class is unknown, select a data class from the
Selected menu. You can create additional user classes and subclasses in the
Data Classes workspace and the User Classes workspace from the Home
Navigator menu.
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7. Click Save.

Data classification analysis
During a column analysis job, a data class is assigned to each column in your data.
A data class categorizes a column according to how the data in the column is used.
For example, if a column contains data such as 10/04/07, the Date class is
assigned to the column because 10/04/07 is an expression for a date.
By classifying each data column, you gain a better understanding of the type of
data in that column and how it is used. To ensure that your data is of good
quality, you must assign accurate classes to your data. Data classes are also used
by the system during domain analysis to match similar columns.
To assign a data class, the frequency distribution of a column is evaluated for
characteristics such as cardinality (the number of distinct values in a column) and
data type. A data type describes the structural format of data in a column. For
example, columns that contain numeric data are type N (numeric), and columns
that contain alphabetic data are type A (alphabetic). The frequency distribution
results are used by the system to infer a class for the column. After the analysis
completes, you review, accept, or reject the inferences.
One of eight data classes is inferred for each column:
Identifier
A data value that is used to reference a unique entity. For example, a
column with the class of Identifier might be a primary key or contain
unique information such as a customer number.
Indicator
A column that contains only two values. For example a column with the
class of Indicator might contain data such as true and false or yes and no.
Code A column that contains code values that represent a specific meaning. For
example, a column with the class of Code might contain data about the
area code in a telephone number.
Date A column that includes chronological data. For example, a column with the
class of Date might contain data such as 10/10/07.
Quantity
A column that contains data about the numerical value of something. For
example, a column with the class of Quantity might contain data about the
price of an object.
Large Object
A column that uses a BLOB data type. For example, a column with the
class of Large Object might contain an array.
Text
A column that contains free-form alphanumeric data. For example, a
column with the class of Text might contain data about the name of a
company or person.
Unknown
Columns that cannot be classified by the system are defined as Unknown.
The Unknown class is applied temporarily during analysis.

Extended data classification
Extended data classification provides additional information about a given column.
If you perform analyses and enable extended classification, then you can analyze
and classify the data.
You can extend data classification through the use of data classes, subclasses, and
column analysis jobs. You can extend data classification by:
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Adding new data classes
You can add a new data class to your project properties to extend data
classification and analysis capabilities from the Data Class workspace in
the Home Navigator menu.
Adding new subclasses to existing data classes
You can add a subclass to your data class to further extend your data
classification capabilities in the Data Class workspace.
Enabling enhanced data classification when you run a column analysis job
When you run a column analysis job, enable the enhanced data
classification option so you can get extended details about your data. You
can view the extended data classification details when you view the
column analysis results. You can view the column analysis results by going
to the Investigate workspace in the Home Navigator menu, and clicking
Column Analysis > Open Column Analysis.

Generating a master schema definition that includes the
extended data classification details
After adding extended data classes and subclasses, and running a column analysis
job, you can generate a master schema definition. You run column analysis jobs
with the enhanced data classification enabled, to get additional details about your
data, such as the brand of credit card for a particular credit card number. After you
run column analysis jobs, you can generate a master schema definition from the
Publish Analysis Results workspace in the Investigate Navigator menu. The
master schema definition includes all of the inferred data classes that are
associated with specific columns.
After you generate a master schema definition, the master schema definitions are
displayed in portions of IBM InfoSphere Information Analyzer, such as in data
collections or in data fields if you generated a schema definition in the InfoSphere
Model Definitions IDR format. The schema definitions are also displayed in the
metadata fields in IBM InfoSphere DataStage, IBM InfoSphere QualityStage, and
IBM InfoSphere FastTrack.
You can manage the security of the data in the master schema definition by using
the IBM Optim™ Data Privacy solution. The IBM Optim Data Privacy solution can
take this information and refer to all of the classifications in the schema definition,
so that you know which fields that you should consider applying specific privacy
policies to.

Classification options
The following table shows the classification settings that you can enable based on
your column analysis preferences. These preferences can be set in your Project
Properties. You can enable an additional level of data classification such as credit
card number or name by clicking Enable when you run a column analysis job.
Table 11. Classification order of preference settings
Data class

Description

Account Number

Infers whether a column can be considered
an account number.

Addresses

Infers whether a column can be considered
an address.

Chapter 5. Analyzing columns

67

Table 11. Classification order of preference settings (continued)

68

User's Guide

Data class

Description

AMEX

Infers whether a column can be considered
an American Express credit card number.

Bank Account Number

Infers whether a column can be considered a
bank account.

Canadian SIN

Infers whether a column can be considered a
Canadian social insurance number (SIN).

Code

A column that contains code values that
represent a specific meaning. For example, a
column with the class of Code might contain
data about the area code in a telephone
number.

Company Name

Infers whether a column can be considered a
company name.

Computer Addresses

Infers whether a column can be considered a
computer address.

Country Code

Infers whether a column can be considered a
country or region code.

Credit Card Number

Infers whether a column can be considered a
credit card number.

Date

Infers whether a column can be considered a
chronological data. For example, a column
with the class of Date might contain data
such as 10/10/07.

Date of Birth

Infers whether a column can be considered a
date of birth.

Diners Club

Infers whether a column can be considered a
Diners Club credit card number.

Discover

Infers whether a column can be considered a
Discover credit card number.

Drivers License

Infers whether a column can be considered a
drivers license number.

Email Address

Infers whether a column can be considered
an e-mail address.

France INSEE

Infers whether a column can be considered a
French National Institute for Statistics and
Economic Studies (INSEE) number.

Gender

Infers whether the column is a gender code,
such as Male/Female or M/F.

Host Name

Infers whether a column can be considered a
host name.

Identification Number

Infers whether a column can be considered
an identification number.

Identifier

A data value that is used to reference a
unique entity. For example, a column with
the class of Identifier might be a primary
key or contain unique information such as a
customer number.

Table 11. Classification order of preference settings (continued)
Data class

Description

Indicator

Infers whether a column contains binary
values such as M/F, 0/1, True/False,
Yes/No.

International Securities Identification
Number

Infers whether a column can be considered
an international securities identification
number.

International Standard Book Number

Infers whether a column can be considered
an international standard book number.

IP Address

Infers whether a column can be considered
an IP address.

Italy Fiscal Code

Infers whether a column can be considered
an Italian fiscal code.

Japan CB

Infers whether a column can be considered a
Japanese CB number.

Large Object

A large object is a column whose length is
greater than the length threshold. A column
defined as a large object will not be
explicitly profiled. Large Object is assigned
to columns that have a BLOB data type.

MasterCard

Infers whether a column can be considered a
MasterCard credit card number.

Names

Infers whether a column can be considered a
name.

Notes® Email Address

Infers whether a column can be considered
an IBM Lotus® Notes® e-mail address.

Passport Number

Infers whether a column can be considered a
passport number.

Personal Addresses

Infers whether a column can be considered a
personal address.

Personal Identification Information

Infers whether a column can be considered
personal identification information.

Personal Identification Numbers

Infers whether a column can be considered a
personal identification number.

Personal Name

Infers whether a column can be considered
an individual's personal name.

Quantity

A column that contains data about a
numerical value. For example, a column
with the class of Quantity might contain
data about the price of an object.

Spanish NIF

Infers whether a column can be considered a
Spanish identification number (número de
identificación or NIF).

Text

A column that contains unformatted
alphanumeric data and special character
data.

UK NINO

Infers whether a column can be considered a
UK national insurance number (NINO).

Universal Product Code

Infers whether a column can be considered a
universal product code.
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Table 11. Classification order of preference settings (continued)
Data class

Description

Unknown

Columns that cannot be classified by the
system are defined as Unknown. The
Unknown class is applied temporarily
during analysis.

URL

Infers whether a column can be considered a
Web address.

US Phone Number

Infers whether a column can be considered a
U.S. telephone number.

US SSN

Infers whether a column can be considered a
U.S. Social Security number (SSN).

US State Code

Infers whether a column can be considered a
U.S. state code or abbreviation.

US Zip

Infers whether a column can be considered a
U.S. postal code.

US Zip+4

Infers whether a column can be considered
an extended U.S. ZIP Code.

Visa

Infers whether a column can be considered a
Visa credit card number.

Verifying properties
When viewing and verifying the results of column analysis, you can compare the
inferred properties of the data field to the actual properties of the data field to
ensure that each data field is optimized for storage and structure considerations.
You can then accept or override the inferences.

Before you begin
You must have IBM InfoSphere Information Analyzer Data Steward privileges or
InfoSphere Information Analyzer Business Analyst privileges to view analysis
results. You must have InfoSphere Information Analyzer Business Analyst
privileges to modify analysis results. A user with InfoSphere Information Analyzer
Data Operator privileges must first perform the following task:
“Running a column analysis job” on page 58

About this task
Data properties analysis determines the optimal data type, precision, length, scale,
and general properties for a data field based on its actual data.

Procedure
1. In the View Analysis Summary pane, click View Details.
2. On the Select View pane, select the column that you want to review.
3. Select the Properties tab. The Defined Summary pane shows an overview of
the defined values, and each property has a pane that shows details.
4. Confirm that the inferred value is correct for each property. If the inferred
value is not correct:
a. Review the value that was originally defined in the metadata and the
analysis results that were used to infer the property value.
b. Select the correct property value from the Selected menu.

70

User's Guide

5. Click Save.

Data property analysis
Properties describe the characteristics of your data. During a column analysis job,
the column is evaluated and data properties are inferred. When the analysis
completes, you review the inferred properties and accept the properties or choose
new properties for the column.
Multiple types of properties are inferred during analysis:
Nulls If the percentage of null values in a column is equal to or greater than the
system-defined threshold, the null property is inferred. The system-defined
threshold is a setting that you can modify to allow a specific amount of
data variances.
Unique
If a column has a cardinality percentage that is equal to or greater than the
system-defined threshold, the Unique property is inferred. Cardinality
refers to the number of distinct values in a column including blanks and
nulls.
Constant
If the highest frequency percentage for a single data value is equal to or
greater than the system-defined threshold, the constant property is
inferred.
Length
The length of the total number of values in a column.
Precision
The total number of digits to the left of a decimal point in a column.
Scale The total number of digits to the right of a decimal point in a column.
Data type
An inferred Data type property describes the structural format of data in a
column. For example, columns that contain numeric data are type N
(numeric), and columns that contain alphabetic data are type A
(alphabetic).

Finding invalid and incomplete data values
Incomplete, empty, or invalid data values affect the quality of data by interrupting
data integration processes and by using up memory on source systems. By
analyzing data for completeness and validity, you can find these anomalies. By
default, the status for each data value is set to valid when you analyze columns.
You can examine each value to determine whether the value is valid or invalid.

Domain analysis
During a column analysis job, the frequency distribution of a column is evaluated
for invalid values. A data value is a specific unit of information in a column such
as a name or a date. If invalid values exist in your data, the quality of your data is
affected because the information in your data is incorrect.
You can use the results from a column analysis job to learn about the types of
values in your data and to search for invalid, incomplete, or empty values in your
data. To determine if your data is complete and valid, you can review the
frequency distribution that is generated for each column in your data. The
frequency distribution lists inferences about the valid and invalid values and
maximum or minimum field lengths that were found during analysis. An invalid
value might suggest that data in the field is missing or that an element of the
column, such as the data type, is incorrect. If a field is incomplete or empty, the
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length of the field will be less than the minimum length that is allowed. The length
will be zero for empty fields. You accept or reject the inferences in the frequency
distribution.
You can add a new value to the list in the frequency distribution if a value was not
included in your imported metadata. All values are saved in the frequency
distribution. You can then choose the method that you will use to examine the
values.
You choose one of three domain analysis methods to examine data values:
Value Select if you want to examine each value individually. Examine each data
value for correct content and structure.
Range Select if you want to specify a range to determine the validity of the
values. For example, you can specify a minimum and maximum value for
a date such as 10/10/07 and 10/10/08. Data values that are lower or
higher than the minimum and maximum date values are invalid.
Reference Table
Select if you want to compare all of the values to the values in a reference
table.
After you evaluate your data, you do not have to make the same decisions again
when you run subsequent analyses on the same data. The frequency distribution is
saved in the metadata repository and is available if you want to make changes to
it.

Specifying the validity of each data value
You can view the frequency distribution values individually and specify invalid
values.

Procedure
In the View Analysis Summary pane, click View Details.
On the View Details pane, select the Domain & Completeness tab.
In the Domain Type menu, select Value.
Review each of the data values listed in the Frequency Distribution table.
Optional: On the Frequency Distribution table, click Drill Down to show all the
instances of that data value in the analyzed column.
6. Optional: Click Show Quintiles.
7. Specify data values that are invalid:
a. Select the data value in the Frequency Distribution table.
b. Click the Status field that corresponds to that data value.
c. Select Invalid from the menu. The data value now appears in the Invalid
Values table.
8. Click Save.
1.
2.
3.
4.
5.

Validating data values by using a reference table
When you are reviewing the results of a column analysis job, you can compare the
data values to a reference table that contains valid values. Any data values that are
not found in the reference table are marked as invalid.

72

User's Guide

Before you begin
You must have completed the following task:
v “Running a column analysis job” on page 58

About this task
For example, you might compare a column that contains city abbreviations for
your orders to a reference table that contains a list of all known city abbreviations.

Procedure
1. In the View Details pane, select the Domain & Completeness tab.
2. In the Domain Type menu, select Reference Table.
3. In the verification window, click OK to verify that you want to change the
domain type.
4. In the Table Type field, select the type of reference table that you want to use.
5. In the Table Name field, select the reference table that you want to use. The
data values are compared and invalid values are specified in the Frequency
Distribution table.
6. Optional: On the Frequency Distribution table, click Drill Down to show all the
instances of that data value in the analyzed column.
7. Optional: Click Show Quintiles.
8. Click Save.

Determining the validity of the data values by range
When you are reviewing the results of a column analysis job, you can set a
minimum value and a maximum value for the data values that you are validating.
All values that fall outside of this range are set to invalid. You can also leave either
the minimum or the maximum value blank but not both.

About this task
You can add a new data value to the frequency distribution if the minimum value
or maximum value is not in the frequency distribution. To set a range to determine
the validity of the data values, complete the following procedure.

Procedure
1. On the View Details pane, select the Domain & Completeness tab.
2. In the Domain Type menu, select Range.
3. In the verification window, click OK to verify that you want to change the
domain type.
4. Optional: Click Show Quintiles to help you determine the appropriate
minimum and maximum values.
5. Optional: On the Frequency Distribution table, click Drill Down to show all the
instances of that data value in the analyzed column.
6. In the Frequency Distribution table, specify the maximum and minimum range.
If the minimum or maximum value that you want to set does not appear in the
frequency distribution, you can click New Data Value to add that value.
a. In the Min/Max field of the maximum value, select Maximum.
b. In the Min/Max field of the minimum value, select Maximum.
7. Click Reload. All data values that fall outside of the range are marked invalid.
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8. Click Save.

Specifying incomplete data values
When you are reviewing the results of a column analysis job, you can review all
data values in the Frequency Distribution table to identify incomplete values.

Procedure
1. On the View Details pane, select the Domain & Completeness tab.
2. In the Domain Type menu, select Value. You can review each of the data
values listed in the Frequency Distribution table.
3. Optional: On the Frequency Distribution table, click Drill Down to show all the
instances of that data value in the analyzed column, table, or file.
4. Specify data values that are incomplete:
a. Select the data value in the Frequency Distribution table.
b. Click the Status field that corresponds to that data value.
c. Select Default from the menu. The data value now appears in the
Incomplete Values table.
5. Click Save.

Updating column analysis inferences
After you specify invalid values in a column, you can update the inferences that
are created during column analysis to only use those valid values.

Before you begin
You must have completed the following task:
v “Specifying the validity of each data value” on page 72

About this task
Invalid values can cause the inferred results of column analysis to be inaccurate.
For example, if you are reviewing a column of employee IDs in which the values
are typically 10 numeric characters, and you have three invalid entries of 25
alphabetic characters, the inferred analysis results might not give you appropriate
information about your data.
After you have identified the invalid values, you can rebuild the inferences to see a
more accurate reflection of your data.

Procedure
On the View Details pane, click Rebuild Inferences > Valid Values.

What to do next
You can then view the inference results against the valid data. If you want to
rebuild the inferences again by using both the valid and invalid data, you can click
Rebuild Inferences > All Values.

Reviewing the general format of the data fields
When you are reviewing the results of a column analysis job, you can review the
general format of a data field and perform in-depth format analysis on that data
field.
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Before you begin
You must have IBM InfoSphere Information Analyzer Data Steward privileges or
InfoSphere Information Analyzer Business Analyst privileges to view analysis
results. You must have InfoSphere Information Analyzer Business Analyst
privileges to modify analysis results.

About this task
The Format tab displays the various general formats and their frequency counts in
a data field. You can:
v View the entire format frequency distribution or you can drill down through any
of the general formats to see the values.
v Mark the records of the selected format to Conform or Violate in the Status
column on the Format tab.
v Mark multiple records that have the same format to the desired domain value,
as well as to verify that the domain value status has successfully been applied to
the records of the selected format.

Procedure
1. In the View Analysis Summary pane, click View Details.
2. On the View Details pane, select the Format tab. View the number of formats
and the general formats.
3. Select a format in the General Format table to view the distinct data values that
have that format.
4. To mark all the records that have the same format to the desired format status,
as well as to verify that the selected format status has successfully been applied
to the records of the specified format:
a. In the General Format table, select a format row.
b. Click the Status field and select one of the options:
Violate
Click the View Violating Records button. The records with the
selected format are displayed on the Format Violations page.
Conform
Click the View Violating Records button, the records with the
selected format will not be on the Format Violations page.
Note: Changing the Status value on the Format tab does not have any
impact in the Domain and Completeness tab for the records with that
format.
5. To mark multiple records that have the same format to the desired domain
value, as well as to verify that the domain value status has successfully been
applied to the records of the selected format:
a. From the Format tab, select a format and click the Domain Values Status
button.
b. Select the desired value, like Invalid, to mark the selected format as
Invalid.
c. Click Save.
Note: Notice that Invalid on the Domain Values Status field of the selected
format disappears when you click Save.
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d. Go to the Domain and Completeness tab. The information on this tab is
reloaded, and you will see that those records in that selected format are
changed to Invalid.

Format analysis
During a column analysis job, a format expression is created for each value in a
column. A format expression is a pattern that describes the type of data in a
column according to the type of the column. For example, if a column is of the
class Date, a format expression such as YYMMDD might be assigned to the
column (year, month, and day.)
To create a format expression for a column, the frequency distribution of the
column is evaluated and each value in the column is translated into a format
symbol. The format symbols create the format expression for the column. For
example, alphabetic characters are represented by an A or a, depending on whether
they are upper or lowercase. Numerals are represented by the number 9 and
special characters and spaces represent themselves.

Format analysis for multiple data fields
During a column analysis job, a format expression is generated for the values in
virtual columns. Format expressions are listed in the frequency distribution for
each column in the virtual column.

Adding a data value to the frequency distribution
If a known data value does not occur in the data source but you want to include
that value in a reference table, you can add a data value to the frequency
distribution.

About this task
You can also add a data value to the frequency distribution if you want to set a
range to determine the validity of data values and the required minimum or
maximum value for the range control is not in the frequency distribution. If you
add a data value to the frequency distribution, the frequency count will be zero.

Procedure
1. On the Column Analysis workspace of the console, select the column or
columns that you want to view details for.
Click Open Column Analysis on the Tasks pane.
From the View Analysis Summary pane, click View Details.
Select the Frequency Distribution tab.
Click New Value.
In the Create a New Data Value window, type the data value name and the
definition.
7. Optional: In the Transform field, type a replacement value for the data value.
8. Click OK to add the value.
2.
3.
4.
5.
6.

Removing a data value from the frequency distribution
If a data value appears in the frequency distribution but does not occur in the
profiled column, you can delete that data value from your frequency distribution.
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Procedure
1. On the Column Analysis workspace of the console, select the column or
columns that you want to view details for.
2. Click Open Column Analysis on the Tasks pane.
3. On the View Analysis Summary pane, click View Details.
4. Select the Frequency Distribution tab.
5. Select the data value that you want to delete.
6. Click Delete User Value.
7. In the confirmation window, click OK.

What to do next
The deleted value no longer appears in the frequency distribution that is saved in
the metadata repository.

Creating reference tables
You can create a reference table to use information in frequency distribution results
outside of column analysis.

Before you begin
You must have completed the following tasks:
v “Running a column analysis job” on page 58
v “Viewing and verifying column analysis results” on page 62

About this task
Valid, Range, Completeness, Invalid, and Mapping reference tables can be used in
additional IBM InfoSphere Information Server capabilities or other systems to
enforce domain requirements and completeness requirements or to control data
conversion.

Procedure
1.
2.
3.
4.

On the View Summary pane, click View Details.
Click Reference Tables > New Reference Table.
On the New Reference Table pane, type a Name for the reference table.
Select the type of reference table that you want to create.

5. Optional: In the Definition field, type a description for the reference table.
6. Click Preview to display a preview of your reference table.
7. Click Save to create the reference table.

Updating reference tables
You can update and refresh references tables with the latest information from the
frequency distribution.

About this task
You can use a reference table to share results from the frequency distribution with
additional IBM InfoSphere Information Server capabilities or other systems.
Reference tables can help to enforce domain requirements and completeness
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requirements or to control data conversion.

Procedure
1.
2.
3.
4.
5.

On the View Summary pane, click View Details.
Select the Frequency Distribution tab.
Click Reference Tables > View Reference Table.
Select the table from the Reference Tables list.
Click Close.

Flagging issues in the frequency distribution
You can flag issues for further investigation and add notes to other analysts for
investigation and review. Use notes to flag an issue, enter comments, or provide
information to other reviewers.

Procedure
1. Select an object that you want to flag.
2. Click the Note icon at the top of the task pane.
3. In the Notes palette, click New.
4. Type a subject for your note.
5. Select the type of note that you are adding:
v Action
v Informational
v Other
6. Select the current status of the issue.
7. Type your comments.
8. Click Close to save the note.

Marking review as complete
You can formally mark a review as complete to enable the system to keep track of
which areas of analysis were reviewed in detail.

Procedure
1. On the View Analysis Summary pane, click View Details.
2. Select the analysis tab that you want to review.
3. Verify the column analysis results for that tab.
4. Select the Reviewed check box.
5. Click Save.

Modifying column analysis options
You can specify the default parameters, settings, and thresholds used for analysis.
Analysis options set the parameters that the system uses to control processing or
analytical results.

About this task
The parameters that you set determine the analysis results. For example, if a
column has null values with a frequency percentage equal to or greater than the
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nullability threshold, the frequency distribution records that the nullability
property equals YES. If null values do not exist in the column or the frequency
percent is less than the threshold, the nullability property is set to NO. When you
modify the project-level analysis settings, the system settings are replaced. All new
analyses in the project will inherit these new settings.

Procedure
1. On the Overview navigator menu in the console, select Project Properties.
2. Select the Analysis Settings tab.
3. Modify the Nullability, Uniqueness, and Constant settings to fine-tune analysis
results.
4. Optional: Click Restore System Settings to return the settings to their default
values.
5. Click Save All to save your changes.

What to do next
You can run a column analysis job again with your new settings.
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Chapter 6. Identifying keys and analyzing relationships
Key and cross-domain analysis provides the option to identify and classify
columns, as well as assign the columns as natural keys, primary keys, or foreign
keys to help you classify your data.
The Run Key and Cross-Domain Analysis workspace, provides the details you
need to identify primary, natural, and foreign keys in your data sources. Columns
that have a high uniqueness percentage and are linked to foreign keys in other
tables are good candidates to become natural keys or primary keys. To determine if
a primary or natural key candidate is linked to foreign keys in other tables, you
can run a key and cross-domain analysis. Results from the analysis allow you to
associate foreign keys with the primary and natural keys. You can assign the
following keys.
Primary keys
Columns that have a high percentage of uniqueness, as well as at least one
foreign key candidate, make the best primary key candidates. Identify the
columns that have the highest uniqueness percentage and assign one of the
columns as the primary key. You might only have one primary key per
table. For example, if you have a customer table with a customer ID that
was auto-generated for identification purposes, and other tables in your
data source link to that customer ID number, the customer ID number is a
good candidate for primary key. It is 100% unique and was auto-generated
for the purpose of being a primary unique identifier.
Natural keys
You can identify additional key relationships by using natural keys.
Columns that have a high percentage of uniqueness, as well as at least one
foreign key candidate, make the best natural key candidates. Natural keys
provide flexibility with your data analysis needs because you can assign
multiple columns in your data source to be natural keys. For example, a
customer record might have a last name in addition to the customer ID
number described above. Although the last name occurs naturally in the
data and was not intentionally generated as a unique identifier, it has an
association with other data within the record such as first name and
address. These associations make the last name a good candidate for a
natural key.
Foreign keys
Columns that have a high percentage of values identical to those contained
in a primary or natural key make the best foreign keys. When viewing the
foreign key candidates for a particular primary or natural key, highlight
the columns that have the highest paired-to-base percentage. A percentage
of 100% indicates that every value within the paired column exists within
the base column (primary key or natural key column).
If a customer table contains a customer ID that was auto-generated, and other
tables in your data source link to that customer ID number, the identifier would be
a good candidate for a primary key, because it is unique. The identifier uniquely
identifies each record from the others.
If you have a customer table with last names, that table is linked to other tables
that have data such as first name, Social Security number, tax ID numbers, and so
© Copyright IBM Corp. 2006, 2012
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on, that would be a good natural identifier. The last name is a good natural key
because it is not artificially generated, and it is a naturally occurring unique
identifier that has natural associations to other data such as first name and
address. Another good natural key is a Social Security number, which has natural
associations with first names, last names, and so on.

Primary key analysis
Primary key analysis information allows you to validate the primary keys that are
already defined in your data and identify columns that are candidates for primary
keys.
A primary key must be unique and cannot contain null values. For example, a
column that contains a customer ID number might be inferred as a primary key
candidate by the system because it is unique and does not have null values.
During analysis, multiple unique columns might be inferred as candidates. When
you review the results, you choose the columns that you want to select as primary
key from the list of inferred candidates.
After a column analysis job completes and a frequency distribution for the column
is generated, all single columns are available to review by using the key analysis
functionality found in the Investigate navigator menu. Using the frequency
distributions that were generated during the column analysis job, the cardinality
percentage is evaluated for each column in a table. A cardinality percentage is the
total number of distinct values in the column divided by the total number of rows
in the table that the column resides in. For example, 1000 distinct values divided
by 1000 rows equals 1.0 or 100% uniqueness. Columns that have a cardinality
percentage of 95% or greater than the system threshold, are identified as primary
key candidates. You configure the system threshold before you run a primary key
analysis job if you want to allow more variations of unique values. For example, a
threshold of 90% will allow more columns to be considered candidates than a
threshold of 100%. A threshold of 100% does not allow any variations.
During analysis, any cardinality percentage that is less than 100% indicates that
there are duplicate values in a column. Duplicate columns might exist if your data
was integrated with another data source or if the structure of your data changed.
For example, by using a system threshold of 95%, column B in table 1 has a
cardinality percentage of 98%. The cardinality percentage for column B is above the
threshold, and column B is inferred as a primary key candidate. However, when
you review the results, you find that 2% of the values in column B are duplicate
values. The 2% of duplicate values renders the inference flawed because the
column does not contain the uniqueness to be a primary key. You can either use a
data cleansing tool to remove the duplicate values from the column or choose
another primary key candidate.
If your data already contains defined primary keys, the columns will be marked as
primary keys during analysis. However, you can still use the results of a primary
key analysis job to assess the validity of defined primary keys.

Single and multiple column primary keys
To understand the structure and integrity of your data, you can run a relationship
analysis to identify and validate primary key candidates.
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Primary keys are columns that uniquely define all of the rows in a table. For
example, Employee ID, a unique number that is assigned to each employee, might
be a primary key in an employee table.
Single column primary key candidates are automatically identified when you run a
column analysis. When a column analysis is run, the uniqueness of distinct values
is analyzed in each column based on frequency distribution statistics. Multiple
column primary key candidates are initially determined by analyzing the
uniqueness of distinct values for each column combination based on a data sample
of the table. You can then run a full analysis on the multiple column primary key
candidates to confirm.
After a multiple column key analysis job completes, you can review and select a
primary key from a list of inferred candidates. You can also identify duplicate
primary key values for defined or selected primary keys.

Analyzing single column primary keys
To identify a single column primary key for a table or file, you locate a column
that is a unique identifier for your data.

About this task
Primary key analysis uses the frequency distribution statistics that are gathered
when you analyze columns to profile the uniqueness of distinct values in each
column of a table. You can review the key and cross-domain analysis results and
select a primary key from the list of all key candidates.

Identifying a single column primary key
To identify a primary key for a table or file, you locate a column that's values
uniquely identify the rows in the selected table. Additionally, you can verify that a
primary key that is defined in the data source is the true primary key.

Before you begin
You must have IBM InfoSphere Information Analyzer User authority and complete
the following task:
v Chapter 5, “Analyzing columns,” on page 55

Procedure
1. On the Investigate navigator menu of the console, select Key and
Cross-Domain Analysis.
2. Click Open Key Analysis from the Tasks menu.
3. Select the Single Column tab. View the analysis results for all the columns in
the selected table.
4. If the column is not 100% unique, click View Duplicate Check to view the
duplicate data values within the selected column.
5. Optional: Click Frequency Distribution to view all data values that make up
the selected column and their values.
6. Select the column that you identified as the primary key, and click Key Status
> Mark as Primary Key.
Note: If the column is already selected as a natural key, then it cannot be
selected as a primary key.
7. Click Close.
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What to do next
If you accept or modify a defined primary key, that setting is stored in the
metadata. If you want to change the data itself, you must make the change in the
external database, and then rerun column analysis to see the data changes.
If you cannot identify an appropriate single column primary key, you can look for
a multicolumn primary key.

Flagging primary key candidates
After running a key and cross-domain analysis, you can flag the key candidates
that would make suitable primary keys.

About this task
You can flag candidates that would make suitable primary keys.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select a table from the list of data sources and click Open Key Analysis from
the Tasks menu.
3. Click the either the Single Column or Multiple Column tab.
4. Enter a percentage of unique data values in the Flag Percentages Above field.
Columns with a uniqueness value above this percentage will be flagged. For
example, if you want to flag columns with a 90% or higher uniqueness
percentage, enter 90%.
5. Enter the minimum foreign key candidates that a column must have to be
flagged in the Minimum Foreign Key Candidates field. For example, if you
want to flag columns with four or more foreign key candidates, set the number
to 4.
6. Click Apply. The columns that meet the conditions will be flagged.
7. Click Save. A flag icon will appear next to the columns that meet the
uniqueness threshold and minimum number of foreign key candidates

Identifying duplicate values in a single column
When you evaluate a candidate for a single column primary key, you can look for
duplicate values in a selected column to help you determine if that column should
be selected as the primary key.

About this task
A column is a good primary key candidate if it contains all or a high level of
unique values. However, a column that contains some duplicate values might still
be considered a primary key. You can view the duplicate values in a column to
determine whether those values exclude the column from being considered the
primary key of the table.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Click Open Key Analysis from the Tasks menu.
3. On the Single Column tab, select the column whose duplicate values that you
want to view.
4. Click Primary Key Analysis, and then click View Duplicate Check.
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5. In the View Duplicate Check pane, review the duplicate data values.
6. Optional: If you identify the column as a natural or primary key, click Key
Status, and then Mark as Primary Key or Mark as Natural Key.
7. Click Close.

Accepting a single column primary key
After you analyze a single column on the Single Column tab in the Open Key
Analysis workspace, you can review the analysis results and accept a primary key.

Before you begin
You must have IBM InfoSphere Information Analyzer User authority and complete
the following task:
v “Identifying a single column primary key” on page 83

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Click Open Key Analysis from the Tasks menu.
3. Click the Single Column tab.
4. Optional: Gather more information about the selected columns.
Option

Description

To view all data values that make up the
selected columns and their values:

Click Primary Key Analysis > Frequency
Distribution.

To look for duplicate data values within the
selected columns:

Click Primary Key Analysis > View
Duplicate Check.

5. Select the column that you want to mark as the primary key.
6. Click Key Status > Mark as Primary Key.
7. Click Close.

Analyzing multiple column primary keys
You can run a key analysis job to compare concatenated columns in your data to a
sample of your data and infer candidates for primary keys. You might want to run
a multiple column analysis to identify primary keys if no single column adequately
serves as a primary key.
Before you can run a multiple column analysis in order to identify a primary key
for your data, you need to have a sample of your data. A sample of your data
represents the data that is in the entire table that you want to evaluate. Analyzing
a sample of data lessens processing time for the permutations that are required
during a multiple column primary key analysis job. If a sample of your data does
not exist, you must create the sample. When you create the sample, you can choose
whether you want the sample to be created at random, in sequential order, or at
another interval that you specify. A sample that contains between 2,000 to 50,000
rows is adequate to represent most data sources.
After you create a sample of your data, you set the maximum composite key
setting before you run the analysis job. The maximum composite key setting is a
number that you select to specify the total number of columns that can be
combined. The setting is 3 by default but can be set to any value between 2 and 7.
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You can include or exclude columns from the analysis at this time. Next, the
system generates all possible combinations of the columns that you included
during analysis.
During analysis, each combination of columns is analyzed against the sample of
your data to determine uniqueness. To be inferred as a primary key candidate, the
combination of columns must have a cardinality percentage that is equal or greater
than the primary key threshold. The cardinality percentage of a combination of
columns refers to the number of concatenated distinct values in the pair divided
by the total number of rows in the data sample. For example, 1000 distinct values
divided by 1000 rows equals 1.0 or a cardinality percentage of 100%. Combinations
of columns that have a cardinality percentage equal or greater than the primary
key threshold, are identified as primary key candidates. You configure the primary
key threshold before you run a key analysis. For example, a threshold of 90% will
allow 10% more variations than a threshold of 100%. A threshold of 100% does not
allow any variations.
When you select a primary key candidate to analyze further, the system builds a
virtual column and a frequency distribution to check for duplicates. A virtual
column is a concatenation of one or more columns. You need to review the list of
duplicate values in the results because a multiple column analysis job uses only a
sample of data rather than the entire data source that the sample comes from.
Since the entire source is not used, it is possible that some duplicates might exist in
the source but not the sample. You must also review the results to be able to accept
the primary key candidate as the selected primary key.

Running a multiple column primary key analysis job
To identify a multiple column primary key, you use a data sample to run analysis
with concatenated combinations of columns to determine which combinations
contain the most unique values and are candidates for primary keys.

Before you begin
You must have IBM InfoSphere Information Analyzer User authority and Data
Operator privileges.

About this task
You run a multiple column primary key analysis job to determine if one
combination of the columns in the table can be the primary key. Multiple column
primary key analysis profiles the uniqueness of distinct values in each column
concatenation to the data sample.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select a table from the list of data sources and click Run Multi-Column Key
Analysis from the Tasks menu.
Note: Alternatively, you can select a table from the list of data sources, click
Open Key Analysis from the Tasks menu, click the Multiple Column tab and
select Analyze Multiple Columns.
3. Optional: Click Create Data Sample to create a smaller sample of your data to
expedite the key analysis by creating a smaller sample of data to analyze.
4. Type a name and description for the analysis job.
5. Select the columns to include in the multiple column primary key analysis job.
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6. Optional: Click the Connections tab and configure the connections for the
data source that you are using.
a. Highlight the data store you want to configure in the Configure
Connections section and then select the connector you want to use from
the Connector drop-down menu.
b. Enter your User ID and password for the connector in the Connection
Settings section and click Test Connection. You can enter a different set of
user credentials for the connector that you select from the drop-down
menu. For example, the system level connector settings might use a
administrator's credentials, but at the project level you might want to use
your personal User ID and password for the same connector.
c. Click Submit after you successfully test the connection.
7. Select Run Now, Create External Bundle Location, or Schedule on the
Scheduler tab to determine when you want the analysis to run.
8. Click Submit.
9. Click Open Key Analysis and select the Multi-Column tab. View the analysis
results for the column in the selected table.
10. Select the column and click Key Status, and then Mark as Primary Key after
you have analyzed the data and determined that the column would be a good
primary key.

What to do next
You can now run a relationship analysis on any of the multicolumn primary key
candidates to discover foreign keys, review the frequency distribution, or check for
duplicates by running and viewing duplicate check.
Data sampling:
You can create a sample of data before you run a multiple key analysis job.
When you create the sample, you can choose whether you want the sample to be
random, sequential, or structured according to the parameters that you define. A
sample size of between 1,000 to 10,000 records is adequate for most large data sets.
Creating a data sample:
You can create a sample of data before you run a multiple column key analysis job.
When you create the sample, you can choose whether you want the sample to be
random, sequential, or structured according to the parameters that you define. A
sample size of between 1,000 to 10,000 records is adequate for most large data sets.
Before you begin
You must have IBM InfoSphere Information Analyzer User authority and Data
Operator privileges and complete the following task:
v Chapter 5, “Analyzing columns,” on page 55
About this task
Column combinations with uniqueness percentages equal or greater than the
primary key threshold percentage become multicolumn primary key candidates.
You must create a data sample before you can run a multicolumn primary key
analysis job.
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Procedure
1. On the Investigate navigator menu in the console, select Key and
Cross-Domain Analysis.
2. Select a table from the list of data sources and click Create Data Sample.
v You also have the option of selecting a table from the list of data sources,
clicking Open Key Analysis from the Tasks menu, clicking the
Multi-Column tab, and then clicking Create Data Sample.
Type a job name for the data sample. You can optionally provide a description.
Specify a size for the sample.
Select the method that will be used to create the sample.
Select Run Now to create the data sample now, or select Schedule to specify a
time and date to create the data sample.
7. Click Submit to create the data sample.

3.
4.
5.
6.

What to do next
After you create the data sample, you can run a key and cross-domain analysis job.

Flagging primary key candidates
After running a key and cross-domain analysis, you can flag the key candidates
that would make suitable primary keys.

About this task
You can flag candidates that would make suitable primary keys.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select a table from the list of data sources and click Open Key Analysis from
the Tasks menu.
3. Click the either the Single Column or Multiple Column tab.
4. Enter a percentage of unique data values in the Flag Percentages Above field.
Columns with a uniqueness value above this percentage will be flagged. For
example, if you want to flag columns with a 90% or higher uniqueness
percentage, enter 90%.
5. Enter the minimum foreign key candidates that a column must have to be
flagged in the Minimum Foreign Key Candidates field. For example, if you
want to flag columns with four or more foreign key candidates, set the number
to 4.
6. Click Apply. The columns that meet the conditions will be flagged.
7. Click Save. A flag icon will appear next to the columns that meet the
uniqueness threshold and minimum number of foreign key candidates

Identifying multiple column duplicate values
When you run a multiple column key and cross-domain analysis job, the column
combinations are tested against a data sample. Before you accept a candidate for a
multiple column primary key, you should run a duplicate check on the full data
volume to ensure that you have a valid key.
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About this task
You can view the duplicate values in a set of columns to determine whether those
values exclude the columns from being considered as the primary key of the table.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select a table and click Open Key Analysis from the Tasks menu.
3. On the Multi-Column tab, select the multicolumn primary key candidate that
you want to check duplicate values for.
4. Click Primary Key Analysis > Run Duplicate Check.
5. In the Run Duplicate Check pane, type a name for the job.
6. Select Run Now to look for duplicates now, or select Schedule to specify a
start date and end date to look for duplicates.
7. Click Submit.
8. After the duplicate check completes, click Primary Key Analysis > View
Duplicate Check. In the View Duplicate Check pane, review the duplicate
data values.
9. Optional: If you identify the column as a primary key, click Key Status, and
then click Mark as Primary Key.
10. Click Close.

Accepting a multiple column primary key
After you analyze multiple columns on the multiple column tab in the Open Key
Analysis workspace, you can review the analysis results and accept a primary key.

Before you begin
You must have IBM InfoSphere Information Analyzer User authority and complete
the following task:
“Running a multiple column primary key analysis job” on page 86

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select a table from the list of data sources and click Open Key Analysis from
the Tasks menu.
3. Click the Multiple Column tab and view the analysis results.
4. Optional: Gather more information about the selected columns.
To view all data values that make up the selected column combination:
Click Primary Key Analysis and then View Frequency Distribution.
To look for duplicate data values within the selected columns:
Click Primary Key Analysis > Run Duplicate Check. After running a
duplicate check job, click Primary Key Analysis > View Duplicate
Check to view the results.
5. Select the concatenated column that you identified as the primary key.
6. Click Key Status > Mark as Primary Key .
7. Optional: To remove primary key status from a column select Key Status >
Remove Primary Key Status.
8. Click Close.
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Natural key analysis
Natural keys are meaningful values that identify records, such as social security
numbers, that identify specific customers, calendar dates in a time dimension, or
SKU numbers in a product dimension. A natural key is a column that has a logical
relationship to other pieces of data within the record.
Identifying natural keys to classify your data is beneficial because it allows you the
flexibility to have multiple natural keys that are associated with multiple foreign
keys, rather than having one primary key that is associated with multiple foreign
keys. After you select a natural key, you are able to automatically identify foreign
keys by running a key and cross-domain analysis on the column. After running a
key and cross-domain analysis, you can view the number of foreign key candidates
and the details associated with them.

Identifying a single column natural key
To identify a natural key for a table or file, you locate a column that's values
uniquely identify the rows in the selected table and have a logical relationship to
other pieces of data within the record.

Before you begin
You must have IBM InfoSphere Information Analyzer User authority and complete
the following task:
v Chapter 5, “Analyzing columns,” on page 55

About this task
Natural key analysis uses the frequency distribution statistics that are gathered
when you analyze columns to profile the uniqueness of distinct values in each
column of a table. You can review the natural key analysis results and select a
natural key from the list of all natural key candidates.
Important: You might not be able to identify a natural key if you do not have data
values that are unique enough to qualify as an adequate natural keys. You can go
to the Key and Cross-Domain Analysis workspace and adjust the uniqueness
threshold to be higher or lower, and then click Apply when you set a natural key
for your data, depending on your data analysis needs.

Procedure
1. On the Investigate navigator menu of the console, select Key and
Cross-Domain Analysis.
2. Click Open Key Analysis from the Tasks menu.
3. Select the Single Column tab. View the analysis results for all the columns in
the selected table.
4. If the column is not 100% unique, click Primary Key Analysis > View
Duplicate Check to view the duplicate data values within the selected column.
5. Optional: Click Primary Key Analysis > Frequency Distribution to view all
data values that make up the selected column and their values.
6. Select the column that you identified as the natural key, and click Key Status >
Mark as Natural Key.
Note: If the column is already a primary key, then it cannot be chosen as a
natural key.
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7. Click Close.

What to do next
If you accept or modify a defined natural key, that setting is stored in the
metadata. If you want to change the data itself, you must make the change in the
external database, and then rerun column analysis to see the data changes.
If you cannot identify an appropriate single column natural key, you can look for a
multicolumn natural key.

Flagging natural key candidates
After running a key and cross-domain analysis, you can flag the key candidates
that would make good natural keys.

About this task
You run a key and cross-domain analysis to determine which columns in a table
should be assigned as natural keys, the primary key, or foreign keys. After the
analysis provides you with details about the columns you flag the candidates that
would make good natural keys.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Click Open Key Analysis from the Tasks menu.
3. Click the either the Single Column or Multiple Column tab
4. Enter a percentage of unique data values in the Flag Percentages Above field.
Columns with a uniqueness value above this percentage will be flagged. For
example, if you want to flag columns with a 90% or higher uniqueness
percentage, then you would enter 90%.
5. Enter the minimum foreign key candidates that a column must have to have to
be flagged in the Minimum Foreign Key Candidates field. For example, if you
want to flag columns with 4 or more foreign key candidates, then set the
number to 4.
6. Click Apply. The columns that meet the conditions will be flagged.
7. Click Save.

Foreign key analysis
Run a key and cross-domain analysis job to identify foreign keys, as well as
columns that have common domain values.
IBM InfoSphere Information Analyzer determines whether a column has a
minimum percentage of distinct values that also appear in another column. If the
column meets the criteria for having a common domain, the column is flagged.
Columns that share a common domain might represent a primary to foreign key
relationship or the common domain might represent redundancy in your data.
After selecting base and paired tables, columns from the base tables are paired
with columns from the paired tables. Next, the system performs a compatibility
test on each column pair to determine whether those columns are compatible with
each other according to their data class, type, and length. If the column pair is
compatible, the columns are available for inclusion in the relationship analysis job.
Column pairs that are not compatible are excluded from the analysis.
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You can view the total number of pairs that are created, the total number of
incompatible pairs, and the total number of compatible pairs. You review the
compatibility test results and select specific pairs to be included in the analysis. If
you want additional pairs that are not available, return to the table selection step,
select additional or different base and paired tables, and continue. You can also run
a column analysis job again to review or modify any inferences or selections to
create additional compatible pairs. When you rerun a column analysis job and
modify the results, a new frequency distribution is generated and used as input for
the key and cross-domain analysis job.
After you review the compatible column pairs, the system compares the frequency
distributions of each column to the other to determine if they have common
domains. Columns share a common domain when they share the same values. The
values from the frequency distribution of the second column (the paired and
foreign key column) are compared against the values from the frequency
distribution of the first column (the base and primary or natural key column).
After the comparison, the number of matching values in the columns are counted,
and a commonality (overlap) percentage is calculated. A commonality percentage
describes the proportion of matching values between two columns. For example,
you might have a column pair that contains column 1 (the primary key column)
and column 2. If forty-nine out of fifty values in column 2 match column 1, the
commonality percentage of column 2 to column 1 is 98%.
Next, the commonality percentage is compared with the common domain
threshold. You set the common domain threshold to define the criteria for
determining when two columns share a commonality. For example, if you set the
common domain threshold to 95%, the columns must have a commonality
percentage equal to 95% or higher for the system to infer that they share a
common domain. You can tighten the criteria for commonality by raising the
common domain threshold setting or loosen the criteria it by lowering the setting.
In the example that uses column 1 and column 2, column 2 has a common domain
with column 1 because its commonality percentage (98%) is higher than the
common domain threshold (95%). You use the results from the common domain
test to determine whether a paired table contains a column or multiple columns
that match the primary or natural key column in a base table. If there is a match,
the columns in the paired table are inferred as foreign key candidates. To qualify
as a foreign key candidate, there must be at least one column in the paired table
that has a common domain with a primary of natural key in the base table.
If your data already contains defined foreign keys, the columns will be marked as
defined foreign keys during analysis. However, you can still use the results of a
key and cross-domain analysis job to assess the validity of defined foreign keys.

Identifying foreign keys
To define and validate the relationships between tables, you can run a key and
cross-domain analysis job to find foreign key candidates, select foreign keys, and
then validate their referential integrity. You identify foreign keys in the Key and
Cross-Domain Analysis workspace.

Before you begin
You must complete the following task:
v Run column analysis on the columns in two or more tables
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About this task
The key and cross-domain analysis job builds a complete set of all the column
pairs between columns in the selected tables. After selecting base and paired tables,
columns that have a compatible data type, length, and data class are listed for
analysis.

Procedure
1. Run a key and cross-domain analysis job on the compatible column pairs.
2. View the results of the job, test for referential integrity and determine if a
foreign key candidate should be selected as a foreign key to a primary or
natural key.

Running a key and cross-domain analysis job to identify
foreign keys
To identify the foreign key candidates in two or more tables, you can run a
relationship analysis job in the Key and Cross-Domain Analysis workspace. Key
and cross-domain analysis compares columns in one table to columns in other
tables to determine if a key relationship exists between the tables.

Before you begin
You must complete the following task:
v Run column analysis on all of the columns in two or more tables

About this task
Key and cross-domain analysis compares columns in one table to columns in other
tables to determine if a key relationship exists between the tables.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select the tables that you want to identify the foreign key relationship for and
click Open Key Analysis from the Tasks menu.
3. Select a primary or natural key candidate and click Key and Cross-Domain
Analysis > Run Key and Cross-Domain Analysis.
4. In the Run Key and Cross-Domain Analysis pane, type a name and
description for the analysis job.
5. Select tables in the Available Tables section and click Add to Base List or
Add to Paired List to designate tables as base or paired tables.
6. Click Next.
7. Review the column pairs. Compatible pairs are included in the selected pairs
list by default. If a compatible column pair is missing column analysis results
for 1 or both columns, a flag icon will appear beside the pair. These pairs are
not automatically added to the selected pairs list. If you wish to add these
pairs to the selected list manually, select the pair and click the Add to
Selected.
8. Optional: Click the Connections tab and configure the connections for the
data source that you are using.
a. Highlight the data store you want to configure in the Configure
Connections section and then select the connector you want to use from
the Connector drop-down menu.
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b. Enter your User ID and password for the connector in the Connection
Settings section and click Test Connection. You can enter a different set of
user credentials for the connector that you select from the drop-down
menu. For example, the system level connector settings might use a
administrator's credentials, but at the project level you might want to use
your personal User ID and password for the same connector.
c. Click Submit after you successfully test the connection.
9. Select Run Now, Create External Bundle Location, or Schedule on the
Scheduler tab to determine when you want the analysis to run.
10. Click Finish.

What to do next
After the relationship analysis job completes, you can review the foreign key
candidates and accept the foreign keys for primary and natural keys.
Note: You can also mark redundant columns in this workspace. Click Key and
Cross-Domain Analysis > View Foreign Key Candidates. From here highlight the
base column and click Paired Column Status > Mark as Redundant to mark
columns as redundant.

Determining the integrity of the foreign keys
You run a referential integrity analysis job to evaluate whether a relationship
between the foreign keys and the primary keys is valid. Foreign key values that do
not match a primary key value are identified as violations.

About this task
Referential integrity analysis calculates the total number of foreign key values and
primary key values that are not common.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select a table from the list of data sources and click Open Key Analysis from
the Tasks menu.
3. Select the primary or natural key candidate and click Key and Cross-Domain
Analysis > View Foreign Key Candidates.
4. Select a foreign key candidate from the list of paired columns and click
Referential Integrity > Run Referential Integrity Analysis.
5. Type a name for the analysis job in the Run Referential Integrity Analysis
pane.
6. Select Run Now to run the job now, Create External Bundle Location, or select
Schedule to specify a time and date to run the job.
7. Click Submit.
8. After the job completes, select Referential Integrity > View Referential
Integrity Analysis to view the results of the analysis job.

Results
Referential integrity analysis shows the common domain percentages of the
primary key-foreign key relationship including a graphical representation of the
overlap.
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What to do next
After you have viewed the results of the referential integrity analysis job, you can
mark foreign key candidates as foreign keys.

Referential integrity analysis
You run a referential integrity analysis job to evaluate whether all of the references
between the foreign keys and the primary keys in your data are valid. You use the
results to help you choose foreign keys or remove foreign key violations from your
data.
During analysis, the values in the foreign key candidate and the primary key are
examined for referential integrity. Foreign keys and primary keys maintain a
referential integrity when all of the values in the foreign key column match all of
the values in the referenced primary key column. A referential integrity analysis
job identifies the orphan values and calculates statistics about the relationship.
During analysis, if the foreign key column and primary key column are both single
columns, the system uses the frequency distribution for each column to perform
the test. However, if the foreign key candidate consists of multiple columns, the
system creates a virtual column by concatenating the columns together and then
generates a frequency distribution for the virtual column. During a multiple
column primary key analysis job, primary keys with multiple columns are already
combined into a virtual column and a frequency distribution was generated for the
virtual column.
Next, the values in the frequency distribution of the foreign key column are
matched with the values in the frequency distribution for the primary key column.
If any of the values in the foreign key column are not found in the related primary
key column, the foreign key data value is flagged as a referential integrity
violation. An inverse analysis is also performed to determine whether the values in
the primary key column have a matching value in the foreign key column. When
the analysis completes, the system shows the results and lists any violations.

Accepting the foreign key status
After you view the results of the key and cross-domain analysis job and run a
referential integrity job on the key relationship, you can assign the foreign key.

About this task
The foreign key that you assign is recorded in the repository.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select the tables that you want to assign the foreign key relationship for and
click Open Key Analysis from the Tasks menu.
3. Highlight a primary or natural key candidate column that you ran a foreign
key analysis on, and then click Key and Cross-Domain Analysis > View
Foreign Key Candidates.
4. Optional: In the Open Foreign Key Analysis pane, you can review the results of
the foreign key analysis job.
5. Select the paired column that you want to define as the foreign key.
6. Select Key Status > Mark as Foreign Key.
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7. Optional: Select a foreign key candidate and click View Details to display the
frequency values and analysis details for the selected foreign key candidate. To
remove foreign key status from a column select Key Status > Remove Foreign
Key Status.
8. Click Close.

Removing the foreign key status
If you view the results of the foreign key analysis job and the referential integrity
job and determine that a foreign key is not valid, you can remove the foreign key
status from the column or columns.

About this task
The foreign key status that you remove is recorded in the repository.

Procedure
1. Select Key and Cross-Domain Analysis from the Investigate navigator menu.
2. Select the table that contains the primary or natural key associated with the
foreign key you wish to remove and click Open Key Analysis from the Tasks
menu.
3. Select the primary or natural key column and click Key and Cross-Domain
Analysis > View Foreign Key Candidates.
Note: In the Open Foreign Key Analysis pane, you can review the results of
the relationship analysis job.
4. Optional: Click View Details to display the frequency values and analysis
details for the selected columns.
5. Select the column that you want to remove the foreign key status from.
6. Select Foreign Key Status > Remove Foreign Key Status.
7. Click Close.
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Chapter 7. Locating overlapping data across domains
To determine if columns contain overlapping or redundant data, you can run a key
and cross-domain analysis job across columns in one or multiple tables or sources.

About this task
A key and cross-domain analysis compares the data values between two columns
to locate overlapping data. You can compare pairs of columns in one table or
across tables.

Procedure
1. On the Investigate navigator menu in the console, select Key and
Cross-Domain Analysis.
2. Select one or more tables from the list of data sources and click Key and
Cross-Domain Analysis > Run Key and Cross-Domain Analysis from the
Tasks pane.
3. Enter a job name and description for the key and cross-domain analysis.
4. Select Enable filters.
5. Click Filter Settings and select Exclude columns containing nulls, Exclude
columns missing column analysis results, and any other filters you want to
set for the cross domain analysis.
6. Click OK.
7. Select tables in the Available Tables section and click Add to Base List or Add
to Paired List to designate tables as base or paired tables.
8. Select Run Now, Create External Bundle Location, or Schedule on the
Scheduler tab to determine when you want the analysis to run.
9. Click Next and then Finish.
10. After you run a key and cross-domain analysis, click Open Cross-Domain
Analysis.
11. Enter a percentage in the Flag Percentages Above field to flag columns that
have a particular percentage of unique values and then click Apply.
12. Review the cross-domain results.
13. Highlight the Paired Source column and click Paired Column Status > Mark
as Foreign Key or Mark as Redundant.
14. Click Close.
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Related concepts
“Cross-domain analysis”
Run a key and cross-domain analysis job to identify columns that have common
domain values. The system determines whether a column has a minimum
percentage of distinct values that also appear in another column. If the column
meets the criteria for having a common domain, the column is flagged. Columns
that share a common domain contain overlapping and potentially redundant data.
Related tasks
“Marking redundant columns” on page 99
After you run a key and cross-domain analysis job, you can review the
cross-domain results and mark a column as redundant.

Cross-domain analysis
Run a key and cross-domain analysis job to identify columns that have common
domain values. The system determines whether a column has a minimum
percentage of distinct values that also appear in another column. If the column
meets the criteria for having a common domain, the column is flagged. Columns
that share a common domain contain overlapping and potentially redundant data.
Your data might contain redundant values if the data has been moved to multiple
tables by system processes. For example, after an acquisition, Bank A must merge
their customer data with the customer data of Bank B. It is possible that both
banks might have customer data that is redundant in their data sources. To move
data between sources, an analyst must know how the data is structured so that he
can determine which information he wants to move and how much space will be
needed on the new system. To identify any redundant data, the analyst runs a key
and cross-domain analysis job on the data that will be merged and then uses a
data cleansing tool to remove any data that is specified as redundant.
Running a key and cross-domain analysis job is a multiple step process. After you
designate one or more tables as base and paired tables, a list of all of the possible
column pairs is generated. The system performs a compatibility test on each
column pair to determine whether those columns are compatible with each other
depending on their data class, type, and length. If the column pair is compatible,
the column pair is made available for analysis. Column pairs that are not
compatible are excluded. The statistics show the total number of pairs that were
created, the total number of incompatible pairs, and the total number of
compatible pairs.
If you want additional pairs that are not available, return to the table selection
step, select additional or different base and paired tables, and continue. You can
also rerun a column analysis job to review or modify any inferences or selections
to create additional compatible pairs. When you rerun a column analysis job and
modify the results, a new frequency distribution is generated and used as input for
the key and cross-domain analysis job.

Common domains
A key and cross-domain analysis job evaluates each of the column pairs to
determine if the columns have common domains. The frequency distribution for
each column in a pair is used to test the columns in two ways. First, the values in
the frequency distribution of one column are compared against the values in the
frequency distribution of the second column. The number of matching distinct
values between the first column and the second column are counted.
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After the values in a column pair are evaluated, a commonality percentage is
calculated. A commonality percentage describes the proportion of matching values
between two columns. For example, column 1 and column 2 are paired together. If
7 out of 10 values in column 2 match column 1, the commonality percentage of
column 2 to column 1 is 70%. If 7 out of 7 values in column 1 match, the
commonality percentage for column 1 to column 2 is 100%. Next, the commonality
percentage is compared with the common domain threshold. You set the common
domain threshold to define the criteria for determining when two columns share
commonality. For example, if the common domain threshold is set to 95%, the
columns must have a commonality percentage equal to 95% or higher for the
system to infer that they share a common domain. You can tighten the criteria for
commonality by raising the common domain threshold setting or loosen it by
lowering the setting. In the commonality percentage example for column 1 and
column 2, column 2 does not have a common domain with column 1 (70% is less
than 95%), but column 1 does have a common domain with column 2 (100% is
greater than 95%).
Related tasks
Chapter 7, “Locating overlapping data across domains,” on page 97
To determine if columns contain overlapping or redundant data, you can run a key
and cross-domain analysis job across columns in one or multiple tables or sources.
“Marking redundant columns”
After you run a key and cross-domain analysis job, you can review the
cross-domain results and mark a column as redundant.

Marking redundant columns
After you run a key and cross-domain analysis job, you can review the
cross-domain results and mark a column as redundant.

About this task
Your data might contain redundant values if the data has been moved to multiple
tables by system process. For example, customer data might be moved through
several different systems, with a goal of a customer master file. However, it might
be stored redundantly in each system. If you find multiple customer data locations,
you can mark certain locations as redundant. Redundant information consists of
columns that have the same values, or common domains. When you identify the
redundant columns, you can remove them to save space on the new system.

Procedure
1. On the Investigate navigator menu in the console, select Key and
Cross-Domain Analysis.
2. Select a table and click Key and Cross-Domain Analysis > Run Key and
Cross-Domain Analysis.
3. Highlight the table and click Open Cross-Domain Analysis in the Tasks section
after the key and cross-domain analysis job completes.
4. Select a column from the Select Base Column menu in the Open Cross-Domain
Analysis section.
5. Review the paired columns for redundant columns.
6. Select a paired column and click Paired Column Status > Mark as Redundant .
7. Optional: Enter a value in the Flag Percentages Above field and then click
Apply in order to flag columns over a certain percentage.
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8. Optional: Select a paired column and click View Details to see the detailed
comparison of the columns, to drill down into the data, and to view specific
analysis details.
Related concepts
“Cross-domain analysis” on page 98
Run a key and cross-domain analysis job to identify columns that have common
domain values. The system determines whether a column has a minimum
percentage of distinct values that also appear in another column. If the column
meets the criteria for having a common domain, the column is flagged. Columns
that share a common domain contain overlapping and potentially redundant data.
Related tasks
Chapter 7, “Locating overlapping data across domains,” on page 97
To determine if columns contain overlapping or redundant data, you can run a key
and cross-domain analysis job across columns in one or multiple tables or sources.
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Chapter 8. Identifying changes in your data over time
To determine whether the content and structure of your data has changed over
time, you can use baseline analysis to compare a saved analysis summary of your
table to a current analysis result of the same table.

About this task
You can use baseline analysis to identify an analysis result that you want to set as
the baseline for all comparisons. Over time, or as your data changes, you can
import metadata for the table into the metadata repository again, run a column
analysis job on that table, and then compare the analysis results from that job to
the baseline analysis. You can continue to review and compare changes to the
initial baseline as often as needed or change the baseline if necessary.

Baseline analysis
When you want to know if your data has changed, you can use baseline analysis
to compare the column analysis results for two versions of the same data source.
The content and structure of data changes over time when it is accessed by
multiple users. When the structure of data changes, the system processes that use
the data are affected.
To compare your data, you choose the analysis results that you want to set as the
baseline version. You use the baseline version to compare all subsequent analysis
results of the same data source. For example, if you ran a column analysis job on
data source A on Tuesday, you could then set the column analysis results of source
A as the baseline and save the baseline in the repository. On Wednesday, when you
run a column analysis job on data source A again, you can then compare the
current analysis results of data source A with the baseline results of data source A.
To identify changes in your data, a baseline analysis job evaluates the content and
structure of the data for differences between the baseline results and the current
results. The content and structure of your data consists of elements such as data
classes, data properties, primary keys, and data values. If the content of your data
has changed, there will be differences between the elements of each version of the
data. If you are monitoring changes in the structure and content of your data on a
regular basis, you might want to specify a checkpoint at regular intervals to
compare to the baseline. You set a checkpoint to save the analysis results of the
table for comparison. You can then choose to compare the baseline to the
checkpoint or to the most recent analysis results.
If you know that your data has changed and that the changes are acceptable, you
can create a new baseline at any time.

Setting an analysis baseline
To establish which version of analysis results will be used as the baseline for
comparison, you must set an analysis baseline.
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Before you begin
You must have IBM InfoSphere Information Analyzer Business Analyst privileges
and an Information Analyzer Data Operator must have completed the following
task.
v “Running a column analysis job” on page 58

About this task
After you run a column analysis job and verify the results of that analysis, you can
set the analysis results as an analysis baseline. You set an analysis baseline to
create a basis for comparison. You can then compare all of the subsequent analyses
of this table to the baseline analysis to identify changes in the content and
structure of the data.

Procedure
1. On the Investigate navigator menu in the console, select Baseline Analysis.
2. Select a table in which at least one column has been analyzed.
3. On the Tasks pane, click Set Baseline.
4. On the Set Baseline window, click Close.

What to do next
You can now compare the analysis baseline to a subsequent analysis result of the
table.

Comparing analysis results
To identify changes in table structure, column structure, or column content from
the baseline version to the current version, you can compare analysis results.

Before you begin
You must have IBM InfoSphere Information Analyzer Business Analyst privileges
and have completed the following task.
v “Setting an analysis baseline” on page 101

About this task
Over time, the data in your table might change. You can import metadata for the
table again, analyze that table, and then compare the analysis results to a prior
version to identify changes in structure and content. You can use baseline analysis
to compare the current analysis results to a previously set baseline.

Procedure
1. On the Investigate navigator menu, select Baseline Analysis.
2. Select the table that you want to compare to the baseline analysis. To locate
changes in data, you must have re-imported metadata for the table and run a
column analysis job on the table.
3. On the Tasks pane, click View Baseline Analysis.
4. In the Pick an Analysis Summary window, select which analysis result you
want to compare to the baseline.
v Select Checkpoint to compare the baseline to the last checkpoint analysis.
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v Select Current Analysis to compare the baseline to the last run analysis job.

What to do next
The View Baseline Analysis pane details the changes in data.

Setting the checkpoint
You can set a checkpoint to save a subsequent point of the selected analysis results
for a table to use in comparing to the baseline. The checkpoint is saved as a point
of comparison even if subsequent analysis jobs are run on the table.

About this task
If you are monitoring changes in the structure and content of your data on a
regular basis, you might want to specify a checkpoint at regular intervals to
compare to the baseline. You set a checkpoint to save the analysis results of the
table for comparison. You can then choose to compare the baseline to the
checkpoint or to the most recent analysis results.
A checkpoint can also save results at a point in time for analysis publication.

Procedure
1. On the Investigate navigator menu in the console, select Baseline Analysis.
2. Select the table that you want to set as the checkpoint.
3. On the Tasks pane, click Set Checkpoint.

What to do next
You can now compare the checkpoint to the baseline.

Chapter 8. Identifying changes in your data over time
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Chapter 9. Publishing analysis results
You can view an analysis result and publish it to the metadata repository.

About this task
You might want to publish statistics and annotations for a table or column to
provide developers in additional suite components, such as IBM InfoSphere
DataStage or IBM InfoSphere Business Glossary, access to analytical results.

Procedure
1. On the Investigate navigator menu in the console, select Publish Analysis
Results.
2. In the Publish Analysis Results workspace, select the analysis results that you
want to publish.
3. Optional: Click View Analysis Results.
4. Click Publish Analysis Results. The analysis results are prepared for
publishing.
5. In the Publish Analysis Results window, select which analysis result you want
to publish: the current analysis, the set checkpoint, or the baseline.
6. Optional: Select whether you want to include notes. If you select to include
notes, then enter the notes in the Notes field.
7. Click OK.

Analysis result publication
You can publish your analysis results to the metadata repository to provide users
of other suite components, such as IBM InfoSphere DataStage and IBM InfoSphere
Business Glossary, access to the result summaries.
In IBM InfoSphere Information Analyzer, analysis occurs on a project basis. All the
results of analysis are bound by the project. For example, you might have three
projects that perform analysis on a table called Address_ShipTo and three sets of
analysis results exist for that table. The results of those three analyses contain valid
analysis, however the administrator might want to make one of analysis results the
official shared results.
Analysis results can be published to the source objects that they are associated
with. Source objects are shared by all of the suite components. Therefore, if these
source objects are referenced in IBM InfoSphere DataStage or IBM InfoSphere
Business Glossary, those suite components also have access to the analysis results
that are published.
For example, an Information Analyzer Project Administrator can create three
projects: Address_primary, Address_compare, Address_worldwide. Each of these
projects analyze the table Address_ShipTo. While performing analysis, Information
Analyzer Data Analysts can annotate the analysis results with notes that provide
additional information to other reviewers. After the analysis review completes, the
administrator might select the analysis results for the Address_ShipTo table from
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the Address_compare project as the enterprise standard results. The administrator
can then publish those results to the metadata repository. The last analysis
published overlays any prior publication.
An IBM InfoSphere DataStage developer can then go into an IBM InfoSphere
DataStage job, look at the Address_ShipTo table, and elect to look at the analysis
results for that table. The developer can also view any notes or annotations created
by the Information Analyzer Data Analyst. The developer can design or modify
their job based on those results and notes. For example, the Information Analyzer
Data Analyst might suggest that the data type of a particular column in the table
should be changed, that a table should have a foreign key established, or that a
table has invalid values that the job should eliminate.

Publish analysis results reference
The following table describes the properties, attributes, and values that are
returned after you publish analysis results.
Table 12. Publish analysis results reference
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Attribute

Description

Column

Shows the name of the column that was
analyzed.

Sequence

Shows the logical sequence number of the
column in the order of columns.

#

Shows the number of distinct values in the
column.

%

Shows the percent of distinct values in the
column.

Data Class

Shows the data class of the column.

Data Type

Shows the data type of the column. A data
type is a classification that indicates what
type of data is stored in the data field.
Number, character, floating point, date, and
integer are examples of data types.

Length

Shows the length of the column.

Precision

Shows the maximum number of digits that
are needed (both to the left and right of the
decimal place) to hold all values that are
present in a numeric column. Precision is
applicable only to numeric columns.

Scale

Shows the maximum number of digits that
are needed to the right of the decimal place
to hold all values that are present in a
numeric column. Scale is applicable only to
numeric columns.

Nullability

Shows whether null values are allowed in
the column.

Nulls

Shows the total number of null values in the
column.

PK

Shows a check mark if the column is part of
a defined primary key.

FK

Shows a check mark if the column is part of
one or more defined foreign keys.

Table 12. Publish analysis results reference (continued)
Attribute

Description

NK

Shows a check mark if the column is part of
one or more defined natural keys.

Valid Value Criteria

Shows the type of the valid value definition.
The type can be either Range or Reference
Table.

Compliance Definition

Shows the compliance definition for the
valid value criteria type.

Compliance Statistics

Shows the percentage of valid values for the
asset that you select.

Deleting analysis results
When you no longer need published summaries of analysis results, you can delete
them from the metadata repository.

Procedure
1. On the Investigate navigator menu, select Analysis Results Publication.
2. In the Publish Analysis Results workspace, select the analysis results that you
want to delete.
3. In the Tasks pane, click Delete Analysis Results.
4. Click OK to confirm the deletion.

Generating a physical model
You can generate a physical model to produce details and definitions of the data
selected, including inferences about the data, such as data type and properties. You
can then use the master schema definition to analyze, cleanse, or modify your data
in other suite components, such as IBM InfoSphere DataStage and IBM InfoSphere
Business Glossary.

About this task
Generate a physical model to get a comprehensive view of the inferred data types
and properties based on all of the analysis results. When you generate a physical
model, IBM InfoSphere Information Analyzer takes all of the primary and foreign
key relationships that you selected, as well as any column properties, such as any
data classes that you selected, and creates a physical data model from the analysis
results.

Procedure
1. On the Investigate navigator menu in the console, select Publish Analysis
Results.
2. Highlight the table and click Generate Physical Model.
Note: You can select multiple tables at once by holding down the control key
and highlighting each table that you want to include in the master schema
definition.
3. Click Create physical model. You can browse for the location for the physical
model or enter a file name in the File name field.
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4. Click Create DDL file to generate a physical model in ANSI data definition
language (DDL) format and enter a file or location for the DDL file in the File
name field. Click Preview to preview the physical model.
5. Click Submit.

What to do next
You can see the physical models that you generated in various portions of
InfoSphere Information Analyzer, such as data collections or data fields if you
generated a schema definition in the InfoSphere Model Definitions IDR format. The
model will also be displayed in the metadata fields for products such as
InfoSphere DataStage and IBM InfoSphere FastTrack.
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Chapter 10. Importing and exporting project assets
You can interchange IBM InfoSphere Information Analyzer project and analysis
assets by using the istool command line interface (CLI) or the InfoSphere
Information Analyzer client.
You can import and export assets and move them between instances of the IBM
InfoSphere Information Server metadata repositories by using the istool CLI or the
InfoSphere Information Analyzer client.
You can move projects and the assets that are associated with them, including
analysis results, data rules, data classes, reports, and common metadata.

Importing projects from the InfoSphere Information Analyzer client
You can use the IBM InfoSphere Information Analyzer client to import projects.

Before you begin
To perform this task you must have InfoSphere Information Analyzer Project
Administrator privileges.

Procedure
1. Open the InfoSphere Information Analyzer client, and click File > Import
Project.
2. Specify a location in the Location field, and click Show Files. For example:
C:\IBM.
3. Select the project you want to import and click Next.
4. Review the import summary and click Import.
5. Click OK on the import status page to close the import dialog box. You can
monitor the status of the import by viewing the status bar.

What to do next
After importing the assets, you can use InfoSphere Information Analyzer to
analyze the data.
Note:
v The imported asset archive is stored on the server.
v If an imported asset already exists on the system, an internal identity conflict
will occur. You can choose to bypass the imported item (ignore) or replace the
existing item with the imported one (replace).
v If an imported item has the same name as an existing item in the system, a
name conflict will occur. You can choose to bypass the imported item (ignore),
replace the existing item with the imported one (replace), or provide the
imported item with a unique name(rename).

Exporting projects from the InfoSphere Information Analyzer client
You can use the IBM InfoSphere Information Analyzer client to export projects.
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Before you begin
To perform this task you must have InfoSphere Information Analyzer Project
Administrator privileges.

Procedure
1. Open the InfoSphere Information Analyzer client, and click File > Export
Project.
2. Select the project you want to export assets for and click Next.
3. In the Export window, specify details about the project that you want to export:
a. In the Package Name field, enter a name for the file that will contain the
exported project.
b. Enter the location that you want to export the project to in the Location
field. For example, specify "C:\IBM\InformationServer\temp" on a
Microsoft Windows system or "/opt/export" on a Unix system.
c. Select any artifacts that you want to include.
4. Click Export.
5. Click OK on the export status page to close the export dialog box. Keep the
status page open if you want to monitor the progress of the export task.

What to do next
After completing the export task, the assets are exported in a package file to the
server. After they are exported to the server, any IBM InfoSphere Information
Server product that can access the server can import the package from the server.
Note: Archive files that are exported by using the client can be imported only by
using the client.
.
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Chapter 11. Importing published analysis results
Import the analysis results from other IBM InfoSphere Information Server products
to view high-level analysis results within IBM InfoSphere Information Analyzer.

Before you begin
You must have InfoSphere Information Analyzer Data Operator privileges. The
following task must have been completed by an InfoSphere Information Analyzer
Data Administrator.

Procedure
1. On the Investigate navigator menu in the console, select Column Analysis.
2. On the Column Analysis workspace, select the data sources that you want to
import the published results for.
3. In the Tasks pane, click Import Published Results.
4. Review the sources that have published results on the Import Published
Results screen.
5. Review the Column Analysis Status field on the Column Analysis workspace
to verify that the data source status is Published. The Published status
indicates that the results were imported successfully.

What to do next
To see details about the imported published column analysis results, highlight the
data source that you have imported published results for, click Open Column
Analysis from the Tasks pane, and then click View Details for an overview of the
Published or Imported from Published details for the data source.

Analysis results imported from IBM InfoSphere products
Use IBM InfoSphere Information Analyzer to view analysis information from IBM
InfoSphere Discovery and IBM InfoSphere Data Architect.
To view the analysis summaries from these products you must install MetaBrokers
and bridges.
You can import published analysis results and related implemented data resources
into the metadata repository of IBM InfoSphere Information Server by using the
following MetaBrokers:
v IBM Rational® Data Architect MetaBroker®
v DBM File MetaBroker (imports DBM files from InfoSphere Discovery)
After you import the analysis results, you can add the data sources to a project
and view the high-level results of the analyses in InfoSphere Information Analyzer.
The analysis information includes:
v Table analysis properties
v Column analysis properties
v Data classification codes
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v Inferred candidate keys
v Inferred foreign keys
Additionally, you can publish analysis results for an InfoSphere Information
Analyzer project, and then import the analysis results into another InfoSphere
Information Analyzer project.
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Chapter 12. Running and scheduling InfoSphere Information
Analyzer jobs
You can run and schedule IBM InfoSphere Information Analyzer jobs outside of
the InfoSphere Information Analyzer client.

Running InfoSphere Information Analyzer jobs from the command line
You can use the command line interface to invoke the scheduling service of IBM
InfoSphere Information Analyzer, without logging into the InfoSphere Information
Analyzer client.
You can integrate the execution of InfoSphere Information Analyzer activities, by
issuing commands from the command line interface without having a client
connection to that particular project environment. Use this utility to run:
v Column analyses
v Table analyses
v Cross-table analyses
v Reports
v Data rules, rule sets, or metrics
You can also use the utility to obtain a list of reports, data rules, or metrics for a
particular project.
By issuing commands from the command line interface, you can integrate the
execution of InfoSphere Information Analyzer activities into a script, an external
application, or a standard system scheduler.
To run InfoSphere Information Analyzer jobs, start the command line interface, and
specify the following command:
iaJob

–user username -password password

-isHost hostname -port port_number <options>

iaJob is the location of the InfoSphere Information Analyzer command line utility,
which is usually found where the Application Service Backbone (ASB) Server and
Node are located. <options> is one of the following options that you can specify:
-lprojects
Lists all InfoSphere Information Analyzer projects by name.
-lexecutables project_name
Lists all executable quality components, such as data rules and rule sets, in
a given project, by name.
-lprojectInfo project_name
Lists information about a particular project.
-lexecutableInfo project_name executable_name
Lists information about a particular executable control, such as a data rule,
rule set, or metric.
-run project_name executable_name
Runs a particular executable control, such as a data rule or metric.
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-runBundle bundle_name
Runs a given bundle. You create the bundle by using the InfoSphere
Information Analyzer client. Use this option to invoke packaged column
analyses, table analyses, and cross-table analyses, as well as data quality
analysis with data rules, rule sets, and metrics.
-lreports project_name
Lists all of the reports for a given project. If you do not specify a project
name, then all reports will be displayed, and grouped by project.
-runReports async report_identifier
Runs a report by the report's identifier. You can specify the optional
keyword async if you want to run the report in asynchronous mode.
Note: The option fields are case sensitive. All project_name and executable_name
variables need to be declared in quotation marks.

Using an external scheduler for analysis jobs
You can use a scheduler outside IBM InfoSphere Information Analyzer to schedule
a column analysis, primary key analysis, multi-column primary key analysis,
foreign key analysis, or referential integrity analysis.

Scheduling activities with an external scheduler
Schedule a column analysis, multi-column primary key analysis, foreign key
analysis, cross-domain analysis, referential integrity analysis, or data rule execution
by using an external scheduler.

About this task
Before scheduling a column analysis, multi-column primary key analysis, foreign
key analysis, or referential integrity analysis by using a scheduler outside of IBM
InfoSphere Information Analyzer, you must create an external bundle location in
InfoSphere Information Analyzer. Create a script to run the bundle by using
command line capabilities, specifying the external bundles as part of the execution.

Procedure
1. To schedule any data analysis tasks, such as a column analysis, select the
analysis that you want to create an external bundle for from the Investigate
icon in the Navigator menu. To schedule a data rule operation, open the data
rule from the Develop icon in the Navigator menu, and click Run or Test.
2. After you run your data analysis task, click on the Scheduler tab in the Tabbed
Palette on the right side of the screen.
3. Click Create External Bundle Location on the Scheduler tab.
4. Specify the location of your external bundle script in the Create External
Bundle Location field.
5. Click Submit.

Use case scenario
You want to run a large column analysis operation against all of your data sources,
but you want to schedule the analysis for Monday of next week. You do not want
to use the existing scheduler in InfoSphere Information Analyzer, because you use
IBM Tivoli® Storage Manager software for all of your other system scheduling
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operations. You decide to set up an external bundle so that you can perform your
column table analysis in your current scheduling environment.
To schedule a column analysis operation against all of your data sources on
Monday of next week, you can start by creating the following script for your UNIX
system:
#!/bin/sh
bundleName=camonday
uname=admin
pwd=admin
host=localhost
port=9080
iaJob -user $uname -password $pwd -host $host -port $port -runBundle $bundleName

The name of the script is "camonday.sh."
Next, start InfoSphere Information Analyzer and open the project that you want to
work with. Click the Investigate icon in the Navigator menu, and then click
Column Analysis. After the column analysis runs, click on the Scheduler tab in
the Tabbed Palette in the right side of the screen. Select Create External Bundle
Location, and then type, "camonday" (the bundle name that you specify in your
script) in the Create External Bundle Location field. Click Submit.
Start IBM Tivoli Storage Manager, and schedule a time for the camonday.sh script
to run.

What to do next
Now, you can schedule the script that you created for the InfoSphere Information
Analyzer external bundle to run within your external scheduler. After you
schedule the script to run within your external scheduler, you can run column
analyses, multi-column primary key analyses, foreign key analyses, or referential
integrity analyses by using the scheduler. You can also run data rules from your
external scheduler.

Chapter 12. Running and scheduling InfoSphere Information Analyzer jobs
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Chapter 13. Managing tables
You can manage reference tables and tables that are generated during analysis. You
can open a table, delete a table, export a table to a file, and view the metadata in a
table.

Table management
You use table management tasks to manage reference tables and the tables that are
generated during analysis. For example, you can use table management tasks to
open a table, delete a table, export a table to a file, and view the metadata in a
table.
You create a reference table to save criteria for a column and then use that criteria
elsewhere. Reference tables can be exported to other projects in the suite or to
external systems. You might want to create a reference table to reuse information
about a column. For example, when you evaluate the frequency distribution of a
column that was created during a column analysis job, you might mark some
values in column A as invalid. You can then create a reference table that contains
all of the invalid values and apply those values to column B so that you do not
need to perform the same task on the invalid values in column B.
Tables that are generated during analysis include data sample tables that are
created during a multiple column primary key analysis job and frequency
distribution tables that are created during a column analysis job. These tables
contain information about your data that you might want to view to learn more
about how the data was handled during analysis. You can also export the tables to
a file to share the information with other users or processes.
Note: Frequency distribution tables can be very large and take up a lot of space.
You can delete a frequency distribution to reduce the amount of space that is used
on a system. However, if you delete a frequency distribution, you lose the results
from the column analysis job that created it and you will not be able to run
subsequent analyses that use the frequency distribution as input, such as primary
key analysis and baseline analysis.

Viewing the records in a table
To view the records of a reference table or a table that was generated during
analysis, you open the table.

Procedure
1. On the Investigate navigator menu in the console, select Table Management.
2. In the Table Management workspace, select the table that you want to open.
3. In the Tasks pane, click Open. In the Open Reference Table pane, you can view
the contents of the table.

Exporting a table to a file
To save a copy of the table to a local folder, you export the table to a file.
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Procedure
1.
2.
3.
4.

On the Investigate navigator menu in the console, select Table Management.
In the Table Management workspace, select the table that you want to export.
In the Tasks pane, click Open.
In the Browse Reference Table pane, click Export.

5. In the Export Settings window, click Browse to specify where you want to save
the table.
6. Select additional output options.
7. Click OK to export the table.

Viewing metadata for a table
You can view the definition of a table, including column names and the data type
for each column.

Procedure
1. On the Investigate navigator menu in the console, select Table Management.
2. In the Table Management workspace, select the table that you want to view
the metadata for.
3. In the Tasks pane, click View Metadata. The View Metadata pane shows the
detailed metadata of the selected table.

Deleting a table from the metadata repository
You can delete a reference table or a table that was generated during analysis from
the metadata repository.

About this task
If a frequency distribution table is deleted, you can no longer view any details for
the associated column, such as the frequency distribution, domain, or format
analyses results.

Procedure
1. On the Investigate navigator menu in the console, select Table Management.
2. In the Table Management workspace, select the table that you want to delete.
3. In the Tasks pane, click Delete.
4. In the confirmation window, click OK. The table is deleted from the metadata
repository.
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Chapter 14. Creating rules for data analysis
You can define and run data rules, which evaluate or validate specific conditions
associated with your data sources. Data rules can be used to extend your data
profiling analysis, to test and evaluate data quality, or to improve your
understanding of data integration requirements.
To work with data rules, start by going to the Develop icon on the Navigator
menu in the console, and select Data Quality. This will get you to the starting
point of creating and working with data rule functionality.
From the Data Quality workspace you can:
v
v
v
v

Create data rule definitions, rule set definitions, data rules, rule sets, and metrics
Build data rule definition, rule set definition, and metric logic
Create data rule definition and rule set definition associations
Associate a data rule definition, rule set definition, metric, data rule, or rule set
with folders

v Associate a data rule definition, rule set definition, metric, data rule, or rule set
with IBM InfoSphere Business Glossary terms, policies, and contacts
v Build data rule definitions or rule set definitions by using the rule builder
v Add a data rule definition with the free form editor

Characteristics of data rules
You can use data rules to evaluate and analyze conditions found during data
profiling, to conduct a data quality assessment, to provide more information to a
data integration effort, or to establish a framework for validating and measuring
data quality over time.
Data rules are generated out of data rule definitions. These definitions describe the
rule evaluation or condition. By associating physical data sources with the
definition, a data rule can be run to return analysis statistics and detail results. The
process of creating a data rule definition and generating the subsequent data rule
is shown in the following figure:

Test
Data Rule

Create Rule
Definition

View Output

Generate
Data Rule

Run
Data Rule

Figure 3. Process of creating and running a data rule definition

© Copyright IBM Corp. 2006, 2012

119

IBM InfoSphere Information Analyzer data rules include the following
characteristics:
Reusable
The definitions are not explicit to one data source, but can be used and
applied to many data sources.
Quickly evaluated
They can be tested interactively, as they are being created, to ensure that
they deliver expected information.
Produce flexible output
Data rules can produce a variety of statistics and results, at both the
summary and detail levels. You can evaluate data either positively (how
many records meet your condition) or negatively (how many records
violate your condition), and control the specifics of what you need to view
to understand specific issues.
Historical
They capture and retain execution results over time, allowing you to view,
monitor, and annotate trends.
Managed
Each data rule has a defined state, such as draft or accepted, so that you
can identify the status of each rule.
Categorical
You can organize data rules within relevant categories and folders.
Deployable
You can transfer data rules to another environment. For example, you can
export and transfer a data rule to a production environment.
Audit functionality
You can identify specific events associated with a rule such as who
modified a rule and the date that it was last modified.

Getting started with rule analysis
To work with IBM InfoSphere Information Analyzer rules, go to the Develop icon
on the Navigator menu, and select Data Quality from the menu.
From the Data Quality workspace you can:
v Create a rule definition
v Create a rule set definition
v Create a data metric
v Open and work with an existing rule definition, data rule, or metric
v Generate a data rule from an existing rule definition or a rule set from an
existing rule set definition
v Run an existing data rule, rule set, or metric
v View output of a data rule, rule set, or metric
v Manage the folders in your project in order to organize your data rules, data
rule definitions, rule sets, and metrics
v Import a rule definition or data rule from another project
v Export a rule definition, rule set definition, data rule, or metric
v Copy data rules, rule sets, or metrics
v Publish data rules and rule sets
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v Delete data rule definitions, rule set definitions, data rules, rule sets, or metrics
To open an item from the main screen, double-click the item or select the item and
click Open from the Tasks menu on the right side. To perform the other functions,
select the item and click the corresponding task from the Task menu.

Data rule definitions
Rule definitions are the foundation for rule analysis, allowing you to extend and
explore beyond basic data profiling. They provide a flexible method to define
specific tests, validations, or constraints associated with your data. The resulting
data rules provide you with the ability to ensure compliance to expected
conditions or identify and review exceptions.
Data rule definitions provide you a way to write and define the logic that you
want to apply to the data in your projects. You can write data rule definitions to
setup a wide range of rule logic, including rules that check for equality,
uniqueness, existence, occurrence, and format types.
When you create a data rule definition, you define the logic that is useful for
analyzing the data in your projects. The rule definition describes particular
conditions of a record, which you can then execute with specific references to
particular columns or tables in the data sources that are included in your projects.
The logic that you define in your rule definitions can be re-used against any
explicit data sources that you specify when you generate a data rule. After you
create and save a rule definition, you can use it in projects in your current
environment, or the definitions can be exported and migrated to test or production
environments on a different server.
You can create rule definitions by using the IBM InfoSphere Information Analyzer
rule builder to construct the rule logic, or you can use the free form builder to
manually construct more complex definitions into rule logic. When you create data
rule definitions, you define rule logic that describes certain conditions of a record.
By segmenting the rule logic from physical data sources, you write rules from a
logical perspective. By creating rule definitions that are not associated with actual
data in your project, you are able to reuse the logic multiple times, for multiple
scenarios. When you want to use the rule logic against real data in your project,
you can generate a data rule. When you generate a data rule, you associate the
logical components of your rule definition with physical data in your projects.

Data rule definition logic
You use rule definitions to develop rule logic to analyze your data. IBM InfoSphere
Information Analyzer rule logic evaluates to a true or false value, and sets up pass
or fail checks to evaluate the quality of your data. Rule definitions represent a
logical expression that can include multiple conditional expressions.
Incomplete, empty, or invalid data values affect the quality of the data in your
project by interrupting data integration processes and by using up memory on
source systems. You can create rule definitions to analyze data for completeness
and validity to find these anomalies.
A rule definition is a true or false (Boolean) expression that contains various
conditions to evaluate data records. After you transform your rule definition into a
data rule, you can run the data rule against data in your project. Each record you
run the data rule against either meets or does not meet the logic defined in the
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data rule. You can test the quality of your data based on the number of records
that meet or do not meet the rule logic. Rule definitions can contain simple tests or
complex nested Boolean conditions.
To create the rule logic, define a source value and select a condition to evaluate.
Rule definitions can be built from various components. You can include physical
sources, such as standard metadata sources that are imported by using InfoSphere
Information Analyzer, or logical sources, such as glossary terms or words that you
create to map to physical sources. You can choose any words you want to describe
the source or reference values in your rule definitions. For example, if you have a
date of birth value in your source data or reference data fields, you could type in a
common word or abbreviation such as "DOB," "Date_of_Birth," or "Birthdate." You
could also use a specific data source field or column name such as
"SystemA_DATE_BIRTH."
In the rule definition state, the rules are logical representations. Eventually you
turn the rule definitions into data rules, and bind the logical representations with
real data from your physical data sources. Data rules are objects that you run to
produce specific output. When you build data rule definitions, you create
representational rule logic to map data that you want to analyze.
If you use physical data sources when building your rule logic, then a logical
variable representing the physical source is created, and is the default binding for
this variable when you transform the data rule definition into a data rule. When
you transform the data rule definition into a data rule, you can either keep the
default binding, or you can modify the setting and bind the logical variable to a
different physical data source.

Example
If a campaign agency is analyzing data on voters in its system, to make sure that
all individuals in its source data under the age of 18 are flagged as being unable to
vote, the following rule definition can be created:
IF Age < 18 THEN Can_Vote = ’false’

In this example, "Age" and "Can_Vote" might be fields in one of the data sources in
the project that you plan to use when you turn the rule logic into a data rule.
This data rule definition can be written in any terms that you want to use. For
example, you can type "Age," "voter_age," or you can create a logical variable for
"Age," by highlighting an "Age" column in one of your data sources and clicking
Add to Logic. When creating the data rule definition, you can type the
components of the rule logic in any way that you prefer. When you generate a
data rule, you transform the logical representations into elements that are bound to
real data in your data sources.

Creating a rule definition
Creating a rule definition requires two components: a name for the rule definition
and a logical statement (the rule logic) about what the rule definition tests or
evaluates.

About this task
Create a rule definition by defining the name and description of the rule. Use the
free form editor or rule logic builder to complete the rule logic for the rule
definition.
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Procedure
1. From the Develop icon on the Navigator menu in the console, select Data
Quality.
2. Click New Rule Definition in the Tasks list, located on the right side of the
screen.
3. Enter a name for the new rule definition in the Name field.
4. Optional: Enter a brief description of your rule definition in the Short
Description field.
5. Optional: Enter a longer description of your rule definition in the Long
Description field.
6. Optional: In the Validity Benchmark section, check Include Benchmark to set
benchmarks to check the validity of your data.
7. Click Save.
Note: Save your work at periodic intervals as you creating your rule
definition, particularly if the rule definition is complex.

What to do next
After you create a name and a description for your rule definition on the
Overview tab, switch to the Rule Logic tab, to define the specific condition you
wish to analyze or validate. You can build the rule logic by using either the rule
builder or the free form editor. After you have defined the rule logic, you can turn
the rule logic into a data rule, and then you can test and analyze data with the
rule.

Data rule definition checks
You can use a variety of checks or conditions when you build rule definitions.
Each rule expression is made up of at least one check, and can combine a variety
of checks. These checks can be thought of as the core units that describe rule
definition logic. You can employ the checks one at a time or as multiple building
tools for putting together rule definitions.
For each check, the following information is shown:
v Syntax
v Description
v Notes
v Use case scenario or example
Containment check:
This rule definition logic checks whether the source data contains the reference
data, where both elements are part of a string. For example, “abcdef” contains “cd”
and does not contain “dc.”
Syntax
Positive:
source-data CONTAINS reference-data

Negative:
source-data NOT CONTAINS reference-data
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Description
When positive, the data rule definition finds rows for which the source data
contains the reference data. When negative, it finds rows for which the source data
does not contain the reference data.
Notes
v The containment check is case sensitive.
v Both source and reference data must be strings. Quotation marks are required if
the string is a hard coded literal.
v Both source and reference data can be a variable or the result of a scalar
function.
v You can use a expression that is made up of scalar functions, arithmetic
operations and variables as a source data. If you do this, make sure that each
expression evaluates to a character or string data type.
Use case scenario
You want to create a data rule called, "Detecting Unprintable Characters in Column
Analysis" to detect and report the carriage return ASCII unprintable characters
embedded within a character or varchar string. You build your rule definition logic
as follows:
v Source Data: codefield
v Type of Check: contains
v Reference Data: '\r' (literal)
When you are done, the rule definition looks like this example:
codefield contains ’\r’

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: codefield
– Go to the Tabbed Palette and scroll over to the Data Sources tab. Find the
table and then the column that you want to search for unprintable characters.
Highlight the column and click Set as Binding.
v Name: literal
– To specify the unprintable character, you need to go to the Tabbed Palette and
scroll over to the Literal tab. Create a new literal that is set to the character
type to '\r' (the unprintable carriage return character), and then click Set as
Binding.
For this example, you do not need to perform any joins. You can select the output
that you would like to see on the Output tab.
Date check:
The date data rule definition logic checks whether the source data, which must be
a character data type, is in a valid date format.
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Syntax
Positive:
source-data is_date

Negative:
source-data NOT is_date

Description
When positive, the type check finds rows for which the source data is a valid date
data type. When negative, it finds rows for which the source data is not a valid
date data type.
The "is_date" logic checks for the following date formats:
Table 13. Date format checking table
No delimiter

Dash delimiter

Slash delimiter

Dot delimiter

v %yyyy%mm%dd

v %yyyy-%mm-%dd

v %yyyy/%mm/%dd

v %yyyy.%mm.%dd

v %yy%mm%dd

v %yy-%mm-%dd

v %yy/%mm/%dd

v %yy.%mm.%dd

v %mm%dd%yyyy

v %mm-%dd-%yyyy

v %mm/%dd/%yyyy

v %mm.%dd.%yyyy

v %mm%dd%yy

v %mm-%dd-%yy

v %mm/%dd/%yy

v %mm.%dd.%yy

v %yyyy%dd%mm

v %yyyy-%dd-%mm

v %yyyy/%dd/%mm

v %yyyy.%dd.%mm

v %yy%dd%mm

v %yy-%dd-%mm

v %yy/%dd/%mm

v %yy.%dd.%mm

v %dd%mm%yyyy

v %dd-%mm-%yyyy

v %dd/%mm/%yyyy

v %dd.%mm.%yyyy

v %dd%mm%yy

v %dd-%mm-%yy

v %dd/%mm/%yy

v %dd.%mm.%yy

Notes
v For rule definition logic, you can use a expression that is made up of scalar
functions, arithmetic operations and variables as a source data. If you do this,
make sure that each expression evaluates to a character or string data type.
Use case scenario
You work for a shipping company and you want to determine how many rows in
your shipment date table have dates that are not in a valid date format.
The rule you title, "Invalid date check," is going to report back the number of dates
in the shipment date table that are in an invalid date format. Build your rule
definition logic as follows:
v Source Data: shipment_date
v Condition: NOT
v Type of Check: is_date
When you are done, the rule logic looks like this example:
shipment_date NOT is_date

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
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v Name: shipment_date
– Go to the Tabbed Palette and scroll over to the Data Sources tab. Find the
table and then the column that you contains the shipment dates you want to
analyze. Highlight the column and click Set as Binding.
For this example, you do not have to perform any joins. You can select the output
that you want to see on the Output tab. To see all the invalid dates, on the Output
tab, you would want to specify that you want to see all the records that meet the
data rule.
Equality check:
The equality data rule definition logic checks for equality between the source data
and the reference data.
Syntax
Positive:
source-data = reference-data

Negative:
source-data

NOT = reference-data

source-data

<> reference-data

Description
When positive, the equality check finds rows for which the source data is equal to
the reference data. When negative, it finds records for which the source data is not
equal to the reference data.
Notes
v For string data, the equality check is case sensitive and ignores all trailing spaces
in the value you are checking. When you run an equality check, all trailing
spaces in the value you are checking are removed. For example, if the source or
reference data fields contain "name," the equality check will verify "name " (a
value with a data type of CHAR(10)) as a match.
v For string data, spaces at the beginning of the values you are checking are not
ignored. Additional spaces or characters or differences between upper and
lowercase values might prevent a successful validation. You can use functions
such as TRIM or UPPERCASE to standardize the values.
v The source data and reference data must have compatible data types.
v You can use a expression that is made up of scalar functions, arithmetic
operations and variables as a source data. If you do this, make sure that each
expression evaluates to a character or string data type.
Use case scenario
You work for a company that sells emergency food packages that are packed in a
shipment bag. Each bag has an approximate weight of 50 pounds. You want to
create a data rule to figure out how many bags in your warehouse weigh exactly
50 pounds, to make sure that the number of bags with this weight match the total
number of bags that have been produced. If these numbers do not match, you
might have a production error.
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The rule that you call, "Finding the number of bags that are 50 pounds in the
master catalog" will report the number of bags that weigh exactly 50 pounds in the
master catalog table. You can build your rule definition as follows:
v Source Data: Master_Catalog_Weight
v Type of Check: =
v Reference Data: 50
When you are done, the rule definition looks like this example:
Master_Catalog_Weight = 50

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: MSTRCTLG_WEIGHT
– In the rule definition, the logical representation for the MSTRCTLG_WEIGHT
was written as "Master_Catalog_Weight," but now you need to find the actual
MSTRCTLG_WEIGHT column in your table. Find the table and then the
column that contains rows that record the weight of the bags. Highlight the
column and click Set as Binding.
For this example, you do not need to perform any joins. You can select the output
that you want to see on the Output tab.
Existence check:
The existence data rule definition logic checks whether anything exists in the
source data.
Syntax
Positive:
source-data EXISTS

Negative:
source-data NOT EXISTS

Description
When positive, the existence check finds rows for which the source data is any
value other than null values. When negative, it finds rows for which the source
data contains null values.
Notes
v No reference data is necessary for this type of data rule definition logic. If
reference data is present, it is ignored.
v You can use a expression that is made up of scalar functions, arithmetic
operations and variables as a source data. If you do this, make sure that each
expression evaluates to a character or string data type.
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Use case scenario
You want to create a data rule called, "ORDER EXISTS" to verify that the ORDER
column is populated (not null) for every row of the table, "DAD_DTL."You build
your rule definition logic as follows:
v Source Data: DAD_DTL_ORDER
v Type of Check: exists
When you are done, the rule logic looks like this example:
DAD_DTL_ORDER exists

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: DAD_DTL_ORDER
– Find the table DAD_DTL in your project, and then find the ORDER column.
Highlight the ORDER column and click Set as Binding.
For this example, you do not need to perform any joins. You can select the output
that you want to see on the Output tab.
Occurrence check:
The occurrence data rule definition logic checks the source data for cardinality,
which is the number of times that values occur within a table.
Syntax
Positive:
source-data OCCURS reference-data
source-data OCCURS > reference-data
source-data OCCURS >= reference-data
source-data OCCURS < reference-data
source-data OCCURS <= reference-data

Negative:
source-data NOT OCCURS reference-data
source-data NOT OCCURS > reference-data
source-data NOT OCCURS >= reference-data
source-data NOT OCCURS < reference-data
source-data NOT OCCURS <= reference-data

Description
When positive, the occurrence check finds rows for which the source data occurs
greater than, less than, or equal to the number of times specified by the reference
data. When negative, it finds rows for which the source data does not occur
greater than, less than, or equal to the number of times specified by the reference
data.
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Notes
This type of checks implies the computation of aggregations on the source
columns. These operations can take much longer to execute than other types of
checks which only have to test single records.
Use case scenario
You want to create a data rule called, "15 or More Product Codes" to determine
how many rows have product codes that appear 15 or more times in the master
catalog table. Build your data rule definition logic as follows:
v Source Data: product_code
v Type of Check: occurs >=
v Reference Data: 15
When you are done, the data rule definition looks like this example:
product_code occurs>= 15

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: MSTRCTLG_PRODCODE
– Go to the Tabbed Palette and scroll over to the Data Sources tab. In the rule
definition, the logical representation for the MSTRCTLG_PRODCODE was
written as "Product_code," but now you need to find the actual
MSTRCTLG_PRODCODE column in your table. Find the MSTRCTLG table
and then highlight PRODCODE and click Set as Binding.
For this example, you do not have to perform any joins. You can select the output
that you want to see on the Output tab.
Matches regular expression check:
This data rule definition logic checks to see if your data matches a regular
expression.
Syntax
Positive:
source-data

MATCHES_REGEX pattern-string

Negative:
source data

NOT MATCHES_REGEX pattern-string

Description
You can use a regular expression to search for a particular character, or a character
string in the beginning, middle, or end of a word. You can also use regular
expressions to find a particular variable, a range of characters, or specific kinds of
characters, such as printable or unprintable characters. When positive, it finds rows
for which the source data matches the specified expression. When negative, it finds
rows for which the source data does not match the specified expression.
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Any lowercase character that you specify in a pattern string searches for that
specific lowercase character. Any uppercase character that you specify in a pattern
string indicates that particular uppercase letter. Any specific digit you specify, from
zero to nine, indicates the particular digit that you specified in the pattern string.
You can use these operators in combination with other valid characters to build
very complex expressions.
The following table provides examples of regular expression operators that you can
use to construct your regular expression data rule definition logic:
Table 14. Examples of regular expression operators
Operator

Function

. (period)

Indicates a match for a single character.

$ (dollar sign)

Indicates the end of a line.

^ (caret)

Indicates that the pattern string starts at the
beginning of a line.

[uppercase character]

Indicates a match for a specific uppercase
character.

[lowercase character]

Indicates a match for a specific lowercase
character.

[digit from 0–9]

Indicates a match for a specific single digit.

\d [a particular digit from 0–9]

Indicates a match for a specific single digit.

\b

Indicates a match at a word boundary.

\s

Indicates a match for any whitespace
character.

\S

Indicates a match for any non-whitespace
character.

\w

Indicates a match for any single
alphanumeric character.

[]

Indicates the start for the character class
definition that you specify.

[^X]

Indicates a match for the start of a line,
followed by the specific characters that you
specify.

X?

Indicates a match for no or one occurrence
of the qualifier. It also extends the meaning
of the qualifier.

X*

Indicates a match for a qualifier of zero or
more.

X+

Indicates a match for one or more qualifiers.

{X, Y}

Indicates a match between X and Y number
of occurrences.

(X|Y) +

Indicates the start of an alternative branch.

?

Indicates an optional match.

Regular expression support
Additional regular expression information is provided by the Perl Compatible
Regular Expression (PCRE) library package, which is open source software, written
by Philip Hazel, and copyright by the University of Cambridge, England. The
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PCRE documentation can be found at http://regexkit.sourceforge.net/
Documentation/pcre/pcrepattern.html.
Notes
v You can use a expression that is made up of scalar functions, arithmetic
operations and variables as a source data. If you do this, make sure that each
expression evaluates to a character or string data type.
v To perform a simple format check, you can use the matches format check.
Examples
Postal Codes
v You are searching for all US postal codes in a column:
’\b[0-9]{5}(?:-[0-9]{4})?\b’

v You are searching for all Canadian postal codes in a column:
’\b[ABCEGHJKLMNPRSTVXY][0-9][A-Z] [0-9][A-Z][0-9]\b’

v You are searching for all UK postal codes in a column:
’\b[A-Z]{1,2}[0-9][A-Z0-9]? [0-9][ABD-HJLNP-UW-Z]{2}\b’

v You are searching for all US postal codes in a column that start with '02',
such as 02112, 02113, 02114, and so on:
’\b02[0-9]{3}(?:-[0-9]{4})?\b’

Phone numbers
v You are searching for phone numbers in the standard North American
format. You want to account for variations in the format such as
123-456-7890, (123)-456-7890, 123 456 7890 , 123.456.7890 and so on:
’\(?[0-9]{3}\)?[-. ]?[0-9]{3}[-. ]?[0-9]{4}’

v You want to search for phone numbers with the US area code of 212:
\(?212\)?[-. ]?[0-9]{3}[-. ]?[0-9]{4}’

IP addresses
v You want to find IP addresses that match 0.0.0.0 to 999.999.999.999:
’\b([0-9]{1,3})\.([0-9]{1,3})\.([0-9]{1,3})\.([0-9]{1,3})\b’

or
’\b(?:[0-9]{1,3}\.){3}[0-9]{1,3}\b’

v You want to verify that all values in a column have the format of an IP
address:
ipaddress matches_regex ’\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3}’

Specific words
v You are searching for a word:
’\b%word%\b’

v You are searching for words that occur more than twice in a column:
’\b(\w+)\s+\1\b’

v You are searching for pairs of words from the following list: firstword,
secondword, thirdword. You want to find the words that are separated
by at least one word, but up to five words:
’\b(firstword|secondword|thirdword)(?:\W+\w+){1,5}\W+
(firstword|secondword|thirdword)\b’

v You are searching from one of the following words: firstword,
secondword, or thirdword.
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’\b(?:firstword|secondword|thirdword)\b’

v You are searching for a word that does not begin with uppercase
characters:
’\b(a-z)+(a-z,A-Z)*\b’

Others
v Find names at the beginning of a line, which start with "Smi,":
firstnamecolumn matches_regex ’^Smi’

v Find all file names that begin with an uppercase A, followed by any
number of characters ending with ".txt":
v filenamecolumn matches_regex ’^A.*\.txt$’
v You are searching for an employee named Kristie Jones who has
accounts on various applications, in which she has used the first names
Kristie, Kristin, and Kristen as her first name:
firstname matches_regex (’Kristie’|’Kristin’|’Kristen’)[ ]’Jones’

Matches format check:
This type of check determines whether values in the source data are an exact
match to a pattern string. The pattern string explicitly defines what is acceptable in
each specific character position.
Syntax
Positive:
source-data matches_format pattern-string

Negative:
source-data not matches_format pattern-string

Description
You can use a matches format check to validate that the sequence of alphabetic and
numeric characters in your data is an exact match to a specified pattern. The
following table provides examples of operators that you can use to construct your
matches format data rule definition logic:
Table 15. Matches format check operators
Operator

Function

'A'

Indicates the character can be any uppercase
letter.

'a'

Indicates the character can be any lowercase
letter.

' 9'

Indicates the character can be any 0-9 digit.

'x'

Indicates any alphanumeric value, regardless
of casing.

Any other character in the pattern string indicates that you are explicitly looking
for the exact character you entered.
The source data must be of a character data type. When positive, it finds rows for
which the source data matches the specified pattern. When negative, it finds rows
for which the source data does not match the pattern.
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Notes
You can use a expression that can be made up of scalar functions, arithmetic
operations and variables as a source data. If you use this expression, make sure
that the expression evaluates to a character or string data type.
Examples
Verify that all US postal codes (zip codes) in your project have the standard United
States 5-digit format:
zip matches_format ’99999’

Verify that the product code follows the format of two uppercase letters, a dash,
three digits, a period, and then two more digits:
code matches_format ’AA-999.99’

Verify the conformance of a six character string to a format of three digits, any
alphanumeric character in the 4th position, and then two lowercase alpha
characters:
’999xaa’

Numeric check:
The numeric data rule definition logic checks to determine if the source data
represents a number.
Syntax
Positive:
source-data is_numeric

Negative:
source-data NOT is_numeric

Description
When positive, the numeric data rule definition check finds rows for which the
source data is a numeric data type. When negative, it finds rows for which the
source data is not a numeric data type.
Notes
v The numeric data rule definition check accepts non-formatted numbers or
numbers which are formatted in a locale specific way, such as "100,000.00." By
default the current locale is used. If the formatting of a foreign locale must be
used during the test, you can provide the name of the locale, such as 'fr' or 'de,'
as reference data. For example, "col is_numeric 'fr'" will return true for the value
"100 000,00" and "col is_numeric 'de'" will return true for the value "100.000,00."
You can find a list of ISO 639-1 code standards to validate locale codes at
http://www.loc.gov/standards/iso639-2/php/code_list.php.
v You can use a expression that is made up of scalar functions, arithmetic
operations and variables as a source data. If you do this, make sure that each
expression evaluates to a character or string data type.

Chapter 14. Creating rules for data analysis

133

Use case scenario
You work for a shipping company and you want to determine how many rows in
your unit catalog have division codes that are non-numeric.
The rule you title, "Non-Numeric division codes," is going to report back the
number of division codes in the unit catalog that are in a non-numeric format.
Build your rule definition logic as follows:
v Source Data: division_code
v Condition: NOT
v Type of Check: is_numeric
When you are done, the rule logic looks like this example:
division_code NOT is_numeric

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: division_code
– Find the table and then the column that contains rows that contain the unit
catalog division code. Highlight the column and click Set as Binding.
For this example, you do not have to perform any joins. You can select the output
that you want to see on the Output tab.
Reference column check:
The reference column definition logic validates whether the value in the source
data exists in the identified reference column.
Syntax
Positive:
source-data in_reference_column reference-column

Negative:
source-data NOT in_reference_column reference-column

Description
The reference column check can be used to ensure that a value is in a master
reference table or that the referential integrity of two tables is correct. When
positive, the reference column check finds rows for which the source data value
exists in the specified reference column. When negative, it finds rows for which the
source data value does not exist in the reference column.
Notes
v The source data and reference data must have compatible data types.
v This type of data rule definition logic performs a check against another column
(possibly from another table), and can take much longer to execute than
non-columnar checks, such as existence and containment.
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v

If you bring a rule definition or data rule into a rule set that has a reference
column check, you will need to explicitly join the tables together.

Use case scenario
You want to create a data rule called, "Shipping Location" to determine how many
rows in your master data catalog have a primary shipping location that is not
found in the location number column in the "Location" table. You would build
your rule definition logic as follows:
v Source Data: master_catalog_primary_shipping_address
v Condition: NOT
v Type of Check: in_reference_column
v Reference Data: location_number
When you are done, the rule logic looks like this example:
master_catalog_primary_shipping_address NOT in_reference_column location_number

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: master_catalog_primary_shipping_address
– Go to the Tabbed Palette and scroll over to the Data Sources tab. Find the
master catalog table, highlight shipping_address, and click Set as Binding.
v Name: location_number
– Go to the Tabbed Palette and scroll over to the Data Sources tab. Find the
table that contains the location_number data, highlight the column, and click
Set as Binding.
For this example, you would not need to perform any joins. You can select the
output that you want to see on the Output tab.
Reference list check:
The reference list rule definition logic checks the source data against a reference list
of allowed values. For example, if a column should contain only multiples of 5 that
are less than 25, then the reference list should contain 5, 10, 15, and 20.
Syntax
Positive:
source-data in_reference_list reference-list

Negative:
source-data NOT in_reference_list reference-list

Description
When positive, the reference list check finds rows for which the source data is in
the reference list. When negative, it finds rows for which the source data is not in
the reference list.
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Notes
v The source data and reference list must have compatible data types.
v For rule definition logic, you can use a expression that is made up of scalar
functions, arithmetic operations and variables as a source data. If you do this,
make sure that each expression evaluates to a character or string data type.
Use case scenario
You want to create a data rule named, "Invalid Material Type" that will help you to
determine how many records in the unit catalog do not contain one of the
following material type codes:
v FG- finished goods
v IP- intermediate product
v RM-raw materials
v RG- resale goods
Build your rule definition logic as follows:
v Source Data: material_type
v Condition: NOT
v Type of Check: in_reference_list
v Reference Data: {'FG', 'IP', 'RM', 'RG'}
When you are done, the rule logic looks like this example:
material_type NOT in_reference_list {’FG’, ’IP’, ’RM’, ’RG’}

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: material_type
– Go to the Tabbed Palette and scroll over to the Data Sources tab. Find the
table and then the column in which you want to search for the material type
data. Highlight the column and click Set as Binding.
For this example, you would not need to perform any joins. You can select the
output that you want to see on the Output tab.
Uniqueness check:
This data rule definition logic checks for unique data values. It can be used to
confirm that you do not have duplicate data values.
Syntax
Positive:
source-data UNIQUE

Negative:
source-data NOT UNIQUE
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Description
When positive, the uniqueness check finds rows for which the source data value
occurs exactly once in the table. When negative, it finds rows for which the source
data value occurs more than once in the table.
Notes
v No reference data is necessary for this type of data rule definition logic. If
reference data is present, it is ignored.
v This type of checks implies the computation of aggregations on the source
columns. These operations can take much longer to execute than other types of
checks which only have to test single records.
Use case scenario
You work for a chocolate bar retailer, and you want to make sure that all the
product codes that you have assigned to each type of chocolate bar are unique.
You want to create a data rule to verify that all the product codes in the master
catalog table are unique. If there are duplicate product codes, this rule definition
will alert you to errors that need to be fixed.
The rule definition that you name, "Unique product codes for chocolate bars," will
report the number of unique product codes in the master catalog table. Build your
data rule definition logic as follows:
v Source Data: Master_Catalog_Product_Code
v Type of Check: unique
When you are done, the data rule definition looks like this example:
Master_Catalog_Product_Code unique

Next, generate a data rule out of the data rule definition. Click the Bindings and
Output tab.
On the Bindings and Output tab, bind your rule definition components to real
data in your data sources:
v Name: MSTRCTLG_PRODCODE
– In the rule definition, the logical representation for the
MSTRCTLG_PRODCODE was written as "Master_Catalog_Product_Code,"
but now you need to find the actual MSTRCTLG_PRODCODE column in
your table. Find the table and then the column that contains rows that contain
the master catalog product code. Highlight the column and click Set as
Binding.
For this example, you do not need to perform any joins. You can select the output
that you want to see on the Output tab.

Data rule definition components
You can use the rule definition logic builder to define the data for your data rules.
You build rule definitions and data rules by using the rule logic builder. The rule
logic builder is located on the Rule Logic tab when you create a new rule
definition or when you work with an existing data rule. Each line or row in the
rule logic builder represents a condition that can be placed on the data, and
conditions are logically combined with AND and OR operators. You can use the
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parentheses option to nest up to three conditions. Each line of the rule logic
builder must contain at least source data and a type of check. Most checks also
require a reference data. If the rule logic builder contains more than one line, every
line except the last one must contain AND or OR to combine it with the next line.
The rule logic builder includes the following columns:
Condition
Specifies the conditions IF, THEN, AND, ELSE, OR, NOT to help define
your rule logic.
( (opening parenthesis)
Groups lines or conditions, to override the default order of evaluation,
which is AND followed by OR. Each opening parenthesis must correspond
to a closing parenthesis.
Source Data
Represents the value you want to test in the rule definition. This is
typically just a column reference, but it might be more complex. The value
can be a local variable, a literal, or the result of a scalar function. To enter
source data information, click in the source data box, and type your source
data in the text box that opens below the rule builder workspace. You also
can use the Tabbed Palette, located on the right side of the screen, to define
your source data. From this menu you can select your source data from the
Data Sources, Logical Variables, Terms, Reference Tables, or Functions
tabs.
Condition
Sets the conditions to NOT. The Condition option can be used to invert
the test defined in Type of Check when building your data rule.
Type of Check
Contains the type of check that the rule definition logic builder executes.
Some checks can be applied only to columns of a character data type.
The rule definitions that you create perform the following types of checks:
>

Checks whether your source value is greater than your reference
data.

>=

Checks whether your source value is greater than or equal to your
reference data.

<

Checks whether your source value is less than your reference data.

<=

Checks whether your source value is less than or equal to your
reference data.

contains
Checks your data to see if it contains part of a string. The check
returns true if the value represented by the reference data is
contained by the value represented by the source data. Both source
and reference data must be of string type.
exists

Checks your data for null values. The check returns true if the
source data is not null, and false if it is null.

=

Checks whether the source value equals the reference data.

in_reference_column
Checks to determine whether the source data value exists in the
reference data column. For this check, the source data is checked
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against every record of the reference column to see if there is at
least one occurrence of the source data.
in_reference_list
Checks to determine whether the source data is in a list of
references, for example, {'a','b','c'}. The list of values are entered
between brackets ({ }) and separated by commas. String values can
be entered by using quotations and numeric values should be in
the machine format (123456.78). A list can contain scalar functions.
is_date
Checks to determine whether the source data represents a valid
date. For this type of check, you cannot enter reference data.
is_numeric
Checks to determine whether the source data represents a number.
For this type of check, you cannot enter reference data.
matches_format
Checks whether your data matches the format that you define, for
example:
IF country=’France’ then phone matches_format ’99.99.99.99.99’

Both source and reference data must be strings.
matches_regex
Checks whether data matches a regular expression, for example:
postal_code matches_regex ’^[0-9]{5}$’

Both source and reference data must be strings.
occurs Checks to evaluate if the source value occurs as many times as
specified in the reference data in the source column. The reference
data for this check must be numeric. For example, if in the
firstname column, "John" appears 50 times and the rule logic is
written as firstname occurs <100, after you bind the column
firstname with the literal John, then records with "John" in the
firstname column meet the conditions of the rule logic. You have
the following occurrence check options:
v occurs>=
v occurs>
v occurs<=
v occurs<
unique
Checks to evaluate if the source data value occurs only one time (is
a cardinal value) in the source data.
Reference Data
Contains an expression that represents the reference data set for the data
rule definition. Reference data can be a single value, a list of values, or a
set of values against which the data rule definition compares the source
data. To enter reference data, click in the reference data box, and type your
reference data in the text box that opens below the rule builder workspace.
You also can use the Tabbed Palette menu, located on the right side of the
screen to define your source data. From this menu you can select your
source data from the Data Sources, Logical Variables, Terms, Reference
Tables, or Functions tabs. Some types of checks do not require reference
data.
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) (closing parenthesis)
Closes groupings of lines in the data rule definition. Each closing
parenthesis must correspond to an opening parenthesis.
Note: If your rule logic becomes very complex, particularly if you nest more than
three conditions, you have the option to edit your data rule definition by using the
free form editor.

Rule definition building options
You can create rule definitions in two ways. You can build your rule definitions in
a structured manner with the rule builder. The rule builder allows you to select a
variety of rule logic elements with various types of predefined components and
checks. You can also use the free form editor. The free form editor is a good tool if
you want more flexibility when building a rule definition.
Rule definitions are built with a basic logic describing what you are evaluating. For
example, the statement "DepartmentID = '300'" is a rule definition. For any given
piece of data where a department ID exists, the statement is either true or false.
You use the building options to create this rule validation.
After you create a new rule definition, you build the data rule definition logic on
the Rule Logic tab. You design the new rule definition logic with the rule builder,
by entering the rule logic that you want to create, condition by condition, in the
rule builder workspace. You build the rule logic one piece of logic at a time,
linking the lines of logic by using “and” or “or” Boolean operators in the
Condition field in the rule builder. If you want to group lines of logic to form a
single condition, you can enclose the lines of logic in parentheses.
You can use the free form rule builder by selecting Use Free Form Editor in the
bottom left of the workspace. The free form editor allows you more flexibility as
your are building your data rule. You can construct your rule logic by typing the
data rule definition logic in a free form manner.
You can switch from the rule builder and the free form builder as you are
constructing your rule definitions. You have the ability to compose the rule in the
rule builder, view the resulting expression, and then modify the expression in the
free form editor.
Note: IBM InfoSphere Information Analyzer will attempt to parse expressions from
the free form builder into the rule builder. However, not all free form expressions
can be parsed due to complexity of the logic. If the complexity becomes too great,
you must work in the free form editor.

Building data rule definitions with the rule builder
Use the rule builder to select a variety of predefined rule definition combinations
to build your rule logic.

Procedure
1. Click the Develop icon on the Navigator menu in the console, and select Data
Quality.
2. Click New Data Rule Definition or open an existing logical rule definition.
3. Click the Rule Logic tab.
4. Optional: The first field to the left of the screen is the Condition. This
condition field contains logic operation options. Choose the condition IF or
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NOT, or leave this field blank. This field is most often used to connect two
lines of logic on the rule building menu.
5. Optional: The next field is the parenthesis “(“ icon. This is a logical operation
feature for compound logic, and is used for nested conditional statements.
Select (, ((, or ((( for the next sequence in the creation of your rule definition,
or leave this field blank if you do not need to create nested conditional
statements.
6. Selecting your source data is the next part of the sequence. Go to the Source
Data field, and either type a name for your local variables in this field, or go
to the Tabbed Palette menu on the right side of the screen. From this menu
you can select your source data from the Data Sources, Global Logical
Variables, Terms, or Functions tabs. Note: You can select both a data source
and a function from the Tabbed Palette menu for the Source Data field. For
example, you can select the column "Salary" from one of your data sources
and the function "AVG(value)" as a combined value for your Source Data
field. Type "salary" to override the "value" default value so the expression
reads "AVG(salary)." The Source Data value would become the average value
of the "Salary" column. You can build rule logic by using the Tabbed Palette as
shown in the following figure:

Figure 4. Building a data rule definition by using the Tabbed Palette
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7. Optional: The next icon is another Condition menu. This condition option is
for inverse rule logic. Select the “NOT” option to create a rule definition that
sets a negative condition, or leave this field blank.
8. Type of Check is the next building option. The Type of Check options
include equals, contains, exists, and is_numeric. Choose the type of check that
you want to use for this rule logic.
9. Type the Reference Data that you want to use in the Reference Data field. You
can also go to the Tabbed Palette menu in the right side of the screen. From
this screen select an entry for this field from the Data Sources, Global Logical
Variables, Terms, or Functions tabs.
10. Optional: Click the second Parenthesis tab to close any open parenthesis or
leave this field blank.
11. You can continue to build new rule logic in each row in the interface. Go to
the next line on the rule logic builder screen, and select AND, ELSE, OR,
THEN, or, NOT in the Condition field.
12. Select Save or Save and Close. The list of data rule definitions, rule set
definitions, data rules, metrics and monitors is displayed. The data rule
definition that you created is added to the folder you were working in.

Creating a rule definition with the free form editor
Use the free form editor to quickly create rule logic manually.

About this task
IBM InfoSphere Information Analyzer allows you to create rule definitions with the
free form editor. The free form editor allows experienced users to quickly create
rule logic manually.

Procedure
1. Click the Develop icon on the Navigator menu in the console, and select Data
Quality.
2. Click New Data Rule Definition from the Tasks menu on the right side of the
workspace.
3. Click the Rule Logic tab.
4. Click the Use Free Form Editor check box to enable the free form editor. The
free form editor replaces the rule building component.
5. Type the rule logic that you want to create.
6. Click the Save button and then click Close. The list of rule definitions, rule set
definitions, data rules, metrics, and monitors are displayed.
Syntax for the free form editor:
Create data rule definitions by using appropriate syntax in the free form editor.
Purpose
Use the syntax below to build data rule definitions with the free form editor.
Parameters
The following table provides the syntax to use when you are building rule logic
with the free form editor:
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Table 16. Syntax to use when working with the free form editor
Concept

Syntax

Example

Boolean keywords

AND, OR (the syntax is not
case sensitive)

value >0 AND value<100

Boolean grouping

()

(valueA=0) and (valueB=0 or
valueC=0)

Conditional keywords

IF, THEN, ELSE (the syntax
is not case sensitive)

IF age<18 THEN
status='child'

Variables

Variable names can be made
up of letters, unicode
characters belonging to the
Letter category, digits, ‘_'
(underscores), '?' (question
marks), or ‘$'(dollar signs).
The first character must be a
letter. Periods or spaces are
not allowed.

age>0 AND client_ID exists

Numeric constants

col>10 and col<12343.35
Numeric constants must
consist of the numeric
characters 0-9. No quotation
marks, decimal separators, or
fraction separators are
allowed. Numeric constants
are in the machine format
(12345.789) and are not in the
locale specific format.

String constants

All string constants must
have single quotations
around them when declared,
for example 'value'. If the
value itself contains single
quotes, you must put a
backslash before the
quotations. The backslash
itself is escaped with a
double backslash.

value<>'xyz' AND
value<>'John\'s idea' AND
col<>'C:\\docs'

Date or time constants

Functions dateValue(),
timeValue(), and
timestampValue() must be
use to hard code a time,
date, or timestamp in an
expression.

time>timeValue('08:45:00') ,
date>dateValue('2008-31-12'),
timestamp>timestampValue
('2008-31-12 08:45:00')

Lists

You can specify a comma
separated list of values
within a {} (braces) group.

{'a','b','c'} {1.54, 2.32, 34.12}

Arithmetic operators

+ (plus sign for addition), / (valueA+valueB)/2 =
(forward slash for division), - (valueC-valueD)*(valueE)
(minus sign for subtraction) *
(asterisk for multiplication.
Use parentheses to group
arithmetic operations.
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Table 16. Syntax to use when working with the free form editor (continued)
Concept

Syntax

Example

Scalar function

Specify the function name,
and then the parameters for
that function in parenthesis,
for example,
"function_name(parameter1,
parameter2)."

ltrim(upper(col))='ABC'

Supported functions: date (),
datevalue (string,format),
day (date), month(date),
weekday(date), year(date),
time(),
timevalue(string,format),
timestampvalue
(value,format), timestamp(),
hours(time), minute(time),
seconds(time), datediff(date1,
date2), timediff (time1,
time2), abs(value),
avg(value), exp(value),
max(value), min(value),
sqrt(value),
standardize(col,group),
stddev(col, group),
sum(value), coalesce (value,
nullValueReplacement),
lookup (value, keyRefCol,
valRefCol), ascii(char),
char(asciiCode),
convert(originalString,
searchFor, replaceWith),
count(column), lcase(string),
index(string, substring),
left(string, n), len(string),
ltrim(string), pad(string,
begin, end), lpad(string, n),
rpad(string, n), right(string,
n), rtrim(string),
substring(string, begin,
length), str(string, n),
tostring(value, format string),
trim(string), ucase(string),
val(value),
Comments

# (number sign) comment,
\\(double backslash)
comment or \* (back slash
and an asterisk) comment *\
(asterisk and a back slash)

# Test the value below the
limit col<$limit
//default=100 or \* end of
test *\

Data check types
You can use the following types of data checks with the free form editor:
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>

Checks to see if your source value is greater than your reference
data.

>=

Checks to see if your source value is greater than or equal to your
reference data.

<

Checks to see if your source value is less than your reference data.

<=

Checks to see if your source value is less than or equal to your
reference data.

contains
Checks your data to see if contains part of a string. The check
returns true if the value represented by the reference data is
contained by the value represented by the source data. Both source
and reference data must be of string type.
exists

Checks your data for null values. The check returns true if the
source data is not null, and false if it is null.

=

Checks to see if the source value equals the reference data.

in_reference_column
Checks to determine if the source data value exists in the reference
data column. For this check, the source data is checked against
every record of the reference column to see if there is at least one
occurrence of the source data.
in_reference_list
Checks to determine if the source data is in a list of references, for
example, {'a','b','c'}. The list of values are entered between brackets
({ }) and separated by commas. String values can be entered by
using quotations and numeric values should be in the machine
format (123456.78). A list can contain scalar functions.
is_date
Checks to determine if the source data represents a valid date. For
this type of check you cannot enter reference data.
is_numeric
Checks to determine if the source data represents a number. For
this type of check you cannot enter reference data.
matches_format
Checks to make sure your data matches the format that you define,
for example:
IF country=’France’ then phone matches_format ’99.99.99.99.99’

Both source and reference data must be strings.
matches_regex
Checks to see if your data matches a regular expression, for
example:
postal_code matches_regex ’^[0-9]{5}$’

Both source and reference data must be strings.
occurs Checks to evaluate if the source value occurs as many times as
specified in the reference data in the source column. The reference
data for this check must be numeric. For example, if in the
firstname column, "John" appears 50 times and the rule logic is
written as firstname occurs <100, after you bind the column
firstname with the literal John, then records with "John" in the
firstname column meet the conditions of the rule logic. You have
the following occurrence check options:
v occurs>=
v occurs>
Chapter 14. Creating rules for data analysis

145

v occurs<=
v occurs<
unique
Checks to evaluate if the source data value occurs only one time (is
a cardinal value) in the source data.

Creating rule logic by using tools in the Tabbed Palette
When you create rule definitions and data rules, you have the option to use the
Tabbed Palette, in the right side of the data rule workspace, to assist you with
defining your physical data sources.
When you build data rule definitions, you can either type in logical names for
elements in your data rule definition or use the tabbed palette to select data
descriptions for your data rule definition. If you select a column from the
Implemented Data Resources, Physical Data Models, or Logical Data Models tab,
you can create a rule variable with the same name as the column from the data
source, and the column becomes the default binding (the design binding) for the
variable. When you create a rule from this rule definition, the binding panel is
automatically populated with the design binding. During the binding step you can
reference the design binding to assist in the selection of the implemented binding
that designates the data to be evaluated at execution time.
If you select a global variable from the Global Variable tab, you can create a rule
variable by using the same name as the global variable, and this becomes a design
binding for this variable. When a rule variable is bound to a global variable, the
value of the global variable is used in place of the rule variable at execution time.
If you select a term from the Term tab, then you are simply referencing a standard
business description as populated through IBM InfoSphere Business Glossary. This
does not create an explicit link to the term, but does help you standardize the
language of your rule definition. You can also select a function from the Function
tab.
The bindings that you create between your data rule definition components and
actual tables or functions by using the Tabbed Palette will be carried into your data
rules.
When you create rule definitions and data rules, you can choose from the
following options to define your data:
Global Logical Variables
A global logical variable is a representative value that you can set to
represent a fact or a specific piece of data. You can create global variables
to hold values or parameters which are valid system wide, such as
currency exchange rates, a credit rate, or any other value used by a
company. You can create a global logical variable for one rule definition,
and then reuse it in all your rule definitions and data rules. Before a rule
definition can be used, all global logical variables must be “bound” to a
concrete concept, such as a physical source column, a defined constant, or
other such physical representation, along with all of the other rule
variables in the rule definition. When you specify a global logical variable
when you are building your data rule definition, the global logical variable
becomes a default binding when you generate a data rule.
Functions
Data rule functions can be used to perform specific operations when you
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build rule definitions and data rules. Functions are populated in the
Source Data or Reference Data fields in the data rule logic builder. Select
the functions that you want to use to perform a particular action on your
data such as COUNT , SUM, or AVG(value). You can choose from the
functions listed under the Functions tab.
Implemented Data Resources
Click the Implemented Data Resources tab in the Tabbed Palette to define
a default binding to specific columns in the tables of data sources in your
project when you build data rule logic. Defining data sources is useful
when you have an idea of how you want your rule logic to work, and you
have particular data in mind. By using the Implemented Data Resources
tab, you are creating a shortcut to the data source by creating a rule
variable with the same name that has a predefined default binding. After
you create your rule definition and you generate a data rule out of the rule
definition, you can either keep or change this binding. You can use the
search box in the top part of the workspace to help you search for
particular data sources.
Physical Data Models
Physical data models can be created in Publish Analysis Results pane. You
generate a physical model by clicking Generate physical model and then
specifying the required options. The generated physical model can be
viewed in the list in the Physical Data Models tab.
Click the Physical Data Models tab in the palette to define a default
binding to specific columns in the tables of physical data models when you
build data rule logic.
The Usage tab of the data rule definition shows the combined hierarchy of
Physical Data Model, Logical Data Model, and Implemented Data
Resources variables which are involved in creation of the data rule
definition.
You can add new table names in the Customization Name pane. Note that
names must be unique. When a new table name is added, you can view
the new table names by clicking the Preview button.
Logical Data Models
Click the Logical Data Models tab in the Tabbed Palette to define a default
binding to specific columns in the tables of logical data models when you
build data rule logic.
Terms InfoSphere Business Glossary terms are business definitions that becomes a
part of the IBM InfoSphere Business Glossary vocabulary and classification
system. Use the Terms tab in the Tabbed Palette to define a default binding
to specific InfoSphere Business Glossary term. Terms can only be viewed
by users who have InfoSphere Business Glossary Author or User roles.

Creating a copy of a rule definition, rule set definition, or
metric
You can create copies of rule definitions, rule set definitions, and metrics in your
projects.

About this task
You can create copies of data rule definitions, and rule set definitions both locally
and from published data quality components. You can also create local copies of
metrics. You must have the "Rules Author" role to make copies of data rule
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definitions, rule set definitions, and metrics.

Procedure
1. Highlight the data rule definition, rule set definition, or metric that you want to
copy.
Note: You can create copies of multiple data rule definitions, rule set
definitions, or metrics at the same time by highlighting each component that
you want to copy.
2. Click Create a Copy in the tasks panel.
Note: To create a copy of a published rule definition or published rule set
definition in the Published Rules folder, you can either click Create a Copy or
click Generate Data Rule or Rule Set in the tasks menu.
3. Click OK in the Create a Copy window.

What to do next
You can modify the copy of the data rule definition, rule set definition, or metric,
or you can start rule analysis with the copy. To rename the data rule definition,
rule set definition, or metric open up the rule or metric and then modify the name
in the Name field. When you are finished click Save.

Publishing data rule definitions and rule set definitions within
a project or from the shared library
You can publish data rule definitions or rule set definitions in your local projects to
make them available to other users who do not have access to the project. When a
rule definition or rule set definition is published, a copy of the rule is created in
the public area, which is visible by all projects.

About this task
Publish data rule definitions or rule set definitions to make them available to other
users for all projects. The other users in the project must have Rules Author roles
assigned to them in order for them to access the published data rule definitions or
rule set definitions.
When you start working with rule definitions or rule set definitions, you create
rules that are local to the project that you are working in. If the rules need to be
shared with other projects, you can publish them by using the steps below. When a
rule definition or rule set definition is published, a copy of that rule definition or
rule set definition is created in the Published Rules folder in the data quality
workspace, and then it is available to all the other projects.
Note: Published rule definitions and rule set definitions are copies of the local
rules. When the local rules and rule set definitions are modified, there is no impact
on the published rule and rule set definitions. Also, when the published rule and
rule set definitions are modified, there is no impact on the local rule and rule set
definitions.

Procedure
1. Select the data rule definition or rule set definition that you want to publish.
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Note: You can publish multiple data rule definitions or rule set definitions by
highlighting each data rule definition or rule set definition that you want to
publish.
2. Click Publish in the tasks panel.
3. Click OK when prompted by the Publish dialog box.

What to do next
You can view the published data rule definition or rule set definition in the
Published Rules folder. The published data rule definition or rule set definition
has the same name that it had in your local Data Quality workspace unless
another published rule has the same name.

Data rules
After you create your rule definition logic, you generate data rules to apply the
rule definition logic to the physical data in your project.
You can generate data rules after you create rule definitions that are defined with
valid rule logic. After you create your rule logic, you can apply the logic to
physical data in your project. After you generate data rules, you can save them,
and re-run them in your project. They can be organized in the various folders
listed on the Data Quality tab in your project. The process of creating a data rule
definition and generating it in to a data rule is shown in the following figure:
rule definition

rule logic
department exists
and does not equal ' '

data rule

source bindings
department=UNITCTLG.CDP

logic and bindings
UNITCTLG.CDP exists
and does not equal ' '

statistic & output
# records that meet conditions
# records that do not meet
conditions

Figure 5. Process of creating and running a data rule

When you create a data rule, you turn rule definitions into data rules, and bind the
logical representations that you create with data in the data sources defined for
your project. Data rules are objects that you run to produce specific output. For
example, you might have the following rule definition:
fname = value

The rule definition defines the rule logic that you will use when building your
data rule. When you create your data rule from this logic, you might have the
following data rule:
firstname = ’Jerry’

In the example, the "fname" entry is bound to "firstname," a column in your
customer information table. "Jerry" is the actual first name you are searching for.
After you create your data rule, you can reuse your rule definition to search for
another customer's first name by creating a new data rule. Another data rule you
can create out of the rule definition example is:
firstname = ’John’

You can reuse your rule logic multiple times by generating new data rules.
You can generate a data rule in the following ways:
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v By clicking a rule definition in the Data Quality workspace and selecting
Generate Data Rule from the Tasks menu.
v By opening a rule definition, and clicking Test in the lower right corner of the
screen. Follow the Steps to Complete list in the left corner of the screen to run
the test successfully. When you are done with the test, click View Test Results.
After viewing the test results, you can save the test as a data rule. This means
that all the bindings you set when you were running the test become a data
rule. Creating the data rule here will create a copy of the test results as the first
execution of the data rule.

Generating a data rule from a rule definition
After you create rule definition logic, you can create a data rule to analyze real
data in your projects.

Procedure
1. From the Develop icon on the Navigator menu, select Data Quality.
2. Highlight the rule definition that you want to generate a data rule from.
3. In the Tasks menu on the right side of the screen, click Generate Data Rule or
Rule Set.
4. On the Overview tab, type a name for the data rule. The name must contain at
least one character and cannot contain the slash (\) character. The name must
be unique in your project.
5. Optional: Type a short description and long description of your data rule. The
Created By, Created On, and Last Modified fields are automatically populated
after you create and save your data rule. You can optionally provide
information into the Owner and Data Steward fields.
6. Decide if you would like to set a validity benchmark for your data rule.
Benchmarks quantify the quality of your data, as well as monitor your data.
Click the Monitor Records Flagged by One or More Rules check box in the
Validity Benchmark box, if you would like to monitor records that are marked
for other rules in your project.
7. At the top of the workspace, switch from the Overview tab to the Bindings
and Output tab.
8. Click Save to create the data rule.

What to do next
At this point you have saved details about the data rule, but you have not set any
of the functionality. Click the Bindings and Output and set the bindings, join keys,
and output for your data rule.

Setting the bindings for a data rule
When you set bindings for a data rule, you connect each local variable used in the
rule logic to an implemented data resource, global variable, or literal value.

About this task
When you set the bindings for a data rule, you create a direct relationship between
a logical element in your rule definition, such as "fname", and an actual column in
one of your data source tables, such as the "first_name" column in your employee
first name table. Instead of referring to a conceptual first name, for example, you
are defining what table you want the first name data to come out of, and you are
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binding that element so that whenever you run the data rule that you create, the
data rule always extracts the first name from the specific table that you created a
binding for.
To set the bindings for a data rule, you must first open an existing data rule, or
create a new data rule. You can create a new data rule by either highlighting an
existing rule definition and clicking Generate a Data Rule, or by running a test on
an existing rule definition, going to view output, and then clicking Save as a Data
Rule. If you generate a data rule from the test results, then the bindings that you
specified for the test are saved. If you generated a data rule from a rule definition,
then you must bind physical data sources to the data rule by using the following
steps. If you want to modify the bindings that you set when you generated a data
rule from the test results page, you can use the following steps below after you
open the data rule so that you can edit it.

Procedure
1. From the Data Quality workspace, open the data rule that you want to set the
bindings for or click Generate a Data Rule or Rule Set. If you click Generate a
Data Rule or Rule Set, then specify a name for the data rule.
2. From the Overview and Binding and Output tabs at the top of the screen, click
the Bindings and Output tab.
3. Click Bindings in the Select View menu on the left side of the screen. Each
logical variable that is a part of your data rule is displayed with the following
elements:
Name The name of the logical variable that is part of your data rule.
Rule Definition
The name of the rule definition that you are working with.
Data Type
The data type of the logical variable.
Design Binding
The implemented data resource, global variable, or literal that the local
variable is bound to. The design binding is the default binding of the
rule variable. The design binding name is determined by the object you
add from the tabbed palettes to the source or reference data cells when
creating the rule logic. If you hand-type the variable Col into the cell,
there would be no design binding. Hand-typed rule variables will not
have design bindings.
The design binding name is determined by the object you add from the
tabbed palettes to the source or reference data cells when creating the
rule logic. If you hand-type the variable Col into the cell, there would
be no design binding. Hand-typed rule variables will not have design
bindings
Implemented Binding
The column that is bound. You select an implemented binding from the
list based on the design binding.
4. In the Rule Elements box, click the Binding box for the data rule element that
you are working with. With the box you are working with still highlighted,
move your cursor over to the Tabbed Palette in the right side of the screen.
Select one of the following tabs: Implemented Data Resources, Global Logical
Variables, or Literal.
5. Click Discover Bindings to identify potential matches based on the Physical
Model definition.
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6. After you select a tab that contains the data you want to work with, click the
data that you want to bind to your data rule element. Then click Set as
Binding. You can also double-click the data source that you want to bind your
data rule element to, and automatically set your bindings.
7. When you finish setting the bindings, click Save or Save and Close in the
lower right corner of the screen.

Example
For example, you have a rule definition for social security number validation
named Validate_SSN. You want to bind the column Col to the Physical Column
SSN. This is what you would have in the rule definition:
Table 17. Defining the Implemented Binding for this example
Name

Rule Logic

Data Type

Design Binding

Validate_SSN

SSN
matches_format
'999-99-9999'

String

SSN

Implemented
Binding
From the
Implemented
Binding list, you
find that the
Physical Column
has been
implemented by
a set of
implemented
data resources:
v Table1.SSN
v Table2.Social
Security
Number
v Table3.SSS_
Code
For this
example, you
select
Table2.Social
Security
Number to
validate social
security
numbers.

In this example, the Design Binding is SSN. The Implemented Bindings include a
list of all those implementation models that implement the Design Binding SSN,
which are Table1.SSN, Table2.SocialSecurityNumber, and Table3.SSS_CODE.

What to do next
Now you can add information to the Join Keys or the Output screens that you can
access from the Select View menu on the left side of the screen.

Setting the join keys elements for a data rule
When you set the bindings and output for a data rule, you create a direct link
between a conceptual element in a rule definition, and a physical piece of data in
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one of your data sources. If you want to use data from more than one table, then
you need to set join key elements as part of the binding process.

About this task
When you create a data rule and want to use physical data that is located in two
or more separate tables, or you need to set up output columns that are from more
than one table, then you need to set up join key conditions to join the tables.
To set the join key elements for a data rule, open an existing data rule or create a
data rule. You can create a data rule either by highlighting an existing rule
definition and clicking Generate a Data Rule, or by running a test on an existing
rule definition, clicking View Output, and then clicking Save as a Data Rule.

Procedure
1. Open the data rule you want to set the join key elements for from the Data
Quality workspace.
2. Find the Overview and Binding And Output tabs on the top of the screen, and
click on the Binding and Output tab.
3. In the Select View menu on the left side of the screen, click on Bindings and
fill out the appropriate information in the Rule Logic Variables box to bind
your data rule to the appropriate physical data elements.
4. In the Select View menu, click Join Keys. The Join Keys workspace displays a
Tables Requiring Joins table that shows the tables that you need to join.
5. Use the Tabbed Palette on the right side of the screen to define Key 1 and Key
2. Click the Data Sources tab and select a key from a specific table in your data
sources. Select the Show tables from Bindings Only box if you want to select
only keys from tables that you set in your binding settings. You can search
your volumes of tables by using the search box on top of the Data Sources tab.
Use the arrows to the right of the search box to jump to the next piece of data
that matches your search criteria.
6. Specify the join type by selecting from the Include Records menu.
7. Optional: Validate the join settings by clicking the Validate button, and running
the data rule with the new join settings by clicking Run. You can view the
output of the data rule by clicking View Output.
8. Click Saveto save your current settings or click Save and Close if you have
finished working with this data rule.

What to do next
Now you can add information to the Output screen by clicking the Output item
from the Select View menu on the left side of the screen.
Note: If your rule logic does not span multiple tables, you do not have to use a
join key. Also, if you bring a rule definition or data rule into a rule set that has a
reference column check (in_reference_column), you will need to explicitly join the
tables together.

Setting the output specifications for a data rule
You can specify the output that you want to see from particular columns in the
output tables produced when you executed a data rule. The columns of the output
table can contain the value of rule variables, the value of physical columns,
metrics, statistics, and expressions made up of functions or arithmetic operations.
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About this task
To set the specific output for a data rule, open an existing data rule or create a
data rule. You can create a data rule either by highlighting an existing rule
definition and clicking Generate a Data Rule, or by running a test on an existing
rule definition, clicking view output, and then clicking Save as a Data Rule. If you
generate a data rule from the test results, then the bindings you specified for the
test will be saved.

Procedure
1. Open the data rule that you want to set the output elements for from the Data
Quality workspace by double-clicking the data rule.
2. Click the Bindings and Output tab.
3. Click Output in the Select View menu on the left side of the screen, and
select the output records you want to display in your output from the Output
Records menu.

4.

5.

6.

7.

Note: The default output type is Do not meet rule conditions. If you select
Statistics Only, then no output details records are created.
Optional: Highlight any rule logic variables you want to include in your
output on the Rule Logic Variables tab on the right side of the screen and
click Add to Selected. Note: The rule logic variables will show up by default
in the output workspace. You can remove any of the rule logic variables, by
highlighting the variable, and clicking Remove.
Optional: Select any additional columns you want to show in your output on
the Data Sources tab on the right side of the screen. You can select individual
columns or the entire table by highlighting the data sources you want to add
and clicking Add to Selected. To add a column from a table that is not part of
your bindings or join keys for your rule logic variables, ensure that the Show
items from bindings and join keys only box is not checked. This feature
allows you to be very selective about the data you want to display in your
output. For example, you can choose to add all the columns in a particular
table to your output, or select just one or two.
Optional: Click the Expressions tab if you want to add an expression you
created to the data rule or rule set. Highlight the expressions and click Add to
Selected.
Optional: Click the Statistics and Attributes tab and select any additional
attributes or statistics that you want to display in your output. For example,
you can select System Timestamp if you want information about the time the
data rule was run.

8. Optional: Click Add Custom Expression at the bottom of the Selected
Columns section to add a new expression to your output. For example, you
could create a rule to calculate that a checking balance added to a savings
balance is equal to the total account balance. CHECKING + SAVINGS =
TOTAL_BALANCE When you define the output columns of a rule, you can choose
to include the checking column, savings column, and total_balance columns.
You can now also include the expected total_balance by adding the expression
CHECKING + SAVINGS as an output column. This will allow you to see both the
TOTAL_BALANCE value as well as the expected total value as calculated by
adding the checking and savings values together.
a. Create your new expression in the Create New Expression section by
typing out the expression or by highlighting functions and rule logical
variables in the Tabbed Palette section and clicking Add to Expression.
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b. Click OK when you are finished creating your expression.
c. Optional: Click Edit to make changes to the expression after you add it to
your output specifications.
9. Go to the Output workspace and click the Move Up or Move Down buttons
to move your columns into the order that you want.
10. Click Save in the bottom right corner of the screen when you finish specifying
your output.
11. Optional: As you are putting together your output, you have the option to
open your rule definition, validate the output selections you have so far, or
view the output of the data rule by selecting Open Definition, Run, View
Output, or Validate.

What to do next
You can view the output of a specific data rule that you have executed by
highlighting the rule in the Data Quality workspace and clicking View Output in
the Tasks menu. You must run a data rule before you can see any rule output.

Function definitions and use case scenarios
You can use data rule functions to perform specific operations when you build
data rule definitions and working with data rules.
Functions are populated in the Source Data or Reference Data fields in the data
rule logic builder. Select the functions you want to use to perform a particular
action with your data such as COUNT, SUM, or AVG(value). You can choose from
the functions listed under the Functions tab. Below are detailed definitions and use
case scenarios for all of the available functions.
Note: Where applicable, the examples in the function scenarios are based on data
rule definitions. Each data rule definition source data or reference data component
needs to be bound to a physical database-table-column to create a data rule.

Date and time functions
You can use date and time functions to manipulate temporal data.
date () Definition: Returns the system date from the computer as a date value.
Use case scenario 1: You want to find order dates that are no older than
365 days, but not beyond today's date.
Example 1: dateCol > date()-365 and dateCol < date()
Use case scenario 2: You want to find all the sales activity that has
occurred in the last week.
Example 2: IF ( date_of_sale > date() - 7days ) )
datevalue (string,format)
Definition: Converts the string representation of a date into a date value.
string The string value to be converted into a date.
format
The optional format string describing how the date is represented
in the string.
%dd

Represents the two-digit day (01 – 31)
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%mm Represents the two-digit month (01 – 12)
%mmm
Represents the three-character month abbreviation (For example,
Jan, Feb, Mar)
%yy

Represents the two-digit year (00 – 99)

%yyyy
Represents the four-digit year (nn00 – nn99)
If a format is not specified, the function assumes (%yyyy-%mm-%dd) as
the default format.
Note: You can use this function to convert a string, which represents date,
into its literal date value as part of your data rule.
Use case scenario 1: You want to check that the date value in a column,
which is coded as a string, is not older than 365 days from now.
Example 1: datevalue(billing_date,'%yyyy%mm%dd') > date()-365
Use case scenario 2: You want to check that all dates in your project are
older than 01/01/2000.
Example 2: billing_date > datevalue('2000-01-01')
day (date)
Definition: Returns a number that represents the day of the month for a
date that you specify.
Use case scenario: You are interested in orders placed on the first day of
the month.
Example: day(sales_order_date) =1
month (date)
Definition: Returns a number that represents the month for a date that
you specify.
Use case scenario: You want to ensure that the month of the billing date is
a valid date.
Example 1: month(billing_date) >= 1 and month(billing_date) <= 12
Example 2: If month(billing_date) = 2 then day(billing_date) >= 1 and
day(billing_date) <= 29
weekday (date)
Definition: Returns a number that represents the day of the week for a
specified date, starting with 1 for Sunday.
Use case scenario: You expect sales orders on Sunday to be below 1000
entries, so you want to run a function that checks to make sure orders on
Sunday are below 1000 entries.
Example: If weekday(sales_order_date) = 1 then count(sales_order_id) <
1000
year (date)
Definition: Returns a number that represents the year for a date that you
specify.
Use case scenario: You want to collect a focus group of customers that
were born between 1950 and 1955.
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Example: year(date_of_birth)> 1950 AND year(date_of_birth) < 1955
time () Definition: Returns the system time (current time) from the computer as a
time value.
Use case scenario: You want to find all the sales transactions that have
occurred within the last four hours.
Example: IF ( time_of_sale > time() - 4hours )
timevalue (string,format)
Definition: Converts the string representation of a time into a time value.
string The string value to be converted into a time value.
format
The optional format string that describes how the time is
represented in the string.
%hh

Represents the two-digit hours (00 – 23)

%nn

Represents the two-digit minutes (00 – 59)

%ss

Represents the two-digit seconds (00 – 59)

%ss.n Represents the two-digit milliseconds (00 – 59) where n = fractional
digits (0 – 6)
If a format is not specified, the function assumes (%hh:%nn:%ss) as the
default format.
Note: You can use this function to convert a string, which represents time,
into its literal time value as part of your data rule.
Use case scenario: You want to make sure that the check-in time for guests
at a hotel is set to a time later than 11 a.m.
Example: checkin_time>timevalue('11:00:00')
timestampvalue (value,format)
Definition: Converts the string representation of a time into a timestamp
value.
string The string value to be converted into a timestamp value.
format
The optional format string describing how the timestamp is
represented in the string.
%dd

Represents the two-digit day (01 – 31)

%mm Represents the two-digit month (01 – 12)
%mmm
Represents the three-character month abbreviation (For example,
Jan, Feb, Mar)
%yy

Represents the two-digit year (00 – 99)

%yyyy
Represents a four-digit year (nn00 – nn99)
%hh

Represents the two-digit hours (00 – 23)

%nn

Represents the two-digit minutes (00 – 59)

%ss

Represents the two-digit seconds (00 – 59)
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%ss.n Represents the two-digit milliseconds (00 – 59) where n = fractional
digits (0 – 6)
If a format is not specified, the function assumes (%yyyy-%mm-%dd
%hh:%nn:%ss) as the default format.
Use case scenario: Your sales reports use a non-standard timestamp for the
order time. You need to find all the sales prior to a specific time.
Example: timestampvalue(timestamp_of_sale, '%yyyy %mm %dd %hh %nn
%ss') < timestampvalue('2009-01-01 00:00:00', '%yyyy-%mm-%dd
%hh:%nn:%ss')
timestamp()
Definition: Returns the system time (current time) from the computer as a
timestamp value.
Use case scenario: You want to ensure that no orders have a future order
date.
Example: order_timestamp < timestamp()
hours(time)
Definition: Returns a number that represents the hours for the time value
that you specify.
Use case scenario: You want to validate that the sale occurred between
midnight and noon.
Example: 0 < hours(sales_time) AND hours(sales_time) < 12
minutes(time)
Definition: Returns a number that represents the minutes for the time
value that you specify.
Use case scenario: You want to validate that the sale occurred in the first
fifteen minutes of any hour.
Example: 0 < minutes(sales_time) AND minutes(sales_time) < 15
seconds(time)
Definition: Returns a number that represents the seconds and milliseconds
for the time value that you specified.
Use case scenario: You want to validate that a sale occurred in the last
thirty seconds of any minute.
Example: 30 < seconds(sales_time) AND seconds(sales_time) < 60
datediff(date1, date2)
Definition: Returns the number of days between two dates. Date1 is the
most recent date of the two dates. Date2 is the later of the two dates.
Use case scenario: You want to determine the number of days between the
billing date and the payment date.
Example: datediff(pay_date,bill_date)
timediff (time1, time2)
Definition: Returns the number of hours, minutes, and seconds difference
between two times. Time1 is the earliest of the two times. Time2 is the later
of the two times. The returned value is a time value.
Use case scenario: You want to determine the amount of time between the
start of a task and its completion.
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Example: timediff(end_time, start_time,)

Mathematical functions
Mathematical functions return values for mathematical calculations.
abs(value)
Definition: Returns the absolute value of a numeric value (For example
ABS(-13) would return 13).
Use case scenario 1: You want to return the absolute value of the sales
price to make sure that the difference between two prices is less than $100.
Example 1: abs(price1-price2)<100
Use case scenario 2: You want to find all the stocks that changed more
than $10 in price.
Example 2: abs(price1-price2) > 10
avg(value)
Definition: An aggregate function that returns the average of all values
within a numeric column.
Use case scenario: You want to determine the average hourly pay rate for
employees in a division.
Example: avg(hrly_pay_rate)
exp(value)
Definition: Returns the exponential value of a numeric value.
Use case scenario: You want to determine the exponential value of a
numeric value as part of an equation.
Example: exp(numeric_variable)
max(value)
Definition: An aggregate function that returns the maximum value found
in a numeric column.
Use case scenario: You want to determine the highest hourly pay rate for
an employee in a division.
Example: max(hrly_pay_rate)
min(value)
Definition: An aggregate function that returns the minimum value found
in a numeric column.
Use case scenario: You want to determine the lowest hourly pay rate for
an employee in a division.
Example: min(hrly_pay_rate)
sqrt(value)
Definition: Returns the square root of a numeric value.
Use case scenario: You want to determine the square root of a numeric
value as part of an equation.
Example: sqrt(numeric_variable)
standardize(col,group)
Definition: Transforms a numerical value into a number of standard
deviation above or under the average value of the column. You can use the
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standardize(col,group) function as a simpler alternative to using this
function: (col-avg(col, group))/stddev(col, group). The function normalizes
a numerical value based on the mean value and standard deviation of the
column.
Note: The second parameter is optional, and can be used for specifying a
grouping key.
Use case scenario 1: You want to review how many employees at your
company have salaries that deviate from the company average. The
outliers are defined to be the values which are above the average value
plus three times the standard deviation.
Example 1: standardize(salary) < 3
Use case scenario 2: You want to identify all the same outliers described in
use case scenario 1, but you want to account for the male and female
populations separately.
Example 2: standardize(salary, gender) < 3
stddev(col,group)
Definition: An aggregate function that computes the standard deviation of
a numerical column.
Note: The second parameter is optional, and can be used for specifying a
grouping key.
Use case scenario 1: You want to review how many employees at your
company have salaries that deviate from the company average. The
outliers are defined to be the values which are above the average value
plus three times the standard deviation
Example 1: salary < avg(salary)+3*stddev(salary)
Use case scenario 2: You want to identify all the same outliers described in
use case scenario 1, but you want to account for the male and female
populations separately.
Example 2: salary < avg(salary, gender)+3*stddev(salary,gender)
sum(value, sum)
Definition: An aggregate function that returns the sum of all the values
within a numeric column.
Note: The second parameter is optional, and can be used for computing
the sum of the subgroups.
Use case scenario: You want to determine the total sales amount for a
store.
Example: sum(sales_amount)

General functions
You can use this group of functions to perform a variety of tasks on values in your
tables.
coalesce(value, nullValueReplacement)
Definition: Searches for null values, and then replaces any null values
found with another value.
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Use case scenario: You want to search a column that contains department
code numbers to see if any of the code numbers are undefined. If there are
any null values, you want to replace the null value fields with the text
'undefined.'
Example: coalesce(code, 'undefined'). All values that are null will be
replaced with the text 'undefined.'
count(column)
Definition: An aggregate function that provides a count of the occurrences
of a given column.
Use case scenario: You want to provide a frequency count by a customer
US postal code (zip code).
Example: count(customer_ZIP)
count(col,groupBy)
Definition: An aggregate function that returns the number of rows/values
in each group of rows defined by the column groupBy.
Use case scenario: You want to determine the number of employees in
each department of a company.
Example: count(employeeID,departmentID)
lookup(value, keyRefCol, valRefCol)
Definition: Performs a replacement of a value with its corresponding value
in a lookup table. To run this function, there must be a lookup table that
contains a list of the values with a corresponding column that contains
data related to the first column. For example, if the original value you are
looking for is contained in a column containing keys, such as product
codes, then the related lookup table contains one column listing all the
possible key values and another column containing the corresponding
values to use as a replacement for the keys. This is a function which is
generally used in systems where internal codes are used to represent
values that appear in different places in your data sources.
Note: The first parameter of the function is the value to lookup. The
second parameter should be bound to the reference column containing the
keys in the lookup table. The third parameter should be bound to the
reference column containing the values in the lookup table. Both reference
columns must be in the same physical table The result of the function is
the value from the lookup table corresponding to the key given as first
parameter.
Use case scenario: You have a customer table that contains a column that
represents the country that the customer is from. Instead of storing the
country name in the column (for example, Germany), your company stores
a country code (for example, 100) that represents the country. Your
company has a corresponding lookup table that captures which code
represents each country (100=Germany, 101=France, 102=Italy, and so on).
You want to write a data rule that uses the lookup function to find all the
French customers in your data source that have a phone number made up
of ten digits.
Example: If lookup(country, countrycodes, countrynames)='France' then
phone matches_format '99.99.99.99.99'
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String functions
You can use string functions to manipulate to strings.
ascii(char)
Definition: Returns the ASCII character set value for a character value.
Use case scenario: You want to search for all rows where a column begins
with a non printable character.
Example: ascii(code) <32
char(asciiCode)
Definition: Returns the character value for an ASCII character.
Use case scenario 1: You want to convert an ASCII character code to its
localized character (For example, ‘35' returns ‘C').
Example 1: char(‘35')
Use case scenario 2: You are searching for the next letter in the alphabet in
the following sequence: if col1='a', col2 must be 'b', if col1='b' col2 must be
'c', and so on.
Example 2 (a): col2=char(ascii(col1)+1)
Example 2 (b): ascii(col2)=ascii(col1)+1
convert(originalString, searchFor, replaceWith)
Definition: Converts a substring occurrence in a string to another
substring.
originalString
The string containing the substring.
searchFor
The substring to be replaced.
replaceWith
The new replacement substring.
Use case scenario 1: After a corporate acquisition, you want to convert the
old company name, "Company A," to the new company name, "Company
B."
Example 1: If ( convert(old_company_name, 'Company A', 'Company B' ) =
new_company_name )
Use case scenario 2: After a corporate acquisition, you want to convert the
company acronym contained in the acquired product codes from ‘XX” to
‘ABC'.
Example 2: convert(product_code, ‘XX', ‘ABC')
lcase(string)
Definition: Converts all alpha characters in a string to lowercase.
Use case scenario: You need to change all product codes to use only
lowercase letters.
Example: lcase(product_code)='ab'
index(string, substring)
Definition: Returns the index of the first occurrence of a substring within a
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string. The result is a zero-based index, so a zero indicates that the
substring was found at the beginning of a string. Negative one (-1), means
that the substring was not found.
Use case scenario: You want to locate a company code, ‘XX', within a free
form product code.
Example: index(col, 'XX')>=0
left(string, n)
Definition: Returns the first n characters of a string.
Use case scenario: You want to use the three-digit prefix of each product
code to determine which division is responsible for the product.
Example: left(product_code, 3)='DEV'
len(string)
Definition: Returns the total number of characters (that is, the length) in a
string.
Use case scenario: You want to determine the actual length of each
customer's last name in the customer file.
Example: len(cust_lastname)
ltrim(string)
Definition: Removes all space characters at the beginning of a string.
Use case scenario: You want to eliminate any leading spaces in the
customer's last name.
Example: ltrim(cust_lastname)
pad(string, begin, end)
Definition: Adds space characters at the beginning and at the end of a
string.
string

The string to be converted.

begin

The number of spaces to add at the beginning of the string.

end

The number of spaces to add at the end of the string.

Use case scenario: You want to add three spaces at the beginning and end
of each product title.
Example: pad(product_title, 3)
lpad(string, n)
Definition: Adds space characters to the beginning of a string.
string

The string to be converted.

n

The number of spaces to add to the beginning of the string.

Use case scenario: You want to add three spaces at the beginning of each
product title.
Example: lpad(product_title, 3)
rpad(string, n)
Definition: Adds space characters at the end of a string.
string

The string to be converted.

n

The number of spaces to add at the end of the string.
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Use case scenario: You want to add three spaces at the end of each
product title.
Example: rpad(product_title, 3)
right(string, n)
Definition: Returns the last n characters of a string.
string

The string to be converted.

n

The number of spaces to return at the end of a string.

Use case scenario: Use the three-digit suffix of each product code to
determine which division is responsible for the product.
Example: right(product_code, 3)
rtrim(string)
Definition: Removes all space characters at the end of a string.
string

The string to be converted.

n

The number of spaces to remove from the end of a string.

Use case scenario: You want to eliminate spaces at the end of the
customer's last name.
Example: rtrim(cust_lastname)
substring(string, begin, length)
Definition: Returns a substring of a string value.
string

The string value.

begin

The index of the first character to retrieve (inclusive), 1 being the
index of the first character in the string.

length

The length of the substring to retrieve.

Use case scenario: You want to use the three-digit (actual character
positions four to six) value from each product code to determine which
division is responsible for the product.
Example: substring(product_code, 4, 3)
str(string, n)
Definition: Creates a string of n occurrences of a substring.
Use case scenario: You want to create a filler field of “ABCABCABCABC”.
Example: str(‘ABC', 4)
tostring(value, format string)
Definition: Converts a value, such as number, time, or date, to its string
representation.
You have the option to specify "format (string)" to describe how the
generated string should be formatted. If the value to convert is a date, time
or timestamp, then the format string can contain the following format tags:
%dd

Represents the two-digit day (01 – 31)

%mm Represents the two-digit month (01 – 12)
%mmm
Represents the three-character month abbreviation (For example,
Jan, Feb, Mar)
%yy
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Represents the two-digit year (00 – 99)

%yyyy
Represents the four-digit year (nn00 – nn99)
%hh

Represents the two-digit hours (00 – 23)

%nn

Represents the two-digit minutes (00 – 59)

%ss

Represents the two-digit hours

%ss

Represents the two-digit seconds (00 – 59)

%ss.n Represents the two-digit milliseconds (00 – 59), where n =
fractional digits (0 – 6)
If the value to convert is numeric, the format string can contain one of the
following format tag:
%i

Represents the value to be converted into a signed decimal integer,
such as "123."

%e

Represents the value to be converted into a scientific notion
(mantissa exponent), by using an e character such as 1.2345e+2.

%E

Represents the value to be converted into a scientific notion
(mantissa exponent), by using an E character such as 1.2345E+2.

%f

Represents the value to be converted into a floating point decimal,
such as 123.45.

The tag can also contain optional width and precision specifiers, such as
the following:
%[width][.precision]tag

In the case of a numeric value, the format string follows the syntax used
by printed formatted data to standard output (printf) in C/C++.
Use case scenario 1: You want to convert date values into a string similar
to this format: '12/01/2008'
Example 1: tostring(dateCol, '%mm/%dd/%yyyy')
Use case scenario 2: You want to convert numeric values into strings,
displaying the value as an integer between brackets. An example of the
desired output is, "(15)".
Example 2: val(numeric_col, '(%i)')
Use case scenario 3: You want to convert a date/time value to a string
value so that you can export the data to a spreadsheet.
Example 3: tostring(posting_date)
trim(string)
Definition: Removes all space characters at the beginning and end of a
string.
Use case scenario: You want to eliminate any leading or trailing spaces in
the customer's last name.
Example: trim(cust_lastname)
ucase(string)
Definition: Converts all alpha characters in a string to uppercase.
Use case scenario: You want to change all product codes to use only
uppercase letters.
Example: ucase(product_code)
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val(value)
Definition: Converts the string representation of a number into a numeric
value.
string

The string value to convert.

Use case scenario 1: You want to convert all strings with the value of
123.45 into a numeric value in order to do computations.
Example 1: val('123.45')
Use case scenario 2: You have a string column containing numeric values
as strings, and want to make sure that all the values are smaller than 100.
Example 2: val(col)<100

Benchmark overview
Benchmark settings establish thresholds with which to gauge the statistics created
by a data rule, rule set, or metric. They can be used to identify a minimum level of
acceptability for the data or a tolerance for some level of exceptions
A benchmark is a quantitative quality standard that you define. When you set a
benchmarks for a data rule, all statistics from the rule can be measured against the
benchmark. Differences between the benchmark and the statistic against which it is
measured is called a variance. On an ongoing basis for data monitoring, the
variances from the established benchmark identify whether a data rule has passed
or achieved its target, or if it has failed its target. You can apply benchmarks to
any of the statistics resulting from data rule tests or a metric value computations.
You typically apply benchmarks to data rules or metrics as part of a data quality
monitoring process.
For data rules the benchmark criteria can be based on a count or percentage of
records, and determines if your data meets, exceeds or fails benchmark criteria. A
positive or negative variance to the benchmark value is also calculated. Using
percentage statistics to normalize the trends, you can evaluate the performance of
your data against standards and analyze the deviations over time.

Example
You set a benchmark for a data rule definition that checks to see if a social security
number string exists in one of the columns in one of your data sources. For the
benchmark, your tolerance for error is .1%. You can code the benchmark, which is
essentially your acceptance threshold, either as: Records Not Met > .1% or Records
Met < 99.9%.

Setting benchmarks for data rules
You can set a validity benchmark either when you initially create a rule definition,
or when you generate the data rule, in order to quantify the quality of your data,
as well as monitor your data.
Validity benchmark: The validity benchmark establishes the level or tolerance
you have for exceptions to the data rule. The benchmark indicates whether
sufficient records have met or not met the rule in order to mark a specific
execution of the rule as having passed or failed to meet the benchmark.
Select Monitor records that do not meet one or more rules in the data rule
workspace.
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You can define the validity benchmark by using the following options that can be
found in the menu in the validity benchmark workspace. Start by selecting one of
the following options:
% Not Met
Determines the percentage of records that did not meet the rule logic in the
data rule. You can set the benchmark to display a pass or fail condition
when this value is greater than, less than, or equal to a reference value that
you specify. For example, to ensure that the percentage of records that do
not meet a data rule never exceeds or falls below 10%, you would set the
benchmark to "% Not Met % <= 10."
# Not Met
Determines the number of records that did not meet the rule logic in your
data rule. You can set the benchmark to display a pass or fail condition
when this value is greater than, less than, or equal to a reference value that
you specify. For example, to ensure that the percentage of records that do
not meet a data rule never exceeds or falls below 1000, you would set the
benchmark to "# Not Met <= 1000."
% Met
Determines the percentage of records that meet the rule logic in your data
rule. You can set the benchmark to display a pass or fail condition when
this value is greater than, less than, or equal to a reference value that you
specify. For example, to ensure that the percentage of records that meet the
data rule never falls below 90%, you would set the benchmark to "Met %
>= 90."
# Met Determines the number of records that meet the rule logic in your data
rule. You can set the benchmark to display a pass or fail condition when
this value is greater than, less than, or equal to a reference value that you
specify. For example, to ensure that the number of records that meet the
data rule never falls below 9000, you would set the benchmark to "Met #
>= 9000."

Rule set definition overview
Rule set definitions are a collection of data rule definitions.
While data rules capture an understanding of data quality at the columnar level
(as they are executed or associated with one or multiple columns) and provide
information about which records meet or do not meet an individual rule, they do
not capture how a record within a data source conforms to multiple data rules, for
example, how many rules does a specific record break, nor do they identify the
overall quality or confidence in a data source. Rule sets provide the capability to
achieve this broader, more holistic, view of a data source and its records by
executing and evaluating multiple rules together against individual records. The
output from rule sets provides a view into your data at several levels:
Rule level
As with individual Data Rules, this view provides insight into the
exceptions to each rule within the rule set. For example, "record 1 did not
meet rule A."
Record level
Looking across the entire record, this view provides insight into the cases
where a record had an exception to one or multiple rules. For example,
"record 1 did not meet rules A, B, and C."
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Source level
Looking through the entire data source, this view provides summarized
insight into how many records have one or multiple rule exceptions, what
the mean number of record exceptions are, what the standard deviation is
from the mean, and, when compared to a baseline run, whether the source
has improved or degraded in quality.

Rule set definitions and data rule definitions
You can use data rule definitions or rule set definitions to create rule logic to
evaluate your data.
When you build rule logic, you can either create individual data rule definitions or
rule set definitions.
Rule set definitions: Collection of data rule definitions.
v Rule sets run much faster than executing individual rules one by one because
rule sets are executed by using unique processing algorithms on a parallel
execution framework. Also, since the processing and statistics are aggregated
during execution, no additional steps are necessary to aggregate exception
information after individual rule processing is completed.
v Rule sets provide a broader range of statistical information, allowing you to see
the multiple views of output such as which records break certain combinations
of rules, which combination of rules are broken together, and so on. This
additional level of detail allows you to focus corrective attention on problem
records and all associated issues at once, rather than sporadically responding to
isolated rule exceptions, as well as look for patterns of issues that might not be
apparent looking at a rule in isolation.
v When you create a rule set definition, you add data rule definitions that are
already created and defined. The individual data rule definitions cannot be
modified in the rule set workspace. After you create a rule set definition, you
generate a rule set. When you run the rule set, all the data rule definitions that
are part of the rule set are executed at the same time and produce a
comprehensive set of analysis results.
v When you use rule set definitions, rather than include all of the logic within a
single definition, you can divide the logic over multiple definitions. Each
definition can check for a specific condition. You can then group all of the
definitions in a rule set definition. You build the rule logic that you want to be
applied to your data, and group the rule definitions that you create in rule set
definitions.
The process of creating a rule set definition out of data rule definitions is shown in
the following figure:
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Figure 6. The process of creating a rule set definition out of data rule definitions

Data rule definitions: Individual data rules that you construct rule logic for. When
you create data rule definitions, you construct rule logic to analyze data.
v When it is time to generate data rules, you would generate data rules from each
individual data rule definition, and then execute the data rules you want to run,
one rule at a time. The data that you run the rule against either passes or fails
the check.
A major difference between a rule set and individual data rules is the results they
produce when they are executed. When you execute a rule set, all the rules in the
rule set are evaluated at the same time against the data. The rule set either passes
or fails a percent of the rules in the rule set. The results of all the rules in the rule
set are aggregated into rule set statistics. When you run a series of data rules one
by one, the data either passes or fails each rule that you execute.
For example, you are maintaining a master product catalog and are monitoring a
number of rules for that catalog. You have individual rules to ensure that the
division and supplier codes exist and that they are part of respective standard
reference lists. You have rules to ensure that the product description is not blank
and does not include an excessive string of random consonants. You also have a
rule to ensure a valid hazardous material flag exists. Running the valid hazardous
material flag rule in isolation, you find a small percentage of exceptions, and can
identify the records involved. If you run that rule in context with the other rules,
you find that all records where the hazardous material flag does not exist (the
exception records), all records that do not meet the rules for a supplier code in the
standard reference list, and a product description without too many random
consonants. Looking at the detailed output for the entire record, you recognize that
the supplier code represents a test code. You can then take corrective action to
ensure that such test records do not enter the system and resolve several issues
simultaneously.
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Creating a rule set definition
To create a rules set definition, select two or more data rule definitions or data
rules and add them to the rule set. When a rule set is executed, the data will be
evaluated based on the conditions of all rule definitions and data rules included in
the rule set.

Before you begin
When you create a rule set definition, you select individual data rule definitions,
and organize them into a rule set definition. The process of creating a rule set
definition is shown in the following figure:

Test
Rule Set

Rule Definition
Create
Rule Set
Definition

View
Output

Data Rule
Generate
Rule Set

Run
Rule Set

Figure 7. The process of creating a rule set

About this task
A rule set definition allows you to define a series of data rule definitions as one
combined rule definition. After you define your rule set definition, you generate a
rule set out of the rule set definition. When you generate a rule set, you bind all of
the variables from your data rule definitions, such as "first_name" and "column_a,"
to actual data in your data sources, such as "Fred" or "division_codes." Your
representational rule set definition elements are generated as a rule set that is
bound to real data. Once your rule set is generated, you run the rule set to gather
information on the data in your projects.

Procedure
1. From the Develop icon on the Navigator menu in the console, select Data
Quality.
2. Click New Rule Set Definition in the Tasks list, located on the right side of
the screen.
3. Enter a name for the new rule in the Name field.
4. Optional: Enter a brief description of your data rule in the Short Description
field.
5. Optional: Enter a longer description of your data rule in the Long Description
field.
6. Optional: Select any benchmarks that you want to set for the rule set definition.
You can set a Validity Benchmark, Confidence Benchmark, or Baseline
Comparison Benchmark.
7. Click Save.
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What to do next
Now, you have a rule set definition. After creating a name and a description for
your rule set definition on the Overview tab, click the Quality Controls tab, where
you will select the data rule definitions you want to use in your rule set definition.

Defining the logic for a rule set definition
To create a rule set definition, specify the data rule definitions or data rules that
you want to combine to form a rule set.

Procedure
1.
2.
3.
4.

From the Develop icon on the Navigator menu, select Data Quality.
Create a rule set definition or open an existing rule set definition.
Click the Quality Controls tab.
Click the Rule Element column.

5. Go to the Rule Definitions workspace in the Tabbed Palette on the right side
of the screen. Select the rule definition that you want to add to your rule set.
6. At the bottom of the Rule Definitions workspace, click Add to Rule Set. You
can select multiple data rules at a time by holding down either the shift or
control key and highlighting all of the data rules that you want to add. When
you are done, click Add to Rule Set at the bottom of the screen.
7. When you finish adding all of the rule definitions that you want to include in
your rule set definition, click Save at the bottom of the workspace.
8. Choose one of the following tasks:
a. Click Test to test the validity of the rule set definition.
b. Click View Test Results to view the results of the validity test of your rule
set definition. This test can help ensure that your rule set is analyzing data
the way you want your rule logic to work.
c. Click Generate Rule Set to create a rule set that is based on your rule set
definition logic. When you generate a rule set, you are taking the logical
variables in your data rule definitions and binding the variables to physical
data sources.
d. Click Validate to verify that the rule set definition you are creating is valid.
e. Click Close to close the workspace.

Setting benchmarks for rule sets
You can set a benchmark or threshold for your rule set to define a target
measurement you can use to assess various aspects of your rule set. The validity,
confidence, and baseline comparison benchmarks allow you to establish a tolerance
for possible errors or deviations in the quality of your data, as well as assess the
trends of your data around those benchmarks as you monitor your data over time.
When you are building data rule set definitions and data rule sets you can use a
variety of benchmarks to gather information about the quality of your data.
Validity benchmark: The validity benchmark is used to monitor the number or
percentage of records that either meet or do not meet one or more rules that you
set forth when you define the benchmark. The benchmark defines a record as not
meeting the rules set logic if it does not pass one or more of the rules in a rule set.
Select Monitor records that do not meet one or more rules in the rule set
workspace.
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You can define the validity benchmark by using the following options that can be
found in the menu in the validity benchmark workspace. Start by selecting one of
the following options:
Did Not Meet 1 or More Rules %
Determines the percentage of records that did not meet one or more of the
rules that you specified.
You can set the benchmark to display a pass or fail condition when this
value is greater than, less than, or equal to a reference value that you
specify. For example, to ensure that the percentage of records that do not
meet one or more rules never exceeds 10%, you would set the benchmark
to "Did Not Meet One or More Rules % <= 10."
Did Not Meet 1 or More Rules #
Determines the number of records that did not meet one or more of the
rules that you specified. You can set the benchmark to display a pass or
fail condition when this value is greater than, less than, or equal to a
reference value that you specify. For example, to ensure that the percentage
of records that do not meet one or more rules never exceeds 1000, you
would set the benchmark to "Did Not Meet One or More Rules # <= 1000."
Met All Rules %
Determines the percentage of records that meet one or more of the rules
that you specified. You can set the benchmark to display a pass or fail
condition when this value is greater than, less than, or equal to a reference
value that you specify. For example, to ensure that the percentage of
records that meet all rules never falls below 90%, you would set the
benchmark to "Met All Rules % >= 90."
Met All Rules #
Determines the number of records that meet one or more of the rules that
you specified. You can set the benchmark to display a pass or fail
condition when this value is greater than, less than, or equal to a reference
value that you specify. For example, to ensure that the number of records
that meet all rules never falls below 9000, you would set the benchmark to
"Met All Rules # >= 9000."
Confidence benchmark: The confidence benchmark allows you to specify a pass
or fail threshold according to the number or percentage of rules in a rule set that a
record fails. For example, if you have a rule set that contains 10 rules, you might
want to consider records that fail half of the rules (50%) as "low confidence"
records. You might be willing to accept a certain number of "low confidence"
records, but if the number of "low confidence" records exceeds a certain number or
percentage, then you would like the rule set to indicate failed confidence.
Select Monitor records according to the number of rules not met in the data rule
definition, rule set definition, data rule, or rule set workspace.
Rules Not Met Limit (Maximum Acceptable Rules Not Met Per Record)
The maximum percentage of rules that a record does not meet before it is
considered "low confidence."
Max Records Allowed Over Not Met Limit:
The maximum percentage of "low confidence" records you are willing to
accept before the benchmark fails.
For example, you declare records that fail half of the rules in a rule set as "low
confidence" and you want to allow 10% of the total records to be low confidence
records. You would specify the benchmark as follows:
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Rules Not Met Limit: 50%
Max Records Allowed Over Not Met Limit: 10%

Baseline comparison benchmark: The baseline comparison is a benchmark which
quantifies the difference of quality between the current execution of a rule set and
a reference, or baseline run of a rule set by comparing the distribution of the
number of failed rules by record. It evaluates the number of rules violated per
record against the number of rules violated per record in a baseline run. Similarity
and degradation are calculated by using the mean number of rules not met and the
standard deviation.
Improvements from the baseline are indicated by the following:
v A run in which both the mean number of rules not met per record and the
standard deviation are smaller than the baseline.
v A run in which the mean number of rules not met per record is equal to the
baseline run and the run has a smaller standard deviation.
v A run in which the mean number of rules not met per record is smaller than the
baseline run and the standard deviation is equal to the standard deviation of the
baseline run.
Degradations from the baseline are indicated by the following:
v A run in which both the mean number of rules not met per record and the
standard deviation are larger than the baseline.
v A run in which the mean number of rules not met per record is equal to the
baseline run but the run has a larger standard deviation.
v A run in which the mean number of rules not met per record is larger than the
baseline run and the standard deviation is equal to the standard deviation of the
baseline run.
When you execute a rule set, each record can break any number of the rules in the
rule set. The result of the run is characterized by a distribution that displays the
percentage of records that break none of the rules, one rules, two rules, and so on.
The distribution is characterized by a mean number of rules broken by each record
and a standard deviation. The current execution of the rule set and the baseline
run give two different distributions of the number of violated rules with two
different mean number of rules and standard deviation. The baseline comparison
benchmark quantifies the difference between the two runs by displaying how
similar or different the two distributions are.
Select Monitor Records According to Difference from Baseline in the data rule
definition, rule set definition, data rule or rule set workspace.
Degradation
Measures the area of the distribution of the run which is outside (to the
right of) the baseline distribution. The degradation is a metric between 0
and 100%. Zero means that the distribution of the run presents less
violations per record than the baseline. 100% would mean that the run
distribution is fully outside the baseline.
Similarity
Measures the surface of the intersection of both the test run and the
baseline run distributions. 100% would mean that both distributions are
identical.
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Metrics
You use metrics to consolidate the detailed statistical results from one or more data
rules, rule sets, or other metric results into a meaningful measurement. This could
be a specific weighted average, a cost factor, or a risk calculation.
The process of creating and running a metric is shown in the following figure:

Test
Metric

Data Rule Statistic

Rule Set Statistic

Create
Metric

View Output

Run
Metric

Metric Result

Figure 8. The process of creating and running a metric

Creating a metric
You can create a metric, which is an equation that you define, in order to develop
a measurement you can apply against data rules, rule sets, and other metrics.

About this task
You can create metrics to establish a set of key performance indicators (KPI)
around the data quality of the sources that are being evaluated. You can use
metrics to aggregate the results of multiple rules and rule sets to provide you with
a higher level of key performance indicators across multiple sources.

Procedure
1. From the Develop icon on the Navigator menu in the console, select Data
Quality.
2. Click New Metric in the Tasks pane.
3. Required: In the Name field, type a name for the metric.
4. Optional: Provide a short and long description.
5. Optional: In the Validity Benchmark section, select Include Benchmark to set
benchmarks to check the validity of your data.
6. To associate the metric with a folder:
a. Select the Folders view.
b. Click Add. You can search for folders by name and select folders to be
associated with the metric.
7. To develop the logic for the new metric, select from a variety of predefined
metric combinations to build logic for the metric:
a. Click the Measures tab.
b. Select an opening parenthesis if you are grouping lines of logic to form a
single condition.
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c. Compose a metric expression that can include rules, rule sets, metric
executables, and functions from the Quality Control and Functions tabs on
the Expression palette.
d. Select a closing parenthesis if you are grouping lines of logic to form a
single condition.
e. Select a Boolean operator.
8. Save the new metric.

What to do next
Now you can test the new metric.

Logic for building metrics
Use quality controls statistics and functions in the metric building workspace or
the free form builder to create metric logic that you can apply against statistical
results from data rules, data rule sets, and other metric results.
When you create logic for your metrics, you are formulating an equation that will
be applied against data rules, rule sets, and other metric results, in order to
produce a consolidated and meaningful measurement. For example, if you know it
costs your company 48 cents for every invalid address that exists in your system,
then you can create a metric that calculates the amount of money lost by
calculating a sum of the statistics from rules checking where the address is
missing, the state code is invalid, and the zipcode is in the wrong format. This
metric might look like this:
’( Invalid Address Rule # Number Failed + State Code Invalid Rule # Number
Failed + Zipcode Wrong Format Rule # Number Failed ) * 0.48’

Metrics can perform any of the basic arithmetic functions by using any of the data
rule related statistics and any literal values that you enter in the equation. You can
use the following quality controls, syntax and functions to develop the logic for
metrics.

Quality controls
When building metrics, you can use the quality control options to formulate your
logic. The quality control options are statistics for each individual data rule, rule
set, or metric that you want to use when you build a new metric.
Select the quality control that you want to use to build your metric, and then you
can apply a function to the data or perform an arithmetic operation with the
quality control components. For example you could use
ABS(ruleA Total Records - ruleB TotalRecords)

to check that the value is, for instance, lower than 100, which would mean that
both rules ruleA and ruleB should be run on datasets of same size with a tolerance
of 100 (either the one or the other can be up to 100 records larger than the other).
You can also build a similar metric comparing the results of two rules:
ABS(ruleA %failed - ruleB %failed)

This metric would give you the absolute difference of the failing rate between the
two rules.
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You can mix and match different statistics from the various data rules, rule sets,
and metrics in your metric. For example, you can take the % Rules Not Met Per
Record Mean from a rule set in your project, perform a function on this data, and
then divide it or add it to the Total Records for a data rule in your project. You
can build your metrics by using a variety of different functions and quality control
components. You can also type in literal values when building your metrics. For
example, you can say:
Data Rule A # Met All Rules +
Data Rule B # Met All Rules –
5

In the example, 5 is the literal that is typed into the metric building workspace.
The available statistics for data rules are:
Total records
The number of records tested.
Validity variance
The number and percent of records outside of the validity benchmark.
# Met The number of records that passed.
# Not Met
The number of records that failed.
% Met
The percentage of records that passed.
%Not Met
The percentage of records that failed.
The available statistics for rule sets are:
# Did Not Meet One or More Rules
The number of records in the run where, for each record, one or more of
the rules failed.
# Met All Rules
The number of records in the run that met the conditions in all rules in the
rule set.
# Rules Not Met Per Record Mean
The average number of rules that are not met by each record.
# Rules Not Met Per Record Standard Deviation
The standard deviation of the number of rules that are not met by each
record.
% Did Not Meet One or More Rules
The percentage of records (0 -100) in the run where, for each record, one or
more of the rules failed.
% Met All Rules
The percentage of records (0 -100) in the run that met the conditions in all
rules in the rule set.
% Rules Not Met Per Record Mean
The average percentage of rules (0-100) that are not met by each record.
% Rules Not Met Per Record Standard Deviation
The standard deviation of the percentage of rules that are not met by each
record
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Baseline Comparison Variance
The degradation factor of the last execution of the metric compared to a
baseline execution.
Confidence Variance
The number and percent of records beyond the maximum allowable
number of records exceeding the limit for rules not met.
Total Records
The total records that relate to a particular rule.
Validity Variance
The number and percent of records outside of the validity benchmark.
The available statistic for a metric is:
Metric result
The result of the metric evaluation.

Functions
You can choose to either use basic mathematical functions such as addition (+),
subtraction (-), multiplication (*), or division (/) when you are creating your
functions, or you can choose to use more complex set and scalar functions.
Functions allow you to perform a calculation or conversion on your data as part of
one parameter of your metric. The following table provides the set functions you
can use when you are building metrics:
Table 18. Set functions
Function

Description

Function Example

AVG( [ val1, val2,...] )

Returns the average of the
values contained within the
set

AVG( [1,2,4] ) == 2.33

COUNT( [val1, val2, ...] )

Returns the number of
values contained within the
set

COUNT([1,2,4]) == 3

MIN( [val1, val2, ...] )

Returns the minimum value
contained within the set

MIN([1,2,4]) == 1

MAX( [val1, val2, ...] )

Returns the maximum value
contained within the set

MAX([1,2,4]) == 4

SUM( [val1, val2, ...] )

Returns the sum of the
values that is contained
within the set.

SUM([1,2,4]) ==7

The following table provides the scalar functions you can use when you are
building metrics:
Table 19. Scalar functions
Function

Description

Function Example

ABS( expression )

Returns the absolute value of ABS( -3 ) == 3
an expression
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Table 19. Scalar functions (continued)
Function

Description

Function Example

CEIL( expression )

Returns the smallest (closest
to negative infinity) input
value that is greater than or
equal to the argument and is
equal to a mathematical
integer. The ceiling value is
the smallest integer that is
greater than or equal to the
current value.

If the value is 3.3, then the
ceiling is the smallest integer
that is greater than 3.3,
which is 4. CEIL( 3.3 ) == 4

EXP( expression )

Returns the exponential
value of a given expression

EXP(1.0) == 2.71828

FLOOR( expression )

Returns the largest (closest to
positive infinity) input value
that is less than or equal to
the argument and is equal to
a mathematical integer. The
floor value is the largest
integer that is less than or
equal to the current value.

If the value is 3.3, the floor is
the largest integer that is less
than 3.3, which is 3. FLOOR(
3.3 ) == 3

LN ( expression)

Returns the natural
logarithm of the specified
expression

LOG( 10 ) == 2.30259

LOG10( expression )

Returns the base-10
logarithm of the specified
expression

LOG10( 145.175643 )
==2.16189

RANDOM()

Returns a random float
between 0.0 and 1.0

SQRT ( expression )

Returns the square root of
the specified value

SQRT ( 9 ) == 3

It is also possible to create your own user-defined functions to use when building
your metrics.

Syntax
You can use the free form editor to write your own metric logic. When you create
metric logic with the free form editor, you must use the appropriate syntax. The
following table provides the syntax you can use when you are creating metrics:
Table 20. Syntax you can use with the free form builder
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Syntax

Description

( ) (parenthesis)

Represents parenthetical containment and
grouping operations that are used to create
order or precedence. They can also be used
to encapsulate function definitions and to
define boundaries for functional arguments.

+ (plus)

Adds two values together

- (dash)

Subtract two values

* (asterisk)

Multiplies two values

/ (forward slash)

Divides two values

Table 20. Syntax you can use with the free form builder (continued)
Syntax

Description

^ (caret)

Evaluates a value to the nth power. For
example, 2^4 would be 16 (2*2*2*2).

% (percent)

Takes the modulus of two values. For
example, 8%3 is 2 (3 goes into 8 two times,
leaving a remainder of 2).

Testing a metric
After you create a metric, you can test it in order to make sure your metric
equation is working as expected.

Procedure
1. Create a new metric or open an existing metric from the Data Quality menu.
2. Click the Measures tab.
3. Ensure there is metric data on the Measures tab, and then click Test in the
bottom right corner.
4. Type a value in the Values field for each parameter of your metric in the Test
Values workspace. You can also highlight the Values field and click Import
Current Values to import values for each parameter from your metric.
5. Click Calculate Result to obtain results from your test. The results are
displayed in the Test Result workspace.
6. Click Close in the bottom right when you are finished.

What to do next
After testing your metric, you can edit or run it.

Global logical variables
A global logical variable is a value that you can set to represent a fact or a specific
piece of data. After you create a global logical variable, it is a shared construct that
can be used in all of your data rule definitions and data rules.
Global logical variables are useful if you want to define a value in your data rule
definitions and data rules that might change in the future. If the data changes, you
can modify the logical variable, instead of changing the data in multiple places in
your rule definitions and data rules.
You can bind the logical variable that you create to any source data that you need
for your project. If your source data changes, or you want to switch your global
logical variable to be bound to a newer table, then you can switch the bindings to
the new table, and all your data rules that are bound to the logical variable, are in
turn, updated.
You can manage all your logical variables from the Global Logical Variables
workspace found in the Metadata Management section of the My Home
workspace grouping. This workspace lists all the global variables in the
system. These span all projects.
To create a global variable, start by entering a name and data type. The format of
the data type can be restrictive if you select a type such as numeric, string, or date.
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If you select a restrictive data type, then you can only bind the data to a
compatible target. You can set the data the data type to Any to remove all data
type restrictions. After the data type is defined, you can define the binding to be
either a physical column or a literal.
When you define a global logical variable, consider including an example of your
variable. An example can be useful for columns or strings that are bound to
obscure values. It is a good idea to give an example of what the value means, for
future reference.
When you are ready to generate a data rule out of a rule definition that contains
global logical variables, the global variables must be bound before the rule can be
executed.

Creating a global logical variable
You create a global logical variable to provide a common, consistent association or
link to a specific piece of data.

About this task
Once you create a global logical variable, it is explicitly bound to either a data
element or a literal data value. For example, a global logical variable "StateCode" is
linked to a data source "MasterStateCodeTable" with a column called
"StateCodeReference."

Procedure
1. From the Home icon on the Navigator menu, select Metadata Management >
Global Logical Rule Variables.
2. Click Create New in the Tasks pane.
3. Enter descriptive information for the new global logical variable.
4. Select the data type of the global logical variable and then choose the data
sources or literals that you want to bind to the global logical variable and click
Set as Bindings.
5. Click Save.

Accessing output results for data rules, metrics, and rule sets
You can access output results from the IBM InfoSphere Information Analyzer My
Home workspace, from the project dashboard, or in the Data Quality workspace.
The InfoSphere Information Analyzer Home Page and the project dashboard are
the best areas to quickly get a summary of the results of all of the data rules,
metrics, and rule sets that have been run. Here you can view summarized statistics
for each item and then drill into details as needed.
The My Home workspace and the project dashboard will display the status of each
data rule, rule set, and metric. A green check mark indicates that the result
statistics were within the benchmark. A red exclamation point indicates that the job
failed. A red "X" indicates that the result statistics are outside of 1 or more of the
benchmarks specified. Multiple red "X" marks indicate that the results were outside
the benchmark for a number of runs. There will be one "X" for each run, to a
maximum of 3 representing the overall trend.
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InfoSphere Information Analyzer My Home workspace
From the My Home workspace, you can view output results for all of your
data rules, metrics, and rule sets by clicking on the configuration icon in
the top right of the screen.
1. Click Add in the bottom left of the Configure My Home workspace to
add a metrics summary, data rules summary, or rule set summary to
your home page.
2. Click on the Metrics, Data Rules, or Rule Sets tab, depending on
which output you want to see.
Note: Data rules, metrics, and rule sets will each appear in their own
summary workspace. There will be a Data Rules Summary workspace,
Rule Set Summary workspace, and a Metrics Summary workspace.
You can also click the All Quality Controls Summary tab, which
includes data rules, metrics, and rule sets.
3. Select the data rules, metrics, or rule sets that you want to include from
the various folders in the configuration workspace and click OK at the
bottom of the workspace. This will save the component to your My
Home workspace.
4. Move the components around on the My Home workspace page by
dragging the headers to the area you want them to be displayed.
5. View the status of each data rule, metric, or rule set, as well as any
benchmarks you specified.
6. Highlight the data rule, metric, or rule set that you want to see
individual output for, and click View Results. This will bring you to
the Data Quality workspace, where you can drill down to individual
output results.
Project dashboard
From the Overview icon, select Dashboard and then click the Quality tab.
You will be able to see the time that each rule set, data rule, and metric
was run, the status of each, and any benchmarks that you specified when
you configured each rule set, data rule, or metric. You can view individual
output results by highlighting the data quality component and clicking
View Results.
Data Quality workspace
From the Develop icon, select Data Quality. You can highlight any data
rule, rule set, or metric and click View Output.
Individual data rules, rule sets, and metrics
From the Develop icon, select Data Quality. You can highlight any data
rule, rule set, or metric and click Open. Click View Output.

Viewing output results for data rules, metrics, and rule sets
You can view output results for data rules, metrics, and rule sets from four
different parts of the IBM InfoSphere Information Analyzer workspace. You can
view results from the InfoSphere Information Analyzer My Home workspace, from
the project dashboard, or from the Data Quality workspace.
The View Output workspace will give you specific details about your data rules,
rule sets, and metrics, in a History workspace that outlines a textual summary of
the data quality element history, as well as graphical views showing the trend of
the execution results. The output displayed differs based on the way you
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configured your output when you created each individual data rule, rule set, and
metric. The following output elements are displayed for the following data quality
items:
Data Rules
In the History workspace, you can view details about the individual
executions of your data rules, such as statistics and benchmarks. Click
Make Baseline to set the starting point in the graphical view. You also
have the option of adding notes to the History workspace by clicking the
Note icon.
To view the graphical history of a data rule, click the graph icon in the
bottom left of the screen. You can change the start date and end dates of
data rule executions you want to see in the graph, as well as change the
view to display either % Not Met or # Met. Use the legend in the lower
left side of the screen for details about the components of the graph.
Click View Details from the History workspace to display details for a
specific data rule execution. In the View Details workspace, click the
Overview or Results tab to view statistics and results about a particular
data rule execution. You can see all exception details based on how you
configured your output. What you will see here matches your output
configuration. The fields you see are based on the columns you selected to
include when setting output for a particular data rule. You can click Export
to export the data rule data to a fixed or delimited text file.
Rule Sets
In the History workspace, you can view details about the individual
executions of your data rules, statistics, and benchmarks. Click Make
Baseline to set the starting point in the graphical view. You also have the
option of adding notes to the History workspace by clicking the Note icon.
Click View Details to display details for a specific data rule execution.
To view the graphical history of a rule set, click the graph icon in the
bottom left of the screen. You can choose from the following graphical
views:
v Validity
v Confidence
v Baseline Comparison
v Number of Rules Not Met
You can change the start date and end dates of rule set executions that you
want to see in each graph. Use the legend in the lower left side of the
screen for details about the components of the graph.
In the View Details workspace, click the Overview or Results tab to view
statistics and results about a particular data rule execution. The Overview
workspace provide provides details about the rule set, such as the mean,
the standard deviation, statistics, and benchmarks.
The Results tab has four different views. Click the view you want to see in
the Select View menu on the left side of the screen:
Record
This displays all of the records for a rule set. You can view all of
the rules not met by for each execution result for a rule set. When
you highlight an execution record for a rule set, you can see the
individual records that violated the rule in the Rules Not Met By
Selected Record workspace on the bottom of the screen.
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Rule

This displays all of the rules for a rule set. You can select multiple
rules at one time. You can select Union to show all records that
failed one of the rules, or both of the rules, or you can select
Intersection to show records that failed both ones that failed both
rules.

Distribution
This view shows the percent of records that had one ore more
violations. You can sort records by # of Rules Not Met or % of
Rules Not Met.
Pattern
This view shows the pattern of your rule set records. It can show
information such as, when rule A broke, rule B also failed 97% of
the time. It provides a confidence to show if there is an association
between two rules. It helps you find correlations between rule
patterns and shows any dependencies or relationships between two
rules.
You can see all exception details based on how you configured your
output. What you will see here matches your output configuration. The
fields you see are based on the columns you selected to include when
setting output for a particular data rule. You can click Export to export the
data rule data to a fixed or delimited text file.
Metrics
In the History workspace, you can view details about the individual
executions of your metrics. Click Make Baseline to set the starting point in
the graphical view. You also have the option of adding notes to the History
workspace by clicking the Note icon. Click View Details to display details
for a specific metric execution.
To view the graphical history of a metric, click the graph icon in the
bottom left of the screen. You can change the start date and end dates of
data rule metric executions you want to see in the graph. Use the legend in
the lower left side of the screen for details about the components of the
graph.
Click View Details from the History workspace to display details for a
specific metric execution. In the View Details workspace, click the
Overview or Results tab to view statistics and results about a particular
metric execution. You can see all exception details based on how you
configured your output. What you will see here matches your output
configuration. The fields you see are based on the columns you selected to
include when setting output for a particular metric. You can click Export to
export the data rule data to a fixed or delimited text file.

Viewing data quality activity history
You can view the activity history of data rule definitions, data rules, metrics, rule
set definitions, and rule sets by using the audit trail feature. The audit trail feature
tracks the history of activity for each data quality object such as when it was
created, changed, executed, and so on.

About this task
By using the audit trail feature of data rule definitions, rule set definitions, data
rules, rule sets, and metrics you can view the history of these objects, including the
date and time that they were created, the date and time that they were executed or
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modified, and the user who initiated each action. The audit trail allows you to
verify the occurrence of events associated with a given quality control from a
management perspective, by providing you with details surrounding the activities
of your rule definitions, rule set definitions, data rules, rule sets, and metrics.

Procedure
From the Develop icon on the Navigator menu, select Data Quality.
Open an existing data rule definition, executable, or rule set.
On the Overview tab, find the Select View menu on the left side of the screen.
Click the Audit Trail view.
You can see the Event, Detail, Contact, and Date and Time fields in the Audit
Trail workspace. Click the scroll arrows at the top of the Audit Trail workspace
to move through the records of your audit trail.
6. Go to the Items Per Page menu on the right side of the screen and select the
number of records that you want to display on each page of your audit trail
workspace.
1.
2.
3.
4.
5.

7. Highlight any Event that you want more information on in the audit trail
workspace, and then click Open Definition in the bottom right corner of the
screen.
8. You can select Run to run any events in your audit trial workspace, View
Output to view output of a particular event, Validate to make sure an event is
valid, Close to close an event, or Save to save any changes you made to an
event.

Associating a data rule definition with folders
Folders provide the ability to organize and view data rules, rule sets, and metrics.
You can use the folders to organize data rules, rule sets, and metrics based on
various business tasks, or you can organize them by data sources or systems.

About this task
Folders are organized in a free form categorization. You can develop an associated
hierarchy to track and view output for frequently used data rules, rule sets, or
metrics, rather than search through an entire list of objects. Folders are visible in
the Data Quality workspace, as well as on the Home Page.

Procedure
1. Click the Develop icon on the Navigator menu in the console, and select Data
Quality.
2. Double-click the data rule definition that you want to work with or select the
data rule definition and click Open in the Tasks menu.
3. Select Folders in the Select View menu. If you are creating a folder for a new
data rule, no folder associations exist yet.
4. Click Add.
5. Select the folder that you want to associate the data rule definition with, and
click Add.
6. Click OK to add the folder that you selected to the list of associated folders.
Note: To remove a folder, highlight the folder in the Quality Control Folders
workspace and click Remove in the right side of the screen.
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Associating a rule definition with terms, policies, and contacts
You can associate a rule definition with an IBM InfoSphere Business Glossary term
to provide additional meaning to the rule definition. You can also associate a
policy or a contact in the repository with a rule definition.

About this task
You must have the InfoSphere Business Glossary Author or User role to view and
use the Terms workspace.

Procedure
1. Click the Develop icon on the Navigator menu in the IBM InfoSphere
Information Analyzer console, and select Data Quality.
2. Select a data rule definition and click Open or click New Data Rule
Definition.
3. Select Attachments from the Select View menu. If you are associating a term,
policy, or contact for a new data rule, no associations will exist yet.
4. In the Terms, Policies, or Contacts workspace, select Add.
5. Select the data that you want to add and click Add.
Note: To remove a term, policy, or contact, highlight the item and click
Remove in the right side of the screen.
6. Click Save and Close.

Debugging data rules and rule sets
You can use the debugging log option to isolate errors in your rule logic that are
preventing successful rule evaluation.

Setting the debugging log option
You can set the debugging log option from the data rule job scheduler screens.

Procedure
1. You can select the debugging log option from the following windows of the
user interface:
v Data Rule Definition > Test > Submit Job step > Options tab
v Rule Set Definition > Test > Submit Job step > Options tab
v Run Data Rule > Options tab
v Run Rule Set > Options tab
2. Select Create Debugging Log and specify the number of records to include in
the log.
3. Run the data rule or rule set.

What to do next
After you run the data rule or rule set, you can view the debugging log by
selecting View Debugging Log from the following windows:
v Data Rule > View Output > View Details > Result tab
v Rule Set > View Output > View Details > Result tab and select By Record or
By Rule
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v View Data Rule Test Results > Result tab
v View Rule Set Test > Result tab and select By Record or By Rule
When you view the debugging log, you also have the option to export the log for
further analysis or to send to another user to help debug the data rule or rule set.

Viewing the debugging log
You can view the debugging log to see what is happening each step of the way
with your data rule or rule set conditions and functions.

How to interpret the debugging log
You work through each step of the evaluation (consider each row to be equal to a
step in the evaluation of the rule). In this way, you can isolate errors in your rule
logic that are preventing successful rule evaluation.
For a particular column in your data rule or rule set, you can see how IBM
InfoSphere Information Analyzer views that data. In the following sample
debugging log, you can see the values for colA, colB, colC, and colD.
v If you apply a function, you can see that it returns a particular value, for
example, uppercase(colA).
v When you apply a calculation, you can see the result for that specific record, for
example, colC + colD).
v When a condition is evaluated, you can see whether the result returned is true
or false.
v You can see whether the record was considered to have met the rule or not.

Figure 9. An example debugging log
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Deploying quality components
In a basic deployment scenario, IBM InfoSphere Information Analyzer quality
components are moved from a development or test environment to one or more
production environments. You can import and export quality components,
including data rule definitions, rule set definitions, data rules, rule sets, global
variables, and metrics.
In addition to moving quality components from development or test IBM
InfoSphere Information Server instances to multiple production environment
InfoSphere Information Server servers, you can also use import and export for
backup and restore purposes.

Using the import wizard
You use the import wizard to import quality components from a previously
exported file that exists on your server.

Procedure
1. To import:
v A data rule definition, rule set definition, data rule, or rule set, select
Develop > Data Quality and click Import.
v A global logical variable, select Home > Metadata Management > Global
Logical Variables and click Import.
2. Enter the location of the file or files on the server to be imported and click
Show Files. You must have authority to access the server location.
3. Select the package to import from the grid and click Next.
4. The Import Details window of the wizard lists the package name, number of
items to be imported, the size of the package, and the date and time of the
package import. Click Import.
5. If there is a naming or identity (the file's internally-stored unique attribute)
conflict, select one of the following options and then click Next:
v For name conflicts, the options to choose are:
– Do not replace existing item
– Replace existing item with imported item
– Append a custom suffix to imported item and enter a suffix to the name
of the asset, such as _new.
v For identity conflicts, the options to choose are:
v Do not replace existing item
v Replace existing item with imported item
6. When the package completes successfully, click OK.

Using the export wizard
You use the export wizard to export quality components to a file on your server.

Procedure
1. To export:
v A data rule definition, rule set definition, data rule, or rule set, select
Develop > Data Quality. Select a quality control from the grid and click
Export.
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v A global logical variable, select Home > Metadata Management > Global
Logical Variables. Select a global logical variable and click Export.
2. Enter the destination directory on the server in the Location text field. You
must have authority to write to the server location.
3. Select asset and attribute options to export.
v For data rule definitions and rule set definitions, the option available is
Include Folders.
v For data rules, rule sets, and metrics, the options are:
– Include Folders
– Include Bindings, when selected enables the option Export Global
Variables.
– Include Output Configuration
– Include Result History
v For global logical variables, the option is Include Bindings.
4. Click Export.
5. When the package completes successfully, click OK.
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Chapter 15. Data Rules stage
Use the Data Rules stage to check data quality anywhere in the flow of a job.
By using the Data Rules stage, you can include rules that you create in IBM
InfoSphere Information Analyzer directly in the flow of a job. These rules check the
quality of in-stream data. The Data Rules stage can be added anywhere in a job,
and you can add it multiple times to check for data anomalies and validate the
quality of the data. By including additional downstream stages in the job, you can
analyze or transform the invalid records, and send valid records downstream for
further processing.
The Data Rules stage can use all of the published data rule definitions that you
created in InfoSphere Information Analyzer. You can also create ad hoc rules that
can be used only within that stage. If you have the Rule Author role in InfoSphere
Information Analyzer, you can create and publish rule definitions and rule set
definitions directly from the stage itself. All rule definitions that you publish are
saved to the metadata repository so that they are also available for use within
InfoSphere Information Analyzer.
You can use the Data Rules stage to design the preprocessing of the data (bringing
the data to the right form before it is processed by the Data Rules stage) and the
postprocessing of the result. It also offers the flexibility to chain several rule stages
or to store good or bad records in different target tables. You can also manage
exceptions within the job flow, so that low-quality data does not pass through to a
data warehouse, for example. The Data Rules stage can use three output types: an
output type for data that meets all rules, an output type for data that does not
meet one or more rules, and an output type that contains detailed information
about each record that failed. The details describe each condition that the record
did not meet. You can use this information to perform additional analysis to
determine the cause of the data failures and correct the failure either at the data
source or in-stream within the job.
Although you can create and publish new rules from the Data Rules stage, you
should create rules in InfoSphere Information Analyzer and then implement them
in a job. You can use InfoSphere Information Analyzer to design, test, debug, and
validate the rules on non-operational data. When the rule is ready for production,
publish the rule and implement the rule in the Data Rules stage. This separation of
responsibilities keeps the design, test, and production systems, the rules, and the
data secure.
When a job that uses the Data Rules stage runs, the output of the stage is passed
to the downstream stages. Unlike InfoSphere Information Analyzer, a job does not
store results or history in the Analysis Results database (IADB).
If you reuse rules that were created in InfoSphere Information Analyzer or if you
create new rules in InfoSphere Information Analyzer and plan to use them in the
Rules Stage, be aware of the following requirements:
v The Data Rules stage works with rule definitions only, not with InfoSphere
Information Analyzer executable rules. Bindings, join conditions, and output
definitions must be defined within InfoSphere DataStage Rule Stage editor. For
example, if you use a rule definition that requires one or more joins, you must
add Join stages to the job.
© Copyright IBM Corp. 2006, 2012
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v The Data Rules stage does not support benchmarks and metrics.
You perform the majority of the configuration within the Data Rules Editor, which
is available from the Stage > General tab of the Data Rules stage. The Rules Editor
presents an Input tab and an Output tab. On the Input tab, you select the rules to
include in the stage and then map, or bind, each rule variable to a column from an
input link or to a literal value. On the Output tab, you select the columns to pass
to the output links. In addition, you can specify additional statistics and attributes,
such as the date or time, to add to the output, as well as create a custom
expression to perform a calculation.

Prerequisites for the Data Rules stage
Before you use the Data Rules stage, confirm that your system has the required
versions of software and enable scripting in Microsoft Internet Explorer.
The following are prerequisites for using the Data Rules stage:
1. IBM InfoSphere Information Analyzer, Version 8.7 must be installed.
2. IBM InfoSphere DataStage Version 8.7 must be installed.
3. Microsoft Internet Explorer, Version 7 or higher must be installed on the client
machine.
4. You must enable scripting in Internet Explorer on the client machine. There are
two ways to enable scripting in Internet Explorer security. You can:
v Add the host name of the services tier to the Trusted Zone, which enables
scripting for the services tier only.
v Enable active scripting, which permits scripting for all web sites.
Note: If you do not enable scripting, the first time that you click Configure
Data Rules from the Data Rules stage page, a blank screen with an error
message appears, where you can enable scripting. If you enable scripting at
that point, you must click the Close button on the Data Rules Editor, and then
click Configure Data Rules again to access the editor interface.
To
1.
2.
3.

add the host name of the services tier to the Trusted Zone:
Open Internet Explorer and choose Tools > Internet Options.
On the Security tab, choose Trusted sites, and click Sites.
Enter the host name of the services tier. Do not include the port number or
protocol. Then click Add.

To enable active scripting:
1. Open Internet Explorer and choose Tools > Internet Options.
2. Choose Security > Internet and then click Custom level.
3. Scroll to the Scripting section of the list, and then, under Active Scripting,
click Enable.

Rule definitions (Data Rules stage)
A rule definition is a logical expression that evaluates specific conditions in a data
set.
When you write a rule definition, you define logic that analyzes the data that
flows through a job. For example, if you are concerned that some records might
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not contain customer last names, you can write the following rule, which checks
that a last name exists and that the value of the last name field is not the space
character:
LastName EXISTS AND LastName <> " "

This rule checks for valid data. If the last name exists and is not null, the rule
evaluates to True. However, you can also write the rule to test for invalid data. The
following rule checks if the last name is missing or if the value of the last name
field is null. If either condition is true, the record is invalid, and the rule evaluates
to True.
LastName NOT EXISTS OR LastName = " "

Use rule sets to manage related rules. For example, a company might define a
business rule that states that a valid customer record contains a valid account
number, a valid region, and both a given name and a surname. By using rule logic,
you might create the following rule definitions to describe this business rule:
v The account number must contain three numbers, a dash, three letters, a dash,
and three numbers.
Account MATCHES_REGEX ’^[0-9]{3}-[a-zA-Z]{3}-[0-9]{3}$’

v The only valid regions are north, south, east, and west.
Region IN_REFERENCE_LIST {’north’, ’south’, ’east’, ’west’}

v The first name of the customer must exist and must not be null.
FirstName EXISTS AND FirstName <> " "

v The last name of the customer must exist and must not be null.
LastName EXISTS AND LastName <> " "

You can add each of these four rule definitions individually to the Data Rules stage
each time that you need to validate customer records or you can combine them all
into a rule set definition. For example, you might name the rule set
ValidCustomers. Then whenever you need to validate customer records, you add
the ValidCustomers rule set to the stage. Each rule in the set is added to the stage.
In the example above, the variables are Account, Region, FirstName, and
LastName. Your data sources, however, might use different column names to
describe the same types of data. For example, one source might use the column
name Location to describe the regions, while another uses the term Territory. When
you configure the rule with each data source, you map, or bind, each rule variable
to the column that contains the related data. Then when the job runs, the Rule
Stage replaces each variable name with the mapped data source column name, and
for each record, the rule evaluates the value of each field in the column.

Creating rule definitions (Data Rules stage)
If you are a rule author, you can create rule definitions and rule sets.

About this task
With the exception of global variables, benchmarks, and metrics, the Data Rules
stage provides all of the rule-creation functionality that is in IBM InfoSphere
Information Analyzer. Rule definitions and rule set definitions that you publish
from the Data Rules stage are saved to the metadata repository, where they are
available for use in any instance of the Data Rules stage and in InfoSphere
Information Analyzer.
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Procedure
1. From the Selected Rules pane in the Data Rules Editor, click Create New.
2. Enter a name for the rule and the rule logic.
3. Enter the rule logic manually, or click Add to Logic to access lists of functions,
checks, parentheses, and conditional statements to add to the rule.
4. Click Save.

What to do next
You can select a rule definition in the grid and then edit, copy, or publish the rule
definition:
v Click Edit to change the selected rule definition.
v Click Copy to use the selected rule as a model for creating a rule definition.
v Click Publish > Rule Definition to publish the selected rule definition.

Syntax for rule logic
Rule logic describes what a rule evaluates and how the evaluation is completed.
Table 21. Syntax for rule logic
Component

Syntax

Example

Boolean operators

AND, OR

value >0 AND value<100

Boolean grouping

()

(valueA=0) AND (valueB=0)
OR valueC=0)

Condition

IF, THEN, ELSE, NOT

IF age>18 THEN status NOT
CONTAINS 'child'

Names

Names can contain the
following characters:

age>0 AND client_ID EXISTS

v Alphabetic characters
v Unicode characters that
belong to the Letter
category
v Numeric characters
v Underscore (_)
v Question mark (?)
v Dollar sign ($)
The first character of a
variable name must be an
alphabetic character. Names
cannot contain periods and
spaces.
Numeric constants
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Numeric constants contain
numeric characters 0-9 that
are specified in machine
format (12345.789), not in a
locale-specific format.
Numeric constants cannot
contain quotation marks,
decimal separators, or
fraction separators.

col>10 AND col<12343.35

Table 21. Syntax for rule logic (continued)
Component

Syntax

String constants

value<>'xyz' AND
Enclose string constants in
value<>'John\'s idea' AND
single quotation marks, for
example 'value'. If the string col<>'C:\\docs'
itself contains a single
quotation mark, precede the
single quotation mark with a
backslash. If the string
contains a backslash, precede
the backslash with another
backslash.

Date and time constants

Use the functions
dateValue(), timeValue(), and
timestampValue() to hard
code a time, date, or time
stamp in an expression.

Lists

Enter a comma-separated list 'a','b','c' 1.54, 2.32, 34.12
of values.

Functions

Enter the function name,
followed by the function
parameters, enclosed in
parentheses.

Comments

Enter the comment using this IF country='01' /*01 =
France*/ THEN
format:
region='EMEA')
// comment (double slash
followed by comment)
or
/* comment */ (comment
between /* and */)

Checks

Enter the check, followed by
the required reference data.

Source data

Source data can contain any
of the following strings:
v Column names
v Variable names
v Expressions that are
composed of functions,
arithmetic operators, and
variables. The expressions
must evaluate to a
character or string data
type.

Example

time>timeValue('08:45:00') ,
date>dateValue('2008-31-12'),
timestamp>timestampValue
('2008-31-12 08:45:00')

ltrim(upper(col))='ABC'

# Test the value below the
limit
col < $limit
// default = 100
\* end of test *\

Checks for rule logic
A check is a part of the rule logic in a rule definition that determines whether the
source data meets a particular condition. When you create rule logic, you can use
checks.
contains
Checks that the source data contains the reference data, where both
elements are part of a string. For example, the string “abcdef” contains
“cd” but does not contain “dc.” Both the source data and the reference
data must be of string type. The contains check is case sensitive. Both
source data and the reference data can be a variable or the result of a
Chapter 15. Data Rules stage

193

scalar function. For the source data, you can use an expression that is
comprised of scalar functions, arithmetic operations, and variables.
However, you must ensure that the expression evaluates to a character or
string data type.
The syntax is:
source_data contains reference_data

comparison
Checks that the source data equals the reference data. Use the operators =,
>, <, >=, <=, and <> to create equality checks. The source data and the
reference data must have compatible data types. For string data, the check
is case sensitive. In addition, the check ignores all trailing spaces in the
data. For example, if the source data or reference data contains name, the
equality check verifies "name" (a value that has a data type of CHAR(10))
as a match. For string data, the check does not ignore leading spaces. If
data contains leading spaces and differences in case, use the string
functions to normalize the values.
exists

Checks the source data for null values. The check returns true if the source
data is not null and returns false if it is null.
source-data exists

in_reference_column
Checks that the values in the source data exist in the specified reference
column. You can use the reference column check to ensure that a value is
in a master reference table or that the referential integrity of two tables is
correct. The source-data and reference-column must have compatible data
types. This type of logic performs a check against another column that
could be in another table; therefore, the check takes longer to run than a
non-columnar check, such as the exists or contains checks. If you bring a
rule definition or data rule into a rule set that has a reference column
check, you will need to explicitly join the tables together.
source-data in_reference_column reference-column

in_reference_list
Checks that the values in the source data are from a specified reference list
of values. The source data and reference list must have compatible data
types. Enter the list of values between brackets ({ }) and use commas to
separate the values. To enter string values, use quotation marks. Enter
numeric values in machine format (123456.78). The list can contain scalar
functions.
source-data in_reference_list {reference-list}

For example, this rule checks that records use the approved material codes:
material_type in_reference_list {’FG’, ’IP’, ’RM’, ’RG’}

is_date
Checks that the source data, which must be a character data type, is in a
valid date format.
source-data is_date

The following list contains the valid date formats, which can have no
delimiter or can have a dash (-), slash (/), or dot (.) delimiter. Note that the
list shows the formats with a dash delimiter:
v %yyyy-%mm-%dd
v %yy-%mm-%dd
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v
v
v
v
v

%mm-%dd-%yyyy
%mm-%dd-%yy
%yyyy-%dd-%mm
%yy-%dd-%mm
%dd-%mm-%yyyy

v %dd-%mm-%yy
is_numeric
Checks that the source data represents unformatted numbers or numbers
that are formatted for a specific locale. By default, the current locale is
used. To use the format for a specific locale, provide the name of the
locale, such as 'fr' (France) or 'de' (Germany) as reference data. For
example, "col is_numeric 'fr'" returns true for the value "100 000,00" and
"col is_numeric 'de'" returns true for the value "100.000,00." For a list of ISO
639-1 codes that represent the names of languages, see
http://www.loc.gov/standards/iso639-2/php/code_list.php.
source-data is_numeric optional_locale_name

matches_format
Checks that a sequence of characters in the source data matches the format
of the specified pattern string. Both the source data and the pattern string
must be strings.
Use the following characters to construct the pattern string, which must be
entered in quotation marks:
v A - Represents any uppercase character.
v a - Represents any lowercase character.
v 9 - Represents any digit 0 to 9.
v x - Represents any alphanumeric value in uppercase or lowercase.
source-data matches_format pattern-string

For example, this rule checks that the source contains product codes that
use the format of two uppercase letters, a dash, three digits, a period, and
two digits:
source-data matches_format ’AA-999.99’

matches_regex
Checks that the source data contains the character or string of characters
that are specified in a pattern string. The pattern string might include the
location, beginning, middle, or end, of a character string.
source-data matches_regex pattern-string

Regular expressions can be tested with the matches_regex data check.
Regular expressions are a convention for evaluating string data, whether
for formats, specific characters, or particular sequences of text data.
InfoSphere Information Analyzer uses the Perl Regular Expression Library
for these types of evaluations. Many regular expressions address typical
data including text-based dates, email addresses, web addresses, and
standard product codes.
For example, to test for a valid credit card, the data might contain these
conditions:
v A series of 16 numbers, optionally separated by a dash after every four
numbers, that starts with the value of '4'.
v The length, for example, is not actually specified as 16, and may be as
many as 19 if dashes are used.
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Credit_card MATCHES_REGEX '/^4\d{3}-?\d{4}-?\d{4}-?\d{4}$/’
The following table lists operators that are frequently used to construct the
pattern strings:
Table 22. Examples of regular expression operators
Operator

Function

. (period)

Indicates a match for a single character.

$ (dollar sign)

Indicates the end of a line.

^ (caret)

Indicates that the pattern string starts at the
beginning of a line.

[uppercase character]

Indicates a match for a specific uppercase
character.

[lowercase character]

Indicates a match for a specific lowercase
character.

[digit from 0–9]

Indicates a match for a specific single digit.

\d [a particular digit from 0–9]

Indicates a match for a specific single digit.

\b

Indicates a match at a word boundary.

\s

Indicates a match for any whitespace
character.

\S

Indicates a match for any non-whitespace
character.

\w

Indicates a match for any single
alphanumeric character.

[]

Indicates the start for the character class
definition that you specify.

[^X]

Indicates a match for the start of a line,
followed by the characters that you specify.

X?

Indicates a match for no or one occurrence
of the qualifier. It also extends the meaning
of the qualifier.

X*

Indicates a match for a qualifier of zero or
more.

X+

Indicates a match for one or more qualifiers.

{X, Y}

Indicates a match between X and Y number
of occurrences.

(X|Y) +

Indicates the start of an alternative branch.

?

Indicates an optional match.

For more information about regular expressions, see the Perl Compatible
Regular Expression (PCRE) library package: http://
regexkit.sourceforge.net/Documentation/pcre/pcrepattern.html
occurs Checks that the source value occurs the number of times specified by the
reference data This check computes aggregations on the source data and
can take longer to run than other checks that evaluate only one record.
source-data OCCURS reference-data

For example, the value John might appear 50 times in the firstname
column. If the rule logic is written as firstname occurs <100, you bind the
column firstname with the literal John, records with "John" in the firstname
column meet the conditions of the rule logic.
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The possible operators are:
v occurs
v occurs>
v occurs>=
v occurs<
v occurs<=
unique
Checks that the source data value occurs only once. This check computes
aggregations on the source data and can take longer to run than other
checks that evaluate only one record.
source-data unique

Functions for rule logic
Use functions to specify operations in rule logic.

Date and time functions
date() Returns the system date from the computer as a date value.
For example, to find records that contain shipment dates that are not more
than a year old and not later than today's date:
dateCol > date()-365 and dateCol < date()
To find records in which sales activity occurred in the last week:
IF (date_of_sale > date() - 7) )
datevalue(string, format)
Converts the string representation of a date into a date value, where:
v string is the string to convert into a date.
v format is a string that defines how the date is represented in string. The
format variable uses the following syntax and must be enclosed in single
quotation marks:
– %dd is the two-digit day (01-31).
– %mm is the two-digit month (01-12).
– %mmm is the three-character month abbreviation, for example, Jan,
Feb, Mar.
– %yy is the two-digit year (00-99).
– %yyyy is the four-digit year (nn00-nn99).
If you do not specify a format, the function uses the default format
%yyyy-%mm-%dd.
For example, to find records in which the billing date is not older than 365
days from today:
datevalue(billing_date,’%yyyy%mm%dd’) > date()-365.
To find all records in which the billing date is later than
01/01/2000:billing_date > datevalue(’2000-01-01’)
Important: In the previous example, billing_date in this case should be a
string column containing values representing dates in the following format
%yyyy%mm%dd (ex: 20110606 for 06/06/2011)
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day(date)
Returns a number that represents the day of the month for the date value
that you specify. The parameter of day(date) must be a date.
For example, to find orders that were placed on the first day of the
month:day(sales_order_date) =1
month(date)
Returns a number that represents the month for the date value that you
specify.
For example, to ensure that the month of the billing date is
valid:month(billing_date) >= 1 and month(billing_date) <= 12
weekday(date)
Returns a number that represents the day of the week for the date value
that you specify. Sunday is 1; Monday is 2; and so on.
For example, to check that the total number of sales orders that you receive
on Sunday are greater than 1000:If weekday(sales_date) = 1 then
count(sales_order_id) > 1000
year(date)
Returns a number that represents the year for the date value that you
specify.
For example, to verify that applicants have birth dates between 1950 and
1955:year(date_of_birth) > 1950 AND year(date_of_birth) < 1955
time() Returns the system time from the computer as a time value.
For example, to find all sales transactions that occurred in the last hour: .IF
( time_of_sale > time() - 4 )
timevalue(string, format)
Converts the string representation of a time into a time value, where:
v string is the string to convert into a time.
v format is a string that defines how the time is represented in string. The
format variable uses the following syntax and must be enclosed in single
quotation marks:
– %hh is the two-digit hour (00-23).
– %nn is the two-digit minute (00-59).
– %ss is the two-digit second (00-59).
– %ss.n is the two-digit millisecond (00-59), where n is a fractional digit
(0-6).
If you do not specify a format, the function uses the default format
%hh:%nn:%ss.
For example, to confirm that the check-in time for guests at a hotel is later
than 11 AM:check_in_time > timevalue(’11:00:00’)
timestampvalue(value, format)
Converts the string representation of a time into time stamp value, where:
v string is the string to convert into a time stamp value.
v format is a string that defines how the time stamp is represented in
string. The format variable uses the following syntax and must be
enclosed in single quotation marks:
– %dd is the two-digit day (01-31).
– %mm is the two-digit month (01-12).
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– %mmm is the three-character month abbreviation, for example, Jan,
Feb, Mar.
– %yy is the two-digit year (00-99).
– %yyyy is the four-digit year (nn00-nn99).
– %hh is the two-digit hour (00-23).
– %nn is the two-digit minute (00-59).
– %ss is the two-digit second (00-59).
– %ss.n is the two-digit millisecond (00-59), where n is a fractional digit
(0-6).
If you do not specify a format, the function uses the default format
%yyyy-%mm-%ddhh:%nn:%ss.
timestamp()
Returns the system time from the computer as a time value.
hours(time)
Returns a number that represents the hour for the time value that you
specify.
minutes(time)
Returns a number that represents the minutes for the time value that you
specify.
seconds(time)
Returns a number that represents the seconds and milliseconds for the time
value that you specify.
datediff(date1, date2)
Returns the number of days between two dates, where date1 is the earlier
date and date2 is the later date.
For example, to determine the number of days between the billing date
and the payment date: datediff(pay_date, bill_date)
timediff(time1, time2)
Returns the difference in hours, minutes, and seconds difference between
two times, where time1 is the earlier time and time2 is the later time.
For example, to determine the amount of time between the start and end
of a task: timediff(end_time, start_time).

Mathematical functions
abs(value)
Returns the absolute value of the value that you specify. For example,
ABS(-13) returns 13.
For example, to determine if the sale price is less than $100:
abs(price1-price2)<100
avg(value)
An aggregate function that returns the average of all values in a numeric
column. You can optionally specify a grouping column as a second
parameter.
For example, avg(age) will compute the mean value of all values in the
column age avg. (age, gender) will compute the mean value for the
values of the age column grouped by gender (you will get the mean value
for the male and the mean value for the female as two distinct values).
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exp(value)
Returns the exponential value of a numeric value.
max(value)
An aggregate function that returns the maximum value in a numeric
column. You can optionally specify a grouping column as a second
parameter.
min(value)
An aggregate function that returns the minimum value in a numeric
column. You can optionally specify a grouping column as a second
parameter.
sqrt(value)
Returns the square root of a numeric value.
standardize(col, group)
Returns a numeric value into a number of standard deviation above or
under the average value of the column. The group parameter is optional
and can be used to specify a grouping key. Use the standardize function
instead of using this function: (col-avg(col, group))/stddev(col, group).
For example, to determine which employees have salaries that deviate
from the company average. The outliers are defined to be values that are
above the average value plus three times the standard deviation: salary <
avg(salary)+3*stddev(salary)).
sum(value, group)
An aggregate function that specifies the optional grouping column, such as
for all other aggregation functions

General functions
coalesce(value, nullValueReplacement)
Replaces null values with a specified replacement value.
nullValueReplacement.
For example, to replace null values in a column of department codes with
the string 'undefined': coalesce(code, ’undefined’).
count(column)
An aggregate function that provides a count of the number of distinct
values in the whole column or in the groups if a grouping key is specified.
count(column, groupBy)
An aggregate function that returns the number of rows or values in each
group of rows defined by the column groupBy.
lookup(value, keyRefCol, valRefCol)
Replaces a key value with a corresponding value from a lookup table,
where:
v value is the key value to look up.
v keyRefCol is the column of the lookup table that contains all of the key
values.
v valRefCol is the column of the lookup table that contains the replacement
values that correspond to the key values.
This function is generally used in systems where internal codes represent
values that appear in many places within the data sources.
For example, a customer table contains a column that represents the
country where the customer lives. Instead of storing the country name in
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the column (for example, Germany), your company stores a country code
(for example, 100) that represents the country. A corresponding lookup
table contains a column for the country codes and a column for the
country names. To write a rule that uses the lookup function to find all the
French customers in your data source that have a 10-digit phone number:
If lookup(country, countrycodes, countrynames)=’France’ then phone
matches_format ’99.99.99.99.99’

String functions
ascii(char)
Returns the ASCII character set value for a character value.
For example, to search for all records where the code column contains an
entry that begins with a non-printable character: ascii(code)<32
char(asciiCode)
Returns the localized character value for an ASCII character.
For example, to convert the ASCII character code 35 to the letter C:
char(35)
convert(originalString, searchFor, replaceWith)
Replaces a substring that occurs in one string with another substring,
where:
v originalString is the string that contains the substring.
v searchFor is the substring to replace.
v replaceWith is the replacement string.
For example, to convert a product code from XX to ABC:
convert(product_code, 'XX’, 'ABC’)
index(string, substring)
Returns the index of the first occurrence of a substring in a string. The
result is a zero-based index, so a zero indicates that the substring was
found at the beginning of a string. Negative one (-1) indicates that the
substring was not found.
lcase(string)
Converts all alphabetic characters in a string to lowercase.
left(string, n)
Returns the first n characters of a string.
len(string)
Returns the length, or total number of characters, in a string.
ltrim(string)
Removes all space characters at the beginning of a string.
pad(string, begin, end)
Adds space characters at the beginning or end of a string, where:
v string is the string to convert.
v begin is the number of spaces to add at the beginning of the string.
v end is the number of spaces to add at the end of the string.
You must specify begin and end characters.
lpad(string, n)
Adds n space characters to the beginning of a string.
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rpad(string, n)
Adds n space characters to the end of a string.
right(string, n)
Returns the last n characters of a string.
rtrim(string)
Removes all spaces characters from the end of a string.
substring(string, begin, length)
Returns a substring from a string, where:
v string is the string.
v begin is a number that represents the first character to retrieve, where 1
is the first character in the string.
v length is the length of the substring to retrieve.
For example, your product codes have a three-character division code,
followed by a six-character department code, followed by a five-character
product ID. You want to return only the department codes:
substring(product_code, 4, 6)
tostring(value, format string)
Converts a value, such as a number, time, or date, into a string. The
optional format string variable specifies the format for the converted string.
If the value to convert is a date, time, or time stamp, specify the format by
using the following syntax, which must be enclosed in single quotation
marks:
v %dd is the two-digit day (01-31).
v %mm is the two-digit month (01-12).
v %mmm is the three-character month abbreviation, for example, Jan, Feb,
Mar.
v %yy is the two-digit year (00-99).
v %yyyy is the four-digit year (nn00-nn99).
v %hh is the two-digit hour (00-23).
v %nn is the two-digit minute (00-59).
v %ss is the two-digit second (00-59).
v %ss.n is the two-digit millisecond (00-59), where n is a fractional digit
(0-6).
If the value to convert is numeric, use the following syntax to specify the
format:
v %i converts the value into a signed decimal integer, such as 123.
v %e converts the value into scientific notation (significand exponent), by
using an e character, such as 1.2345e+2.
v %E converts the value into scientific notation (significand exponent), by
using an E character, such as 1.2345E+2.
v %f converts the value into a floating point decimal value, such as 123.45.
The tag can also contain optional width and precision specifiers, such as
the following:
%[width][.precision]tag

For example, %4.2f.

202

User's Guide

In the case of a numeric value, the format string follows the syntax that is
used by printed formatted data to standard output (printf) in C/C++. For
more information, refer to http://www.cplusplus.com/reference/clibrary/
cstdio/printf/
For example, to convert date values into a string with the format
12/01/2008: tostring(dateCol, ’%mm/%dd/%yyyy’)
trim(string)
Removes all space characters at the beginning and the end of a string.
ucase(string)
Converts all alphabetic characters in a string to uppercase.
val(string)
Converts the string representation of a number into a numeric value.

Publishing rule definitions and rule sets (Data Rules stage)
If you are a rule author, you can publish rule definitions and rule sets.

Procedure
Publish a rule definition or rule set definition by completing one of the following
tasks:
v To publish a single rule definition, select the rule definition, and click Publish >
Rule Definition .
v To publish a rule set definition, add the published rule definitions to the
Selected Rules pane, and if necessary, create any required new rule definitions.
Then click Publish > Rule Set Definition. The rule set definition and the new
rule definitions are published.

What to do next
You can select a published rule in the grid and then edit or copy the published
rule.
v Click Edit to change the published rule information.
v Click Copy to use a published rule as a model for creating rule definitions.
Note: When you create a rule definition using the copy function using a
published rule, the rule definition is not yet published.

Creating a job that uses the Data Rules stage
The Data Rules stage checks data quality anywhere in the job

Setting up a Data Rules stage job
You set up the Data Rules stage in a job by configuring the rules input and output
links.

About this task
Use the InfoSphere Information Analyzer Data Rules Editor to configure the job.
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Important: After you configure the rules job from the Data Rules Editor, do not
change any setting in the DataStage canvas. Otherwise, you might not get the
results from the originally configured settings and the job might fail.

Procedure
1. From the IBM InfoSphere DataStage and QualityStage Designer, open the Data
Quality section of the palette and drag the Data Rules stage to the canvas.
2. Add input links to the Data Rules stage and configure the columns on the
links.
Note: You will have the cleanest workflow if you add the incoming and
outgoing links to the rule stage before configuring it. You need the input link
before you can specify bindings. You need the output link before you can
specify output per link.
To use a rule with variables that must be bound to columns from two different
sources, use a Join stage to join the required columns. Because the columns are
joined, they come into the Data Rules stage from the same input link.
3. Add output links from the InfoSphere DataStage Output > Columns dialog. Do
not use the Output > Columns tab to configure the output columns. Instead,
you use the Data Rules Editor to configure the output of the stage. When you
use the Data Rules Editor to configure the output, you specify type of output to
send to each link: records that meet all rules, records that do not meet one or
more rules, and violation details.

Configuring rules input links (Data Rules stage)
You configure a rule by binding each variable in the rule to an input column or to
a literal value, such as number, date, or time. When the rule runs, the variable is
replaced with the value in the bound column or the literal value, and the rule logic
is evaluated to produce a Boolean result.

Before you begin
Before you configure rules, you can create the input and output links to the Data
Rules stage. The task assumes that you previously published rules, either in the
Data Rules stage or in IBM InfoSphere Information Analyzer .

Procedure
1. Double-click the Data Rules stage.
2. On the Stage > General tab, click Configure Data Rules to open the Data
Rules Editor to the Input tab.
3. In the Published Rule Definitions pane, select one or more rule definitions
and rule set definitions to add to the stage, and click Add to Data Rules Stage.
The Selected Rule Definitions pane lists each rule that you add, and the
Rule Variables pane lists the variables from the selected rules. If you add the
same rule more than once, a number is added to each instance.
4. In the Rule Variables pane:
a. Select a variable.
b. Select the column that contains the actual data for that variable on the
Input Links tab or enter a literal value on the Literal tab.
c. Click Bind to Variable.
Note: You can select multiple rule variables, select the single source column
from the input links tab, and click the bindings for all the selected rule
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variables to be bound to that column. You can do the same to select multiple
literal bindings. The Binding column of the Rule Variables pane lists the
bindings.

Configuring rules output links (Data Rules stage)
Use the Data Rules Editor to configure columns for the output links and to specify
the type of records to send to each link.

Before you begin
Create the output links for the stage before you click Configure Data Rules to
open the Data Rules Editor. However, you do not configure the columns for the
links on the Output > Columns tab of the stage editor. Instead, you configure the
columns on the Output tab of the Data Rules Editor.
Important: After you configure the rules job from the Data Rules Editor, do not
change any setting in the DataStage canvas. Otherwise, you might not get the
results from the originally configured settings and the job might fail.

About this task
As part of the output configuration, you specify the type of records to send to each
link. The record output types include:
v Meets all rules
v Does not meet one or more rules
v Violation details
All columns that you add to the output are passed to both the Meets all rules and
Does not meet one or more rules links. You cannot configure a different set of
columns to pass to each link.
In addition, you can configure one link to receive details about the records that do
not pass one or more rules. This link type contains the details about the rule
violated by each row.

Procedure
1. Double-click the Data Rules stage.
2. Click the Output tab of the Data Rules Editor. By default, every column that is
bound to a rule variable is included in the Selected Output pane.
3. Use the Rule Variables, Input Links, Expressions, and Statistics
and Attributes tabs to add columns to the Selected Output table. When
adding a variable that has been bound to a literal to the Selected Output grid,
the literal value is displayed in the Binding column.
4. If the job includes a link for violation details, consider adding the RecordID
attribute to the output. If you add the RecordID attribute, records that are sent
to the links for the Meets all rules and Does not meet one or more rules
output will contain the ID that is used in the violations output.
Note: The output columns for the Violation Details output type are
pre-defined and cannot be modified. If you select the output link to be this
output type from the Rule Stage editor Output > Columns, the two column
definition are displayed in the grid. You should not change the columns in the
Rule Stage editor.
5. Optional: You can edit the name of any column in the Selected Output list.
Chapter 15. Data Rules stage
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Note: Each column name must be unique. In addition, the name must begin
with an alphabetic character or a dollar sign ($) and contain only alphanumeric,
underscore (_), and dollar sign ($) characters.
6. Optional: Use the Move Up and Move Down buttons to rearrange the order in
which the columns will appear in the downstream stages.
7. In the Output Links pane, select an output type for each link.
8. Click OK to save the configuration, and then click OK to return to the canvas.

Results
You can now compile and run the job.

Statistics for output of the Data Rules stage
You can add statistics and attributes to calculate the number or percentage of rules
that each record meets or does not meet and generate violation details indicating
which particular rules a record does not meet.
Use the Statistics and Attributes tab to add one or more statistics to the output of
the Data Rules stage. The following statistics are available to add to the output:
v Number of Rules Met
v Number of Rules Not Met
v Percentage of Rules Met
v Percentage of Rules Not Met
In addition, the following attributes are available to add to the output:
v Record ID - This attribute contains the internal unique key generated for each
record, which is the same as in the RecordID column of the Violation Details
output. This attribute should be added if you want to join the details of the
violated rules to the RecordID.
v System Date
v System Timestamp
When you add a statistic to the output, the statistic is calculated for each record.
The result is listed in the column that is automatically added to the output of the
Meets all rules link and the Does not meet one or more rules link.
The following example shows the output for the Does not meet one or more rules
link when the Number of Rules Not Met statistic is added to the output. Only the
record for supplier SUP13, which has the record ID 22, failed two rules.
"SupplierID","po","leadtime","RecordID","FailedRules"
"SUP6","Y","","2","1"
"SUP10","","30 DAYS","4","1"
"SUP14","Y","","6","1"
"SUP18","Y","","8","1"
"SUP22","","1 WEEK","10","1"
"SUP5","","15 DAYS","18","1"
"SUP9","Y","","20","1"
"SUP13","","","22","2"

By adding the attribute #FailedRules in the output, a column containing each
record for the number of violated rules is generated, but it does not provide the
information on which rules where violated by each record. If you need this
information, set up an output link with the type Violation Details, which stores
this information in a two-column format, as shown in the next example. Each
record and violated rule pair produces one row containing the internal generated
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key of the violating record (RecordID) and the name of the rule it violates. If a
record violates more than one rule, it produces several rows in this output. Records
that do not violate any rules do not generate any record in this output.
The following example shows typical violations output. In this output, only record
22 failed two rules.
"recordID","ruleID"
"2","LeadTime_Valid"
"4","PO_Valid"
"6","LeadTime_Valid"
"8","LeadTime_Valid"
"10","PO_Valid"
"18","PO_Valid"
"20","LeadTime_Valid"
"22","PO_Valid"
"22","LeadTime_Valid"

If you correlate the output from the Violation Details link with the output from
the Does not meet one or more rules link, you can identify that the record for
SUP13, which is assigned recordID 22, fails both the PO_Valid rule and the
LeadTime_Valid rule. This information is valuable when you want to identify the
records violating the rule in the source dataset. The violation details output lists
only the generated internal key to identify the records. If you want to identify
which record it is (for instance, find the customer ID or the customer name for the
problematic record), you must join this dataset with the dataset from the output
containing the failing records.

Adding calculation results to the output (Data Rules stage)
Create a custom expression to complete a calculation for each record of the output.

About this task
When you configure the output for the Data Rule stage, you can include a custom
expression. A custom expression is a calculation that is completed for each record
of the output. The results of the expression appear in a new column that is added
to the output. For example, in a data set that describes bank customers, you might
have variables col1 and col2 that are bound to the two columns CHECKING and
SAVINGS. To display the total account balance for each customer, you can add a
custom expression output column 'col1 + col2'.

Procedure
1. Double-click the Data Rules stage.
2. From the Output tab of the Data Rules Editor, click Add Custom Expression.
3. Enter the custom expression. Use the option on the Functions tab to add
common functions to the expression. Use the option on the Rule Variables tab
to enter the name of a variable in the expression.
4. Save the expression by clicking OK.
5. To add the expression to the selected output:
a. Click the Expressions tab.
b. Select the expression.
c. Click Add to Output The expression is added to the Selected Output table.
The expression has a default name that is in the format Expressionx where x
is a number.
6. Optional: You can add an expression by using either of the following methods:
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v Click the Edit icon beside the expression name to rename the expression so
that output column that contains the results of the calculation has a
meaningful name. The name must be unique among all output columns. In
addition, the name must begin with an alphabetic character or a dollar sign
($) and contain only alphanumeric, underscore (_), and dollar sign ($)
characters.
v You can also add an expression by using an expression that already exists in
the rule logic. In this case, you only need to select the expression in the
palette and click Add to Output. The expression palette will extract the
individual expressions that it finds in the rule logic. For example, if your rule
logic is AVG(checking,savings) > 300, the expression AVG(checking,savings)
will appear automatically in the Expressions palette. For this example
output, you might want to include columns for CHECKING, SAVINGS, and
ACCOUNTAVERAGE. Without the ability to include the expression in the
output (as ACCOUNTAVERAGE), you can see which records did not have
an average over 300, but you would not have any idea of the differences
(unless you did manual calculation for each record when looking at the
output). If you output the ACCOUNTAVERAGE as a separate value/column,
you can immediately see how far away from 300 the customer was. In fact,
you might want to add a custom expression separately to calculate the
difference using 300-AVG(checking,savings).

Examples of Data Rules stage jobs
These jobs illustrate the use of rules and the Data Rules stage.

Example 1: Data Rules stage job that checks for data
completeness
In this job, two rules validate whether supplier records contain valid purchase
order and lead time information.
A company creates a business rule that defines a complete supplier record. The
record must specify whether a purchase order is required and specify the required
lead time. The data analyst creates data rules to validate whether each supplier
record is complete. The following rules test for valid records.
Table 23. Rules that validate supplier records
Rule name

Rule logic

PO_Valid

PO exists AND PO <> " "

LeadTime_Valid

LeadTime exists ANDLeadTime <> " "

The data analyst wants to analyze any records that fail these rules and view the
details about each rule not met. The job developer creates a job for this purpose. In
the job, the All_Suppliers Sequential File stage uses a source file that contains the
supplier records. These records are passed to the Supplier_Validity Data Rules
stage, named where each record is evaluated for completeness. Records that meet
all rules are sent to the Valid link and passed to the Valid_Suppliers Sequential File
stage. Records that do not meet one or more rules are sent to the Invalid link and
passed to the Invalid_Suppliers Sequential File stage. Two columns are output to
the Invalid_Details link: RecordID and RuleID. The name of each rule that each
record meets all rules is passed to the sequential file stage named Invalid_Details.
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The following figure shows the job before the Data Rule stage is configured. As the
figure indicates, only the input link columns are configured. The output link
columns are configured by using the options on the Data Rules Editor, not by
using the options on the Output > Columns tab on the Data Rules stage itself.

These are the supplier records.
"SupplierID","PO_Required","Lead_Time"
"SUP1","Y","30 DAYS"
"SUP2","N","60 DAYS"
"SUP3","",""
"SUP4","",""
"SUP5","","15 DAYS"
"SUP6","Y",""
"SUP7","Y","15 DAYS"
"SUP8","Y",""
"SUP9","Y",""
"SUP10","","30 DAYS"

On the Input tab of the Data Rules Editor, the two rules are selected. Then the
LeadTime variable is mapped, or bound, to the Lead_Time column. The PO variable
is mapped to the PO_Required column. When the job runs, the values from these
columns replace the variables in the rules.
On the Output tab, the following items are selected. Both the Valid link and the
Invalid link receives the following set of columns.
v po variable
v leadtime variable
v SupplierID column
v Number of Rules Not Met statistic
v Record ID attribute
In the Output Links pane, each output link is mapped to the type of records that
it will receive. The Valid link is mapped to Meets all rules. The Invalid link is
mapped to Does not meet one or more rules. The Exception_Details link is
mapped to Violation Details.
Chapter 15. Data Rules stage
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After the job runs, three output files are created, one for each Sequential File stage.
The file for the valid suppliers contains the following records. The results indicate
that in each record, the PO_Required column contains a Y or an N, and the
Lead_Time column contains an entry.
"po","leadtime","SupplierID","NumberofRuleNotMet","RecordID"
"Y","15 DAYS","SUP7","0","19"
"N","60 DAYS","SUP2","0","0"
"Y","30 DAYS","SUP1","0","16"

The file for invalid suppliers contains the following records that did not meet one
or more rules. The Number of Rules Not Met column indicates the number of rules
that each record did not meet.
"po","leadtime","SupplierID","NumberofRulesNotMet","RecordID"
"","","SUP4","2","1"
"Y","","SUP8","1","3"
"","","SUP3","2","17"
"Y","","SUP6","1","2"
"","30 DAYS","SUP10","1","4"
"","15 DAYS","SUP5","1","18"
"Y","","SUP9","1","20"

The file for the details about each rule that each record failed contains these
records. Because the job output includes the RecordID attribute, the information in
the violations file can be correlated with the information in the invalid records file.
"recordID","ruleID"
"1","LeadTime_Valid"
"1","PO_Valid"
"3","LeadTime_Valid"
"17","LeadTime_Valid"
"17","PO_Valid"
"2","LeadTime_Valid"
"4","PO_Valid"
"18","PO_Valid"
"20","LeadTime_Valid"

The results indicate that in each record, either the PO_Required or the Lead_Time
columns are missing values. In some cases, both values may be missing.

Example 2: Data Rules stage job that verifies values by using
a reference table
In this job, a rule verifies that product records contain a valid category ID that is
listed in a reference table.
A company that sells grocery items requires that each product record contain a
valid category ID to identify the type of product. The data analyst wants to
identify products that do not have a valid category ID. The category IDs are stored
in one file, and the product records are stored in a separate file. The data analyst
writes the following rule, which is named Valid_Category_Test:
category in_reference_column catID

The following figure shows the job that the ETL job developer creates. The Data
Rules stage takes two inputs. The Products Sequential File stage uses a source file
that contains the product records. The Categories Sequential File stage uses a
source file that contains the product category codes. The Data Rule stage links to
one output. The Invalid_Records Sequential File stage contains the output of the
Data Rules stage, which is a list of the records that do not have a valid category
ID.
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The following columns from the supplier records are used as input to the Data
Rules stage:
"ProductID","ProductName","SupplierID","CategoryID"
1,"Chai","SUP1","A1111"
2,"Aniseed Syrup","SUP1","B"
3,"Chef Anton’s Cajun Seasoning","SUP2"," "
4,"Chef Anton’s Gumbo Mix","SUP2","B"
5,"Grandma’s Boysenberry Spread","SUP3","B2111"
6,"Uncle Bob’s Organic Dried Pears","SUP3","7111"
7,"Northwoods Cranberry Sauce","SUP3","B"
8,"Ikura","SUP4","H8111"
9,"Queso Cabrales","SUP5","D4111"
10,"Queso Manchego La Pastora","SUP5","C311"
11,"Konbu","SUP6","H8111"
12,"Tofu","SUP6","G7111"
13,"Genen Shouyu","SUP6","B2111"
14,"Alice Mutton","SUP7","6111"
15,"Teatime Chocolate Biscuits","SUP8","B2111"
16,"Sir Rodney’s Marmalade","SUP8","C3111"
17,"Sasquatch Ale","SUP9","A1"
18,"Mascarpone Fabioli","SUP9","C31"
19,"Gustaf’s Knäckebröd","SUP10","E511"
20,"Rössle Sauerkraut","SUP10","G711"

The following are the categories:
"CategoryID","CategoryName"
"A1111","Beverages"
"
"B2111","Condiments"
"C3111","Confections"
"D4111","Dairy Products"
"E5111","Grains/Cereals"
"F6111","Poultry"
"G7111","Produce"
"H8111","Seafood"
"I9111","Chicken""

The following bindings are created:
v The variable category is bound to Products.CategoryID.
v The variable catID is bound to Categories.CategoryID.
The following output is selected:
v Category rule variable
v ProductName column
Chapter 15. Data Rules stage
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v SupplierID column
The Invalid output link is set to Does not meet one or more rules.
After the job runs, the file for the invalid output contains the following records:
"category","ProductName","SupplierID"
" ","Chef Anton’s Cajun Seasoning","SUP2"
"6111","Alice Mutton","SUP7"
"7111","Uncle Bob’s Organic Dried Pears","SUP3"
"A1","Sasquatch Ale","SUP9"
"B","Northwoods Cranberry Sauce","SUP3"
"B","Aniseed Syrup","SUP1"
"B","Chef Anton’s Gumbo Mix","SUP2"
"C31","Mascarpone Fabioli","SUP9"
"C311","Queso Manchego La Pastora","SUP5"
"E511","Gustaf’s Knäckebröd","SUP9"
"G711","Rössle Sauerkraut","SUP10"

Example 3: Data Rules stage job that uses a Join stage to
produce analysis results
In this job, a rule tests supplier records for purchase order information. The
supplier records that do not meet the rule are joined with a list of products to
produce a list of products that are at risk because the supplier does not have
purchase order information.
Because the supplier list is in one file and the product list is in another file, the job
requires a Join stage to join the records on the Supplier ID.
In the job, the Suppliers Sequential File stage points to a file that contains the
supplier records. The Products Sequential File stage uses a source file that contains
the product records. The Data Rules stage, named Valid_PO_Test, uses the rule
named PO_Valid to test whether each supplier record contains purchase order
information. The Valid_PO rule has the following syntax:
PO exists AND PO <> " "

The supplier records that fail the rule because they lack valid purchase order
information, are sent as output from the Data Rules stage to the Join stage named
Join_on_Supplier_ID. In the Join_on_Supplier_ID Join stage, the SupplierID field is
used as a join key for an inner join. The output of the Join stage is a list of
products that are at risk because the supplier record lacks purchase order
information.
The following figure shows the job that the ETL job developer creates.
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The following input lists the supplier records:
"SupplierID","PO_Required","Lead_Time"
"SUP1","Y","30 DAYS"
"SUP2","N","60 DAYS"
"SUP3","",""
"SUP4","",""
"SUP5","","15 DAYS"
"SUP6","Y",""
"SUP7","Y","15 DAYS"
"SUP8","Y",""
"SUP9","Y",""
"SUP10","","30 DAYS"

The following columns from the product records are used as input to the Join
stage:
"ProductID","ProductName","SupplierID"
1,"Chai","SUP1","A1111"
2,"Aniseed Syrup","SUP1"
3,"Chef Anton’s Cajun Seasoning","SUP2"
4,"Chef Anton’s Gumbo Mix","SUP2"
5,"Grandma’s Boysenberry Spread","SUP3"
6,"Uncle Bob’s Organic Dried Pears","SUP3"
7,"Northwoods Cranberry Sauce","SUP3"
8,"Ikura","SUP4"
9,"Queso Cabrales","SUP5"
10,"Queso Manchego La Pastora","SUP5"
11,"Konbu","SUP6"
12,"Tofu","SUP6"
13,"Genen Shouyu","SUP6"
14,"Alice Mutton","SUP7"
15,"Teatime Chocolate Biscuits","SUP8"
16,"Sir Rodney’s Marmalade","SUP8"
17,"Sasquatch Ale","SUP9"
18,"Mascarpone Fabioli","SUP9"
19,"Gustaf’s Knäckebröd","SUP10"
20,"Rössle Sauerkraut","SUP10"

By running the job, the following products are identified as at risk:
"ProductID","ProductName","SupplierID"
5,"Grandma’s Boysenberry Spread","SUP3"
6,"Uncle Bob’s Organic Dried Pears","SUP3"
7,"Northwoods Cranberry Sauce","SUP3"
8,"Ikura","SUP4"
9,"Queso Cabrales","SUP5"
10,"Queso Manchego La Pastora","SUP5"
19,"Gustaf’s Knäckebröd","SUP10"
20,"Rössle Sauerkraut","SUP10"
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Chapter 16. Developing applications with the HTTP API
A Hypertext Transfer Protocol (HTTP) application programming interface (API) is
provided with IBM InfoSphere Information Analyzer. You can develop applications
with this API to access and analyze InfoSphere Information Analyzer content.

HTTP API overview
You use the IBM InfoSphere Information Analyzer HTTP (Hypertext Transfer
Protocol) API (application programming interface) to develop client applications
that can access and author InfoSphere Information Analyzer content.
The HTTP API makes many tasks that you can perform by using InfoSphere
Information Analyzer available as HTTP URLs. You can use some of the URLs to
query information from InfoSphere Information Analyzer and use others to modify
project content stored in InfoSphere Information Analyzer data stores. Most of the
HTTP URLs use XML documents to exchange data. XML schemas that reside on
the server on which InfoSphere Information Analyzer is installed define the
structure of the XML documents. Each task consists of an HTTP request and
response.

Read API component
By using the read capabilities of the HTTP API, you can make InfoSphere
Information Analyzer content available in other applications. For example, you can
retrieve results of analysis tasks, such as column analysis or data rules executions
by using an HTTP API. You can then process the results by using another
application to create reports. You can use data about an analysis project that was
retrieved by using the HTTP API as a starting point for creating a template for
similar projects.

Write API component
With the write capabilities of the HTTP API, you can integrate the authoring of
InfoSphere Information Analyzer content with another application. For example, a
business analyst can use an HTTP API to automatically translate business rules to
the database level and put them into InfoSphere Information Analyzer. Templates
obtained by using the read capabilities of the HTTP API can be adapted to data
sources of a new project, added to a project by using the HTTP API, and you can
run analysis within InfoSphere Information Analyzer.

User roles and viewing permissions
The InfoSphere Information Analyzer HTTP API enforces the same user roles that
are defined in InfoSphere Information Analyzer. Viewing permissions for particular
categories for each user or user group, as set by the InfoSphere Information
Analyzer Administrator, are also enforced. You can restrict the type of content
available to users by allowing access only to certain asset types in your application
code.
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Using the HTTP resource URLs and commands
You can add data sources to IBM InfoSphere Information Analyzer projects,
perform data analysis tasks from client applications, retrieve analysis results, define
and run data rules, and retrieve data rule results, by using the Hypertext Transfer
Protocol (HTTP) application programming interface (API).
An HTTP API provides a way to control InfoSphere Information Analyzer
operations based on HTTP requests. The HTTP-based API allows you to integrate
InfoSphere Information Analyzer operations with other vendors' products.
You run the HTTP API by sending HTTP GET, POST, and DELETE requests to IBM
InfoSphere Information Server.
The general differences between GET and POST commands include:
GET requests
v The GET command is typically used to retrieve information.
v The parameters are contained in the request URL.
POST requests
v The POST command is typically used to send and persist information.
v Parameters are embedded in the body of the request in form of an XML
string.
HTTP API requests can be sent from any kind of system, including computers and
mobile devices, by using any kind of language or script. After an HTTP API is
available, you can build other APIs for special languages or environments, such as
a Java API, a C API, a Python API, or a command line interface (CLI) by building
a thin wrapper around the HTTP API.
By using HTTP API operations, you can deploy ready-to-use templates to automate
the creation of projects, data analysis tasks, and the retrieval of analysis results.

Examples
You can prepare a data quality project template that is based on past projects, and
deploy all the data rules that are defined in this template automatically for a new
customer project.
Note: You might have to adapt the template for a different data structure in the
new project.
You can use the API to control Information Analyzer from a third party application
(for example, a business tool or a web portal) without having to use the InfoSphere
Information Analyzer client.
You can generate customized reports by using the API to retrieve the information
in XML format and use XSLT style sheets to produce a report in the required
format

HTTP API resources
IBM InfoSphere Information Analyzer supports a set of APIs that are implemented
by using HTTP (Hypertext Transfer Protocol) Services. The HTTP resource URLs

216

User's Guide

are a set of HTTP commands that represent the different entities and operations
that are supported by InfoSphere Information Analyzer.

Resource URLs
Typically, you use the HTTPS resource URL instead of HTTP. The format of each
HTTPS resource URL is:
https://{host}:{port}/InformationAnalyzer/{anyCommand}?{query}

where:
v https://{host}:{port} is the host address and port
v {anyCommand} represents the command that you want to issue
v {query} is the query string (required by some of the resources)
Note: If HTTPS is not enabled on the server, the URL would read "HTTP" instead
of "HTTPS." Typically, the port for HTTPS is 9443, and for HTTP is 9080.
To retrieve a list of rule definitions for the project IATest with HTTPS enabled, use
this example:
https://myserver.com:9443/InformationAnalyzer/ruleDefinitions?projectName=IATest

To retrieve a list of rule definitions for the project IATest using the HTTP resource
URL, use this example:
http://myserver.com:9080/InformationAnalyzer/ruleDefinitions?projectName=IATest

HTTP methods
The InfoSphere Information Analyzer HTTP interface uses the following HTTP
methods:
v POST - create or update a resource
v GET - read a resource
v DELETE - delete a resource
Not all resources support all HTTP methods.

Content types
The data sent or returned by the HTTP methods has application/xml content type,
with UTF-8 encoding. The schema that defines each XML resource is accessible on
the IBM InfoSphere Information Server host in the following location:
ASBServer/docs/IA/schema

You can locate the XSD (XML Schema Definition) files for the client in the
following location:
ASBNode/docs/IA/schema

Content localization
All content is UTF-8 encoded. In particular:
v The XML requests and responses
v Parameters that are passed in the query string of a resource can have any
encoding, but if the parameter values passed in the URL are using a non
latin-codepage (for example if the values contain double bytes characters
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encoded in UTF-8), the value must be URL encoded by using the right
codepage, and additionally the codepage must be specified in the header of the
HTTP request, by setting the Content-Type header to text/plain; charset=utf8 (if
UTF-8 is used).
v Dates are in the format yyyy-MM-ddTHH:mm:ss. This is the date/timestamp
returned by the InfoSphere Information Server that is running InfoSphere
Information Analyzer.
Tips:
– You must separate the date and time with the letter "T".
– To optionally specify a time zone, you can add a "z" after the time (for
example, <startdate>2010-05-30T09:30:10z</startdate>.

Error handling
For errors recognized during processing of an InfoSphere Information Analyzer
HTTP request, an appropriate HTTP status code is returned to the calling client
(For example: 200 OK or 404 Not Found).
Additional error information is provided depending on the error type. For severe
errors (HTTP status code 500 Internal Server Error), additional details are
returned. In addition to the relevant status code, the Error resource is returned
with any error (as the body of the response).

Security consideration
The credentials of users must be set in the HTTP request.

DELETE executableRule command: Deleting data rules
Delete a data rule by using the HTTP API.

Command
DELETE executableRule

Purpose
Use this command to delete data rules that you want to remove from your
computer.

Parameters
projectName
The name of the project that contains the data rules that you want to delete.
ruleName
The name of the data rules that you want to delete. To delete more than one
data rule, use a comma to separate the names. Put data rules that have names
that contain commas between quotation marks.
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Available HTTP methods
Table 24. HTTP API for deleting data rules
HTTP method

URI pattern

Data format

Success code

Error codes

DELETE

executableRule

XML

200

400 (bad request)
or 500 (server
error)

DELETE executable rule example
The following example shows how to delete the data rule myRule from the project
myProject on the server myServer:
DELETE http://myserver:9080/InformationAnalyzer/executableRule?projectName
=myProject&ruleName=myRule

DELETE metric command: Deleting metrics
Delete a metric by using the HTTP API.

Command
DELETE metric

Purpose
Use this command to delete one or more metrics from a project.

Parameters
projectName
The name of the project that contains the metrics to delete.
metricName
The name of the metric to delete, or a comma-separated list of metrics to
delete. If a metric name contains a comma, put double quotation marks around
the metric name.

Available HTTP methods
Table 25. HTTP API for deleting metrics
HTTP method

URI pattern

Data format

Success code

Error codes

DELETE

metric

XML

200

400 (bad request)
or 500 (server
error)

DELETE metric example
The following example shows how to delete the data rule myRule from the project
myProject on the server myServer:
DELETE http://myserver:9080/InformationAnalyzer/metric?projectName=
myProject&metricName=myMetric

Note: The DELETE request is issued within an HTTP request that is sent within a
Java program to the HTTP API server.
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DELETE project command: Deleting a project
Delete a project by using the HTTP API.

Command
DELETE project

Purpose
Use this command to delete a project that you want to remove from your
computer.

Parameters
projectName
The name of the project that you want to delete. To delete more than one
project, separate the project names with commas. If the project name contains a
comma, a space or spaces, or other special characters, enclose the project name
in quotation marks.

Available HTTP methods
Table 26. HTTP API for deleting a project
HTTP method

URI pattern

Data format

Success code

Error codes

DELETE

project

XML

200

400 (bad request)
or 500 (server
error)

DELETE project example
The following example shows how to delete the project project1 on the server
myserver:
DELETE http://myserver:9080/InformationAnalyzer/project?projectName=project1

DELETE publishedResults command: Deleting published
analysis results
Delete published analysis results for a project’s table by using the HTTP API.

Command
DELETE publishedResults

Purpose
You can use this command to delete the published analysis results of tables of a
project.

Parameters
projectName
The name of the project that contains the table whose published analysis
results are to be deleted.
tableName
The name of the tables whose published analysis results should be deleted.
The names must be fully qualified (DATASOURCE.SCHEMA.TABLE). The
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published analysis results of several columns can be retrieved in one operation
by providing a comma separated list of table names and/or using wildcards *.

Available HTTP methods
Table 27. HTTP API for deleting a project
HTTP method

URI pattern

Data format

DELETE

publishedResults XML

Success code

Error codes

200

400 (bad request)
or 500 (server
error)

DELETE published results example
The following example shows how to delete the project project1 on the server
myserver:
DELETE http://myserver:9080/InformationAnalyzer/publishedResults?projectName
=myProject&tableName=myTable

Note: The DELETE request is issued within an HTTP request that is sent within a
Java program to the HTTP API server.

DELETE publicRule command: Deleting published data rule
and rule set definitions
Delete a published data rule and rule set definition by using the HTTP API.

Command
DELETE publicRule

Purpose
Use this command to delete published data rule and rule set definitions that you
want to remove from the server.

Parameters
ruleName
The name of the rule or rule set definitions that you want to delete. To delete
more than one rule or rule set definitions, use a comma to separate the names.
Put data rule definitions that have names that contain commas between
quotation marks.

Available HTTP methods
Table 28. HTTP API for deleting data rule definitions
HTTP method

URI pattern

Data format

Success codes

Error codes

DELETE

publicRule

XML

200

400 (bad request)
or 500 (server
error)

DELETE public rule example
The following example shows how to delete the project project1 on the server
myserver:
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DELETE http://myserver:9080/InformationAnalyzer/publicRule?ruleName=myMetric

Note: The DELETE request is issued within an HTTP request that is sent within a
Java program to the HTTP API server.

DELETE ruleDefinition command: Deleting data rule
definitions
Delete a data rule definition by using the HTTP API.

Command
DELETE ruleDefinition

Purpose
Use this command to delete data rule definitions that you want to remove from
the server.

Parameters
projectName
The name of the project that contains the data rule definitions that you want to
delete.
ruleName
The name of the data rule definitions that you want to delete. To delete more
than one data rule definition, use a comma to separate the names. Put data
rule definitions that have names that contain commas between quotation
marks.

Available HTTP methods
Table 29. HTTP API for deleting data rule definitions
HTTP method

URI pattern

Data format

Success codes

Error codes

DELETE

ruleDefinition

XML

200

400 (bad request)
or 500 (server
error)

DELETE data rule definition example
The following example shows how to delete the data rule definition myRule from
the project myProject on the server myServer:
DELETE http://myServer:9080/InformationAnalyzer/ruleDefinition?projectName
=myProject&ruleName=myRule

Note: The DELETE request is issued within an HTTP request that is sent within a
Java program to the HTTP API server.

GET columnAnalysis/results command: Getting column
analysis results
Retrieve column analysis results by using the HTTP API.

Command
GET columnAnalysis/results
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Parameters
projectName
The name of the project that contains the columns that you want to retrieve
column analysis results for.
columnName
The name of the column that you want to retrieve column analysis results for.
To retrieve analysis results for more than one column, use a comma to separate
the list of column names. The names must be fully qualified
(DATASOURCE.SCHEMA.TABLE.COLUMN) and you can use the asterisk
character (*) as a wildcard. The wildcard retrieves all columns of a table,
schema or database.

Available HTTP methods
Table 30. HTTP API for getting column analysis results table
HTTP method

URI pattern

Data format

Success code

Error codes

GET

columnAnalysis/
results

XML

200

400 (bad
request) or 500
(server error)

GET columnAnalysis/result example
The following example shows how to get the column analysis results for the
columns of the table TABLE1 of the schema SCHEMA1 or the data source
SOURCE1 of the project project1:
GET http://myserver:9080/InformationAnalyzer/columnAnalysis/results?projectName=
project1&columnName=SOURCE1.SCHEMA1.TABLE1.*

GET columnAnalysis/result return value example
The following example shows the return value for getting column analysis results:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="TABLE1">
<Column name="COL1">
<ColumnAnalysisResults>
<RuntimeMetadata sampleUsed=”true” whereClause=”GENDER=’M’”
analysisDate=”2010-02-09T18:56:31+01:00”
runTime=”120”>
<SampleOptions type=”RANDOM” percent=”0.10” size=”100”/>
</RuntimeMetadata>
<Cardinality count=”1000” percent=”1.0”
inferredCardinalityType=”UNIQUE”
definedCardinalityType=”NOT_CONSTRAINED”
selectedCardinalityType=”UNIQUE”/>
<DataType definedType=”STRING” definedLength=”128”
inferredType=”STRING” inferredLength=”32”
selectedType=”STRING” selectedLength=”32”
definedNullability=”true” inferredNullability=”true”
selectedNullability=”true”
definedIsEmpty=”false” inferredIsEmpty=”false”
selectedIsEmpty=”false”
inferredIsConstant=”false” definedIsConstant=”false”/>
<DataClass classificationDate=”2010-02-09T18:56:31+01:00”
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classificationStatus=”REVIEWED”
inferredClass=”Code”
selectedClass=”Code”/>
<Format analysisDate=”2010-02-09T18:56:31+01:00”
analysisStatus=”REVIEWED” generalFormat=”AAAA”
generalFormatPercent=”0.95”/>
<CompletenessAnalysis analysisDate=”2010-02-09T18:56:31+01:00”
analysisStatus=”REVIEWED”/>
<DomainAnalysis analysisDate=”2010-02-09T18:56:31+01:00”
analysisStatus=”REVIEWED”/>
</ColumnAnalysisResults>
</Column>
<Column name="COL2">
<ColumnAnalysisResults>
(...)
</ColumnAnalysisResults>
</Column>
</Table>
</Schema>
</DataSource>
</DataSources>
</iaapi:Project>

GET columnAnalysis/frequencyDistribution command:
Retrieving the frequency distribution of a column
Retrieve the frequency distribution of a column by using the HTTP API.

Command
GET columnAnalysis/frequencyDistribution

Purpose
The purpose of this command is to return the frequency distribution for specified
columns.

Parameters (required)
projectName
The name of the project that contains the columns.
columnName
The name of the columns for which you want to retrieve the frequency
distribution. The names must be fully qualified, for example,
"DATASOURCE.SCHEMA.TABLE.COLUMN." You can retrieve the frequency
distributions of several columns in one operation by providing a
comma-separated list of column names, or by using wildcard characters. For
example, DATASOURCE.SCHEMA.TABLE.* retrieves the results for all columns
of the table TABLE, in the schema SCHEMA of the database DATASOURCE.
DATASOURCE.SCHEMA.*.* retrieves all results for all columns of all tables of
the schema SCHEMA in the database DATASOURCE.

Parameters (optional)
maxNbOfValues
The maximum number of values to retrieve. By default all values will be
retrieved
startIndex
The index is 1-based, meaning 1 being the index of the first value. This option
can be used by applications that present the values in pages and load one page
at a time.
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ordering
The order of the values to retrieve. The value can be "ascendingFrequencies,"
"descendingFrequencies," "ascendingValues," or "descendingValues." The
ordering value that you specify controls the sort order of the returned value.

Available HTTP methods
Table 31. HTTP API for retrieving the frequency distribution of a column
HTTP method

URI pattern

GET

columnAnalysis/
frequencyDistribution

DATA
format

Success
code

XML

200

Error codes
400 (bad
request) or
500 (server
error)

GET columnAnalysis/frequencyDistribution example
The following example shows how to get the frequency distribution for column
COL1 of the table TABLE1 of the schema SCHEMA1 of the data source SOURCE1
of the project project1 on the server myServer::
GET http://myserver:9080/InformationAnalyzer/columnAnalysis/frequencyDistribution
?projectName=project1&columnName=SOURCE1.SCHEMA1.TABLE1.COL1

GET columnAnalysis/frequencyDistribution return value example
The following example shows the return value for retrieving the frequency
distribution of a column:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="name="TABLE1">
<Column name="COL1">
<ColumnAnalysisResults>
<FrequencyDistribution nbOfDistinctValues=”50”>
<Value frequency="150" percent="0.15">0</Value>
<Value frequency=”25” percent=”0.025”>Value1</Value>
<Value frequency=”1” percent=”0.001”>Value2</Value>
<Value frequency=”1” percent=”0.001”>Value3</Value>
<Value frequency=”1” percent=”0.001”>Value4</Value>
<Value frequency=”1” percent=”0.001”>Value5</Value>
<Value frequency=”1” percent=”0.001”>Value6</Value>
<Value frequency=”1” percent=”0.001”>Value7</Value>
<Value frequency=”1” percent=”0.001”>Value8</Value>
<Value frequency=”1” percent=”0.001”>Value9</Value>
<Value frequency=”1” percent=”0.001”>Value10</Value>
(...)
</FrequencyDistribution>
</ColumnAnalysisResults>
</Column>
</Table>
</Schema>
</DataSource>
</DataSources>
</iaapi:Project>
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GET copyPublicRule command: Copying published data rule
or rule set definitions
Copy a public rule or rule set definition by using the HTTP API.

Command
GET copyPublicRule

Purpose
Use this command to copy a published rule or rule set definition to an existing
project. You can rename the rule or rule set definition.

Parameters
ruleName
The name of the public rule or rule set definition that you want to copy in the
project. To retrieve more than one rule or rule set definitions, use a comma to
separate the names. Put data rule definitions that have names that contain
commas between quotation marks.
projectName
The name of the target project where the public rule should be copied to.
newRuleName
The new name of the rule or rule set definitions in the project

Available HTTP methods
Table 32. HTTP API for getting a public rule or rule set definition to copy in a project
HTTP method

URI pattern

Data format

Success codes

Error codes

GET

copyPublicRule

XML

200

400 (bad request)
or 500 (server
error)

GET a copy of a published data rule or rule set definition
example
GET http://myserver:9080/InformationAnalyzer/copyPublicRule?ruleName
=dataRuleDefintion&projectName=project1&newRuleName
=dataRuleDefintionCopy

GET publicRule command: Getting the content of published
data rule and rule set definitions
Get the content of published data rule and rule set definitions by using the HTTP
API.

Command
GET publicRule

Purpose
You can use this command to get the content of published data rule and rule set
definitions.
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Parameters
ruleName
The name of the data rule definition or rule set definition that you want to
retrieve. To retrieve more than one data rule definition or rule set definition at
a time, use a comma to separate the names. Put data rule definitions or rule set
definitions that have names that contain commas between quotation marks.

Available HTTP methods
Table 33. HTTP API for retrieving content of a published data rule
HTTP method

URI pattern

Data format

Success codes

Error codes

GET

publicRule

XML

200

400 (bad request)
or 500 (server
error)

GET the content of a published data rule definition example
The following XML string retrieves a data rule definition:
GET publicRule?ruleName=age

GET the content of a published rule set definition example
The following XML string retrieves a published rule set definition:
GET publicRule?ruleName=ruleset

GET ruleDefinition and GET executableRule commands:
Getting the content of validity benchmarks assigned to data
rules, rule sets, and their definitions
Get the content of validity benchmarks assigned to data rules, rule sets, and their
definitions by using the HTTP API.

Command
GET ruleDefinition
GET executableRule

Purpose
You can use this command to get the content of validity benchmarks assigned to
data rules, rule sets, and their definitions.

Parameters
projectName
The name of the project containing the rules, rules sets, and their definitions to
be retrieved.
ruleName
The name of the data rule, rule set, and their definitions that you want to
retrieve. To retrieve more than one rule, rule set, and their definitions at a time,
separate the names with commas. If the name contains a comma, enclose the
name with quotation marks.
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GET the validity benchmarks assigned to data rules, rule sets,
and their definitions example
The following XML string retrieves a rule that contains ValidityBenchmark
elements:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<DataSources>
(...)
</DataSources>
<DataRuleDefinitions>
<DataRuleDefinition name="AccountID_Unique_Def">
<ExecutableRules>
<ExecutableRule name="AccountID_Unique">
<description>Account ID must be unique.</description>
<OutputDefinition type="FailingRecords">
<OutputColumn name="Account_ID" type="variable" value="account_id”/>
</OutputDefinition>
<Bindings>
<Binding var="account_id"><Column name="BANK.BANK_SCHEMA.ACCOUNTS"/>
</Binding>
</Bindings>
<Benchmarks>
<ValidityBenchmark metric=”percent_met” operator=”greater_than”
value=”0.99”/>
</Benchmarks>
</ExecutableRule>
</ExecutableRules>
<Benchmarks>
<ValidityBenchmark metric=”nb_not_met” operator=”less_than” value=”5”/>
</Benchmarks>
</DataRuleDefinition>
(...)
</DataRuleDefinitions>
(...)
</DataRuleDefinitions>
<Metrics>
(...)
</Metrics>
</iaapi:Project>

GET crossDomainAnalysis/results command: Retrieving the
results of foreign-key and cross-domain analysis
Get the results of foreign-key and cross-domain analysis by using the HTTP API.

Command
GET crossDomainAnalysis/results

Purpose
You can use this command to identify columns that have common domain values.

Parameters
projectName
The name of the project that contains the tables that have been analyzed.
columnName
A comma separated list of column names whose cross-domain analysis results
should be retrieved. The names must be fully qualified
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(DATASOURCE.SCHEMA.TABLE.COLUMN) and * wildcards can be used to
include all columns of table or a schema.
percentOverlapThreshold
Minimum percentage of overlap that overlap candidate pairs must be retrieved
either in the direction from base to paired or vice versa.

Available HTTP methods
Table 34. HTTP API for retrieving content of a published data rule
HTTP method

URI pattern

Data format

Success codes

Error codes

GET

crossDomain
Analysis

XML

200

400 (bad request)
or 500 (server
error)

GET crossDomainAnalysis/results example
The command to retrieve a list of key candidates is:
GET crossDomainAnalysis/results?projectName=projectName&columnName
=BANK.BANK_SCHEMA.BANK_CLIENTS.CLIENT_ID

GET crossDomainAnalysis/results return value example
The following example shows the return value for getting a list of key candidates:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<OverlapCandidate baseColumn="myDataStore.mySchema.myTable.myColumn"
pairedColumn="myDataStore.mySchema.myTable.myColumnPair"
absolutePairedToBase="2631"
percentPairedToBase="99.0"
absoluteBaseToPaired="2631"
percentBaseToPaired="19.0"
date="11/5/2009 3:04:00 PM"/>
</iaapi:Project>

GET ruleDefinition and GET executableRule commands:
Getting data rules, rule sets, and their definitions to add or
modify validity benchmarks
Get data rules, rule sets, and their definitions to which you want to add or modify
validity benchmarks by using the HTTP API.

Command
GET ruleDefinition
GET executableRule

Purpose
You can use this command to get data rules, rule sets, and their definitions to
which you want to add or modify validity benchmarks.

Parameters
projectName
The name of the project containing the rules, rules sets, and their definitions to
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be retrieved. The XML document follows the same syntax as for the creation of
new validity benchmarks, but only the attributes that you want to update must
be specified.
ruleName
The name of the data rule, rule set, and their definitions that you want to
retrieve. To retrieve more than one rule, rule set, and their definitions at a time,
separate the names with commas. If the name contains a comma, enclose the
name with quotation marks.

GET data rules, rule sets, and their definitions to which you want
to add or modify validity benchmarks example
The following XML string retrieves a rule that contains <ValidityBenchmark>
elements:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<DataSources>
(...)
</DataSources>
<DataRuleDefinitions>
<DataRuleDefinition name="AccountID_Unique_Def">
<ExecutableRules>
<ExecutableRule name="AccountID_Unique">
<description>Account ID must be unique.</description>
<OutputDefinition type="FailingRecords">
<OutputColumn name="Account_ID" type="variable" value="account_id”/>
</OutputDefinition>
<Bindings>
<Binding var="account_id"><Column name="BANK.BANK_SCHEMA.ACCOUNTS"/>
</Binding>
</Bindings>
<Benchmarks>
<ValidityBenchmark metric=”percent_met” operator=”greater_than”
value=”0.99”/>
</Benchmarks>
</ExecutableRule>
</ExecutableRules>
<Benchmarks>
<ValidityBenchmark metric=”nb_not_met” operator=”less_than” value=”15”/>
</Benchmarks>
</DataRuleDefinition>
(...)
</DataRuleDefinitions>
(...)
</DataRuleDefinitions>
<Metrics>
(...)
</Metrics>
</iaapi:Project>

GET executableRule command: Getting data rules
Get the content of data rules by using the HTTP API.

Command
GET executableRule
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Purpose
You can use this command to get the content of data rules. The content of the data
rules is returned in an XML string that is a subset of the XML string that is
returned when you run the GET Project command. You can manually edit, archive,
version, and import the XML document.

Parameters
projectName
The name of the project containing the data rules that you want to retrieve.
ruleName
The name of the data rule, or a comma-separated list of rule names if there is
more than one data rule that you want to retrieve. Put names that contain a
comma between quotation marks.

Available HTTP methods
Table 35. HTTP API for getting data rules
HTTP method

URI pattern

DATA format

Success code

Error codes

GET

executableRule

XML

200

400 (bad request)
or 500 (server
error)

GET executableRule example
The following example shows how to get the data rule Rule1 from the project
project1 on the server myServer:
GET http://myserver:9080/InformationAnalyzer/executableRule?projectName
=project1&ruleName=Rule1

GET executableRule return value example
The following example is a subset of the XML string returned by the GET Project
command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1">
<description>Description of Rule1</description>
<OutputDefinition type="FailingRecords">
<OutputColumn name="col1" type="variable" value="col1"/>
<OutputColumn name="col2" type="variable" value="col2"/
</OutputDefinition>
<Bindings>
<Binding var="col1"><Column name="SOURCE1.SCHEMA1.
TABLE1.COL1"/></Binding>
<Binding var="col2"><Column name="SOURCE1.SCHEMA1.
TABLE1.COL2"/></Binding>
<Binding var="refcol"><Column name="SOURCE1.SCHEMA1.
REFTABLE1.COLA"/></Binding>
</Bindings>
</ExecutableRule>
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</ExecutableRules>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

GET executableRule/executionHistory command: Getting data
rule history and results
Get the history of when data rules were run, as well as the results of the data rules
by using the HTTP API.

Command
GET executableRule/executionHistory

Parameters
projectName
The name of the project containing the data rules that you want to retrieve.
ruleName
The name of the data rule definitions that you want to get the rule history and
results for. To retrieve more than one data rule definition, use a comma to
separate the names. Data rule definitions with names that contain commas
must be enclosed in quotation marks.

Available HTTP methods
Table 36. HTTP API for getting a data rule's history
HTTP method

URI pattern

Data format

GET

executableRule/ XML
executionHistory

Success code

Error codes

200

400 (bad request)
or 500 (server
error)

GET executableRule/executionHistory example
The following example shows how to get the data rule, Rule1 on the server,
myServer:
GET http://myserver:9080/InformationAnalyzer/executableRule?projectName=
projectName&ruleName=Rule1

GET executableRule/executionHistory return value example
The following example shows the return value for getting the data rule history:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<!-- Example for a simple rule -->
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1Exec1">
<ExecutionHistory>
<RuleExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-09T18:57:02+01:00"
id=”0”
status="successful"
nbOfRecords="10"
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nbPassed="10"
percentPassed="1.0"
nbFailed="0"
percentFailed="0.0"
runBy="admin"/>
<RuleExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-08T14:34:26+01:00"
id=”1”
status="successful"
nbOfRecords="100"
nbPassed="98"
percentPassed="0.98"
nbFailed="2"
percentFailed="0.02"
runBy="admin"/>
<RuleExecutionResult
startTime="2010-02-09T17:53:31+01:00"
endTime="2010-02-08T17:31:26+01:00"
id=”2”
status="failed"
nbOfRecords="0"
nbPassed="0"
percentPassed="0.0"
nbFailed="0"
percentFailed="0.0"
runBy="admin"/>
</ExecutioHistory>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
<!-- Example for a rule set -->
<RuleSetDefinition name="RuleSetDef">
<ExecutableRules>
<ExecutableRule name="RuleSetExec1">
<ExecutionHistory>
<RuleSetExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-08T14:34:26+01:00"
id=”0”
status="successful"
nbOfRecords="100"
runBy=”admin”
nbRules=”10”
meanNbFailedRulesPerRecord=”1.15”
stddevNbFailedRulesPerRecord=”0.13”
meanPercentFailedRulesPerRecord=”0.115”
stddevPercentFailedRulesPerRecord=”0.013”>
<AbsoluteFailureDistribution>
<DiscreteDistributionItem value=”0”
percentFrequency=”0.35” absoluteFrequency=”35”/>
<DiscreteDistributionItem value=”1”
percentFrequency=”0.60” absoluteFrequency=”60”/>
<DiscreteDistributionItem value=”3”
percentFrequency=”0.5” absoluteFrequency=”5”/>
<DiscreteDistributionItem value=”4”
percentFrequency=”0.0” absoluteFrequency=”0”/>
</AbsoluteFailureDistribution>
<RuleExecutionResult id=”rule1” nbPassed="85"
percentPassed="0.85" nbFailed="15" percentFailed="0.15"/>
<RuleExecutionResult id=”rule2” nbPassed="80"
percentPassed="0.80" nbFailed="20" percentFailed="0.20"/>
<RuleExecutionResult id=”rule3” nbPassed="90"
percentPassed="0.90" nbFailed="10" percentFailed="0.10"/>
</RuleSetExecutionResult>
</ExecutionHistory>
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</ExecutableRule>
</ExecutableRules>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

GET executableRule/executionHistory command: Getting rule
and rule set history and results including benchmark results
Get rule and rule set history and results including benchmark results by using the
HTTP API.

Command
GET executableRule/executionHistory

Parameters
projectName
The name of the project containing the rules and rule sets that you want to
retrieve.
ruleName
The name of the rule and rule sets whose history and results including
benchmarks you want to retrieve. To retrieve more than one rule or rule set,
use a commas to separate the names. If the names contain commas, enclose the
name in quotation marks.

Available HTTP methods
Table 37. HTTP API for getting a data rule's history
HTTP method

URI pattern

Data format

GET

executableRule/ XML
executionHistory

Success code

Error codes

200

400 (bad request)
or 500 (server
error)

GET executableRule/executionHistory example
The following example shows how to get the execution history for a rule and a
rule set:
GET http://myserver:9080/InformationAnalyzer/executableRule?projectName=
projectName&ruleName=Rule1
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<!-- Example for a simple rule -->
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1Exec1">
<ExecutionHistory>
<RuleExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-09T18:57:02+01:00"
id=”1”
status="successful"
nbOfRecords="10"
nbPassed="10"
percentPassed="1.0"
nbFailed="0"
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percentFailed="0.0"
<ValidityBenchmarkResult result=”passed”
percentVariance=”0.5”
absoluteVariance=”104”>
<ValidityBenchmark metric=”percent_met” operator=”greater_than”
value=”0.6”/>
</ValidityBenchmarkResult>
runBy="admin"/>
</ExecutioHistory>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
<!-- Example for a rule set -->
<RuleSetDefinition name="RuleSetDef">
<ExecutableRules>
<ExecutableRule name="RuleSetExec1">
<ExecutionHistory>
<RuleSetExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-08T14:34:26+01:00"
id=”1”
status="successful"
nbOfRecords="100"
runBy=”admin”
nbRules=”10”
meanNbFailedRulesPerRecord=”1.15”
stddevNbFailedRulesPerRecord=”0.13”
meanPercentFailedRulesPerRecord=”0.115”
stddevPercentFailedRulesPerRecord=”0.013”>
<AbsoluteFailureDistribution>
<DiscreteDistributionItem value=”0” percentFrequency=”0.35”
absoluteFrequency=”35”/>
<DiscreteDistributionItem value=”1” percentFrequency=”0.60”
absoluteFrequency=”60”/>
<DiscreteDistributionItem value=”3” percentFrequency=”0.5”
absoluteFrequency=”5”/>
<DiscreteDistributionItem value=”4” percentFrequency=”0.0”
absoluteFrequency=”0”/>
</AbsoluteFailureDistribution>
<RuleExecutionResult id=”rule1”
nbPassed="85" percentPassed="0.85" nbFailed="15"
percentFailed="0.15"/>
<RuleExecutionResult id=”rule2”
nbPassed="80" percentPassed="0.80" nbFailed="20"
percentFailed="0.20"/>
<RuleExecutionResult id=”rule3”
nbPassed="90" percentPassed="0.90" nbFailed="10"
percentFailed="0.10"/>
<ValidityBenchmarkResult result=”passed”
percentVariance=”0.5”
absoluteVariance=”104”>
<ValidityBenchmark metric=”percent_met” operator=”greater_than”
value=”0.8”/>
</ValidityBenchmarkResult>
<ConfidenceBenchmarkResult result=”passed”
rulesPercent=”0.55”
maxRecOverLimit=”20”
actRecOverLimit=”13”
percentVariance=”0.72”
absoluteVariance=”23”>
<ConfidenceBenchmark percentRulesNotMetLimit=”0.3”
percentRecordsAllowedOverLimit=”0.05”/>
<ConfidenceBenchmarkResult/>
<BaselineComparisonBenchmarkResult result=”passed”
percentSimilarity=”0.55”
percentDegradation=”0.2”
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percentImprovement”0.16”
variance=”0.18”/>
<BaselineComparisonBenchmark benchmarkType=”improvement”
operator=”less_than” value=”0.05”/>
</BaselineComparisonBenchmarkResult>
</RuleSetExecutionResult>
</ExecutionHistory>
</ExecutableRule>
</ExecutableRules>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

GET executableRule/outputTable command: Getting the output
table of a data rule
Get the output table of a data rule by using the HTTP API.

Command
GET executableRule/outputTable

Parameters (required)
projectName
The name of the project containing the data rule that you want to get the
output table for.
ruleName
The name of the data rule that you want to retrieve the output table for.

Parameters (optional)
startIndex
Specifies the index of the first row to retrieve. The index of the first row is 1.
nbOfRows
Specifies the maximum number of rows to retrieve. By default all rows will be
retrieved
executionID
The ID of the instance of when a data rule was run. This ID corresponds to the
ID attribute contained in the RuleExecutionResult elements returned by the
GET executableRule/executionHistory command. If the ID is not provided,
then the system takes the ID of the last data rule that was run, if it is available.
Note: Not every instance of running a data rule produces an output table

Available HTTP methods
Table 38. HTTP API for getting a data rule's output table
HTTP method

URI pattern

Data format

Success code

Error codes

GET

executableRule/
outputTable

XML

200

400 (bad request)
or 500 (server
error)

GET executableRule/outputTable example
The following example shows how to get the output table for the project
projectName on the server myServer:
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GET http://myserver:9080/InformationAnalyzer/executableRule/outputTable
?projectName=project&ruleName=rule&executionID=1

GET executableRule/outputTable return value example
The following example shows the return value for getting the output table of a
data rule:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:OutputTable xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<OutputDefinition type="FailingRecords">
<OutputColumn name="john_smith" dataType="STRING" value="john_smith"/>
<OutputColumn name="john_doe" dataType="STRING" value="john_doe"/>
</OutputDefinition>
<Rows>
<Row><Value>Row1Col1Value</Value><Value>Row1Col2Value</Value></Row>
<Row><Value>Row2Col1Value</Value><Value>Row2Col2Value</Value></Row>
<Row><Value>Row3Col1Value</Value><Value>Row3Col2Value</Value></Row>
<Row><Value>Row4Col1Value</Value><Value>Row4Col2Value</Value></Row>
<Row><Value>Row5Col1Value</Value><Value>Row5Col2Value</Value></Row>
<Row><Value>Row6Col1Value</Value><Value>Row6Col2Value</Value></Row>
<Row><Value>Row7Col1Value</Value><Value>Row7Col2Value</Value></Row>
<Row><Value>Row8Col1Value</Value><Value>Row8Col2Value</Value></Row>
<Row><Value>Row9Col1Value</Value><Value>Row9Col2Value</Value></Row>
</Rows>
</iaapi:OutputTable>

GET executableRules command: Getting a list of data rules
Get a list of data rules by using the HTTP API.

Command
GET executableRules

Purpose
You use this command to get a list of all to get a list of all IBM InfoSphere
Information Analyzer data rules contained in a specified project.

Parameters
projectName
The name of the project that contains the data rules for which you want to get
a list.

Available HTTP methods
Table 39. HTTP API for getting a list of data rules
HTTP method

URI pattern

Data format

Success codes

Error codes

GET

executableRules

XML

200

400

GET a list of data rules example
The following example shows how to get a list of data rules for the project
projectName on the server myServer:
GET http://myserver:9080/InformationAnalyzer/executableRules?projectName=projectName
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi" name=
"projectName">
<DataRuleDefinitions>
Chapter 16. Developing applications with the HTTP API

237

<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1Exec1">
<description>Description of Rule1Exec1</description>
</ExecutableRule>
<ExecutableRule name="Rule1Exec2">
<description>Description of Rule1Exec2</description>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
<DataRuleDefinition name="Rule2Def">
<ExecutableRules>
<ExecutableRule name="Rule2Exec1">
<description>Description of Rule2Exec1</description>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

GET globalVariables command: Getting a list of global logical
variables
Get a list of global logical variables by using the HTTP API.

Command
GET globalVariables

Purpose
You can use this command to get a list of global logical variables. A global logical
variable is a value that you can set to represent a fact or a specific piece of data.
After you create a global logical variable, it can be shared by all your data rule
definitions and data rules.

Parameters
There are no parameters for this command.

Available HTTP methods
Table 40. HTTP API for getting a list of global logical variables
HTTP method

URI pattern

Data format

Success code

Error codes

GET

globalVariables

XML

200

400 (bad request)
or 500 (server
error)

GET globalVariables example
The following example shows how to get a list of global logical variables on the
server myServer:
GET http://myserver:9080/InformationAnalyzer/globalVariables

GET globalVariables return value example
The following example shows the return value for getting a list of global logical
variables:
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<?xml version="1.0" encoding="UTF-8"?>
<iaapi:GlobalVariables xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Variable dataType="any" name="var1">
<description>desc var1</description>
<Binding><Column name="SOURCE1.SCHEMA1.TABLE1.COL1"/></Binding>
</Variable>
<Variable dataType="numeric" name="var2">
<description>desc2</description>
<Binding><Column name="SOURCE1.SCHEMA1.TABLE1.COL3"/></Binding>
</Variable>
<Variable dataType="date" name="var3">
<Binding><Constant dataType="date" dateValue="2010-02-10Z"/></Binding>
</Variable>
<Variable dataType="numeric" name="var4"/>
<Variable dataType="numeric" name="var5">
<Binding><Constant dataType="numeric" numericValue="10.0"/></Binding>
</Variable>
</iaapi:GlobalVariables>

GET publicRules command: Getting list of published data rule
and rule set definitions
Get a list of published data rule and rule set definitions by using the HTTP API.

Command
GET publicRules

Purpose
You can use this command to get a list of the published data rule and rule set
definitions.

Parameters
There are no required parameters for this command.

GET published data rule and rule set list example
An XML string that contains a PublicArea element, that contain one entry for each
published data rule and rule set:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:PublicArea xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<description>Description of Rule1Def</description>
</DataRuleDefinition>
<DataRuleDefinition name="Rule2Def">
<description>Description of Rule2Def</description>
</DataRuleDefinition>
<RuleSetDefinition name="RuleSet1Def">
<description>Description of Rule1Def</description>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:PublicArea>

GET keyAnalysis/results command: Getting the primary key
candidates
Get a list of primary key candidates by using the HTTP API.
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Command
GET keyAnalysis/results

Purpose
You can use this command to get a list of all primary key candidates.

Parameters
projectName
The name of the project that contains the tables that have been analyzed.
tableName
A comma separated list of table names whose key analysis results should be
retrieved. The names must be fully qualified
(DATASOURCE.SCHEMA.TABLE). You can use the wildcard character (*) to
include all tables of a schema or database.
percentagesAbove
The threshold for percentages, between 0 and 1, of uniqueness to retrieve the
key results for.

Available HTTP methods
Table 41. HTTP API for retrieving key analysis results
HTTP method

URI pattern

Data format

Success code

Error codes

GET

keyAnalysis/
results

XML

200

400 (bad request)
or 500 (server
error)

GET key analysis results example
The following example shows the return value for getting a list of key candidates:
GET http://myserver:9080/InformationAnalyzer/keyAnalysis/results?projectName=
myProject&tableName=myDataStore.mySchema.myTable

GET project command: Getting the content of a project
Get the content of a particular project by using the HTTP API.

Command
GET project

Purpose
You can use this command to get the content of a complete project and export it
into an XML document. You can manually edit, archive, version, and import the
XML document to create a project on another system. You can use this command,
and the XML document that it creates, to exchange complete project information,
or you can use it to create a project template that can be deployed in a new system
with one command.

Parameters
projectName
The name of the project whose content you want to retrieve.
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Available HTTP methods
Table 42. HTTP API for getting the content of a project
HTTP method

URI pattern

Data format

Success code

Error codes

GET

project

XML

200

400 (bad request)
or 500 (server
error)

Output returned in the XML document
The following information is returned when you issue this command:
v The basic properties of the project, such as the project name and description
v The list of the registered data sources, schemas, tables and columns, and the
defined virtual columns and virtual tables
v The list of the defined rule and rule set definitions including:
– The basic properties of the rules, such as names and descriptions
– The logical expression of the rules
– The list of the variables of the rules, such as the name, type, and eventual
default binding for each variable
v The list of the data rules and rule sets including:
– The basic properties of the data rules and rule sets, such as names and
descriptions
– The output definition of the rules
– The binding of the variables
– Eventual join conditions
v The list of the defined global variables and their bindings

GET project example
The following example shows how to get the project project1 on the server
myServer:
GET http://myserver:9080/InformationAnalyzer/project?projectName=project1

GET project return value example
The following example shows the return value for getting the content of a project.
Note:
v The registered data sources are listed at the beginning of the XML document
under the element DataSources. All the columns registered in the project are
listed hierarchically (database, schema, table). Eventual virtual columns and
virtual tables are listed with the normal columns by using VirtualColumn and
VirtualColumn elements (see XSD files).
v The rule and ruleset definitions are listed under the RuleDefinitions element.
The data rules and data rule sets are listed as subelements of the
DataRuleDefinition element it refers. Several data rules are enclosed by
ExecutableRules tags. The attributes of a single data rule are captured in the
ExecutableRule element. A rule set is represented by a RuleSetDefinition
element.
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<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="TABLE1">
<Column name="COL1"/>
<Column name="COL2"/>
(...)
<VirtualColumn name="VC1">
<Concatenation separator="|">
<Column name="COL1"/>
<Column name="COL2"/>
</Concatenation>
</VirtualColumn>
(...)
</Table>
<Table name="REFTABLE1">
<Column name="COLA"/>
<Column name="COLB"/>
</Table>
(...)
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<description>Description of Rule1Def</description>
<expression>if col1=’E’ then col2 in_reference_column refcol</expression>
<Variables>
<Variable name="col1" dataType="string"
defaultBinding="SOURCE1.SCHEMA1.TABLE1.COL1"/>
<Variable name="col2" dataType="string"/>
<Variable name="refcol" dataType="string"/
</Variables>
<ExecutableRules>
<ExecutableRule name="Rule1">
<description>Description of Rule1</description>
<OutputDefinition type="FailingRecords">
<OutputColumn name="col1" type="variable" value="col1"/>
<OutputColumn name="col2" type="variable" value="col2"/>
</OutputDefinition>
<Bindings>
<Binding var="col1"><Column name="SOURCE1.SCHEMA1.TABLE1.COL1"/>
</Binding>
<Binding var="col2""><Column name="SOURCE1.SCHEMA1.TABLE1.COL2"/>
</Binding>
<Binding var="refcol"><Column name="SOURCE1.SCHEMA1.REFTABLE1.COLA"/>
</Binding>
</Bindings>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
(...)
</DataRuleDefinitions>
</iaapi:Project>

GET project command: Getting the content of a project
including confidence and baseline benchmarks for rule set
definitions
Get the content of a particular project including confidence and baseline
benchmarks for rule set definitions by using the HTTP API.
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Command
GET project

Purpose
You can use this command to get the content of a complete project including
confidence and baseline benchmarks for rule set definitions and export it into an
XML document. You can manually edit, archive, version, and import the XML
document to create a project on another system. You can use this command, and
the XML document that it creates, to exchange complete project information, or
you can use it to create a project template that can be deployed in a new system
with one command.

Parameters
projectName
The name of the project whose content you want to retrieve.

Available HTTP methods
Table 43. HTTP API for getting the content of a project
HTTP method

URI pattern

Data format

Success code

Error codes

GET

project

XML

200

400 (bad request)
or 500 (server
error)

GET project return value example
The following example shows the return value for getting the content of a project
including confidence and baseline benchmarks for rule set definitions. This XML
string describing a project contains elements of type ConfidenceBenchmark and
BaselineComparisonBenchmark.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<DataSources>
(...)
</DataSources>
<DataRuleDefinitions>
(...)
<RuleSetDefinition name="RuleSet1Def">
<description>Description of Rule1Def</description>
<Benchmarks>
<ConfidenceBenchmark percentRulesNotMetLimit=”0.5”
percentRecordsAllowedOverLimit=”0.1”/>
<BaselineComparisonBenchmark benchmarkType=”similarity”
operator=”less_than” value=”0.15”/>
</Benchmarks>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

GET project command: Getting the content of a project
including metrics
Get the content of a particular project including by using the HTTP API.
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Command
GET project

Purpose
You can use this command to get the content of a complete project including
metrics and export it into an XML document. You can manually edit, archive,
version, and import the XML document to create a project on another system. You
can use this command, and the XML document that it creates, to exchange
complete project information, or you can use it to create a project template that can
be deployed in a new system with one command.

Parameters
projectName
The name of the project whose content you want to retrieve.

Available HTTP methods
Table 44. HTTP API for getting the content of a project
HTTP method

URI pattern

Data format

Success code

Error codes

GET

project

XML

200

400 (bad request)
or 500 (server
error)

Output returned in the XML document
The following information is returned when you issue this command:
v The basic properties of the project, such as the project name and description
v The list of the registered data sources, schemas, tables and columns, and the
defined virtual columns and virtual tables
v The list of the defined rule and rule set definitions including:
– The basic properties of the rules, such as names and descriptions
– The logical expression of the rules
– The list of the variables of the rules, such as the name, type, and eventual
default binding for each variable
v The list of the data rules and rule sets including:
– The basic properties of the data rules and rule sets, such as names and
descriptions
– The output definition of the rules
– The binding of the variables
– Eventual join conditions
v The list of the defined global variables and their bindings
v Set of metrics

GET project example
The following example shows how to get the project project1 on the server
myServer:
GET http://myserver:9080/InformationAnalyzer/project?projectName=project1
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GET project return value example
The following example shows the return value for getting the content of a project.
Note:
v The registered data sources are listed at the beginning of the XML document
under the element <DataSources>. All the columns registered in the project are
listed hierarchically (database, schema, table). Eventual virtual columns and
virtual tables are listed with the normal columns by using <VirtualColumn> and
<VirtualColumn> elements (see XSD files).
v The rule and ruleset definitions are listed under the <RuleDefinitions> element.
The data rules and data rule sets are listed as subelements of the
<DataRuleDefinition> element it refers. Several data rules are enclosed by
<ExecutableRules> tags. The attributes of a single data rule are captured in the
<ExecutableRule> element. A rule set is represented by a <RuleSetDefinition>
element.
v The set of metrics are listed under the <Metrics> element.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<DataSources>
(...)
</DataSources>
<DataRuleDefinitions>
(...)
</DataRuleDefinitions>
<Metrics>
<Metric name=”Unique_accounts”>
<description>Account ID must be unique.</description>
<expression>AccountID_Unique % Met</expression>
<MetricBenchmark operator=”greater_or_equal” value=”100”/>
</Metric>
(...)
</Metrics>
</iaapi:Project>

GET projects command: Getting a list of projects
Get a list of existing projects by using the HTTP API.

Command
GET projects

Purpose
You can use this command to get a list of all IBM InfoSphere Information Analyzer
projects.

Parameters
There are no parameters for this HTTP API command.
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Available HTTP methods
Table 45. HTTP API for getting a list of projects
HTTP method

URI pattern

Data format

Success code

Error codes

GET

projects

XML

200

400 (bad request)
or 500 (server
error)

GET a list of projects example
The following example shows how to get a list of projects on the server myServer:
GET http://myserver:9080/InformationAnalyzer/projects

GET projects return value example
The following example shows the return value for getting a list of projects:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Projects xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Project name="project1">
<description>description of project1</description>
</Project>
<Project name="project2">
<description>description of project2</description>
</Project>
<Project name="project3">
<description>description of project3</description>
</Project>
</iaapi:Projects>

GET publishedResults command: Getting list of published
analysis results
Get a list of published analysis results by using the HTTP API.

Command
GET publishedResults

Purpose
You can use this command to get a list of published analysis results.

Parameters
projectName
The name of the project whose table with published analysis results should be
listed.

GET published analysis results list example
An XML string that contains a PublishedResults element, that contain one entry for
each table that has published analysis results:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<PublishedResults>
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<Table name="BANK.BANK2.TABLE1"/>
</PublishedResults>
</Tasks>
</iaapi:Project>

GET metric/execution history command: Getting the history
and results for metrics
Get the history and results for each time that metrics ran by using the HTTP API.

Command
GET metric/executionHistory

Purpose
You can use this command to retrieve the results for each time that a specified set
of metrics ran.

Parameters
projectName
The name of the project that contains the metrics
metricName
A comma-separated list of metric names. If a metric name contains a comma,
you must enclose the name in double quotation marks. If you omit this
parameter, the history for all metrics is retrieved.

Available HTTP methods
Table 46. HTTP API for getting the history and results for metrics
HTTP method

URI pattern

Data format

GET

metric/
XML
executionHistory

Success code

Error codes

200

400 (bad request)
or 500 (server
error)

GET history and results for metrics example
GET http://myserver:9080/InformationAnalyzer/metric/executionHistory?projectName=
myProject&metricName=myMetric

GET metric/executionHistory return value example
The return value is an XML document that has the following structure:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Metrics>
<!-- Example for a single metric -->
<Metric name="Rule1Def">
<ExecutionHistory>
<MetricExecutionResult
id=”0”
timeStamp="2010-02-09T18:56:31+01:00"
status=”successful”
value=”0.01956”
runBy="admin">
<MetricBenchmarkResult result=”passed” variance=”0.0023”>
<MetricBenchmark operator=”greater_or_equal” value=”98”/>
</MetricBenchmarkResult>
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</MetricExecutionResult>
<MetricExecutionResult
id=”1”
timeStamp="2010-02-09T19:23:00+01:00"
status=”successful”
value=”0.0234”
runBy="admin">
<MetricBenchmarkResult result=”passed” variance=”0.0012”>
<MetricBenchmark operator=”greater_or_equal” value=”98”/>
</MetricBenchmarkResult>
</MetricExecutionResult>
</ExecutionHistory>
</Metric>
</Metrics>
</iaapi:Project>

GET metrics command: Getting the metrics for a project
Get the metrics for a particular project by using the HTTP API.

Command
GET metrics

Purpose
You can use this command to get metrics for a specific project.

Parameters
projectName
The name of the project from which to retrieve the metrics.
metricName
The name of one metric to retrieve or a comma-separated list of metric names.
Names that contain a comma must be enclosed in double quotation marks. If
this parameter is omitted, all metrics for the project are returned.

GET metrics request example
Use the following example to get metrics for a project:
GET metrics?projectName=myProject

GET metrics return value example
The following XML string contains an element on <Metrics>.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<Metrics>
<Metric name=”Unique_accounts”>
<description>Account ID must be unique.</description>
<expression>AccountID_Unique % Met</expression>
<MetricBenchmark operator=”greater_or_equal” value=”100”/>
</Metric>
(...)
</Metrics>
</iaapi:Project>
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GET referentialIntegrityAnalysis/results command: Getting the
results of a referential integrity analysis
Get the results of a referential integrity analysis by using the HTTP API.

Command
GET referentialIntegrityAnalysis/results

Purpose
You can use this command to get the results of a referential integrity analysis.

Parameters
projectName
The name of the project that contains the tables that have been analyzed.
baseColumnName
The name of the base column that acts as the foreign key whose corresponding
referential integrity analysis results should be retrieved. The name must be
fully qualified (DATASOURCE.SCHEMA.TABLE.COLUMN).
pairedColumnName
Name of the column acting as the primary key. The name must be fully
qualified (DATASOURCE.SCHEMA.TABLE.COLUMN).

GET referential integrity analysis/results example
Use the following example to get the results of a referential integrity analysis:
GET referentialIntegrityAnalysis/results?projectName=projectName&baseColumnName
=BANK.BANK1.CLIENTS.CLIENT_ID&pairedColumnName
=BANK.BANK1.ACCOUNTS.CLIENT_ID

GET referential integrity analysis/results return value example
The return value is an XML string that has the following structure:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<ForeignKeyCandidate>
<PrimaryKey>
<Column name="BANK.BANK1.CLIENTS.CLIENT_ID"/>
</PrimaryKey>
<ForeignKey>
<Column name="BANK.BANK1.ACCOUNTS.CLIENT_ID"/>
<ForeignKey/>
<ForeignKeyToPrimaryKey violationsDistinct="3" violationsTotal="4"
integrityDistinct="2,040" integrityTotal="3,179"
...>
<Violation foreignKeyValue="9999/9" records="2" percentage="0.0628"/>
<Violation foreignKeyValue="9999/8" records="1" percentage="0.0314"/>
...
</ForeignKeyToPrimaryKey>
<PrimaryKeyToForeignKey matchingValuesDistinct="2,040" matchingValuesTotal=
"2,040" .../>
<ForeignKeyCandidate/>
</iaapi:Project>

The outermost Project element contains several possible ForeignKeyCanddiate
elements. Each ForeignKeyCandidate element documents its primary key and
foreign key. For each of the two directions of the foreign key candidate, a
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sub-element comprises a set of properties. The ForeignKeyToPrimaryKey direction
can include Violation elements that document the foreign key values that
referential integrity does not hold.

GET ruleDefinition command: Getting data rule definitions
Get the content of data rule definitions by using the HTTP API.

Command
GET ruleDefinition

Purpose
You can use this command to get the content of data rule definitions. The content
of the data rule definitions is wrapped into an XML string that is a subset of the
XML string that is returned when you run the GET Project command. You can
manually edit, archive, version, and import the XML document.

Parameters
projectName
The name of the project containing the data rule definitions that you want to
retrieve.
ruleName
The name of the data rule definition or rule set definition that you want to
retrieve. To retrieve more than one data rule definition or rule set definition at
a time, use a comma to separate the names. Put data rule definitions or rule set
definitions that have names that contain commas between quotation marks.

Available HTTP methods
Table 47. HTTP API for getting data rule definitions
HTTP method

URI pattern

DATA format

Success codes

Error codes

GET

ruleDefinition

XML

200

400 (bad request)
or 500 (server
error)

GET ruleDefinition example
The following example shows how to get the data rule DataRule1 from the project
project1 on the server myServer:
GET http://myserver:9080/InformationAnalyzer/ruleDefinition?projectName=
project1&ruleName=DataRule1

GET ruleDefinition return value example
The following example is a subset of the XML string that is returned by the GET
Project command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<description>Description of Rule1Def</description>
<expression>if col1=’E’ then col2 in_reference_column refcol
</expression>
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<Variables>
<Variable name="col1" dataType="string" defaultBinding=
"SOURCE1.SCHEMA1.TABLE1.COL1"/>
<Variable name="col2" dataType="string"/>
<Variable name="refcol" dataType="string"/>
</Variables>
</DataRuleDefinition>
(...)
</DataRuleDefinitions>
</iaapi:Project>

GET ruleDefinitions command: Getting a list of data rule
definitions
Get a list of data rule definitions by using the HTTP API.

Command
GET ruleDefinitions

Purpose
You can use this command to get a list of all IBM InfoSphere Information Analyzer
data rule definitions belonging to a specified project. The basic properties of the
data rule definitions are displayed in the list.

Parameters (required)
projectName
The name of the project that contains the data rule definitions for which you
want to get a list.

Available HTTP methods
Table 48. HTTP API for getting a list of data rule definitions
HTTP method

URI pattern

Data format

Success code

Error codes

GET

ruleDefinitions

XML

200

400 (bad request)
or 500 (server
error)

GET a list of data rule definitions example
The following example shows how to get a list of rule definitions for the project
projectName on the server myServer:
GET http://myserver:9080/InformationAnalyzer/ruleDefinitions?projectName=projectName

GET a list of data rule definitions return value example
The following example shows the return value for getting a list of data rule
definitions:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<description>Description of Rule1Def</description>
</DataRuleDefinition>
<DataRuleDefinition name="Rule2Def">
<description>Description of Rule2Def</description>
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</DataRuleDefinition>
<RuleSetDefinition name="RuleSet1Def">
<description>Description of RuleSet1Def</description>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

GET publishRule command: Publishing rules and rule sets
Publish data rule or rule sets by using the HTTP API.

Command
GET publishRule

Purpose
You can use this command to publish specific data rule or rule set definitions from
a project.

Parameters
projectName
The name of the project containing the data rule or rule set that you want to
retrieve.
ruleName
The name of the data rule or rule set that you want to publish. To publish
more than one data rule or rule set at a time, use a comma to separate the
names. Data rule or rule sets with names that contain commas must be
enclosed in quotation marks.

Available HTTP methods
Table 49. HTTP API for getting data rule definitions
HTTP method

URI pattern

DATA format

Success codes

Error codes

GET

publishRule

XML

200

400 (bad request)
or 500 (server
error)

POST create command: Adding new metrics
Add new metrics to a project by using the HTTP API.

Command
POST create

Purpose
You can use this command to add new metrics to an existing project.

Parameters
There are no parameters for this command. The XML string defining the content of
the metrics to define is embedded in the body of the POST request.

Adding metrics to an existing project
The metric Country_code_validation is added to the project named myProject:
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<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<Metrics>
<Metric name=”Country_code_validation”>
<description>Country code must be valid..</description>
<expression>Country code validation exec % Met</expression>
<MetricBenchmark operator=”greater_or_equal” value=”90”/>
</Metric>
(...)
</Metrics>
</iaapi:Project>

POST create command: Creating a project
Create a project by using the HTTP API.

Command
POST create

Purpose
Use this command to create a project. You can create either an empty project or a
project filled with content. The same create command is used to create new
projects, new data rule definitions, and new data rules.
Note: You can extract existing content from another project to an XML document
by adding the following text to the URL: http://<YourServerName>:9080/
InformationAnalyzer/project?projectName=<YourProjectName>. This is the
command to retrieve the data for the project <YourProjectName> on the server
<YourServerName>. This XML document can be modified manually and reused to
create a new project with the same content.

Parameters
There are no parameters for this command. The body of the request must contain
the XML string specifying what you want to create.

Available HTTP methods
Table 50. HTTP API for creating a project
HTTP method

URI pattern

Data format

Success code

Error codes

POST

create

XML

200

400 (bad request)
or 500 (server
error)

Creating an empty project example
The following example shows how to create an empty project. The HTTP request
for creating the empty project is http://<ServerName>:9080/InformationAnalyzer/
create. The XML string is embedded in the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="newProject"/>
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Creating a project with registered columns example
The following example shows how to create a project with registered columns. The
HTTP request for creating the project with registered columns is
http://<ServerName>:9080/InformationAnalyzer/create. The XML string is
embedded in the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="newProject">
<description>Description of the project</description>
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="TABLE1">
<Column name="COL1"/>
<Column name="COL2"/>
</Table>
</Schema>
</DataSource>
</DataSources>
</iaapi:Project>

Using an XML document to run multiple commands after
creating a project example
You can create an XML document that:
v Creates a project
v Runs multiple tasks, such as a column analysis or data rule, immediately after
the project is created.
The following is an example of an XML document that uses the create command to
create a new project. It then registers a data source (containing one schema and
two tables) and runs a column analysis on all columns of all tables of the created
schema:
The HTTP request for running multiple commands after creating a project is
http://<ServerName>:9080/InformationAnalyzer/create. The XML string is
embedded in the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi" name
="newProject">
<description>Description of the project</description>
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="TABLE1">
<Column name="COL1"/>
<Column name="COL2"/>
</Table>
<Table name="TABLE2">
<Column name="COLA"/>
<Column name="COLB"/>
</Table>
</Schema>
</DataSource>
</DataSources>
<Tasks>
<RunColumnAnalysis>
<Column name="SOURCE1.SCHEMA1.*.*"/>
</RunColumnAnalysis>
</Tasks>
</iaapi:Project>
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After you issue this command, the column analysis starts or is scheduled to start.
The request is returned immediately without waiting for the task to complete.

POST create command: Creating data rule definitions and
data rules
Create data rule definitions and data rules by using the HTTP API.

Command
POST create

Purpose
You can use this command to create data rule definitions and data rules. The XML
input follows the same syntax pattern as the syntax that you use to create a
project.
You can assign rule definitions, rule sets, and executable rules to a folder or
multiple folders. The value of the folder attribute can be a comma-separated list of
folder names. Also, a folder name can be a folder path using the form
<folder1>/<folder2>/ ... /<folderN>, where each folder is nested in the
preceding one.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.

Available HTTP methods
Table 51. HTTP API for data profiling
HTTP method

URI pattern

DATA format

Success code

Error codes

POST

create

XML

200

400 (bad request)
or 500 (server
error)

Creating a new data rule definition example
The HTTP request for creating the data rule definition: http://<ServerName>:9080/
InformationAnalyzer/create. The XML string is embedded in the body of the POST
request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<DataRuleDefinitions>
<DataRuleDefinition name="newRule11" folder=”myFolder3”>
<description>Description of newRule</description>
<expression>col exists</expression>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

v In DataRuleDefinition name="newRule11" folder=”myFolder3”, myFolder3 is the
folder name under which the rule is to be created.
v If folder="All", the rule would be created under all categories.
v If folder="myFolder3/mySubFolder3", the rule would be created under the
sub-folder.
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Creating a new data rule example
The following example shows how to create a new data rule definition:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1">
<description>Description of Rule1</description>
<OutputDefinition type="FailingRecords">
<OutputColumn name="col1" type="variable" value="col1"/>
<OutputColumn name="col2" type="variable" value="col2"/>
</OutputDefinition>
<Bindings>
<Binding var="col1"><Column name="SOURCE1.SCHEMA1.TABLE1.COL1"/>
</Binding>
<Binding var="col2"><Column name="SOURCE1.SCHEMA1.TABLE1.COL2"/>
</Binding>
<Binding var="refcol"><Column name="SOURCE1.SCHEMA1.
REFTABLE1.COLA"/></Binding>
</Bindings>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

POST create command: Creating global logical variables
Create global logical variables by using the HTTP API.

Command
POST create

Purpose
You can use this command to create global logical variables. You create a global
logical variable to provide a common, consistent association or link to a specific
piece of data.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.

Available HTTP methods
Table 52. HTTP API for creating global logical variables
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HTTP method

URI pattern

DATA format

Success codes

Error codes

POST

create

XML

200

400 (bad request)
or 500 (server
error)

Creating a new global logical variable example
The HTTP request for creating a new global logical variable is
http://<ServerName>:9080/InformationAnalyzer/create?projectContent. The XML
string is embedded in the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:GlobalVariables xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Variable dataType="any" name="var1">
<description>desc var1</description>
<Binding><Column name="SOURCE1.SCHEMA1.TABLE1.COL1"/></Binding>
</Variable>
</iaapi:GlobalVariables>

The HTTP method is POST.

Creating a new global logical variable with other project artifacts
example
The HTTP request for creating a new global logical variable with other project
artifacts is http://<ServerName>:9080/InformationAnalyzer/create. The XML string
is embedded in the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="newProject">
<GlobalVariables>
<Variable dataType="any" name="var1">
<description>desc var1</description>
<Binding><Column name="SOURCE1.SCHEMA1.TABLE1.COL1"/></Binding>
</Variable>
</GlobalVariables>
</iaapi:Project>

No message is returned for this command if it runs successfully. If problems occur,
it returns an XML document that contains the warnings or errors that are
generated when the command runs.

POST create command: Creating rule set definitions including
confidence and baseline benchmarks
Create rule set definitions including confidence and baseline benchmarks by using
the HTTP API.

Command
POST create

Purpose
You can use this command to create rule set definitions that contain confidence or
baseline comparison benchmarks. The XML input follows the same syntax pattern
as the syntax that you use to create a project.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.
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Available HTTP methods
Table 53. HTTP API for data profiling
HTTP method

URI pattern

DATA format

Success code

Error codes

POST

create

XML

200

400 (bad request)
or 500 (server
error)

Creating a rule set definition example
The HTTP request for creating the data rule set: http://<ServerName>:9080/
InformationAnalyzer/create. The XML string is embedded in the body of the POST
request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<DataSources>
(...)
</DataSources>
<DataRuleDefinitions>
(...)
<RuleSetDefinition name="newRuleSetDef">
<description>Description of newRuleSetDef</description>
<Benchmarks>
<ConfidenceBenchmark percentRulesNotMetLimit=”0.3”
percentRecordsAllowedOverLimit=”0.05”/>
<BaselineComparisonBenchmark benchmarkType=”improvement”
operator=”less_than” value=”0.05”/>
</Benchmarks>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

POST execute tasks command: Running a column analysis
Start a column analysis by using the HTTP API.

Command
POST executeTasks

Purpose
Column analysis is a data profiling process that examines the content of columns
in your data. You run a column analysis job to understand the structure of your
data and to find anomalies that might affect the quality of your data.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.

Available HTTP methods
Table 54. HTTP API for running a column analysis
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HTTP method

URI pattern

Data format

Success code

Error codes

POST

executeTasks

XML

200

400 (bad request)
or 500 (server
error)

Running a column analysis example
The HTTP request for running a column analysis is http://<ServerName>:9080/
InformationAnalyzer/executeTasks. The XML string is embedded in the body of
the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunColumnAnalysis>
<Column name="BANK.BANK1.*.*"/>
<Column name="BANK.BANK2.TABLE1.*"/>
</RunColumnAnalysis>
</Tasks>
</iaapi:Project>

The HTTP method is POST.
No message is returned for the POST executeTasks command if it runs successfully.
If problems occurred, it returns an XML document that contains the warnings or
errors that are generated when the command runs.

Running a column analysis with sampling and scheduling
example
The following example shows how to run a column analysis with sampling and
scheduling included:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunColumnAnalysis>
<Column name="BANK.BANK1.*.*"/>
<Column name="BANK.BANK2.TABLE1.*"/>
<SampleOptions type="every_nth" size="1000" nthvalue="10"/>
<Schedule startDate="2010-02-09T18:56:31+01:00"
runUntil="2010-02-15T10:00:00+01:00" nbOfInstances="10">
<ScheduleRepeat second="0" minute="0" hour="12" dayOfMonth="*"
month="*" dayOfWeek="?" year="*"/>
</Schedule>
</RunColumnAnalysis>
</Tasks>
</iaapi:Project>

POST execute tasks command: Running data rules
Run data rules by using the HTTP API.

Command
POST executeTasks

Purpose
You run data rules to evaluate and analyze conditions that are found during data
profiling, to conduct a data quality assessment, to provide more information about
a data integration effort, or to establish a framework for validating and measuring
data quality over time.
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Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.

Available HTTP methods
Table 55. HTTP API for running data rules
HTTP method

URI pattern

Data format

Success codes

Error codes

POST

executeTasks

XML

200

400 (bad request)
or 500 (server
error)

POST executeTasks example
The HTTP request for running data rules is http://<ServerName>:9080/
InformationAnalyzer/executeTasks. The XML string is embedded in the body of
the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunRules>
<ExecutableRule name="rule1"/>
<ExecutableRule name="rule2"/>
<ExecutableRule name="rule3"/>
</RunRules>
</Tasks>
</iaapi:Project>

There is no return value for the POST executeTasks command if it runs
successfully. If problems occurred, it returns an XML string that contains the
warnings or errors that are generated when the command runs.

POST executeTasks with scheduling and options example
The HTTP request for running data rules is http://<ServerName>:9080/
InformationAnalyzer/executeTasks. The XML string is embedded in the body of
the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunRules>
<SampleOptions type="every_nth" size="1000" nthvalue="10"/>
<Schedule startDate="2010-02-09T18:56:31+01:00"
runUntil="2010-02-15T10:00:00+01:00" nbOfInstances="10">
<ScheduleRepeat second="0" minute="0" hour="12"
dayOfMonth="*" month="*" dayOfWeek="?" year="*"/>
</Schedule>
<ExecutableRule name="rule1"/>
<ExecutableRule name="rule2"/>
<ExecutableRule name="rule3"/>
</RunRules>
</Tasks>
</iaapi:Project>
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POST execute tasks command: Running metrics
Run metrics by using the HTTP API.

Command
POST executeTasks

Purpose
Use this command to run metrics for a specific project.

Parameters
There are no parameters for this command. The XML string that defines the
contents of the metrics to run is embedded in the body of the POST request.

Example of running metrics
In this example, the RunMetrics element specifies that metric11, metric12, and
metric13 will run. The RunMetrics element can also contain an <Tasks> element to
specify the schedule for running the metrics.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunMetrics>
<Metric name="metric11"/>
<Metric name="metric12"/>
<Metric name="metric13"/>
</RunMetrics>
</Tasks>
</iaapi:Project>

POST execute tasks command: Running a multiple column
primary key analysis
Start a multiple column primary key analysis by using the HTTP API.

Command
POST executeTasks

Purpose
You run a multiple column primary key analysis job to determine if one
combination of the columns in the table can be the primary key. Multiple column
primary key analysis profiles the uniqueness of distinct values in each column
concatenation to the data sample.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request. The start of a key analysis is specified
by using a <RunMultiColumnKeyAnalysis> element that can contain one or more
references to tables to analyze for multiple column primary keys. The attribute
compositeMax holds the maximum size of the multiple column primary key to
return.
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Available HTTP methods
Table 56. HTTP API for running a multiple column primary key analysis
HTTP method

URI pattern

Data format

Success code

Error codes

POST

executeTasks

XML

200

400 (bad request)
or 500 (server
error)

Running a multiple column primary key analysis example
The HTTP request for running a column analysis is http://<ServerName>:9080/
InformationAnalyzer/executeTasks. The XML string is embedded in the body of
the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunMultiColumnKeyAnalysis compositeMax="2">
<Table name="BANK.BANK1.*/>
<Table name="BANK.BANK2.TABLE1"/>
<Column name="COL1"
<Column name="COL2">
<Column name="COL5">
<Column name="COL8">
</Table>
</RunMultiColumnKeyAnalysis>
</Tasks>
</iaapi:Project>

This task starts the multiple column primary key analysis on all tables in the
schema BANK1 of the database BANK and on the table BANK.BANK2.TABLE1.
The HTTP method is POST. No message is returned for the POST executeTasks
command if it runs successfully. If problems occurred, it returns an XML document
that contains the warnings or errors that are generated when the command runs.

POST execute tasks command: Starting a foreign key and
cross-domain analysis
Start a foreign-key and cross-domain analysis for single-column primary and
foreign keys by using the HTTP API.

Command
POST executeTasks

Purpose
A foreign key analysis identifies foreign key candidates that refer to the primary
key of a table. Foreign keys are either single-column or multicolumn that use a
combination of columns.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request. The start of a foreign key relationship
analysis is specified by using a RunCrossDomainAnalysis element, which can
contain a set of ColumnPair elements. This in turn includes subelements
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BaseColumns and PairedColumns. The element BaseColumns comprises Column
elements with fully qualified names. These columns names have the form
DATASOURCE.SCHEMA.TABLE.COLUMN. The element PairedColumns contains
columns to be paired with the ones in BaseColumns.

Example
This task starts a foreign key and cross-domain relationship analysis between the
column BANK.BANK_SCHEMA.CUSTOMER.CLIENT_ID and all compatible
columns in the table BANK.BANK_SCHEMA.ACCOUNT. The
RunCrossDomainAnalysis element can also contain optional job property elements
to specify sampling and scheduling.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataSources>
<DataSource name="BANK">
<Schema name="BANK1">
<Table name="BANK_CLIENTS">
<KeyAnalysisResult>
<SingleColumnKeys>
<SingleColumnKey alias="..." (...)
percentUnique="..." percentDuplicate="...">
<Column name="..."/>
</SingleColumnKey>
</SingleColumnKeys>
<MultiColumnKeys>
<MultiColumnKey nbOfColumns="..."
percentUnique="..." percentDuplicate="...">
<Column name="..."/>
<Column name="..."/>
</MultiColumnKey>
</MultiColumnKeys>
</KeyAnalysisResult>
</Table>
</Schema>
</DataSource>
</DataSources>
</iaapi:Project>
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunCrossDomainAnalysis excludeColContainingNulls=”false”
excludeByMinimumUniquenessPercent=”0.1”
excludeDateDataClass=”false”
excludeIndicatorsDataClass=”false”
excludeTestDataClass=”false”
excludeByMaximalLength=”1000”
excludeColumnsMissingColumnAnalysisResults=”true”>
<ColumnPair>
<BaseColumns>
<Column name="BANK.BANK_SCHEMA.CUSTOMER.CLIENT_ID "/>
</BaseColumns>
<PairedColumns>
<Column name="BANK.BANK_SCHEMA.ACCOUNTS.*"/>
</PairedColumns>
</ColumnPair>
</RunCrossDomainAnalysis>
</Tasks>
</iaapi:Project>
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POST execute tasks command: Starting a referential integrity
analysis
Start a referential integrity analysis by using the HTTP API.

Command
POST executeTasks

Purpose
The referential integrity analysis tests that every foreign key data value,
single-column or multicolumn (concatenated), can access the primary key of a
related table.

Parameters
The only parameter is an XML document that specifies the name of the project and
the task to execute. To launch a referential integrity analysis, you use a
RunReferentialIntegrityAnalysis element which can contain one or more foreign
key candidate sub-elements. The referential integrity analysis is performed for
these foreign key candidates. The RunReferentialIntegrityAnalysis element can also
contain an optional job property element to specify scheduling. Note that a
referential integrity analysis can only be started if the given primary column has
the status of a selected primary key.

Example
This task starts the referential integrity analysis on the foreign key candidate with
the primary key BANK.BANK1.CLIENTS.CLIENT_ID and the foreign key
BANK.BANK1.ACCOUNTS.CLIENT_ID.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<RunReferentialIntegrityAnalysis>
<ForeignKeyCandidate>
<PrimaryKey>
<Column name="BANK.BANK1.CLIENTS.CLIENT_ID"/>
</PrimaryKey>
<ForeignKey>
<Column name="BANK.BANK1.ACCOUNTS.CLIENT_ID"/>
</ForeignKey>
</ForeignKeyCandidate>
</RunReferentialIntegrityAnalysis>
</Tasks>
</iaapi:Project>

This task will start the referential integrity analysis on the foreign key candidate
with the primary key BANK.BANK1.CLIENTS.CLIENT_ID and the foreign key
BANK.BANK1.ACCOUNTS.CLIENT_ID.

POST publish command: Publishing analysis results
Publish analysis results by using the HTTP API.

Command
POST publishResults
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Purpose
You can use this command to publish the analysis results of tables for broader use
with other components of the IBM InfoSphere Information Server platform.

Parameters
There are no parameters for this command. The XML string specifying the name of
the tables and which state of results should be published is embedded in the body
of the POST request.

Publishing analysis results
The publishing of analysis results is specified by using a PublishResult element
which can contain one or more references to tables whose current analysis results
are to be published. The names of tables are fully qualified
(DATASOURCE.SCHEMA.TABLE) and can contain * wildcards standing for none
to several characters.
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
<PublishResults>
<Table name="BANK.BANK1.* "/>
<Table name="BANK.BANK2.TABLE1"/>
</PublishResults>
</Tasks>
</iaapi:Project>

POST update benchmarks: Modifying benchmarks of existing
rule set definitions
Modify benchmarks of existing rule set definitions by using the HTTP API.

Command
POST update

Purpose
You can use this command to add or change the contents of confidence or baseline
comparison benchmarks of rule set definitions.

Parameters
There are no parameters for this command. The XML string that defines the
content of the rule set definitions to modify is embedded in the body of the POST
request.

Example of modifying benchmarks of an existing rule set
definition
This example shows how you modify the confidence or baseline comparison
benchmarks of a rule set definition:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<RuleSetDefinition name="existingRuleSetDef">
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<Benchmarks>
<ConfidenceBenchmark percentRulesNotMetLimit=”0.2”
percentRecordsAllowedOverLimit=”0.05”/>
<BaselineComparisonBenchmark benchmarkType=”degradation”
operator=”less_than” value=”0.15”/>
</Benchmarks>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

POST update command: Modifying data rule definitions and
data rules
Modify data rule definitions and data rules by using the HTTP API.

Command
POST update

Purpose
You can use this command to modify data rule definitions and data rules. The
XML input follows the same syntax pattern as the syntax that you use to create
new data rules.

Parameters
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.

Available HTTP methods
Table 57. HTTP API for modifying data rule definitions and data rules
HTTP method

URI pattern

DATA format

Success code

Error codes

POST

update

XML

200

400 (bad request)
or 500 (server
error)

Modifying the logical expression of a data rule definition
example
The HTTP request for modifying the data rule definition is http://
<ServerName>:9080/InformationAnalyzer/update. The XML string is embedded in
the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<expression>if col1=’B’ then col2 in_reference_column refcol</expression>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

The HTTP method is POST.
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Modifying the binding of one of the variables of a data rule
example
The HTTP request for modifying the data rule is http://<ServerName>:9080/
InformationAnalyzer/update. The XML string is embedded in the body of the
POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1" folder="tmp">
<Bindings>
<Binding var="col1"><Column name="SOURCE1.SCHEMA1.TABLE1.COL4"/>
</Binding>
</Bindings>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

Modifying the validity benchmark of a rule set
The HTTP request for modifying the rule set is http://<ServerName>:9080/
InformationAnalyzer/update. The XML string is embedded in the body of the
POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<RuleSetDefinition name="RuleSet1" folder=”mat, tmp”>
<ValidityBenchmark metric="percent_met" operator="greater_than" value="50">
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

POST update metrics: Modifying existing metrics
Modify existing metrics by using the HTTP API.

Command
POST update

Purpose
You can use this command to change the value of existing metrics.

Parameters
There are no parameters for this command. The XML string that defines the
content of the metrics to define is embedded in the body of the POST request. The
XML string uses the same syntax that is used for creating new metrics, but only
the attributes to update are specified.

Example of modifying an existing metric
The operator attribute of the MetricBenchmark for the following metric is changed:
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<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="myProject">
<Metrics>
<Metric name=”Country_code_validation”>
<MetricBenchmark operator=”greater_or_equal” value=”98”/>
</Metric>
(...)
</Metrics>
</iaapi:Project>

POST update command: Updating global logical variables
Update global logical variables by using the HTTP API.

Command
POST update

Parameters (required)
There are no parameters for this command. The XML string defining the content is
embedded in the body of the POST request.

Available HTTP methods
Table 58. HTTP API for updating global logical variables
HTTP method

URI pattern

DATA format

Success codes

Error codes

POST

update

XML

200

400 (bad request)
or 500 (server
error)

Updating a global logical variable example
The HTTP request for updating a global logical variable is http://
<ServerName>:9080/InformationAnalyzer/create. The XML string is embedded in
the body of the POST request:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:GlobalVariables xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Variable dataType="any" name="var1">
<description>desc var1</description>
<Binding><Column name="BANK.BANK1.BANK_CLIENTS.AGE"/></Binding>
</Variable>
</iaapi:GlobalVariables>

The HTTP method is POST. This example updates the variable var1 with the given
values.

Schema definition file
IBM InfoSphere Information Analyzer provides XML schema definition (XSD) file
that defines the message formats used by the HTTP APIs.
The HTTP APIs make extensive use of XML documents for exchanging information
between the client and the server: Complex requests, such as creating resources,
are often sent by embedding an XML string in a POST request. The information
returned by the server is also in an XML format. The definition of this XML format
is specified in the iaapi.xsd file. The XSD file can be found in the following
locations:
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v ASBServer/docs/IA/schema (server)
v ASBNode/docs/IA/schema (client)

Schema file elements for getting a list of projects
Specify elements in your XML Schema Definition (XSD) document to request a list
of projects. This is a description of the elements of the XML document that is
returned when requesting a list of projects.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
GET projects

Example of an XML document for the GET projects command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Projects xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Project name="project1" description="description of project1"/>
<Project name="project2" description="description of project2"/>
<Project name="project3"/>
</iaapi:Projects>

XSD file elements
<Projects>
Specifies the list of existing IBM InfoSphere Information Analyzer projects.
Each project source is defined as a child element of the <Projects> element.
The following table shows the children of the <Projects> element:
Table 59. Children of the <Projects> element
Element

Cardinality

Description

<Project>

0..*

Existing projects

<Project name="...">
Specifies a project in the list. This element only contains the project name and
description when you use it to return the list of existing projects. When you
use it to get the details of a project, this element contains other sub elements.
The following table shows the attributes of the <Project> element:
Table 60. Attributes of the <Project> element
Attribute

Description

name

Name of the project

The following table shows the children of the <Project> element:
Table 61. Children of the <Project> element
Element

Cardinality

Description

<description>

0 or 1

A description of the project

<ForeignKeyCandidate>

0 to unbounded

A compound element
describing a candidate for a
foreign key relationship
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<ForeignKeyCandiate>
Specifies a compound element describing a candidate for a foreign key
relationship.
The following table shows the children of the <ForeignKeyCandidate> element:
Table 62. Children of the <ForeignKeyCandidate> element
Element

Cardinality

Description

<PrimaryKey>

1

Column(s) being part of the
primary key. See detailed
description below
<RunReferentialIntegrity
Analysis>.

<ForeignKey>

1

Column(s) being part of the
foreign key. See detailed
description below
<RunReferentialIntegrity
Analysis>.

<ForeignKeyToPrimaryKey>

1

Result of a referential
integrity analysis from the
perspective of the foreign
key.

<PrimaryKeyToForeignKey>

1

Result of a referential
integrity analysis from the
perspective of the primary
key.

<ForeignKeyToPrimaryKey>
Specifies the result of a referential integrity analysis from the perspective of the
foreign key.
The following table shows the children of the <ForeignKeyToPrimaryKey> element:
Table 63. Children of the <ForeignKeyToPrimaryKey> element
Element

Cardinality

Description

<Violation>

0 to unbounded

Violation of referential
integrity.

The following table shows the attributes of the <ForeignKeyToPrimaryKey>
element:
Table 64. Attributes of the <ForeignKeyToPrimaryKey> element
Attributes

Description

violationsDistict

Number of distinct violations

violationTotal

Total number of violations

integrityDistinct

Distinct number of non-violating rows

integrityTotal

Total number of non-violating rows

<Violation>
Specifies a violation of referential integrity.
The following table shows the attributes of the <Violation> element:
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Table 65. Attributes of the <Violation> element
Attributes

Description

foreignKeyValue

Data value of the foreign key column

records

Number of rows with that data value

percentage

Percentage of rows with that value

<PrimaryKeyToForeignKey>
Specifies the result of a referential integrity analysis from the perspective of the
primary key.
The following table shows the attributes of the <PrimaryKeyToForeignKey>
element:
Table 66. Attributes of the <PrimaryKeyToForeignKey> element
Attributes

Description

matchingValuesDistinct

Distinct number of matching values

matchingValuesTotal

Total number of matching values

Getting a list of projects example
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Projects xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Project name="project1" description="description of project1"/>
<Project name="project2" description="description of project2"/>
<Project name="project3"/>
</iaapi:Projects>

Schema file elements for getting a list of data rule definitions,
rule set definitions, data rules, and rule sets
Specify elements in your XML Schema Definition (XSD) document to request a list
of data rule definitions, rule set definitions, data rules, and rule sets. This is a
description of the elements of the XML document that is returned when requesting
lists of data quality components.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
GET ruleDefinitions
GET executableRules

Example of the XML document:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi" name=
"projectName">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1Exec1">
<description>Description of Rule1Exec1</description>
</ExecutableRule>
<ExecutableRule name="Rule1Exec2">
<description>Description of Rule1Exec2</description>
</ExecutableRule>
</ExecutableRules>
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</DataRuleDefinition>
<DataRuleDefinition name="Rule2Def">
<ExecutableRules>
<ExecutableRule name="Rule2Exec1">
<description>Description of Rule2Exec1</description>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
</DataRuleDefinitions>
</iaapi:Project>

XSD file elements
<DataRuleDefinitions>
Specifies the list of data rule definitions, rule set definitions, data rules and
rule sets that are defined in a project. This element is always nested in a
<Project> element. Each data rule definition is defined as a child element of
the <DataRuleDefinitions> element. Data rules are specified as children
elements of their data rule definition.
The following table shows the children of the <DataRuleDefinitions> element:
Table 67. Children of the <DataRuleDefinitions> element
Element

Cardinality

Description

<DataRuleDefinition>

0..*

Data rule definitions that are
defined in a project

<RuleSetDefinition>

0..*

Rule set definitions that are
defined in a project

<DataRuleDefinition name="...">
Specifies a rule definition. A rule definition contains an expression and a list of
data rules that are defined for the rule definition.
The following table shows the attributes of the <DataRuleDefinitions> element:
Table 68. Attributes of the <DataRuleDefinition> element
Attribute

Description

name

Name of the rule definition

The following table shows the children of the <DataRuleDefinition> element:
Table 69. Children of the <DataRuleDefinition> element
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Element

Cardinality

Description

<description>...</
description>

0 or 1

An optional description of
the rule definition in a text
format. This element is only
filled for GET ruleDefinition
requests, and not for GET
executableRule.

Table 69. Children of the <DataRuleDefinition> element (continued)
Element

Cardinality

Description

<ExecutableRules>

0 or 1

A list of data rules created
for this rule definition. This
element is only used if the
request is a GET
executableRule. It is not used
if only the rule definitions
are requested with a GET
ruleDefinition request.

<RuleSetDefinition name="...">
Specifies a rule set definition. A rule set definition contains a list of rule
definitions. The rule definitions can either be references to rule definitions
which already exists or are defined elsewhere in the XML, or they can be
created as nested <RuleDefinition> elements within the rule set definition.
The following table shows the attributes of the <RuleSetDefinition> element:
Table 70. Attributes of the <RuleSetDefinition> element
Attribute

Description

name

Name of the rule set definition

The following table shows the children of the <RuleSetDefinition> element:
Table 71. Children of the <RuleSetDefinition> element
Element

Cardinality

Description

<description>...</
description>

0 or 1

An optional description of
the rule set definition in a
text format. This element is
only filled for GET
ruleDefinition requests, and
not for GET executableRule.

<ExecutableRules>

0 or 1

A list of data rules created
for this rule set. This element
is only used if the request is
a GET executableRule. It is
not used if only the rule
definitions are requested
with a GET ruleDefinition
request.

Schema file elements for project details
Specify elements in your XML Schema Definition (XSD) document to request the
details of a project. This is a description of the elements of the XML document that
is returned when requesting the details of a project.

Name of the XSD file where the elements are defined
iaapi.xsd
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Commands that use these elements
GET project
POST create
POST update

Example of an XML document for the GET project command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="TABLE1">
<Column name="COL1"/>
<Column name="COL2"/>
(...)
<VirtualColumn name="VC1">
<Concatenation separator="|">
<Column name="COL1"/>
<Column name="COL2"/>
</Concatenation>
</VirtualColumn>
(...)
</Table>
<Table name="REFTABLE1">
<Column name="COLA"/>
<Column name="COLB"/>
</Table>
(...)
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<description>Description of Rule1Def</description>
<expression>if col1=’E’ then col2 in_reference_column refcol
</expression>
<Variables>
<Variable name="col1" dataType="string" defaultBinding=
"SOURCE1.SCHEMA1.TABLE1.COL1"/>
<Variable name="col2" dataType="string"/>
<Variable name="refcol" dataType="string"/
</Variables>
<ExecutableRules>
<ExecutableRule name="Rule1">
<description>Description of Rule1</description>
<OutputDefinition type="FailingRecords">
<OutputColumn name="col1" type="variable"
value="col1"/>
<OutputColumn name="col2" type="variable"
value="col2"/>
</OutputDefinition>
<Bindings>
<Binding var="col1"><Column name="SOURCE1.SCHEMA1.
TABLE1.COL1"/></Binding>
<Binding var="col2""><Column name="SOURCE1.SCHEMA1.
TABLE1.COL2"/></Binding>
<Binding var="refcol"><Column name="SOURCE1.SCHEMA1.
REFTABLE1.COLA"/></Binding>
</Bindings>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
(...)
</DataRuleDefinitions>
</iaapi:Project>
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XSD file elements
<Project name="...">
Specifies the name of a project. A project contains the description of the data
sources registered in it, and a list of rules. It can also contain a list of global
variables that are defined or scheduled to be created on the target system, a list
of tasks to run (only when the POST create command is used), and a list of
warnings that might occur when retrieving the details of the project.
The following table shows the attributes of the <Project> element:
Table 72. Attributes of the <Project> element
Attribute

Description

name

Name of the project

The following table shows the children of the <Project> element:
Table 73. Children of the <Project> element
Element

Cardinality

Description

<description>

0 or 1

A description of the project

<DataSources>

0 or 1

A list of data sources that are
registered or scheduled to be
registered for the project

<DataRuleDefinitions>

0 or 1

A list of data rule or rule set
definitions that are declared
in the project and their
associated data rules and
rule sets

<GlobalVariables>

0 or 1

A list of global variables
defined or scheduled to be
defined on the target system

<Tasks>

0 or 1

A list of tasks to run when
the project is created. This
element is used only for the
POST create command. It is
ignored for the other
commands.

<Warnings>

0 or 1

A list of warnings generated
by the system when the
details of a project are
retrieved with the GET
project command. This
element is ignored in all the
other commands.

Schema file elements for data sources
Specify elements in your XML Schema Definition (XSD) document in the list of
data sources registered to a project.

Name of the XSD files where the elements are defined
iaapi.xsd
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Commands that use these elements
GET project
POST create
POST update

Example of an XML document for the command:
http://9.184.184.35:9080/InformationAnalyzer/project?projectName=test104893_2
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="test104893_2">
<description></description>
<DataSources>
<DataSource name="ODBC_DS19">
<Schema name="DB2ADMIN">
<Table name="ALLTYPESDB2">
<Column name="GENDER"/>
<Column name="STREET"/>
<VirtualColumn name="ID_DATEOFBIRTH">
<Concatenation nullValueReplacement="^" padChar=" " quoteChar="\""
separator="|">
<Column name="ID"/>
<Column name="DATEOFBIRTH"/>
(...)
</Concatenation>
</VirtualColumn>
</Table>
</Schema>
</DataSource>
</DataSources>
<DataRuleDefinitions>
(...)
</DataRuleDefinition>
(...)
<Metrics>
(...)
</Metrics>
</iaapi:Project>

XSD file elements
<DataSources>
Specifies a list of data sources registered in the project. Each data source is
defined as a child element of this element.
The following table shows the children of the <DataSource> element:
Table 74. Children of the <DataSources> element
Element

Cardinality

Description

<DataSource>

0 ..*

The data source registered
for the project

<DataSource name="...">
Specifies a data source that is registered in a project.
The following table shows the attributes of the <DataSource name> element:
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Table 75. Attributes of the <DataSource> element
Attribute

Description

Name

Name of the data source

The following table shows the children of the <DataSource> element:
Table 76. Children of the <DataSource> element
Element

Cardinality

Description

<Schema>

0..*

The schemata of the data
source

<Schema name="...">
Specifies a schema of a data source (registered in a project). A schema contains
a list of physical tables or virtual tables.
The following table shows the attributes of the <Schema> element:
Table 77. Attributes of the <Schema> element
Attribute

Description

name

Name of the schema

The following table shows the children of the <Schema> element:
Table 78. Children of the <Schema> element
Element

Cardinality

Description

<Table>

0..*

Physical tables defined in the
schema

<VirtualTable>

0..*

Virtual tables defined in the
schema

<Table name="...">
Specifies a physical table registered in a project. A physical table exists in the
physical data source. A table contains a list of columns (real or virtual) and a
"where" condition that is defined as a filter in the analysis settings for the
table.
The following table shows the attributes of the <Table> element:
Table 79. Attributes of the <Table> element
Attribute

Description

name

Name of the table

The following table shows the children of the <Table> element:
Table 80. Children of the <Table> element
Element

Cardinality

Description

<description>
...</description>

0 or 1

An optional description of a
table

<Column>

0..*

Physical columns that belong
to a table
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Table 80. Children of the <Table> element (continued)
Element

Cardinality

Description

<VirtualColumn>

0..*

Virtual columns that are
defined in a table

<WhereCondition> ...
</WhereCondition>

0 or 1

An SQL statement defining
an optional filter condition to
apply when analyzing the
table. For example,
<WhereCondition>
GENDER='M'
</WhereCondition>
Note: Do not include the
"WHERE" keyword.

<VirtualTable name="..." baseTable="...">
Specifies a virtual table that is defined in a project. A virtual table is based on a
physical table that includes only some of its columns and applies a filter
condition. The concept is similar to a view in a database, but a virtual table
exists only in the project and does not require special permissions on the data
source to create a view.
The following table shows the attributes of the <Virtual Table> element:
Table 81. Attributes of the <Virtual Table> element
Attribute

Description

name

Name of the virtual table

baseTable

Name of the physical table the virtual table
is based on. This name should only contain
the table name and not the full qualified
name with data source and schema.

The following table shows the children of the <Virtual Table> element:
Table 82. Children of the <Virtual Table> element
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Element

Cardinality

Description

<description>
...</description>

0 or 1

An optional description of
the virtual table

<Column>

0..*

Physical columns that belong
to a table

<VirtualColumn>

0..*

Virtual columns that are
defined in a table

<WhereCondition> ...
</WhereCondition>

0 or 1

An SQL statement defining
an optional filter condition to
apply when analyzing the
table. For example,
<WhereCondition>
GENDER='M'
</WhereCondition>
Note: Do not include the
"WHERE" keyword.

<Column name="..." >
Specifies a physical column registered in a physical or virtual table defined in
an project.
The following table shows the attributes of the <Column> element:
Table 83. Attributes of the <Column> element
Attribute

Description

name

Name of the column

The following table shows the children of the <Column> element:
Table 84. Children of the <Column> element
Element

Cardinality

Description

<description>
...</description>

0 or 1

An eventual description
string.

<VirtualColumn name="..." >
Specifies a virtual column to define in a project. A virtual column is a column
that's values are computed during the analysis as the result of the
concatenation of several columns, or as the result of an SQL expression or data
rule expression.
The following table shows the attributes of the <Virtual column> element:
Table 85. Attributes of the <Virtual column> element
Attribute

Description

name

Name of the column

The following table shows the children of the <Virtual column> element:
Table 86. Children of the <Virtual column> element
Element

Cardinality

Description

<description>
...</description>

0 or 1

An optional description of
the virtual column

<Concatenation>

0 or 1

Use this element if the
virtual column is computed
as the concatenation of
several other columns. Using
this element implies that
<DataRuleExpression> and
<SQLExpression> are not
used in the same virtual
column.

<DataRuleExpression>

0 or 1

Use this child element if the
virtual column is computed
as the result of a data rule
expression. The use of this
element implies that
<Concatenation> and
<SQLExpression> are not
used in the same virtual
column.
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Table 86. Children of the <Virtual column> element (continued)
Element

Cardinality

Description

<SQLExpression>

0 or 1

Use this child element if the
virtual column is computed
as the result of an SQL
expression. The use of this
element implies that
<Concatenation> and
<DataRuleExpression> are
not used in the same virtual
column.

<Concatenation>
This element is used as a child of a <VirtualColumn> element if the values of
the virtual column are computed as the result of a concatenation of several
columns of the same table.
The following table shows the attributes of the <Concatenation> element:
Table 87. Attributes of the <Concatenation> element
Attribute

Description

separator

The separator char you can use between the
concatenated values (optional)

nullValueReplacement

The value to use in the place of the null
values in the concatenated columns
(optional)

padChar

Specifies a pad character (optional)

quoteChar

Specifies that a field is enclosed in single
quotes or double quotes

The following table shows the children of the <Concatenation> element:
Table 88. Children of the <Concatenation> element
Element

Cardinality

Description

<Column>

0..*

The list of columns being
concatenated

<DataRuleExpression>...</DataRuleExpression>
This element is used as a child of a <VirtualColumn> element if the values of
the virtual column are computed as the result of a data rule expression. Data
rule expressions are evaluated in IBM InfoSphere DataStage and do not impact
the physical source. The expression can contain any function or arithmetic
expression combining any number of columns of the same table. For example,
<DataRuleExpression> trim(col1)+trim(col2) </DataRuleExpression>.
The following table shows the children of the <DataRuleExpression> element:
Table 89. Children of the <DataRuleExpression> element
Element

Cardinality

Description

<TEXT>

0 or 1

The expression as a text node

<SQLExpression>...</SQLExpression>
This element is used as a child of a <VirtualColumn> element if the values of
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the virtual column are computed as the result of a SQL expression. SQL
expressions are evaluated in the source database. A SQL expression can be
used only if the source is a SQL database that can evaluate the expression in a
SELECT statement. The expression can contain any SQL function, UDF, or
arithmetic expression combining any number of columns of the same table. For
example, <SQLExpression returnType=”string” returnLength=”255”>
concat(col1, col2) </SQLExpression>.
The following table shows the attributes of the <SQLExpression> element:
Table 90. Attributes of the <SQLExpression> element
Attribute

Description

returnType

The expected return type of the expression.
Possible values are:
v numeric
v string
v date
v time
v timestamp

returnLength

If the returnType is string, specify the
maximal length of the string with this
attribute (optional)

The following table shows the children of the <SQLExpression> element:
Table 91. Children of the <SQLExpression> element
Element

Cardinality

Description

<TEXT>

0 or 1

The expression as a text node

Schema file elements for data rule definitions, rule set
definitions, data rules, and rule sets
This is a description of the elements of the XML document used when requesting,
creating or modifying data rule definitions, rule set definitions, data rules, and rule
sets.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
POST create
POST update
GET project
GET ruleDefinition
GET executableRule

Example of an XML document for the GET ruleDefinition command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataRuleDefinitions>
<DataRuleDefinition name="Rule1Def">
<description>Description of Rule1Def</description>
<expression>if col1=’E’ then col2 in_reference_column refcol
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</expression>
<Variables>
<Variable name="col1" dataType="string" defaultBinding
="SOURCE1.SCHEMA1.TABLE1.COL1"/>
<Variable name="col2" dataType="string"/>
<Variable name="refcol" dataType="string"/>
</Variables>
</DataRuleDefinition>
(...)
</DataRuleDefinitions>
</iaapi:Project>

XSD file elements
<DataRuleDefinitions>
Specifies the list of data rule definitions or rule set definitions that are defined
in a project. Each rule definition is defined as a child element of
<DataRuleDefinitions>. Data rules are specified as children elements of the rule
definition element.
The following table shows the children of the <DataRuleDefinitions> element:
Table 92. Children of the <DataRuleDefinitions> element
Element

Cardinality

Description

<DataRuleDefinition>

0..*

Rule definitions defined in
the project

<RuleSetDefinition>

0..*

Rule set definitions defined
in the project

<DataRuleDefinition name="...">
Specifies a rule definition. A rule definition contains an expression and a list of
data rules generated from the rule definition.
The following table shows the attributes of the <DataRuleDefinition> element:
Table 93. Attributes of the <DataRuleDefinition> element
Attribute

Description

name

Name of the rule definition

folder

Folder name or folder path. A folder name
can also be a folder path in the following
form <folder1>/<folder2>/<folder3>/.

The following table shows the children of the <DataRuleDefinition> element:
Table 94. Children of the <DataRuleDefinition> element
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Element

Cardinality

Description

<description>
...</description>

0 or 1

An optional description of
the data rule

<expression>
...</expression>

1

The rule expression

Table 94. Children of the <DataRuleDefinition> element (continued)
Element

Cardinality

Description

<Variables>

0 or 1

The list of variables that are
contained in the data rule
expression. This list is
returned when the "GET
project" or "GET
ruleDefinition" commands
are used, but it is not
required when creating a
rule with the "POST create"
command.

<ExecutableRules>

0 or 1

The list of data rules created
for the rule definition

<RuleSetDefinition name="...">
Specifies a rule set definition. A rule set definition contains a list of rule
definitions. The rule definitions can be references to rule definitions that
already exists or are defined elsewhere in the XML, or they can be created as
nested <RuleDefinition> elements within the rule set definition.
The following table shows the attributes of the <RuleSetDefinition> element:
Table 95. Attributes of the <RuleSetDefinition> element
Attribute

Description

name

Name of the rule set definition

folder

Folder name or folder path. A folder name
can also be a folder path in the following
form <folder1>/<folder2>/<folder3>.

The following table shows the children of the <RuleSetDefinition> element:
Table 96. Children of the <RuleSetDefinition> element
Element

Cardinality

Description

<description>
...</description>

0 or 1

An optional description of
the rule set definition

<RuleDefinitionReference>

0..*

A reference to rule
definitions that either already
exist or are defined in the
document by a
<RuleDefinition> element

<DataRuleDefinition>

0..*

A rule definition that you
want to create as a part of
the rule set

<Variables>

0 or 1

The list of variables
contained in the data rule
expression. This list is
returned when the "GET
project" or "GET
ruleDefinition" commands
are used, but it is not
required when creating a
rule with the "POST create"
command.

Chapter 16. Developing applications with the HTTP API

283

Table 96. Children of the <RuleSetDefinition> element (continued)
Element

Cardinality

Description

<ExecutableRules>

0 or 1

The list of data rules created
for the rule definition

<Variables>
Specifies the list of local variables of the data rule definition or the rule set
definition that contains it. This element is specified in the common.xsd file.
The following table shows the children of the <Variables> element:
Table 97. Children of the <Variables> element
Element

Cardinality

Description

<Variable>

0..*

Local variables of the data
rule or rule set definition

<Variable name=”...” dataType=”...”>
Specifies a local variable of a data rule definition or a rule set definition. A
variable is characterized by its name and its logical data type (numeric, string,
date, time, timestamp, or untyped). It can contain a binding element that
represents the default binding of the variable.
The following table shows the attributes of the <Variable> element:
Table 98. Attributes of the <Variable> element
Attribute

Description

name

Name of the variable

dataType

Logical data type of the variable. Possible
values include:
v Numeric
v String
v Date
v Time
v Timestamp
v Any

The following table shows the children of the <Variable> element:
Table 99. Children of the <Variable> element
Element

Cardinality

Description

<Binding>

0 or 1

The default binding of the
variable

<RuleDefinitionReference ruleName=”...”>
Specifies that a rule definition defined elsewhere in the document or already
existing in the system is part of the containing rule set definition.
The following table shows the attributes of the <RuleDefinitionReference> element:
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Table 100. Attributes of the <RuleDefinitionReference> element
Attribute

Description

ruleName

Name of the rule definition

<ExecutableRules>
Specifies the list of data rules defined for the data rule definition or rule set
definition containing this element.
The following table shows the children of the <ExecutableRules> element:
Table 101. Children of the <ExecutableRules> element
Element

Cardinality

Description

<ExecutableRule>

0..*

The data rules defined for
the data rule definition or
rule set definition

<ExecutableRule name="...">
Specifies a data rule that was generated from a data rule definition or a rule
set definition. The data rule definition or rule set definition is represented by
the parent element. A data rule contains a list of bindings, an output definition,
and eventual join conditions.
The following table shows the attributes of the <ExecutableRule> element:
Table 102. Attributes of the <ExecutableRule> element
Attribute

Description

name

Name of the data rule

folder

Folder name or folder path. A folder name
can also be a folder path in the following
form <folder1>/<folder2>/<folder3>.

The following table shows the children of the <ExecutableRule> element:
Table 103. Children of the <ExecutableRule> element
Element

Cardinality

Description

<description>
...</description>

0 or 1

An optional description of
the data rule

<BoundExpression>
...</BoundExpression>

0 or 1

The expression of the data
rule definition or rule set
definition of this executable
rule, where all the variables
have been replaced by their
binding targets. This element
is filled when the
specification of an data rule
is obtained with the GET
project command or the GET
executableRule command,
but it does not have to be
specified when a data rule is
created or updated with the
POST create command or the
POST update command.

Chapter 16. Developing applications with the HTTP API

285

Table 103. Children of the <ExecutableRule> element (continued)
Element

Cardinality

Description

<Bindings>

0 or 1

The list of bindings for the
data rule

<OutputDefinition>

0 or 1

The definition of the output
of the executable rule. The
output definition specifies
the output type (passing
records, failing records, all
records, and so on) and the
output columns.

<JoinConditions>

0 or 1

The list of join conditions to
use if the bindings are done
on columns from different
tables

<Bindings>
Specifies a list of bindings for the global variables, a data rule or a data rule
set.
The following table shows the children of the <Bindings> element:
Table 104. Children of the <Bindings> element
Element

Cardinality

Description

<Binding>

0..*

Bindings of the global logical
variables of the data rule or
rule set

<Binding var="...">
Specifies the binding of a global logical variable of a data rule or rule set. The
binding element contains an element that represents the binding target that can
be a column, or a constant or a global logical variable.
The following table shows the attributes of the <Binding var> element:
Table 105. Attributes of the <Binding var> element
Attribute

Description

var

Name of the variable that is being bound

The following table shows the children of the <Binding var> element:
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Table 106. Children of the <Binding var> element
Element

Cardinality

Description

<Column>

0 or 1

If this element is used in the
<Binding> element, the
variable name that is defined
by the attribute variable is
bound to the fully qualified
column name that is
specified in the name
attribute of the <Column>
element. If this element is
used, do not define other
children elements in the
<Binding> element.

<Constant>

0 or 1

Indicates that the variable is
bound to a literal value
(either a number, a string, a
date, a time, or a timestamp
constant) If this element is
used, do not define other
child elements in the
<Binding> element.

<Variable>

0 or 1

Indicates that the variable is
bound to a global variable.
The name of the global
variable is specified by the
name attribute of the
<Variable> element

<Constant stringValue=”...” | numericValue=”...” | ...>
Specifies the value of a constant that is used when a variable is bound to a
constant. This element contains an attribute for each possible data type
(number, string, date, time, timestamp, and so on). Use only one of these
attributes at the same time.
The following table shows the attributes of the <Constant> element:
Table 107. Attributes of the <Constant> element
Attribute

Description

numericValue

Use this attribute to specify the numeric
value of the constant, if the type of the
constant is numeric. The value can be a
floating point number.

stringValue

Use this attribute to specify the string value
of the constant if the type of the constant is
a character string

timeValue

Use this attribute to specify the time value
of the constant

dateValue

Use this attribute to specify the date value of
the constant

datetimeValue

Use this attribute to specify the timestamp
value (date+time) of the constant

<OutputDefinition>
Specifies the output definition of a data rule. The output definition contains the
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output type (the type of records in the output: passing records, failing records,
all records, or statistics only) and the name and definition of the columns
composing the output table.
The following table shows the attributes of the <OutputDefinition> element:
Table 108. Attributes of the <OutputDefinition> element
Attribute

Description

outputType

The type of the output. This includes the
type of records, passing records, failing
records, all records or statistics only. Possible
values are:
v PassingRecords
v FailingRecords
v AllRecords
v StatsOnly

The following table shows the children of the <OutputDefinition> element:
Table 109. Children of the <OutputDefinition> element
Element

Cardinality

Description

<OutputColumn>

0..*

The list of columns that are
in the output table

<OutputColumn>
Specifies a column that you want to include in the output table of a data rule.
An output column has a name (as it appears in the output table), a type (either
a global logical variable of the rule, or a physical column, an expression, or a
metric), and a target (the name of the variable, column, the expression, or the
metric).
The following table shows the attributes of the <OutputColumn> element:
Table 110. Attributes of the <OutputColumn> element
Attribute

Description

type

The type of the output column. The output
type can either be a global logical variable of
the rule, a physical column, an expression,
or a metric. Possible values are:
v variable
v column
v expression
v metric

name
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The name of the column in the output table

Table 110. Attributes of the <OutputColumn> element (continued)
Attribute

Description

value

The target of the columnIf type=”variable.”
The value should contain the name of the
rule variable that should be in the output. If
type=”column” the value should contain the
full qualified name
(datasource.schema.table.column) of the
column to put in the output. If
type=”expression” the value should contain
the expression to output. If type=”metric”
the value should be only of the following
metric names:
v METRIC_NB_PASSING_RULES
v METRIC_NB_VIOLATED_RULES
v METRIC_PERCENT_PASSING_RULES
v METRIC_PERCENT_VIOLATED_RULES
v METRIC_RECORD_ID
METRIC_RULE_EXECUTABLE_NAME
v METRIC_SYSTEM_DATE
METRIC_SYSTEM_TIMESTAMP

<JoinConditions>
Specifies an element that contains a list of join conditions to apply to run the
data rule.
The following table shows the children of the <JoinConditions> element:
Table 111. Children of the <JoinConditions> element
Element

Cardinality

Description

<JoinCondition>

0..*

The join conditions

<JoinCondition>
Specifies one join condition that is applied in the binding of a data rule. A join
condition is made up of a pair of key columns whose value should be equal
and a join type (inner, left outer, right outer, or full outer join).
The following table shows the attributes of the <JoinCondition> element:
Table 112. Attributes of the <JoinCondition> element
Attribute

Description

leftKey

The full qualified name
(datasource.schema.table.column) of the left
key of the key pair representing the join
condition

rightKey

The full qualified name
(datasource.schema.table.column) of the
right key of the key pair representing the
join condition
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Table 112. Attributes of the <JoinCondition> element (continued)
Attribute

Description

joinType

The type of join. Possible values are:
v inner
v leftOuter
v rightOuter
v fullOuter

Schema file elements for metrics
This is a description of the elements of the XML document used when requesting,
creating or modifying metrics.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
Get project
Post create
Post update
Get Metrics
Get metric/executionHistory

Example of an XML document for the command:
http://9.184.184.35:9080/InformationAnalyzer/project?projectName=test104893_2
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="test104893_2">
<description></description>
<Metric name="lessThanorEqual3">
<description>Country code must be valid..</description>
<expression>GDR105204 % Met</expression>
<MetricBenchmark operator="less_than" value="92.0"/>
</Metric>
</Metrics>
</iaapi:Project>

XSD file elements
<Metrics>
Specifies the container for all metrics of a project.
The following table shows the children of the <Metrics> element:
Table 113. Children of the <Metrics> element
Element

Cardinality

Description

<Metric>

0..*

Individual metrics

<Metric>
Specifies an individual metric referring to a rule executable.
The following table shows the children of the <Metric> element:
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Table 114. Children of the <Metric> element
Element

Cardinality

Description

<description>

0..1

An eventual description
string

<expression>

0..1

Expression referring to the
results of a data rule. To read
more about the syntax, see
Data rule definition checks.

<MetricBenchmark>

0..1

The benchmark of the metric.

<ExecutionHistory>

0..1

The execution history.

The following table shows the attributes of the <Metric> element:
Table 115. Attributes of the <Metric> element
Attribute

Description

name

Name of the metric

folder

Folder name or folder path. A folder name
can also be a folder path in the following
form <folder1>/<folder2>/<folder3>.

<MetricBenchmark>
Specifies a benchmark associated with the metric.
The following table shows the attributes of the <MetricBenchmark> element:
Table 116. Attributes of the <MetricBenchmark> element
Attribute

Description

operator

Operator of the benchmark expression.
Possible values for a benchmark operator
include greater_than, greater_or_equal,
less_than, less_or_equal.

value

Value of the benchmark expression.

<BenchmarkComparisonOperatorType>
Specifies possible values for a benchmark operator: greater_than,
greater_or_equal, less_than, less_or_equal.

Schema file elements for global logical variables
Specify elements in your XML Schema Definition (XSD) document to create,
modify, or retrieve global logical variables.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
GET globalVariables
POST create
POST update

Example of an XML document for the GET globalVariables command:
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<?xml version="1.0" encoding="UTF-8"?>
<iaapi:GlobalVariables xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<Variable dataType="any" name="var1">
<description>desc var1</description>
<Binding><Column name="SOURCE1.SCHEMA1.TABLE1.COL1"/></Binding>
</Variable>
<Variable dataType="numeric" name="var2">
<description>desc2</description>
<Binding><Column name="SOURCE1.SCHEMA1.TABLE1.COL3"/></Binding>
</Variable>
<Variable dataType="date" name="var3">
<Binding><Constant dataType="date" dateValue="2010-02-10Z"/></Binding>
</Variable>
<Variable dataType="numeric" name="var4"/>
<Variable dataType="numeric" name="var5">
<Binding><Constant dataType="numeric" numericValue="10.0"/></Binding>
</Variable>
</iaapi:GlobalVariables>

XSD file elements
<GlobalVariables>
Specifies the list of global variables defined on the target system.
The following table shows the children of the <GlobalVariables> element:
Table 117. Children of the <GlobalVariables> element
Element

Cardinality

Description

<Variable>

0..*

The definition of a global
variable

<Variable name="..." dataType="...">
Specifies a global logical variable. A global logical variable is characterized by
its name and its logical data type (numeric, string, date, time, timestamp, or
untyped). It also contains a binding element that represents the binding target
of the variable.
The following table shows the attributes of the <Variable> element:
Table 118. Attributes of the <Variable> element
Attribute

Description

name

Name of the global logical variable

dataType

Logical data type of the variable. Possible
values are:
v Numeric
v String
v Date
v Time
v Timestamp
v Any

The following table shows the children of the <Variable> element:
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Table 119. Children of the <Variable> element
Element

Cardinality

Description

<Binding>

0 or 1

The binding target of the
variable

<Binding>
Represents the binding of a global variable. The binding element contains an
element that represents the binding target that can be, for a global variable,
either a column, or a constant.
The following table shows the children of the <Binding> element:
Table 120. Children of the <Binding> element
Element

Cardinality

Description

<Column>

0 or 1

If this element is used in the
<Binding> element, the
variable name that is defined
by the attribute "var" is
bound to the column whose
fully qualified name is
specified in the name
attribute of the <Column>
element. If this element is
used, do not define other
children elements in the
<Binding> element.

<Constant>

0 or 1

The use of this element
indicates that the variable is
bound to a literal value (a
number, a string, a date, a
time, or a timestamp
constant). If this element is
used, do not define other
child elements in the
<Binding> element.

Schema file elements for running column analyses and data
rules
Specify elements in your XML Schema Definition (XSD) document used to run
column analyses and data rules. This is a description of the elements of the XML
document that is used to run column analyses and data rules.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
v POST create
v POST executeTasks
Here is an XML file example for running a column analysis and several data rules:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<Tasks>
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<RunRules>
<SampleOptions type="every_nth" size="1000" nthvalue="10"/>
<Schedule startDate="2010-02-09T18:56:31+01:00" runUntil=
"2010-02-15T10:00:00+01:00" nbOfInstances="10">
<ScheduleRepeat second="0" minute="0" hour="12"
dayOfMonth="*" month="*" dayOfWeek="?" year="*"/>
</Schedule>
<ExecutableRule name="rule1"/>
<ExecutableRule name="rule2"/>
<ExecutableRule name="rule3"/>
</RunRules>
<RunColumnAnalysis>
<Column name="BANK.BANK1.*.*"/>
<Column name="BANK.BANK2.TABLE1.*"/>
<SampleOptions type="every_nth" size="1000" nthvalue="10"/>
<Schedule startDate="2010-02-09T18:56:31+01:00"
runUntil="2010-02-15T10:00:00+01:00" nbOfInstances="10">
<ScheduleRepeat second="0" minute="0" hour="12"
dayOfMonth="*" month="*" dayOfWeek="?" year="*"/>
</Schedule>
</RunColumnAnalysis>
</Tasks>
</iaapi:Project>

XSD file elements
<Tasks>
Specifies the list of tasks to run. You can either run a column analysis (base
profile) on a list of columns or run a list of data rules. Each task can use
individual schedules, run times, and sampling settings.
The following table shows the children of the <Tasks> element:
Table 121. Children of the <Tasks> element
Element

Cardinality

Description

<RunColumnAnalysis>

0..*

Runs a column analysis (base
profile) job on one or more
columns

<RunRules>

0..*

Runs one or more data rules

<RunMultiColumnKey
Analysis>

0..*

Runs multi-column analysis
on a set of given tables

<RunCrossDomainAnalysis>

0..*

Runs a foreign key
relationship and cross
domain analysis on a set of
pairs of column sets.

<RunReferentialIntegrity
Analysis>

0..*

Runs a referential integrity
analysis on a set of foreign
key candidates.

<RunColumnAnalysis>
Specifies that a column analysis should be run on one or more columns. You
can use sub-elements to specify the scheduling, sampling, run time and job
options.
The following table shows the children of the <RunColumnAnalysis> element:
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Table 122. Children of the <RunColumnAnalysis> element
Element

Cardinality

Description

<SampleOptions>

0 or 1

Specifies sampling options
that you can use when
running the job

<EngineOptions>

0 or 1

Specifies engine options that
you can use when running
the job

<JobOptions>

0 or 1

Specifies job options that you
can use when running the
job

<Schedule>

0 or 1

Specifies scheduling options
that you can use when
running the job

<Column>

1*

List of columns that you
want to analyze

<SampleOptions>
Specifies the sampling to apply on the data sources when you run the analysis.
The following table shows the attributes of the <SampleOptions> element:
Table 123. Attributes of the <SampleOptions> element
Attribute
type

Description
The sampling type. Possible values include:
v random
v sequential
v every_nth

percent

Percentage of value to use in the sampling.
The value to provide should be between 0.0
(0%) and 1.0 (100%)

seed

If type=”random”, this value is used to
initialize the random generators. Two
samplings that use the same seed value will
contain the same records

size

The maximum number of records in the
sampling

nthValue

If type=”every_nth”, this value indicates the
step to apply (one row will be kept out of
every nth value rows). This attribute is
ignored for all the other sampling types

<EngineOptions>
Specifies the engine options to use when running the analysis.
The following table shows the attributes of the <EngineOptions> element:
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Table 124. Attributes of the <EngineOptions> element
Attribute

Description

retainOsh

If true, the generated IBM InfoSphere
DataStage job is retained at the end of the
analysis. If false, it will be deleted if the job
runs successfully. Possible values are:
v true
v false

retainDataSets

If true, the generated data sets are retained
at the end of the analysis. If false, they are
deleted. This option is ignored when data
rules are running

PXConfigurationFile

Specifies an alternative configuration file to
use with the data stage engine during this
run

gridEnabled

Specifies if the grid view will be enabled.
Possible values are:
v true
v false

requestedNodes

The name of requested nodes

minimumNodes

The minimum number of nodes that you
want in the analysis

partitionsPerNode

The number of partitions for each node in
the analysis

<JobOptions>
Specifies the job options to use when running the analysis.
The following table shows the attributes of the <JobOptions> element:
Table 125. Attributes of the <JobOptions> element
Attribute

Description

debugEnabled

This attribute only is used for running data
rules. It is ignored when running a column
analysis. If true, a debug table containing
the evaluation results of all functions and
tests contained in the expression is
generated. If false, no debug table is
generated. Possible values are:
v true
v false

296

User's Guide

nbOfDebuggedRecords

If debugEnabled=”true” this attribute
specifies how many rows should be
debugged. The default value is 20

arraySize

The size of the array

autoCommit

Possible values are true or false

isolationLevel

The isolation level for the analysis

Table 125. Attributes of the <JobOptions> element (continued)
Attribute

Description

updateExistingTables

This attribute is only used for column
analysis and is ignored when running data
rules. If true, existing tables in the IBM
InfoSphere Information Analyzer database
(IADB) will be updated. If false, new tables
will be created. Possible values are:
v true
v false

<Schedule>
Specifies the scheduling of a column analysis job or running a data rule. If this
element is omitted, the column analysis will run immediately and only once.
The following table shows the attributes of the <Schedule> element:
Table 126. Attributes of the <Schedule> element
Attribute

Description

startDate

Specifies the date and time when the
analysis or data rule should start. If no value
is specified, the analysis starts immediately.

runUntil

If a repeating analysis is scheduled, this
element specifies the date and time after
which no new analysis should be started. If
this value is not specified, the analysis is
repeated at the defined interval until you
manually delete the schedule.

nbOfInstances

If a repeating analysis is scheduled, this
element specifies the maximum number of
times the analysis should start. If this value
is not specified, then the analysis will be
repeated at the defined interval until you
manually delete the schedule. If the analysis
is scheduled only once and no runUntil
attribute or <ScheduleRepeat> children
elements are defined, you should set the
value of this attribute to "1".

The following table shows the children of the <Schedule> element:
Table 127. Children of the <Schedule> element
Element

Cardinality

Description

<Description>

0 or 1

A description of the schedule

<ScheduleRepeat>

0..*

Specifies intervals when the
analysis should be repeated.
If the analysis is scheduled
only once and no runUntil
attribute or
<ScheduleRepeat> children
elements are defined, you
should set the value of this
attribute to "1".
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<ScheduleRepeat>
Specifies a schedule interval for repeating the column analysis.
The following table shows the attributes of the <Schedule> element:
Table 128. Attributes of the <Schedule> element
Attribute

Description

Allowed values

Allowed special
characters

second

The second that you
want to schedule the
column analysis or
data rule to run

0-59

-*/

minute

The minute that you
want to schedule the
column analysis or
data rule to run

0-59

-*/

hour

The hour that you
want to schedule the
column analysis to
run

0-23

-*/

dayOfMonth

The day of the month 1-31
that you want to
schedule the column
analysis or data rule
to run

month

The month that you
want to schedule the
column analysis or
data rule to run

1-12 or JAN-DEC

-*/

dayOfWeek

The day of the week
that you want to
schedule the column
analysis or data rule
to run

1-7 or SUN-SAT

-*?/

year

The year that you
want to schedule the
column analysis or
data rule to run

1970-2099

-*/

-*?/

Special characters that can be used with attributes of the
<Schedule> element
Asterisk (*)
Specifies all values. For example, "*" (an asterisk) in the minute field means
"every minute". This is the default value used for any unspecified fields.
Question mark (?)
Specifies that there is no specific value. . You must use the '?' (question mark)
for the field that you want to ignore. For example, if you want every 1st and
15th of the month, regardless of which day of the week, use the '?' for the
DayOfWeek field.
Dash (-)
Specifies ranges in value. For example, "10-12" in the hour field means the
hours, "10, 11 and 12."
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Comma (,)
Specifies additional values. For example, "MON,WED,FRI" in the dayOFweek
field means the days, "Monday, Wednesday, and Friday."
Backslash (/)
Specifies increments in value. For example, "0/15" in the seconds field means
the seconds "0, 15, 30, and 45". And "5/15" in the seconds field means the
seconds, "5, 20, 35, and 50."
The following table shows examples of time expressions:
Table 129. Examples of time expressions
Expression

Meaning

"0 0 12 * * ?"

Run at 12 PM every day

"0 15 10 ? * *"

Run at 10:15 AM every day

"0 15 10 * * ? 2005"

Run at 10:15 AM every day during the year
2009

"0 10,44 14 ? 3 WED"

Run at 2:10 PM and at 2:44 PM every
Wednesday in the month of March

<Column name="..."/>
Specifies the name of the columns that you want to run the column analysis
for. When used in a <RunColumnAnalysisTask> element, only its attribute
name must be set with the fully qualified column names.
The following table shows the attributes of the <Column name="..."/> element:
Table 130. Attributes of the <Column name> element
Attribute

Description

name

The name of the column to analyze. The
name must be fully qualified
(datasource.schema.table.column). The *
(asterisk) wildcard is allowed to specify a
range of columns. For example,
“BANK.BANK1.CUSTOMERS.*” indicates
that all the columns of the table
BANK.BANK1.CUSTOMERS should be
analyzed.
Note: <RunColumnAnalysisTask> can
contain several <Column> elements to
specify several columns or several range of
columns.

<RunMultiColumnKeyAnalysis>
Specifies that a column analysis should be run on one or more columns in a
table.
The following table shows the children of the <RunMultiColumnKeyAnalysis>
element:
Table 131. Children of the <RunMultiColumnKeyAnalysis> element
Element

Cardinality

Description

<Table>

0 or unbound

Table specification to run a
key analysis on.
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The following table shows the attributes of the <RunMultiColumnKeyAnalysis>
element:
Table 132. Attributes of the <RunMultiColumnKeyAnalysis> element
Attribute

Description

compositeMax

The maximum number of columns of a
multi-column key.

<RunCrossDomainAnalysis>
Specifies that a cross domain analysis should be run to identify the overlap of
data values between two columns of data.
The following table shows the children of the <RunCrossDomainAnalysis>
element:
Table 133. Children of the <RunCrossDomainAnalysis> element
Element

Cardinality

Description

<ColumnPair>

0 or unbound

A pair of base and paired
columns to be examined for
foreign key relationships and
cross domain.

The following table shows the attributes of the <RunCrossDomainAnalysis>
element:
Table 134. Attributes of the <RunCrossDomainAnalysis> element
Attribute

Description

excludeColContainingNulls

The maximum number of columns of a
multi-column key.

excludeByMinimumUniquenessPercent

Threshold for excluding columns based on
their minimum uniqueness (percentage
between 0 and 1).

excludeDateDataClass

Flag for excluding columns based on their
date data class.

excludeIndicatorsDataClass

Flag for excluding columns based on their
indicators data class.

excludeTestDataClass

Flag for excluding columns based on their
test data class.

excludeByMaximalLength

Threshold for excluding columns based on
their length.

excludeColumnsMissingColumn
AnalysisResults

Flag for not using columns without column
analysis results.

<ColumnPair>
Specifies a pair of base and paired columns to be examined for foreign key
relationships and cross domain.
The following table shows the children of the <ColumnPair> element:
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Table 135. Children of the <ColumnPair> element
Element

Cardinality

Description

<BaseColumns>

1

A set of base columns the
foreign key relationships
points to (for example, the
primary key). The fully
qualified column name can
contain wildcards (*).

<PairedColumns>

1

A set of target columns the
foreign key relationships
originates at (for example,
the foreign key). The fully
qualified column name can
contain wildcards (*).

<RunReferentialIntegrityAnalysis>
Specifies that a referential integrity analysis should be run on a set of foreign
key candidates.
The following table shows the children of the <RunReferentialIntegrityAnalysis>
element:
Table 136. Children of the <RunReferentialIntegrityAnalysis> element
Element

Cardinality

Description

<ForeignKeyCandidate>

0 to unbounded

A compound element
describing a candidate for a
foreign key relationship.

<ForeignKeyCandiate>
Specifies a compound element describing a candidate for a foreign key
relationship.
The following table shows the children of the <ForeignKeyCandiate> element:
Table 137. Children of the <ForeignKeyCandiate> element
Element

Cardinality

Description

<PrimaryKey>

1

Describes the columns of the
primary key of a foreign key
relationship.

<ForeignKey>

1

Describes the columns of the
foreign key of a foreign key
relationship.

<PrimaryKey>
Specifies the columns of the primary key of a foreign key relationship.
The following table shows the children of the <PrimaryKey> element:
Table 138. Children of the <PrimaryKey> element
Element

Cardinality

Description

<Column>

0 to unbounded

Columns that are part of the
primary key.
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<ForeignKey>
Specifies columns of the foreign key of a foreign key relationship.
The following table shows the children of the <ForeignKey> element:
Table 139. Children of the <ForeignKey> element
Element

Cardinality

Description

<Column>

0 to unbounded

Columns that are part of the
foreign key.

<RunRules>
Specifies a task that runs one or more rules. You can use sub elements to
specify the scheduling, sampling, runtime and job options.
The following table shows the children of the <RunRules> element:
Table 140. Children of the <RunRules> element
Element

Cardinality

Description

<SampleOptions>

0 or 1

Specifies optional sampling
options to use when running
the job

<EngineOptions>

0 or 1

Specifies optional engine
options to use when running
the job

<JobOptions>

0 or 1

Specifies optional job options
to use when running the job

<Schedule>

0 or 1

Specifies optional scheduling
options to use when running
the job

<ExecutableRule>

1..*

List of data rules that you
want to run

<ExecutableRule name=”...”/>
Specifies the name of the rule that you want to run. When used in a
<RunRules> element, only its attribute name must be set with the name of the
rule.
The following table shows the attributes of the <ExecutableRule> element:
Table 141. Attributes of the <ExecutableRule> element
Attribute

Description

name

The name of the rule that you want to run

Schema file elements for getting the history of data rules
Specify elements in your XML Schema Definition (XSD) document to get the
history of data rules. This is a description of the elements of the XML document
that is returned when requesting the history of data rules.

Name of the XSD file where the elements are defined
iaapi.xsd
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Commands that use these elements
GET executableRule/executionHistory

Example of the XML document:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="projectName">
<DataRuleDefinitions>
<!-- Example for a simple rule -->
<DataRuleDefinition name="Rule1Def">
<ExecutableRules>
<ExecutableRule name="Rule1Exec1">
<ExecutionHistory>
<RuleExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-09T18:57:02+01:00"
id=”1”
status="successful"
nbOfRecords="10"
nbPassed="10"
percentPassed="1.0"
nbFailed="0"
percentFailed="0.0"
runBy="admin"/>
<RuleExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-08T14:34:26+01:00"
id=”2”
status="successful"
nbOfRecords="100"
nbPassed="98"
percentPassed="0.98"
nbFailed="2"
percentFailed="0.02"
runBy="admin"/>
<RuleExecutionResult
startTime="2010-02-09T17:53:31+01:00"
endTime="2010-02-08T17:31:26+01:00"
id=”3”
status="failed"
nbOfRecords="0"
nbPassed="0"
percentPassed="0.0"
nbFailed="0"
percentFailed="0.0"
runBy="admin"/>
</ExecutioHistory>
</ExecutableRule>
</ExecutableRules>
</DataRuleDefinition>
<!-- Example for a rule set -->
<RuleSetDefinition name="RuleSetDef">
<ExecutableRules>
<ExecutableRule name="RuleSetExec1">
<ExecutionHistory>
<RuleSetExecutionResult
startTime="2010-02-09T18:56:31+01:00"
endTime="2010-02-08T14:34:26+01:00"
id=”1”
status="successful"
nbOfRecords="100"
runBy=”admin”
nbRules=”10”
meanNbFailedRulesPerRecord=”1.15”
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stddevNbFailedRulesPerRecord=”0.13”
meanPercentFailedRulesPerRecord=”0.115”
stddevPercentFailedRulesPerRecord=”0.013”>
<AbsoluteFailureDistribution>
<DiscreteDistributionItem value=”0” percentFrequency=”0.35”
absoluteFrequency=”35”/>
<DiscreteDistributionItem value=”1” percentFrequency=”0.60”
absoluteFrequency=”60”/>
<DiscreteDistributionItem value=”3” percentFrequency=”0.5”
absoluteFrequency=”5”/>
<DiscreteDistributionItem value=”4” percentFrequency=”0.0”
absoluteFrequency=”0”/>
</AbsoluteFailureDistribution>
<RuleExecutionResult id=”rule1”
nbPassed="85" percentPassed="0.85"
nbFailed="15" percentFailed="0.15"/>
<RuleExecutionResult id=”rule2”
nbPassed="80" percentPassed="0.80"
nbFailed="20" percentFailed="0.20"/>
<RuleExecutionResult id=”rule3”
nbPassed="90" percentPassed="0.90"
nbFailed="10" percentFailed="0.10"/>
</RuleSetExecutionResult>
</ExecutionHistory>
</ExecutableRule>
</ExecutableRules>
</RuleSetDefinition>
</DataRuleDefinitions>
</iaapi:Project>

XSD file elements
<ExecutionHistory>
Documents the result of applying a data rule or set of data rules to the bound
data sources. This element is nested in an <ExecutableRule> element.
The following table shows the children of the <ExecutionHistory> element:
Table 142. Children of the <ExecutionHistory> element
Element

Cardinality

Description

<RuleExecutionResult>

0..*

The result of running a data
rule

<RuleSetExecutionResult>

0..*

The result of running a rule
set

<MetricExecutionResult>

0..*

The result of running a
metric

<RuleExecutionResult>
Specifies the results of running a single data rule.
The following table shows the attributes of the <RuleExecutionResult> element:
Table 143. Attributes of the <RuleExecutionResult> element
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Attribute

Description

id

A unique identification for the data rule you
are running. This identification serves as a
reference for the command GET
executableRule/outputTable.

Table 143. Attributes of the <RuleExecutionResult> element (continued)
Attribute

Description

status

The status of the data rule that you are
running. Possible values are:
v not_started
v running
v failed
v successful
v unknown

startTime

The date and time at which the data rule
started running. The format is, yyyy-mm-dd
T hh:mm:ss+hh:mm.

endTime

The date and time at which the data rule
ended running. The format is, yyyy-mm-dd
T hh:mm:ss+hh:mm

runBy

The name of the person who issued the data
rule

nbOfRecords

The total number of records processed when
the data rule was run

nbPassed

The number of records that pass when the
data rule was run

nbFailed

The number of records that failed when the
data rule was run

percentPassed

The percentage of all records that passed the
data rule

percentFailed

The percentage of all records that violate the
data rule

ruleName

The name of the rule. This attribute is only
used when <RuleExecutionResult> is a child
of <RuleSetExecutionResult>.

<RuleSetExecutionResult>
Represents the results after you run a data rule set.
The following table shows the attributes of the <RuleSetExecutionResult> element:
Table 144. Attributes of the <RuleSetExecutionResult> element
Attribute

Description

id

A unique identification for the data rule set
you are running. This identification serves as
a reference for the command GET
executableRule/outputTable.

status

The status of the data rule set execution.
Possible values are:
v not_started
v running
v failed
v successful
v unknown
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Table 144. Attributes of the <RuleSetExecutionResult> element (continued)
Attribute

Description

startTime

The date and time at which the data rule set
started running. The format is, yyyy-mm-dd
T hh:mm:ss+hh:mm.

endTime

The date and time at which the data rule set
ended running. The format is, yyyy-mm-dd
T hh:mm:ss+hh:mm.

runBy

The name of the user who executed the data
rule set

nbOfRecords

The total number of records processed when
the data rule set was run

nbRules

The number of rules in the rule set

meanNbFailedRulesPerRecord

The average number of rules that a record
breaks

stddevNbFailedRulesPerRecord

The standard deviation of the number of
rules broken by each record

meanPercentFailedRulesPerRecord

The average percentage of rules broken by
each record

stddevPercentFailedRulesPerRecord

The standard deviation of the percentage of
rules broken by each record

The following table shows the children of the <RuleSetExecutionResult> element:
Table 145. Children of the <RuleSetExecutionResult> element
Element

Cardinality

Description

<RuleExecutionResult>

0..*

The results of each
individual rule in the data
rule set after running the
rule set

<AbsoluteFailureDistribution> 0 or 1

The distribution data of the
number and percentage of
records violating one rules,
two rules, and so on in the
rule set

<AbsoluteFailureDistribution>
Represents the distribution data of the number and percentage of records
violating one rule, two rules, and so on in the rule set.
The following table shows the children of the <AbsoluteFailureDistribution>
element:
Table 146. Children of the <AbsoluteFailureDistribution> element
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Element

Cardinality

Description

<DiscreteDistributionItem>

0..*

The number and percentage
of records that failed the
number of rules in the
attribute value

<DiscreteDistributionItem>
Represents the number and percentage of records that failed the number of
rules in the attribute value.
The following table shows the attributes of the <DiscreteDistributionItem> element:
Table 147. Attributes of the <DiscreteDistributionItem> element
Attribute

Description

value

The number of failed rules

percentFrequency

The percentage of records violating the
number of rules specified in the attribute
value

absoluteFrequency

The absolute number of records violating the
number of rules specified in the attribute
value

<MetricExecutionResult>
Contains the result of a single run of a metric.
The following table shows the children of the <MetricExecutionResult> element:
Table 148. Children of the <MetricExecutionResult> element
Element

Cardinality

Description

<MetricBenchmarkResult>

0..1

The result of the benchmark
associated with the metric.

The following table shows the attributes of the <MetricExecutionResult> element:
Table 149. Attributes of the <MetricExecutionResult> element
Attribute

Description

id

A unique identification for the run.

status

The status of the run. Possible values
include:
v not_started
v running
v failed
v successful
v unknown

timeStamp

The date/time of the last execution of the
metric. Format: ’yyyy'-'mm''dd'T'hh':'mm':'ss'+'hh:mm’

runBy

Name of the user who executed the run.

value

Value of the metric.

<MetricBenchmarkResult>
Specifies the result of the benchmark associated with the metric.
The following table shows the children of the <MetricBenchmarkResult> element:
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Table 150. Children of the <MetricBenchmarkResult> element
Element

Cardinality

Description

<MetricBenchmark>

1

The benchmark associated
with the metric.

The following table shows the attributes of the <MetricBenchmarkResult> element:
Table 151. Attributes of the <MetricBenchmarkResult> element
Attribute

Description

result

Result of executing the metric benchmark.
Possible values include:
v passed
v failed

variance

Difference between the value of the metric
and the benchmark threshold.

Schema file elements for getting the output of a data rule
Specify elements in your XML Schema Definition (XSD) document to get the
output of a data rule. This is a description of the elements of the XML document
that is returned when requesting the output table of a data rule.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
GET executableRule/outputTable

Example of an XML document for the GET executableRule/outputTable:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:OutputTable xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<OutputDefinition type="FailingRecords">
<OutputColumn name="john_smith" dataType="STRING" value="john_smith"/>
<OutputColumn name="john_doe" dataType="STRING" value="john_doe"/>
</OutputDefinition>
<Rows>
<Row><Value>Row1Col1Value</Value><Value>Row1Col2Value</Value></Row>
<Row><Value>Row2Col1Value</Value><Value>Row2Col2Value</Value></Row>
<Row><Value>Row3Col1Value</Value><Value>Row3Col2Value</Value></Row>
<Row><Value>Row4Col1Value</Value><Value>Row4Col2Value</Value></Row>
<Row><Value>Row5Col1Value</Value><Value>Row5Col2Value</Value></Row>
<Row><Value>Row6Col1Value</Value><Value>Row6Col2Value</Value></Row>
<Row><Value>Row7Col1Value</Value><Value>Row7Col2Value</Value></Row>
<Row><Value>Row8Col1Value</Value><Value>Row8Col2Value</Value></Row>
<Row><Value>Row9Col1Value</Value><Value>Row9Col2Value</Value></Row>
</Rows>
</iaapi:OutputTable>

XSD file elements
<OutputTable>
Specifies which records appear in the output table when you run a data rule.
The following table shows the children of the <OutputTable> element:
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Table 152. Children of the <OutputTable> element
Element

Cardinality

Description

<OutputDefinition>

0 or 1

The output columns and the
type of output

<Rows>

0 or 1

The output records that
match the output definition

<OutputDefinition>
Specifies the output columns and the type of the output.
The following table shows the attributes of the <OutputDefinition> element:
Table 153. Attributes of the <OutputDefinition> element
Attribute

Description

type

The type of output. Possible values are:
v PassingRecords
v FailingRecords
v AllRecords
v StatsOnly
v undefined

The following table shows the children of the <OutputDefinition> element:
Table 154. Children of the <OutputDefinition> element
Element

Cardinality

Description

<OutputColumn>

0 or unbounded

The name, type, and value of
columns that you want to
include in the output

<OutputColumn>
Specifies the columns that you want to include in the output.
The following table shows the attributes of the <OutputColumn> element:
Table 155. Attributes of the <OutputColumn> element
Attribute

Description

type

The type of the output column. The type can
be a variable of the data rule, a physical
column, an expression, or a metric. Possible
values are:
v column
v variable
v expression
v metric

name

The name of the column
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Table 155. Attributes of the <OutputColumn> element (continued)
Attribute

Description

value

The value of the column
v If type=”variable” the value should
contain the name of the rule variable that
should be in the output.
v If type=”column” the value should
contain the full qualified name
(datasource.schema.table.column) of the
column to put in the output.
v If type=”expression” the value should
contain the expression to output.
v If type=”metric” the value should be one
of the following metric names:
– METRIC_NB_PASSING_RULES
– METRIC_NB_VIOLATED_RULES
– METRIC_PERCENT_PASSING_
RULES
– METRIC_PERCENT_VIOLATED
_RULES
– METRIC_RECORD_ID
– METRIC_RULE_EXECUTABLE
_NAME
– METRIC_SYSTEM_DATE
– METRIC_SYSTEM_TIMESTAMP

dataType

The logical data type of the variable.
Possible values are:
v numeric
v string
v date
v time
v timestamp
v any

<Rows>
This element is used to represent the output records.
The following table shows the children of the <Rows> element:
Table 156. Children of the <Rows> element
Element

Cardinality

Description

<Row>

0 to unbounded

An individual output record

<Row>
This element is used to represent an individual output record.
The following table shows the children of the <Row> element:
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Table 157. Children of the <Row> element
Element

Cardinality

Description

<Value>

0 to unbounded

An individual data value
within an output record

<Value>
Represents an individual data value of an output record.
The following table shows the elements of the <Value> element:
Table 158. Elements of the <Value> element
Element

Description

<TEXT>

The data value

Schema file elements for getting the results of a column
analysis
Specify elements in your XML Schema Definition (XSD) document to request the
results of a column analysis. This is a description of the elements of the XML
document that is returned when requesting the results of a column analysis.

Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
GET columnAnalysis/results
Example of an XML document for the GET columnAnalysis command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi"
name="project1">
<DataSources>
<DataSource name="SOURCE1">
<Schema name="SCHEMA1">
<Table name="TABLE1">
<Column name="COL1">
<ColumnAnalysisResults>
<RuntimeMetadata sampleUsed=”true” whereClause=”GENDER=’M’”
analysisDate=”2010-02-09T18:56:31+01:00” runTime=”120”>
<SampleOptions type=”RANDOM” percent=”0.10” size=”100”/>
</RuntimeMetadata>
<Cardinality count=”1000” percent=”1.0”
inferredCardinalityType=”UNIQUE”
definedCardinalityType=”NOT_CONSTRAINED”
selectedCardinalityType=”UNIQUE”/>
<DataType definedType=”STRING” definedLength=”128”
inferredType=”STRING” inferredLength=”32”
selectedType=”STRING” selectedLength=”32”
definedNullability=”true” inferredNullability=”true”
selectedNullability=”true”
definedIsEmpty=”false” inferredIsEmpty=”false”
selectedIsEmpty=”false”
inferredIsConstant=”false” definedIsConstant=”false”/>
<DataClass classificationDate=”2010-02-09T18:56:31+01:00”
classificationStatus=”REVIEWED”
inferredClass=”Code”
selectedClass=”Code”/>
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<Format analysisDate=”2010-02-09T18:56:31+01:00”
analysisStatus=”REVIEWED”
generalFormat=”AAAA” generalFormatPercent=”0.95”/>
<CompletenessAnalysis analysisDate=”2010-02-09T18:56:31+01:00”
analysisStatus=”REVIEWED”/>
<DomainAnalysis analysisDate=”2010-02-09T18:56:31+01:00”
analysisStatus=”REVIEWED”/>
</ColumnAnalysisResults>
</Column>
<Column name="COL2">
<ColumnAnalysisResults>
(...)
</ColumnAnalysisResults>
</Column>
</Table>
</Schema>
</DataSource>
</DataSources>
</iaapi:Project>

XSD file elements
<Project name=”...”>
Specifies the name of the project.
The following table shows the attributes of the <Project> element:
Table 159. Attributes of the <Project> element
Attribute

Description

name

The name of the project

The following table shows the children of the <Project> element:
Table 160. Children of the <Project> element
Element

Cardinality

Description

<DataSources>

0 or 1

A list of data sources that are
registered for the project

<Column name=”...”>
Specifies a physical column to register in a physical or virtual table that is
defined in a project.
The following table shows the attributes of the <Column> element:
Table 161. Attributes of the <Column> element
Attribute

Description

name

The name of the column

The following table shows the children of the <Column> element:
Table 162. Children of the <Column> element
Element

Cardinality

Description

<ColumnAnalysisResults>

0 or 1

The results of the column
analysis for this column

The following table shows the children of the <ColumnAnalysisResults> element:
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Table 163. Children of the <ColumnAnalysisResults> element
Element

Cardinality

Description

<RunTimeMetaData>

0 or 1

Specifies the elements that
were used during the
analysis

<Cardinality>

0 or 1

Specifies the number of
distinct values that are found
and the percentage of
distinct values in the total
number of records

<DataType>

0 or 1

Shows the defined, inferred,
and selected data types

<DataClass>

0 or 1

Specifies the inferred and
selected data classes

<Format>

0 or 1

Specifies the general
information about the format
analysis

<CompletenessAnalysis>

0 or 1

Specifies the date and status
of the completeness analysis
for this column

<DomainAnalysis>

0 or 1

Specifies the date and status
of the domain analysis for
this column

<FrequencyAnalysis>

0 or 1

Specifies the date and status
of the frequency analysis for
this column

<Cardinality>
Specifies the number of values in a column.
The following table shows the attributes of the <Cardinality> element:
Table 164. Attributes of the <Cardinality> element
Attribute

Description

count

The number of distinct values in a column

percent

The total number of distinct values in a
column divided by the total number of
values in the same column

inferredCardinalityType

The inferred cardinality type, based on the
actual data type of the column. Possible
values are:
v unique_and_constant
v unique
v constant
v not_constrained

definedCardinalityType

The defined cardinality type, as defined in
the data source. Possible values are:
v unique_and_constant
v unique
v constant
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Table 164. Attributes of the <Cardinality> element (continued)
Attribute

Description

selectedCardinalityType

The cardinality type selected for this
column. Possible values are:
v unique_and_constant
v unique
v constant

<DataType>
Specifies the defined, inferred, and selected data types.
The following table shows the attributes of the <DataType> element:
Table 165. Attributes of the <DataType> element
Attribute

Description

definedType

The data type defined in the source. Possible
values are:
v Boolean
v date
v datetime
v decimal
v dfloat
v int8
v int16
v int32
v int64
v sfloat
v qfloat
v time
v string
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inferredType

The data type inferred from the actual data
of the column

selectedType

The data type selected for this column

definedLength

The data length defined in the source

inferredLength

The data length inferred from the actual
data of the column

selectedType

The data length selected for this column

definedLength

The data length defined in the source

inferredLength

The data length inferred from the actual
data of the column

selectedLength

The data length selected for this column

definedPrecision

The data precision defined in the data
source

inferredPrecision

The data precision inferred from the actual
data of the column

selectedPrecision

The data precision selected for this column

definedScale

The data scale defined in the data source

Table 165. Attributes of the <DataType> element (continued)
Attribute

Description

InferredScale

The data scale inferred from the actual data
of the column

selectedScale

The data scale selected for this column

definedNullability

The nullability defined in the data source

inferredNullability

The nullability inferred from the actual data
of the column

SelectedNullability

The nullability selected for this column

definedIsEmpty

The empty flag defined in the data source

inferredIsEmpty

The empty flag inferred from the data of the
column

selectedIsEmpty

The empty flag selected for this column

inferredIsConstant

The constant flag inferred from the data of
the column

selectedIsConstant

The constant flag selected by the user for
this column

<DataClass>
Specifies the inferred and selected data classes.
The following table shows the attributes of the <DataClass> element:
Table 166. Attributes of the <DataClass> element
Attribute

Description

inferredClass

The data class inferred by IBM InfoSphere
Information Analyzer from the data of the
column

selectedClass

The data class selected for this column

classificationDate

The date and time of the data classification

classificationStatus

The status of the data classification. Possible
values are:
v not_done
v processing_started
v processing_completed
v review_completed
v error
v not_found
v not_analyzable
v review_only
v lightweight_review

<Format>
Represents the most frequent inferred format of a column.
The following table shows the attributes of the <Format> element:
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Table 167. Attributes of the <Format> element
Attribute

Description

generalFormat

The most general format

generalFormatPercent

The percentage of all column values that
match the format

analysisDate

The date and time of the analysis

analysisStatus

The status of the format analysis. Possible
values are:
v not_done
v processing_started
v processing_completed
v review_completed
v error
v not_found
v not_analyzable
v review_only
v lightweight_review

<CompletenessAnalysis>
Specifies the last completeness analysis run.
The following table shows the attributes of the <CompletenessAnalysis> element:
Table 168. Attributes of the <CompletenessAnalysis> element
Attribute

Description

analysisDate

The date and time of the analysis

analysisStatus

The status of the completeness analysis.
Possible values are:
v not_done
v processing_started
v processing_completed
v review_completed
v error
v not_found
v not_analyzable
v review_only
v lightweight_review

<DomainAnalysis>
Specifies the last domain analysis run.
The following table shows the attributes of the <DomainAnalysis> element:
Table 169. Attributes of the <DomainAnalysis> element
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Attribute

Description

analysisDate

The date and time of the analysis

Table 169. Attributes of the <DomainAnalysis> element (continued)
Attribute

Description

analysisStatus

The status of the domain analysis. Possible
values include:
v not_done
v processing_started
v processing_completed
v review_completed
v error
v not_found
v not_analyzable
v review_only
v lightweight_review

<FrequencyDistribution>
Specifies the number of occurrences of each distinct data value of a column.
The following table shows the attributes of the <FrequencyDistribution> element:
Table 170. Attributes of the <FrequencyDistribution> element
Attribute

Description

nbOfDistinctValues

The number of distinct values that occur in
a column

The following table shows the children of the <FrequencyDistribution> element:
Table 171. Children of the <FrequencyDistribution> element
Element

Cardinality

Description

<Value>

0 to unbounded

Specifies a distinct value and
the number of its occurrences

<Value>
Specifies the frequency and percentage of a particular distinct value.
The following table shows the attributes of the <Value> element:
Table 172. Attributes of the <Value> element
Attribute

Description

frequency

The absolute number of occurrences of the
corresponding distinct value in a column

percent

The percentage of all occurrences of a
particular distinct value with respect to the
total number of values in a column

Schema file elements for getting the results of a key and
cross-domain analysis
Specify elements in your XML Schema Definition (XSD) document to request the
results of a key and cross-domain analysis. This is a description of the elements of
the XML document that is returned when requesting the results of a column
analysis.
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Name of the XSD file where the elements are defined
iaapi.xsd

Commands that use these elements
Post executeTasks
Get keyAnalysis/results
Get crossDomainAnalysis/results
Get referentialIntegrityAnalysis/results

Example of an XML document for the Get keyAnalysis/results command:
<?xml version="1.0" encoding="UTF-8"?>
<iaapi:Project xmlns:iaapi="http://www.ibm.com/investigate/api/iaapi">
<description></description>
<DataSources>
<DataSource name="ODBC_DS19">
<Schema name="DB2ADMIN">
<Table name="BATYPESDB2">
<KeyAnalysisResult>
<SingleColumnKey percentDuplicate="98.0" percentUnique="2.0">
<Column name="QUANTITY"/>
</SingleColumnKey>
<SingleColumnKey percentDuplicate="99.5" percentUnique="0.5">
<Column name="STREET"/>
</SingleColumnKey>
<SingleColumnKey percentDuplicate="98.0" percentUnique="0.0">
<Column name="DEPENDENTS"/>
</SingleColumnKey>
</SingleColumnKeys>
</KeyAnalysisResult>
</Table>
</Schema>
</DataSource>
</DataSources>
</iaapi:Project>

XSD file elements
<KeyAnalysisResult>
Specifies the aggregate result of a key analysis. Contains both single-column
and multi-column keys.
The following table shows the children of the <KeyAnalysisResult> element:
Table 173. Children of the <KeyAnalysisResult> element
Element

Cardinality

Description

<SingleColumnKeys>

0 to 1

Container for all
single-column key
candidates.

<MultiColumnKeys>

0 to 1

Container for all
multi-column key candidates.

<SingleColumnKeys>
Specifies the container for all single-column key candidates.
The following table shows the children of the <SingleColumnKeys> element:
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Table 174. Children of the <SingleColumnKeys> element
Element

Cardinality

Description

<SingleColumnKey>

0 to unbounded

Container for all
single-column key
candidates.

<SingleColumnKey>
Specifies the container for all single-column key candidates.
The following table shows the children of the <SingleColumnKey> element:
Table 175. Children of the <SingleColumnKey> element
Element

Cardinality

Description

<Column>

1

The column making up the
key.

The following table shows the attributes of the <SingleColumnKey> element:
Table 176. Attributes of the <SingleColumnKey> element
Attribute

Description

alias

An alias for the key.

percentUnique

Percentage of unique values for this column.

percentDuplicate

Percentage of duplicate values for this
column.

<MultiColumnKeys>
Specifies the container for all multi-column key candidates.
The following table shows the children of the <MultiColumnKeys> element:
Table 177. Children of the <MultiColumnKeys> element
Element

Cardinality

Description

<MultiColumnKey>

0 to unbounded

Container for all
single-column key
candidates.

<MultiColumnKey>
Specifies the container for all multi-column key candidates.
The following table shows the children of the <MultiColumnKey> element:
Table 178. Children of the <MultiColumnKey> element
Element

Cardinality

Description

<Column>

0 to unbounded

The columns the
multi-column key consists of.

The following table shows the attributes of the <MultiColumnKey> element:
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Table 179. Attributes of the <MultiColumnKey> element
Attribute

Description

nbOfColumns

Number of columns in the multi-column
key.

percentUnique

Percentage of rows for which this key is
unique. Values are between 0 and 1.

percentDuplicate

Percentage of rows for which this key has
duplicates. Values are between 0 and 1.

<OverlapCandidate>
Specifies the results of a key and cross-domain analysis job run across columns
in one or multiple tables or sources where columns contain overlapping or
redundant data.
The following table shows the attributes of the <OverlapCandidate> element:
Table 180. Attributes of the <OverlapCandidate> element
Attribute

Description

baseColumn

Primary key column(s) of a foreign key
relationship or an overlap candidate.

pairedColumn

Foreign key column of a foreign key
relationship or an overlap candidate.

absolutePairedToBase

Number of tuples in the paired column that
have a corresponding tuple in the base
column.

percentPairedToBase

Percentage of tuples in the paired column
that have a corresponding tuple in the base
column.

absoluteBaseToPaired

Number of tuples in the base column that
have a corresponding tuple in the paired
column.

percentBaseToPaired

Percentage of tuples in the base column that
have a corresponding tuple in the paired
column.

date

Creation date of the analysis results.

HTTPS support
You can increase the security of the HTTP API by working with a Secure Sockets
Layer (SSL) encrypted port that uses the HTTPS protocol.
To use the HTTP API with HTTPS requests from a Java program, you must set up
your system by creating a truststore file and obtaining a valid certificate from the
HTTP API server. After you set up your system, you can use stand-alone Java
programs to send HTTPS requests to the HTTP API server and display the XML
results.

Installing the HTTPS certificate and creating a truststore
You must install the HTTPS certificate and create a truststore before you can send
HTTPS requests from a Java program.
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About this task
You must create a truststore to use HTTPS from any client. A truststore file is a key
database file that contains public keys. The public key is stored as a signer
certificate. The keys are used for a variety of purposes, including authentication
and data integrity. You must create a truststore that contains a valid certificate for
the HTTPS server to be used. A certificate can be downloaded from the server by
using a web browser. After you download the certificate, any HTTPS request can
be used against the HTTP API.

Procedure
1. Open an HTTPS connection within a web browser. For example,
https://localhost:9443/InformationAnalyzer/projects.
Note: Replace localhost with the correct hostname or the correct IP address.
A page opens with the message, This Connection is Untrusted.
2. Click Add exception to open the Add Security Exception window.
3. Click the View button to display the certificate.
4. Click the Details tab and then Export. Save the certificate with the file type
X.509 Certificate (PEM).

What to do next
Use the Java 2 SDK (J2SDK), Standard Edition command line tool keytool to create
a new truststore from the certificate you downloaded. Issue the following
command:
keytool -import -file <CertificateFile> -keystore <TruststoreFile>

This command creates the truststore named <TruststoreFile>.

Sending HTTPS requests from a Java program
You can send HTTPS requests from a Java program.
The following stand-alone Java program sends an HTTPS request to the HTTP API
server and displays the XML result. In the following implementation example, the
program creates a new IBM InfoSphere Information Analyzer project that is
specified in the XML document CreateNewProject.xml, which must reside in the
folder where the program is started.
import java.net.*;
import java.util.HashMap;
import java.util.Iterator;
import java.util.Map;
import java.io.*;
import javax.net.ssl.HostnameVerifier;
import javax.net.ssl.HttpsURLConnection;
import javax.net.ssl.SSLSession;
import sun.misc.BASE64Encoder;
/**
* Demonstrates usage of the REST Binding API with HTTPS.
* Creates a project according to a given XML file.
*/
public class RESTBindingAPIExampleHTTPS {
public static class MyHostnameVerifier implements HostnameVerifier {
public boolean verify(String hostname, SSLSession session) {
// verification of hostname is switched off
return true;
}
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}
public static void main(String[] args) throws Exception {
// connection and authentication
Map paramNameToValue = new HashMap(); // parameter name to value map
String URL_BASE = "https://";
String method = "POST";
String userName = "admin";
String password = "admin";
String authentication = userName + ’:’ + password;
String host = "localhost";
String port = "9443";
final String HTTP_MODE_POST = "POST";
// command
String xmlFile = "CreateNewProject.xml";
String command = "create";
// construct URL
StringBuffer params = new StringBuffer();
if (paramNameToValue.keySet().size() > 0) {
boolean isFirstParam = true;
for (Iterator paramIter =
paramNameToValue.keySet().iterator();paramIter.hasNext();) {
String paramStr = (String)paramIter.next();
if (isFirstParam) {
params.append("?" + paramStr);
isFirstParam = false;
} else {
params.append("&" + paramStr);
}
params.append("=" +
URLEncoder.encode((String)paramNameToValue.get(paramStr),"UTF-8"));
}
}
URL url = null;
if (method.equals(HTTP_MODE_POST))
url = new URL(URL_BASE + host + ’:’ + port + "/InformationAnalyzer/" + command);
else
url = new URL(URL_BASE + host + ’:’ + port +
"/InformationAnalyzer/" + command + params.toString());
// open HTTPS connection
HttpURLConnection connection = null;
connection = (HttpsURLConnection)url.openConnection();
((HttpsURLConnection) connection).setHostnameVerifier(new MyHostnameVerifier());
connection.setRequestProperty("Content-Type", "text/plain; charset=\"utf8\"");
connection.setRequestMethod(method);
BASE64Encoder encoder = new BASE64Encoder();
String encoded = encoder.encode((authentication).getBytes("UTF-8"));
connection.setRequestProperty("Authorization", "Basic " + encoded);
// insert XML file
if (xmlFile != null)
{
connection.setDoOutput(true);
OutputStream out = connection.getOutputStream();
FileInputStream fileIn = new FileInputStream(xmlFile);
byte[] buffer = new byte[1024];
int nbRead;
do
{
nbRead = fileIn.read(buffer);
if (nbRead>0) {
out.write(buffer, 0, nbRead);
}
} while (nbRead>=0);
out.close();
}
// execute HTTPS request
int returnCode = connection.getResponseCode();
InputStream connectionIn = null;
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if (returnCode==200)
connectionIn = connection.getInputStream();
else
connectionIn = connection.getErrorStream();
// print resulting stream
BufferedReader buffer = new BufferedReader(new InputStreamReader(connectionIn));
String inputLine;
while ((inputLine = buffer.readLine()) != null)
System.out.println(inputLine);
buffer.close();
}
}

Note: If the HTTP API server does not reside on the same host as the Java code,
substitute localhost in the Java code with the correct hostname or the corresponding
IP address.

Compiling the program
Compile the program by using javac <JavaFileName>. The variable <JavaFileName>
is the name of the Java file containing the code in the preceding example. To run
the program, issue the following command:
java -cp . -Djavax.net.ssl.trustStore=<TruststoreFile>
-Djavax.net.ssl.trustStoreType=JKS
RESTBindingAPIExampleHTTPS

HTTP API requests from the command line
You can use the command line interface to issue HTTP API requests and run
analysis or data rule jobs, without logging into the InfoSphere Information
Analyzer client.
The command line interface allows you to control the format of the output of the
command without having to use a programming language to generate HTTP
requests. You can decide whether the output should be written to a file or in the
console. The possible output formats are the following:
Text

Plain text for the console is the default format.

XML

The XML output format is the same as the output generated when using
the HTTP API.

CSV

The comma separated values (CSV) output is formatted by using tabs as
separators. You can easily copy and paste this format into a spreadsheet.

Custom
You can use customized XSLT style sheets during an XSL transformation.
This allows you to customize the format to any style that you prefer. For
example, you can use a customized XSLT style sheet to generate HTML or
PDF reports.

HTTP API command line syntax and parameter options
The command line interface (CLI) allows you to perform functions without having
to use a programming language to generate HTTP requests.
The basic syntax of running HTTP application programming interface (API) jobs
from the command line is:
IAAdmin
-user <user name>
-password <password>
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-host <host name>
[-port <port number>]
[-xml | -csv | -xsl <XSL file name>]
[-output <output file name>]
(
-listProjects |
-getProject -projectName <project name> |
-listRuleDefinitions -projectName <project name> |
-listExecutableRules -projectName <project name> |
-listGlobalVariables |
-getRuleDefinition -projectName <project name>
-ruleName <rule name 1> |
-getExecutableRule -projectName <project name>
-ruleName <rule name 2> |
-create -projectContent <XML file name> |
-update -projectContent <XML file name> |
-deleteProject -projectName <project name> |
-deleteRuleDefinition -projectName <project name>
-ruleName <rule name> |
-deleteExecutableRule -projectName <project name>
-ruleName <rule name> |
-deleteGlobalVariables -variable <variable name>
-runTasks -content <XML file name> |
-getColumnAnalysisResult -projectName <project name>
-columnName <column name> |
-getOutputTable -projectName <project name>
-ruleName <rule name>
-executionID <execution ID>
[-startIndex StartIndex
-nbOfRows <number of rows>] |
-getFrequencyDistribution -projectName <project name>
-columnName SingleColumnName
[-maxNbOfValues <maximum number of
values>]
[-startIndex <start index>]
[-ordering <ordering>] |
-getExecutionHistory -projectName <project name>
-ruleName <rule name>
-getMetrics -projectName <ProjectName>
[-metricName <MetricName>] |
-deleteMetric -projectName <ProjectName>
-metricName <MetricName> |
-getMetricExecutionHistory -projectName <ProjectName>
-metricName <MetricName> |
-publishResults -content <XMLFileName> |
-deletePublishedResults -projectName <ProjectName>
-tableName <FullyQualifiedTableName> |
-getPublishedResults -projectName <ProjectName> |
-getKeyAnalysisResults -projectName <ProjectName>
-tableName <TableName> |
-getCrossDomainAnalysisResults -projectName <ProjectName>
-columnName <columnName>
-percentOverlapThreshold
<percentOverlapThreshold> |
-getReferentialIntegrityAnalysisResults
-projectName <ProjectName>
-baseColumnName <baseColumnName>
-pairedColumnName <pairedColumnName> |
-publishRule -projectName <ProjectName>
-ruleName <ruleName> |
-getPublicRules |
-getPublicRule -ruleName <ruleName> |
-deletePublicRule -ruleName <ruleName> |
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-copyPublicRule -ruleName <ruleName>
-projectName <projectName>
[-newRuleName <newRuleName>]
)

Parameters
Table 181. HTTP API job command line interface parameters
Parameter

Description

-user <user name>

Name of the user (required)

-password <password>

Password to use (required)

-host <host name>

Host name of the server (required)

-port <port number>

Port number of the server (optional)

-xml

Specifies an XML format. If this option is
used, the command line interface will return
data in the same XML format as the REST
API

-csv

Specifies a comma separated values (CSV)
format. If this option is used, the command
line interface will return data in a
comma-separated format that can be easily
imported in a spreadsheet.

-xsl <XSL file name>

Specifies that you want to use an XSLT style
sheet. If this option is used, the command
line interface will use an XSLT file to
transform the XML documents returned by
the HTTP API into a customized format.

-output <output name>

If this option is used, the data returned by
the command line interface is written into
the file specified as parameter. If this option
is not used, the output is generated on the
output stream of the command line
interface.

Important: On UNIX systems, a parameter for the CLI of the HTTP API that
contains either a dot or blanks has to be enclosed in escaped double quotes: \".
Double quotes do not work because they are interpreted by the shell script of the
CLI and are removed. For example, the following command retrieves the column
analysis results of a column with the name anySchema.tableName in the project
myProject:
IAAdmin -user admin -password adminPW -host localhost -port 9443
-getColumnAnalysisResult -projectName myProject
-columnName \"anySchema.tableName\"

Command options
Table 182. HTTP API job command line interface command options
Option

Description

-listProjects

Returns the list of the existing projects. This
option is the equivalent of the "GET
projects" command in the HTTP API.

-getProject
-projectName <project name>

Returns the content of a specific project. This
option is the equivalent of the "GET project"
command in the HTTP API.
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Table 182. HTTP API job command line interface command options (continued)
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Option

Description

-listRuleDefinitions
-projectName <project name>

Returns the list of the existing data rule
definitions in the specified project. This
option is the equivalent of the "GET
ruleDefinitions" command in the HTTP API.

-listExecutableRules
-projectName <project name>

Returns the list of the existing data rules in
the specified project. This option is the
equivalent of the "GET executableRules
command " in the HTTP API.

-listGlobalVariables

Returns the list of the global variables
defined on the system. This option is the
equivalent of the "GET globalVariables"
command in the HTTP API.

-getRuleDefinition
-projectName <project name>
-ruleName <rule name>

Returns the content of a rule definition. This
option is the equivalent of the "GET
ruleDefinition" command in the HTTP API.

-getExecutableRule
-projectName <project name>
-ruleName <rule name>

Returns the content of a data rule. This
option is the equivalent to the GET
executableRules command in the HTTP API.

-create
-projectContent <XML file name>

Creates new project artifacts defined in the
XML file that is specified as a parameter.
This option is the equivalent of the "POST
create" command in the HTTP API.

-update
-projectContent <XML file name>

Updates new project artifacts defined in the
XML file that is specified as a parameter.
This option is the equivalent of the "POST
update" command in the HTTP API.

-deleteProject
-projectName <project name>

Delete one or several projects. This option is
the equivalent of the "DELETE project"
command in the HTTP API.

-deleteRuleDefinition
-projectName <project name>
-ruleName <rule name>

Delete one or several rule definitions. This
option is the equivalent of the "DELETE
ruleDefinition" command in the HTTP API.

-deleteExecutableRule
-projectName <project name>
-ruleName <rule name>

Delete one or several executable rules. This
option is the equivalent of the "DELETE
executableRule" command in the HTTP API.

-deleteGlobalVariables
-variable <variable name>

Delete one or several global variables. This
option is the equivalent of the "DELETE
globalVariable" command in the HTTP API.

-runTasks
-content <XML file name>

Run the tasks defined in the XML. This
option is the equivalent of the "POST
runTasks" command in the HTTP API.

-getColumnAnalysisResult
-projectName <project name>
-columnName <column name>

Gets the column analysis results for a
column in a project. This option is the
equivalent of the "GET columnAnalysis/
results" command in the HTTP API.

-getOutputTable
-projectName <project name>
-ruleName <rule name>
-executionID <execution ID>
-startIndex <start index>
-nbOfRows <number of rows>

Gets the content of the output table of a
rule. This option is the equivalent of the
"GET executableRule/outputTable"
command in the HTTP API.

Table 182. HTTP API job command line interface command options (continued)
Option

Description

-getFrequencyDistribution
-projectName <project name>
-columnName <column name>
-maxNbOfValues <maximum number of
values>
-startIndex <start index>
-ordering <ordering>

Gets the frequency distribution of a column.
This option is the equivalent of the "GET
columnAnalysis/frequencyDistribution"
command in the HTTP API.

-getExecutionHistory
-projectName <project name>
-ruleName <rule name>

Gets the execution history of a rule. This
option is the equivalent of the "GET
executionRule/executionHistory" command
in the HTTP API.

-getMetrics
-projectName ProjectName
[-metricName MetricName]

Retrieve all or certain metrics of a given
project. Note that the parameter metricName
is optional (equivalent to GET metrics in the
HTTP API).

-deleteMetric
-projectName ProjectName
-metricName MetricName

Delete a metric (equivalent to DELETE
metric in the HTTP API)

-getMetricExecutionHistory
-projectName ProjectName
-metricName MetricName

Get the execution history of a metric
(equivalent to GET metric/executionHistory
in the HTTP API)

-publishResults
-content XMLFileName

Publish analysis results of the tables
specified in the given XML file (equivalent
to POST publishResults in the HTTP API)

-deletePublishedResults
-projectName ProjectName
-tableName FullyQualifiedTableName

Delete published analysis results of a given
table (equivalent to DELETE
publishedResults in the HTTP API)

-getPublishedResults
-projectName ProjectName

Get all tables that have published analysis
results for a given project (equivalent to GET
publishedResults in the HTTP API)

-getKeyAnalysisResults
-projectName ProjectName
-tableName TableName

Get the primary key candidates for the
given table (equivalent to GET
keyAnalysis/results in the HTTP API)

-getCrossDomainAnalysisResults
-projectName ProjectName
-columnName columnName
-percentOverlapThreshold
percentOverlapThreshold

Get the foreign key and cross-domain
analysis results (equivalent to GET
crossDomainAnalysis/results in the HTTP
API)

-getReferentialIntegrityAnalysisResults
-projectName ProjectName
-baseColumnName baseColumnName
-pairedColumnName pairedColumnName

Get the referential integrity analysis results
(equivalent to GET
referentialIntegrityAnalysis/results in the
HTTP API)

-publishRule
-projectName ProjectName
-ruleName ruleName

Publish a certain rule of a project (equivalent
to GET publishRule in the HTTP API)

-getPublicRules

Get the list of existing published rules or
rule sets (equivalent to GET publishedRules
in the HTTP API)

-getPublicRule
-ruleName ruleName

Get the content of a certain published rule
or rule set (equivalent to GET publicRule in
the HTTP API)
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Table 182. HTTP API job command line interface command options (continued)
Option

Description

-deletePublicRule
-ruleName ruleName

Delete a published rule of rule set
(equivalent to DELETE publicRule in the
HTTP API)

-copyPublicRule
-ruleName ruleName
-projectName projectName
[-newRuleName newRuleName]

Copy a published rule to a project
(equivalent to GET copyPublicRule in the
HTTP API)

Examples
Get the list of the existing projects:
IAAdmin -user admin -password admin -host localhost -listProjects

Get the list of the existing rules of the project 'Project1' as an XML file:
IAAdmin -user admin -password admin -host localhost -xml -output out.xml -list
RuleDefinitions -projectName Project1

Get the list of the execution history of the data rule 'nullCheck' in the project
'Project1' as a CSV file:
IAAdmin -user admin -password admin -host localhost -csv -output out.csv -get
ExecutionHistory -projectName Project1 -ruleName nullCheck

Create a new project from a XML file:
IAAdmin -user admin -password admin -host localhost -create -projectContent in.xml
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Chapter 17. Reports for information analysis
You can create reports that summarize analysis results and show details about
your project. Reports are saved in the metadata repository and can be accessed by
any user who is authorized to view them.
Reports can show information in multiple ways. For example, analysis results can
be displayed as the actual data that the results refer to, or, they can be shown in a
graph or chart. Graphs and charts display general information about an object such
as the percentage of columns that have been analyzed in a data source. Graphs
and charts also highlight issues that might otherwise be difficult to locate in the
text of a standard report.
You can create and view reports in the IBM InfoSphere Information Server Web
console and the InfoSphere Information Server console. Both environments contain
predefined parameters and templates that you use to generate a report.
In the console, you can create reports and associate reports with a project:
v Create, run, and view a report without having to save the report in the
repository
v Filter through projects to associate the report with a specific project
In the Web console, you can create a report, configure multiple aspects of the
report, and complete other reporting tasks:
v Schedule a report to run at a specific time
v Configure a report to maintain a history of results
v Schedule a report to be removed automatically at a specific time
v Create reports in folders that you can name, modify, and delete
v Create a business logo in the report
v Configure security options for the report
v Configure details of output types
Important: If you use a pop-up blocker, you might need to disable the pop-up
blocker or configure the pop-up blocker to allow pop-ups for the report to open.

Baseline analysis reports
You use baseline analysis to determine whether the structure or content of your
data has changed between two versions of the same data. After a baseline analysis
job completes, you can create a report that summarizes the results of that job and
then compare the results with the results from your baseline data.
There are two types of baseline analysis reports:
Baseline structure - current to prior variances report
Shows a summary of the structural differences between the baseline
version of your data and another version of the same data. The structure of
your data consists of the elements of the data such as data values and
properties. Structure also depends on how the data is organized.
Baseline content - current to prior variances report
Shows a summary of the differences in content between the baseline
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version and another version of the same data source. Content is the actual
data, such as names, addresses, or dates.

Column analysis summary statistics reports
After a column analysis job completes, you can create a report that shows a
summary of the structure of your data. Structural information about your data is
taken from the analysis results that were generated during column analysis.
There are three types of column analysis summary statistics reports:
Column analysis summary statistics report
A general summary of the structure of your analyzed data. Data structure
consists of elements such as data values, data properties, and data types.
Data properties define the characteristics of data and data types are
elements that describe whether the data is of a numeric type, alphabetic
type, or ambiguous type.
Column analysis structural summary report
A concise summary of the structure of your analyzed data.
Structural summary with inferred data types report
A concise summary of the structure of your analyzed data, including
inferred data types.

Column classification reports
After a column analysis job completes, you can create a report that shows a
summary of the classifications of your data. A data class is a variable that is used
to designate the use of a field in a column, such as the variable Q which might
refer to a quantity of something. Information about data classes is taken from the
analysis results that were generated during column analysis.
There are four types of column classification reports:
Column classification summary report
Shows the inferred data class, subclass, and user class for a selected
column. A subclass is a class that inherits some properties from another
class. A user class is a code that is defined by a user. An example of a user
class is the code ADMIN, which might refer to a user who is an
administrator.
Data classification report
Shows the inferred data class for columns that you select. Data classes are
listed in alphabetic order on the report.

Column domain analysis reports
After a column analysis job completes, you can create a report that shows a
summary of the domain information that was found in your data such as invalid
values, minimum values, or maximum values. Information about the values in
your data is taken from the analysis result that was generated during column
analysis.
There are three types of column domain analysis reports:
Domain value profile report
Shows the classifications of the values in your data, such as invalid values,
maximum values, and default values.
Domain analysis detail report
Shows the inferred domain status of the values that you select in your
data.
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Completeness and validity report
Shows the values that are complete and valid in your data.

Column frequency reports
After a column analysis job completes, you can create a report that shows either a
summary or concise details about the information that is in a frequency
distribution. A frequency distribution contains information about all of the values
in your data and is generated for each column that is analyzed.
There are three types of column frequency reports:
Most frequent values report
Shows the values that are most common in a column.
Most frequent formats report
Shows the formats that are most common in a column. A format is a
symbol for each value that is distinct in a column. For example, all
alphabetic characters in a column might be replaced with the letter A.
Frequency distribution report
Shows the distribution of all values in your data.

Column properties reports
After a column analysis job completes, you can create a report that shows a
summary of the properties in your data. A data property is a variable that defines
the characteristics of data such as the data type or length of a column. Information
about data properties is taken from the analysis summary that was generated
during column analysis.
There are four types of column properties reports:
Column properties definition summary report
A summary of all the data properties in a column that you select.
All data types report
A summary of all the data types in a column that you select. A data type is
an element that describes whether the column contains data that is of a
certain type, such as integer, string, or date type.
Ambiguous data types report
A summary of all of the columns with ambiguous data types in the
columns that you select. A data type is inferred as ambiguous if the data
represents differing interpretations of what the type should be. For
example, a column might contain the integer 123, the string AB, and a date
type such as 11-17-07.
Column storage utilization report
A comparison between the length of data and the length of the column
that contains the data. You use this information to assess effective ways of
storing data.

Inferred properties reports
After a column analysis job completes, you can create a report that shows a
summary of the properties that were inferred during analysis. A data property is a
variable that defines the characteristics of data such as the data type or length of a
column. Information about inferred properties is taken from the analysis results
that were generated during column analysis.
There are eight types of inferred properties reports:
Type and length report
Shows the differences between all data types and length properties in the
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analyzed data. A data type is a data element that describes whether the
data is numeric, alphabetic, or ambiguous.
Data type differences only report
Shows the differences between the defined, inferred, and chosen data types
in the analyzed data.
Length differences only report
Shows the differences between the defined, inferred, and chosen data
length properties in the analyzed data.
Precision differences only report
Shows the differences between the defined, inferred, and chosen data
precision properties in the analyzed data. Precision refers to the total
length of a numeric field in a column.
Constant, unique, and null properties report
Shows the differences between all null, constant, and unique properties in
your analyzed data.
If the percentage of null values in the frequency distribution is greater than
the system-defined threshold, the system allows null values and a null
property is inferred. The system-defined threshold is a variable that allows
or rejects data variances. For example, if the threshold percentage for null
values is 95%, your data must have a percentage of 96% or greater to allow
null values.
If the cardinality is smaller than the system-defined threshold, the constant
property is inferred. Cardinality refers to the number of distinct values in a
column including blanks and nulls.
If the percentage of cardinality is greater than the system-defined
threshold, the unique property is inferred.
Constant value differences only report
Shows the differences between the defined, inferred, and chosen constant
flags in the analyzed data. A constant flag is an attribute that signals the
presence of a constant property in your data.
Uniqueness differences only report
Shows the differences between the defined, inferred, and chosen
uniqueness properties in the analyzed data.
Nullability differences only report
Shows the differences between the defined, inferred, and chosen null
properties in the analyzed data.

Column inference reports
The column inference reports include the Column Inferences-Constant Difference
Only report, Column Inferences-Data Type Difference Only report, Column
Inferences- Length Difference Only report, Column Inferences- Nullability
Difference Only report, and the Column Inferences- Precision Difference Only
report.

Column Inferences-Constant Difference Only report
The Column Inferences- Constant Difference Only report shows all columns where
the inferred, defined, and chosen constant flags are different. A constant flag is an
attribute that signals the presence of a constant property in your data.

Parameters
Specify the parameters for the report:
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Project Name
Select the name of the project that contains the metrics that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the exception table
included in the report.
Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Inferences- Constant Value Difference Only
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Main Section
Column Level Summary
Column Name
Data Type
Defined
Inferred
Chosen
Length Total
Defined
Inferred
Chosen
Precision Total
Defined
Inferred
Chosen
Scale Total
Defined
Inferred
Chosen

Example of Report Output

Column Inferences
Data Type Difference Only

Project :

Methodology

Report Name :

Data Type Difference Only

Report Generated :

2009-05-18

Time Zone:

UTC -04:00

User :

admin admin

13:09:18

Comments :
Host Name :

WB-HOST-APP

Data Store :

Chemco

Data Store Alias :
Database Name :

IAUSER

Database Alias :
Table Name :

CARRIER

Table Alias :

Column Level Summary
Column Name

QUALDT

Data Type

Length Total

Defined

Inferred

Chosen

String

Int32

Int32

Precision Total

Inferred

Chosen

Defined

Inferred

Chosen

Defined

Inferred

Chosen

8

8

8

--

8

8

0

0

0

IBM Information Server
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Scale Total

Defined

1 / 36

Column Inferences-Data Type Difference Only report
The Column Inferences- Data Type Difference Only report shows all columns
where the defined, inferred, and chosen data types are different.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
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in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Inferences- Data Type Difference Only
Main Section
Column Level Summary
Column Name
Data Type
Defined
Inferred
Chosen
Length Total
Defined
Inferred
Chosen
Precision Total
Defined
Inferred
Chosen
Scale Total
Defined
Inferred
Chosen
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Example of Report Output

Column Inferences
Data Type Difference Only

Project :

Methodology

Report Name :

Data Type Difference Only

Report Generated :

2009-05-18

Time Zone:

UTC -04:00

User :

admin admin

13:09:18

Comments :
Host Name :

WB-HOST-APP

Data Store :

Chemco

Data Store Alias :
Database Name :

IAUSER

Database Alias :
Table Name :

CARRIER

Table Alias :

Column Level Summary
Column Name

Data Type

QUALDT

Length Total

Defined

Inferred

Chosen

String

Int32

Int32

Precision Total

Scale Total

Defined

Inferred

Chosen

Defined

Inferred

Chosen

Defined

Inferred

Chosen

8

8

8

--

8

8

0

0

0
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Column Inferences-Length Difference Only report
The Column Inferences- Length Difference Only report shows all columns where
the defined, inferred, and chosen lengths are different

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
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Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Inferences- Length Difference Only
Main Section
Column Level Summary
Column Name
Data Type
Defined
Inferred
Chosen
Length Total
Defined
Inferred
Chosen
Precision Total
Defined
Inferred
Chosen
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Scale Total
Defined
Inferred
Chosen
Notes

Example of Report Output

Column Inferences
Length Difference Only

Project :

hagrid

Report Name :

Length Difference Only

Report Generated :

2009-07-23

Time Zone :

UTC +05:30

10:47:03

User :

admin admin

Comments :

customer comments

Host Name :

WB-HOST-APP

Data Store :

pubsDS

Data Store Alias :
Database Name :

dbo

Database Alias :
Table Name :

authors

Table Alias :

Column Level Summary
Column Name

Data Type

Length Total

Defined

Inferred

Chosen

address

String

String

au_fname

String

String

Precision Total

Scale Total

Defined

Inferred

Chosen

Defined

Inferred

Chosen

Defined

Inferred

Chosen

String

40

20

20

--

--

--

0

--

--

String

20

11

11

--

--

--

0

--

--

note for au_fname
Type :

Action

Creator :

admin

Status :

Opened

Created :

2009-07-23

Modified :

2009-07-23

the quick brown fox jumped over the lazy dogs
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Column Inferences-Nullability Difference Only report
The Column Inferences- Nullability Difference Only report shows all columns
where the defined, inferred, and chosen nullability flags are different.
This report is based on the frequency percents that you can set for columns in the
data for your project. If a column has null values with a frequency percent equal to
or greater than the nullability threshold, then the inference is that the nullability
flag is “YES.” If nulls do not exist in a column or the frequency percent is less than
threshold, then the nullability flag is inferred “NO.” This report provides data on
all the columns where the nullability flags are different.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
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Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Inferences-Nullability Difference Only
Main Section
Host Name
Data Store
Data Store Alias
Database Name
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Database Alias
Table Name
Table Alias
Column Level Summary
Column Name
Constant Flag
Inferred
Chosen
%
Uniqueness Flag
Inferred
Chosen
%
Nullability Flag
Defined
Inferred
Chosen
%
Data Class
Unique Values
Non-Unique Values
Total Actual Rows
Total Rows
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Example of Report Output

Column Inferences
Nullability Difference Only
Project :

Methodology

Report Name :

Nullability Difference Only

Report Generated :

2009-05-18

Time Zone:

UTC -04:00

User :

admin admin

14:01:28

Comments :
Host Name :

WB-HOST-APP

Data Store :

Chemco

Data Store Alias :
Database Name :

IAUSER

Database Alias :
Table Name :

CARRIER

Table Alias :
Defined

Column Level Summary
Column Name

Constant Flag

Uniqueness Flag
%

Nullability Flag

Data Class

Inferred

%

%

Chosen

Unique Values
Non-Unique Values
Total Actual Values
Total Rows

CARRID

N

N

5.556

Y

Y

100.000

Y

N

N

.000

Identifier

18
0
18
18

CARRNAME

N

N

5.556

Y

Y

100.000

Y

N

N

.000

Text

18
0
18
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Column Inferences-Precision Difference Only report
The Column Inferences- Precision Difference Only report shows all columns where
the defined, inferred, and chosen precision values are different.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
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Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Inferences-Precision Difference Only report
Main Section
Column Level Summary
Column Name
Deferred
Inferred
Chosen
Data Type
Defined
Inferred
Chosen
Length Total
Defined
Inferred
Chosen
Precision Total
Defined
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Inferred
Chosen
Scale Total
Defined
Inferred
Chosen

Example of Report Output

Column Inferences
Precision Difference Only
Project :

Methodology

Report Name :

Precision Difference Only

Report Generated :

2009-05-18

Time Zone:

UTC -04:00

User :

admin admin

16:00:33

Comments :
Host Name :

WB-HOST-APP

Data Store :

Chemco

Data Store Alias :
Database Name :

IAUSER

Database Alias :
Table Name :

CARRIER

Table Alias :

Column Level Summary
Column Name

Data Type

QUALDT

Length Total

Defined

Inferred

Chosen

String

Int32

Int32

Precision Total

Scale Total

Defined

Inferred

Chosen

Defined

Inferred

Chosen

Defined

Inferred

Chosen

8

8

8

0

8

8

0

0

0
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Column summary reports
The column summary reports include the Column Frequency- Format Violations
report, Column Frequency- Frequency by Frequency report, Column Profile- Post
Review report, Column Profile- Pre Review Profiling report, Column SummaryColumn Profile Status report, Column Summary- Column Structural Summary
report, Column Summary- Column Structural Summary with Inferred Data Types
report, and the Column Summary- Summary Statistics report.

Column Frequency-Format Violations report
The Column Frequency-Format Violations report displays a summary of the
general formats of data values being used in a column. The summary shows a
distribution of the formats that are considered valid and invalid, based on
information you selected in the format review.

Parameters
Specify the parameters for the report:
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Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables to include
Select the names of the tables you want to include in the report.
Columns to include
Select the names of the columns you want to include in the report.
Include all formats
Select the total number of formats to display per column.
Include alias
Select this option to show the alias names for the tables or columns.
Include notes
Select this option to show any notes associated with the database.
Number of format examples
Select the number of examples for each format to be displayed.

Content
The following defines the structure of the report:
Heading
Column Frequency-Format Violations
Main Section
Host name
Data store name
Data store alias
Database name
Database alias
Table name
Table alias
Column name
Column alias
Column Level Details
Status
Format
Count
Percent of total rows
Example values

Chapter 17. Reports for information analysis

345

Sort order
The report output is displayed in alphabetical order by table name in ascending
order, and by column name in ascending order.
The report data is sorted within each section by format violations. The data is
sorted by format violation frequency in descending order, and then is sorted by
conforming frequency in descending order.

Example of report output

Column Frequency
Format Violations
Project :

pubs

Report Name :

Format Violations 1

Report Generated :

2008-06-03

Time Zone :

UTC +05:30

User

admin admin

15:59:12

Comments :
Host Name :

pubshs

Data Store :

pubsds

Data Store Alias :
Database :

dbo

Database Alias :

schema alias

Table :

authors

Table Alias :
Column :

address

Column Alias :

Column Level Details
Status

Format

Count

Total Rows %

Conform

99 Aaaaaaa Aa.

4

8.33

67 Seventh Av.

Example Values

Conform

9999 Aaaaaa Aa.

4

8.33

3410 Blonde St.

Conform

9999 Aaaaaaa Aa.

4

8.33

5420 College Av.

Conform

9999 Aaaaaaaaa Aa.

4

8.33

1956 Arlington Pl.

Conform

9 Aaaaaa Aa.

2

4.17

3 Silver Ct.

Conform

9 Aaaaaaa Aa.

2

4.17

3 Balding Pl.

Conform

99 Aaaaaa Aaa.

2

4.17

44 Upland Hts.
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Column Frequency- Frequency by Frequency report
The Column Frequency by Frequency report provides the most commonly
occurring values in your project columns. The results include a cumulative
frequency total for the data values for the columns you select.
The Column Frequency by Frequency report includes the value, the frequency of
the value, and the cumulative frequency of values in the report, line by line.
The cumulative percentage will only include the total percent through the values
displayed in the report. The summary will include the total record count as well as
the total records included in the report.
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Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Column Name
Select the columns that you want to find frequency values for that you
want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the column
included in the report.
Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Frequency Limit
Enter an optional frequency cutoff value to reduce the values generated. To
see all values enter 0. This will display values that have occur 0 or more in
the columns you select.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
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Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Frequency- Frequency by Frequency
Main Section
Column Level Summary
Cardinality Count
Null Count
Actual Row Count
Frequency Cut Off
Total Rows Covered
% Rows Covered
Frequency Distribution Data
Distinct Value
Frequency Count
Frequency %
Cumulative %
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Example of Report Output

Column Frequency
Frequency By Frequency
Project:

Methodology

Report Name :

Frequency By Frequency

Report Generated :

2009-05-18

Time Zone :

UTC -04:00

User :

admin admin

11:25:52

Comments :
Host Name :

WB-HOST-APP

Data Store :

Chemco

Data Store Alias :
Database Name :

IAUSER

Database Alias :
Table Name :

CARRIER

Table Alias :
Column Name :

CARRID

Column Alias :

Column Level Summary
Cardinality Count :

18

Null Count :

0

Actual Row Count :

18

Frequency Cut Off :

0

Total Rows Covered :

18

%Rows Covered :

100.00

Frequency Distribution Data
Distinct Value

Frequency Count

Frequency%

Cumulative %

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56
5.56

5.56
11.11
16.67
22.22
27.78
33.33
38.89
44.44
50.00
55.56
61.11
66.67
72.22
77.78
83.33
88.89

SWST
YELL
SOUT
PLNT
WWDE
EAST
STLG
MFGT
RDWY
USPS
BDSV
RPSX
PIEX
SKYH
FGTL
USAT
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Column Profile-Post Review report
The Column Profile-Post Review report provides a summary based on the profiling
details that are defined for a column after a data analyst review.

Parameters
Specify the parameters for the report:
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Project name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the names of the tables you want to include in the report.
Column Name
Select the names of the columns that you want to include in the report.
Enter Data Collection Parameter
Select the columns that you want included in the report.
Display Notes
Select this option if you want any notes associated with the column
included in the report.
Comments
Enter any comments you want included in the report output.
Select Data Class
Select one of the data classes from the drop-down menu that you want to
specify for the report.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future.

Content
The following defines the structure of the report:
Heading
Column Profile-Post Review
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Main Section
Column
Inferred Data Class
Definition
Metadata
Data Type
Length
Precision
Scale
Nullability
Domain Highlights
Total Rows
Cardinality
Cardinality %
Nulls
# General Formats
General Formats
Data Quality
Completeness
Validity
Format
Domain Values
Row
Status
Data Value
#
%
Frequency Zone
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Example of Report Output
Host Name :

CD-DWEERAKOON

DataStore Name :

pubsDS

DataBase Name :

dbo

Table Name :

employee

Column

Inferred Data Class

EMP_ID

IDENTIFIER

Definition

Metadata

Data Type

Length

Precision

Scale

Nullability

Defined

String

9

9

0

N

Inferred

String

9

0

0

N

Domain Highlights
Total Rows

Cardinality

Cardinality %

Nulls

# General Formats

43

100.00

0

2

43
General Formats
A-A99999A
AAA99999A

Data Quality
Completeness
Complete

Validity

#

%

Distinct Values

43

100.00

Records

43

100.00

Incomplete

#

%

Distinct Values

0

Records

0

Valid

Format
#

%

Conform

#

%

Distinct Values

43

100.00

Formats

43

100.00

Records

43

100.00

Invalid

#

%

Violation

#

%

.00

Distinct Values

0

.00

Formats

0

.00

.00

Records

0

.00
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Column Profile- Pre Review Profiling report
The Pre-Review Profiling report summarizes the results of data profiling based on
a data analyst review.

Parameters
Specify the parameters for the report:
Project name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the names of the tables you want to include in the report.
Column Name
Select the names of the columns that you want to include in the report.
Enter Data Collection Parameter
Select the columns that you want included in the report.
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Display Notes
Select this option if you want any notes associated with the columns
included in the report.
Comments
Enter any comments you want included in the report output.
Select Data Class
Select one of the data classes from the drop-down menu that you want to
specify for the report.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future.

Content
The following defines the structure of the report:
Heading
Column Profile-Pre Review
Main Section
Column
Inferred Data Class
Definition
Metadata
Data Type
Length
Precision
Scale
Nullability
Domain Highlights
Total Rows
Cardinality
Cardinality %
Nulls
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General Formats
Lowest Value
Median Value
Highest Value
Least Frequent Value
Most Frequent Value
Domain Values
Row
Status
Data Value
#
%
Frequency Zone
Column
Frequency Distribution Tables

Example of Report Output

Column Profile

0

Pre Review
Project:

nilakshi

Report Name:

Pre Review

Report Generated:

2009-07-17

Time Zone:

UTC +05:30

User:

admin admin

16:25:04

Comments:

the quick brown fox ran over the lazy dogs

Host Name :

WB-HOST-APP

DataStore Name :

pubsDS

DataBase Name :

dbo

Table Name :

authors

Column

Inferred Data Class

address

Text

Definition
Nullability

Metadata

Data Type

Length

Precision

Scale

Defined

String

0

40

0

True

Inferred

String

20

0

0

False

Domain Highlights
Total Rows
23

Cardinality

Cardinality %

Nulls

General Formats

21

91.30

0

1

Lowest Value

Median Value

10 Mississippi Dr.

301 Putnam

IBM Information Server

Highest Value
PO Box 792

1 / 14

IBM, the IBM logo, and IBM Information Server are trademarks of International Business Machines Corporation in the United States, other countries or both.

Column Summary- Column Profile Status
The Column Summary- Column Profile Status report provides a summary of the
profiling of columns within a table.
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The Column Profile Status report provides a summary of profiling execution status
for columns within a table. The report shows the profiling status details of the
columns in each data collection. The results are displayed line-by-line.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Column Name
Select the columns that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
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Content
The following defines the structure of the report:
Heading
Column Summary- Column Profile Status
Main Section
Column Name
Alias
Status
Profiling Time
Profiling Duration
Number of Records
Cardinality
Defined Data Type
Inferred Data Type

Example of Report Output

Column Summary
Column Profile Status
Project :

Gandalf

Report Name :

Column Profile Status

Report Generated :

2009-06-01

Time Zone :

UTC -04:00

User :

admin admin

11:36:57

Comments :
Host Name :

WB-HOST-APP

Data Store :

BankDemo

Data Store Alias :
Database Name :

BANK1

Database Alias :
Table Name :

BANK_CLIENTS

Table Alias :
Definition :
Column

Alias

Status

Profiling Time

Profiling Duration

Number of

Cardinality Defined

Records
ACCOUNT_ID

Analyzed

20-May-09 11:28:52 AM

0 D 0 H 3 M 44 S

5,112

ACCOUNT_TYPE

Analyzed

20-May-09 11:28:49 AM

0 D 0 H 3 M 44 S

ADDRESS

Analyzed

20-May-09 11:28:51 AM

0 D 0 H 3 M 44 S

AGE

Analyzed

20-May-09 11:28:50 AM

AVERAGE_BALAN

Analyzed

BANKCARD

Data Type

Inferred
Data Type

99.98 % Int32

Int32

5,112

0.039 % String

String

5,112

67.078 % String

String

0 D 0 H 3 M 44 S

5,112

1.956 % SFloat

20-May-09 11:28:47 AM

0 D 0 H 3 M 44 S

5,112

85.055 % Decimal

Analyzed

20-May-09 11:28:45 AM

0 D 0 H 3 M 44 S

5,112

0.039 % String

CLIENT_ID

Analyzed

20-May-09 11:28:46 AM

0 D 0 H 3 M 44 S

5,112

75 % String

GENDER

Analyzed

20-May-09 11:28:49 AM

0 D 0 H 3 M 44 S

5,112

0.039 % String

WebSphere Information Analyzer

Int8
Decimal
String
Int16
String
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Column Summary- Column Structural Summary
The Column Summary- Column Structural Summary report provides a summary
of the structural details of columns within the tables in each data collection.
The Column Structural Summary report provides a line by line structural summary
of the statistics for columns within a table.
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Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Column Name
Select the columns that you want to find frequency values for that you
want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
Show custom definitions
Select this option to include aliases and definitions that you created in the
report.
Enter content percentage
Enter a percentage value, which is the threshold for the percentage of
uniqueness, percentage for distinct format, percentage null, and percentage
under the content summary.
Enter content domain percent
Enter a percentage value, which is the threshold for the percentage of
incomplete values and percentage of invalid values under the domain
summary.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
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Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Analysis- Structural Summary
Main Section
Host Name
Data Store
Data Store Alias
Database Name
Database Alias
Table Name
Table Alias
Column Name
Column Alias
Total Records
Content
Content Domain
Column Level Structure Definition Summary
Primary Key Flag
# of Inferred Data Types
Length
Precision
Scale
Column Level Content Summary
Uniqueness Values
Uniqueness %
Distinct Format Count
Distinct Format %
Null %
Column Level Domain Summary
Incomplete %
Invalid %
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Minimum Value
Maximum Value

Example of Report Output

Column Analysis
Structural Summary
Project :

CLYDE

Report Name :

Column Structural Summary

Report Generated :

2009-06-09

Time Zone :

UTC -04:00

User :

admin admin

11:29:54

Comments :
Host Name :

WB-HOST-APP

Datastore:

Chemco

DataStore Alias:
Database Name :

SORBUILD

Database Alias :
Table Name :

CLYDE1

Table Alias:
Column Name :

C1

Column Alias :
Total Records:

16

Content:

90.000

Content Domain:

10.000

Column Level Structure Definition Summary
Primary key Flag:

false

# Of Inferred Data Types:

1

Length:

50

Precision:

50

Scale:

0

Column Level Content Summary
Unique Values:

16

Uniqueness %:

100.000

Distinct Format Count:

16

Distinct Format %:

100.000

Null %:

.000

Column Level Domain Summary
Incomplete %:

0

Invalid %:

.000

Minimum Value:

"

Maximum Value:

middle'squote

IBM Information Server
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Column Summary- Column Structural Summary with Inferred
Data Types
The Column Summary- Column Structural Summary with Inferred Data Types
report provides a summary of the structural details of columns within the tables in
each data collection.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Column Name
Select the columns that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
Show custom definitions
Select this option to include aliases and definitions that you created in the
report.
Enter content percent
Enter a percentage value, which is the threshold for the percentage of
uniqueness, percentage for distinct format, percentage null, and percentage
under the content summary.
Enter content domain percent
Enter a percentage value, which is the threshold for the percentage of
incomplete values and percentage of invalid values under the domain
summary.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.

360

User's Guide

Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Analysis- Structural Summary with Inferred Data Types
Main Section
Host Name
Data Store
Data Store Alias
Database Name
Database Alias
Table Name
Table Alias
Column Name
Column Alias
Total Row Count
Content %
Content Domain %
Column Level Structure Definition Summary Section
Defined Primary Key
# of Inferred Data Types
Length (Min)
Length (Max)
Length (Avg)
Column Level Content Summary Section
Unique Values
Uniqueness %
Column Level Domain Summary Section
Incomplete %
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Invalid %
Minimum Value
Maximum Value
Inferred Data Type Summary Section
Data Type

Example of Report Output

Column Analysis
Structural Summary With Inferred Data Types
Project :

FredTest

Report Name :

Column Structural Summary with Inferred Data Types

Report Generated :

2009-06-17

Time Zone :

UTC -04:00

User :

admin admin

15:29:00

Comments :
Host Name :

WB-HOST-APP

Data Store :

pantherpubs

Data Store Alias :
Database Name :

dbo

Database Alias :
Table Name :

authors

Table Alias :
Column Name :

address

Column Alias :
Total Row Count:

23

Content %:

90.000

Content Domain %:

10.000

Column Level Structure Definition Summary
Defined Primary Key:

false

Precision (Min):

0

# Of Inferred Data Types:

1

Precision (Max):

0

Length (Min):

10

Scale (Min):

0

Length (Max):

20

Scale (Max):

0

Length (Avg):

15.435

Column Level Content Summary
Unique Values:

19

Distinct Format Count:

19

Uniqueness %:

82.609

Distinct Format %:

82.609

Null %:

.000

Column Level Domain Summary
Incomplete %:

0

Invalid %:

.000

Minimum Value:

10932 Bigge Rd.

Maximum Value:

PO Box 792

Inferred Data Type Summary
Data Type

# of Values per Data Type

IBM Information Server
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Column Summary- Summary Statistics
The Column Summary- Summary Statistics report provides a general summary of
the structure of your analyzed data provided on a column-by-column basis for the
tables and columns that you select. The report provides breaks down the
summaries of the column's contents, domain assessment, defined structure, and
inferred structure in individual sections.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Column Name
Select the columns that you want included in the report.
Enter Data Collection Parameter
Select the columns that you want included in the report.
Display Notes
Select this option if you want any notes associated with the columns
included in the report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
Chapter 17. Reports for information analysis

363

in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Column Analysis- Summary Statistics
Main Section
Host Name
Data Store
Data Store Alias
Database Name
Database Alias
Table Name
Table Name Alias
Column Name
Column Alias
Value Summary
Class Code
Column Level Content Summary
Total Actual Row Count
Uniqueness Count
Uniqueness %
Distinct Value
Distinct Value %
Distinct Format Count
Distinct Format %
Nullability Flag Chosen
Null Count
Null %
Column Level Domain Summary
Incomplete Count
Incomplete %
Invalid Count
Invalid Count %
Minimum Value
Maximum Value
Most Frequent Value
Frequency Count
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Frequency Percent
Column Level Structure Definition Summary
Primary Key Flag
Type Code
Length
Precision
Scale
Column Level Inference Structure Summary
Length (Min)
Length (Avg)
Length (Max)
Scale (Min)
Scale (Max)
Precision (Min)
Precision (Max)
Inferred Data Type Summary Section
Data Type
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Example of Report Output

Column Analysis
Summary Statistics
Project :

hagrid

Report Name :

Summary Statistics

Report Generated :

2009-07-23 11:12:05

Time Zone :

UTC +05:30

User :

admin admin

Comments :

customer comments

Host Name :

WB-HOST-APP

Data Store :

pubsDS

Data Store Alias :
Database Name :

dbo

Database Alias :
Table Name :

authors

Table Name Alias :
Column Name :

address

Column Alias :
Value Summary :

True

Class Code :

Text

Column Level Content Summary
Total Actual Row Count :

23

Uniqueness Count :

19

Uniqueness % :

82.609

Distinct Value :

21

Distinct Value % :

91.304

Distinct Format Count :

19

Distinct Format % :

82.609

Nullability Flag Chosen :

False

Null Count :

0

Null % :

.000

Column Level Domain Summary
Incomplete Count :

0

Incomplete% :

0

Invalid Count :

0

Invalid Count % :

.000

Minimum Value :

10 Mississippi Dr.

Maximum Value :

PO Box 792

IBM Information Server
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Cross-domain analysis reports
After a cross-domain analysis job completes, you can create a report that shows a
summary of the columns that share a common domain in your data. Columns that
share a common domain might contain redundant values. Information about
common domains in your data is taken from the frequency distribution that was
generated during column analysis.
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There are two types of cross-domain analysis reports:
Above threshold report
Shows a summary of the columns that contain enough overlapping values
to be considered above the common domain threshold. The common
domain threshold is a setting that you can configure to define the amount
of redundant values in a column.
Redundant value detail report
Shows a summary of redundant values in your data.

Cross-Domain Analysis-Cross Domain Value Commonality
Details report
The Cross-Domain Analysis-Cross Domain Value Commonality Details report
shows a comparison of column details for any cross domain analysis column pair
which equals or exceeds the commonality percentage that you specify.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Base tables to include
Select the base tables you want to include in the report. The base table you
choose will be the driver for the cross-domain analysis.
Base columns to include
Select the base columns that you want to include in the report. The base
column you choose will be the driver for the cross-domain analysis.
Percent threshold overlap for inclusion
Define the percentage of commonality you want between the base column
and the paired column for the column pair to be included in the report.
Include notes
Select this option to show any notes associated with the base or paired
column

Content
The following defines the structure of the report:
Heading
Cross Domain Analysis-Cross Domain Value Commonality Details
Main Section
Host name
Data store name
Data store alias
Database name
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Data store name
Commonality Summary
Base table name
Paired table name
Base column name
Paired column name
Base cardinality
Paired cardinality
Intersection count
Base Column Level Details
Primary key
Foreign key
Data class
Data type
Length
Precision
Scale
Paired Column Level Details
Primary key
Foreign key
Data class
Data type
Length
Precision
Scale
Cardinality Details
Common record count
Common distinct value count
Redundant status
Base total records
Base total distinct values
Base-to-paired value overlap percentage
Base unique flag
Base constant flag

Sort order
The report output is displayed in alphabetical order by table or column name in
ascending order.
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Example of report output
Cross Domain Analysis
Cross Domain Value Commonality Details
Project:

pubs

Report Name:

Cross Domain Value Commonality Details

Report Generated:

2008-01-21

Time Zone:

UTC +05:30

User:

admin admin

10:13:03

Comments:
Host Name:

CD-SPATABENDIGE

Data Store:

pubsDS

Data Store Alias:
Database:

dbo

Commonality Summary
Base Table Name

Paired Table Name

Base Column Name

Paired Column Name

pub_info

publishers

pub_id

pub_id

Base Cardinality

Paired Cardinality

Intersection Count

8

8

8

Base Column Level Details
Primary Key

Foreign Key

Data Class

Data Type

No

No

Identifier

Int16

Length

Precision

Scale

4

4

0

Length

Precision

Scale

4

4

0

Paired Column Level Details
Primary Key

Foreign Key

Data Class

Data Type

No

No

Identifier

Int16

Cardinality Details
Common Record Count

8

Common Distinct Value Count

8

Redundant Status

No

Base Total Records

8

Paired Total Records

Base Total Distinct Values

8

Paired Total Distinct Values

Base-to-Paired Value Overlap %
Base Unique Flag

100.00%
Yes

Base Constant Flag

No

Paired-to-Base Value Overlap %
Paired Unique Flag
Paired Constant Flag

IBM Information Server

8
8
100.00%
Yes
No
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Cross-Domain Analysis-Same Name Value Commonality
Details report
The Cross-Domain Analysis-Same Name Value Commonality Details report shows
a comparison of column details for any cross-domain analysis column pair for
which the base column and the paired column have the same column name.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select schemas on the host computer that you want included in the report.
Tables to include
Select the base tables you want to include in the report. The base table you
choose will be the driver for the cross-domain analysis.
Columns to include
Select the columns that you want to include in the report. The base column
you choose will be the driver for the cross-domain analysis.
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Percent threshold overlap for inclusion
Define the percentage of commonality you want between the base column
and the paired column for the column pair to be included in the report.
Include notes
Select this option to show any notes associated with the base or paired
column.

Content
The following defines the structure of the report:
Heading
Cross Domain Analysis-Same Name Value Commonality Details
Main Section
Host name
Data store name
Data store alias
Database name
Database alias
Table alias
Commonality Summary
Base table name
Paired table name
Base column name
Paired column name
Base cardinality
Paired cardinality
Intersection count
Base column level details
Primary key
Foreign key
Data class
Data type
Length
Precision
Scale
Paired column level details
Primary key
Foreign key
Data class
Data type
Length
Precision
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Scale
Cardinality details
Common record count
Common distinct value count
Redundant status
Base total records
Paired total records

Sort order
The report output is displayed in alphabetical order by table or column name in
ascending order.

Example of report output
Cross Domain Analysis
Same Name Value Commonality Details
Project:

nil

Report Name:

Cross Domain - Same Name Value Commonality Details

Report Generated:

2008-06-17

Time Zone:

UTC +05:30

User:

admin admin

Comments:

dfdfsfsfd

Host Name:

CD-DWEERAKOON

Data Store:

Hippogriff

17:07:09

Data Store Alias:
dbo

Database:
Database Alias:
Table Alias:

Commonality Summary
Base Table Name

Paired Table Name

Base Column Name

Paired Column Name

authors

titleauthor

au_id

au_id

Base Cardinality

Paired Cardinality

Intersection Count

23

19

19

Base Column Level Details
Primary Key

Foreign Key

Data Class

Data Type

Yes

No

Identifier

String

Length

Precision

Scale

11

0

0

Length

Precision

Scale

11

0

0

Paired Column Level Details
Primary Key

Foreign Key

Data Class

Data Type

No

Yes

Text

String

Cardinality Details
Common Record Count:

19

Common Distinct Value Count:

19

Redundant Status:

No

Base Total Records:
Base Total Distinct Values:
Base-to-Paired Value Overlap %:

23
23
82.61%

Paired Total Records:
Paired Total Distinct Values:
Paired-to-Base Value Overlap %:

19
25
100.00%

Base Unique Flag:

No

Paired Unique Flag:

No

Base Constant Flag:

No

Paired Constant Flag:

No
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Cross-Domain Detail Value Discrepancies report
The Cross-Domain Detail Value Discrepancies report shows a detailed display of
data discrepancies that exist in either the base column or in the paired column
based on cross-domain analysis. The display does not include any data values that
are common to both columns.

Parameters
Specify the parameters for the report:
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Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables to include
Select the base tables you want to include in the report. The base table you
choose will be the driver for the cross-domain analysis.
Columns to include
Select the columns that you want to include in the report. The base column
you choose will be the driver for the cross-domain analysis.
Percent threshold overlap for inclusion
Define the percentage of commonality that must exist between the base
column and the paired column for the column pair to be included in the
report.
Maximum number of base column discrepancies
Specify the maximum number of data values in the base column that you
want displayed.
Maximum number of paired column discrepancies
Specify the maximum number of data values in the paired column that
you want displayed.
Include notes
Select this option to show any notes associated with the base or paired
column.

Content
The following defines the structure of the report:
Heading
Cross Domain Detail Value Discrepancies
Main Section
Host name
Data store name
Data store alias
Database name
Database alias
Detail value discrepancies
Base table name
Paired table name
Base column name
Paired column name
Base value
Frequency count

372

User's Guide

Paired value
Frequency count

Sort order
The report output is displayed in alphabetical order by table or column name in
ascending order.
The report output is displayed in alphabetical order by domain value in ascending
order.

Example of report output
Cross Domain Analysis
Cross Domain Detail Value Discrepancies
Project:

pubs

Report Name:

Cross Domain Detail Value Discrepancies

Report Generated:

2008-01-18

Time Zone:

UTC +05:30

User:

admin admin

17:11:08

Comments:
Host Name:

CD-SPATABENDIGE

Data Store:

pubsDS

Data Store Alias:
Database:

dbo

Table:

employee

No cross table analysis exists for this table
Host Name:

CD-SPATABENDIGE

Data Store:

pubsDS

Data Store Alias:
Database:

dbo

Detail Value Discrepancies
Base Table Name

Paired Table Name

Base Column Name

Paired Column Name

Base Value

titleauthor

authors

au_ord

contract

2

Freq Count
7

Paired Value

Freq Count

titleauthor

authors

au_ord

contract

3

1

titleauthor

authors

au_ord

contract

0

4

titleauthor

titles

title_id

title_id

MC3026

1
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Cross-Table Domain Analysis-Cross Domain-Redundant
Column Value Commonality Details report
The Cross Domain Redundant Column Value Commonality Details Report shows a
comparison of column metadata for any cross domain analysis column pair that
you mark as redundant during cross domain analysis review.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
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Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables to include
Select the base tables you want to include in the report. The base table you
choose will be the driver for the cross-domain analysis.
Columns to include
Select the columns that you want to include in the report. The base column
you choose will be the driver for the cross-domain analysis.
Include notes
Select this option to show any notes associated with the base or paired
column.

Content
The following defines the structure of the report:
Heading
Cross-Table Domain Analysis-Cross Domain-Redundant Column Value
Commonality Details
Main Section
Host name
Data store name
Data store alias
Database name
Database alias
Column comparison
Column name
Table name
Primary key
Foreign key
Data class
Data type
Length
Precision
Scale
Cardinality
Unique flag
Constant flag
Definition
Redundant status
Total records
Total distinct values
Common values
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Distinct column values

Sort order
The report output is displayed in alphabetical order by table name or column
name in ascending order.

Example of report output

Cross-Table Domain Analysis
Cross Domain - Redundant Column Value Commonality Details
Project :

nil

Report Name :

Cross Domain - Redundant Column Value Commonality Details

Report Generated :

2008-06-17

Time Zone :

UTC +05:30

16:35:43

User :

admin admin

Comments :

gdgdf

Host Name :

CD-DWEERAKOON

Data Store :

Hippogriff

Data Store Alias :
Database Name :

dbo

Database Alias :

Column Comparison
Base Column Name

Paired Column Name

Column Name :

job_id

job_id

Table Name :

employee

jobs

Primary Key :

No

Yes

Foreign Key :

Yes

No

Data Class :

Quantity

Identifier

Data Type :

Int8

Int8

Length :

2

2

Precision :

2

2

Scale :

0

0

Cardinality :

13

14

Unique Flag :

False

True

Constant Flag :

False

False

Definition :

No

No

Redundant Status :

False

True

Total Records :

43

14

Total Distinct Values :

13

14

Common Records :

0

Common Distinct Values :

0
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Cross-Table Domain Analysis - Same Name Detail Value
Discrepancies report
The Cross-Table Domain Analysis - Same Name Detail Value Discrepancies report
shows a detailed display of data value discrepancies that exist in either the base
column or in the paired column, based on cross domain analysis for a base column
and a paired column that have the same column name. The display does not
include any data values that are common to both columns.
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Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select schemas on the host computer that you want to include in the
report.
Tables to include
Select the base tables you want to include in the report. The base table you
choose will be the driver for the cross-domain analysis.
Columns to include
Select the columns that you want to include in the report. The base column
you choose will be the driver for the cross-domain analysis.
Percent threshold overlap for inclusion
Define the percentage of commonality that must exist between the base
column and the paired column for the column pair to be included in the
report.
Maximum number of base column discrepancies
Specify the maximum number of data values in the base column that you
want displayed.
Maximum number of paired column discrepancies
Specify the maximum number of data values in the paired column that
you want displayed.
Include notes
Select this option to show any notes associated with the base or paired
column.

Content
The following defines the structure of the report:
Heading
Same Name Detail Value Discrepancies
Main Section
Host name
Data store name
Data store alias
Database name
Same name detail value discrepancies
Base table name
Paired table name
Base column name
Paired column name
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Base value
Base value frequency count
Paired value
Paired value frequency count

Sort order
The report output is displayed in alphabetical order by table or column name in
ascending order by:
v Table or column name in ascending order
v Domain value in ascending order

Example of report output
Cross-Table Domain Analysis
Same Name Detail Value Discrepancies
Project :

pubs

Report Name :

Same Name Detail Value Discrepancies

Report Generated :

2008-01-21

Time Zone :

UTC +05:30

User :

admin admin

11:15:49

Comments :
Host Name :

CD-SPATABENDIGE

Data Store :

pubsDS

Data Store Alias :
Database :

dbo

Same Name Detail Value Discrepancies
Base Table Name

Paired Table Name

Base Column Name

Paired Column Name

Base Value

titles

roysched

royalty

royalty

[

titles

roysched

royalty

royalty

18

9

titles

roysched

royalty

royalty

20

7

titles

roysched

royalty

royalty

22

6

titles

roysched

title_id

title_id

MC3026

Freq Count Paired Value

Freq Count

2

1

titles

roysched

title_id

title_id

PC9999

1

titles

titleauthor

title_id

title_id

MC3026

1
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Data quality reports
After you work with data rule definitions, data rules, and metrics, you might want
to generate reports to gather information about the data quality work you
performed.
The reports can include information such as when data rule definitions, data rules,
and metrics were created, run, the number of times they were executed, as well as
benchmark information.

Data Rule Execution History Summary report
The Data Rule Execution History Summary report shows a history of execution
trends for selected data rules and rule sets.
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You can select a specific project that you want to view all the execution trends for
data rules and rule sets, and select a variety of parameters that you want to
include in the report.

Parameters
Specify the parameters for the report:
Folder Name
Specify a specific folder name. The report will include data rules and rule
sets that are associated with the folder that you specify.
Data Rule Name
Select the names of rule definitions and data rules that you want included
in the report.
Comments
Enter any comments you want to include in the report output.
Oldest Rule Data
Select a particular date as the oldest creation date value, and only data
rules that were created after this date will be displayed in the report.
Latest Rule Data
Select a particular date as the latest creation date value, and only data
rules that were created before this date will be displayed in the report.
Trend Chart Based On
Select the record output that you want your trend chart to be based on.
Display Notes
Select this option if you want any notes associated with the exception table
included in the report.
Locale Specification [Language, Territory]
Select the language and demographic region for the exception table
included in the report.

Content
The following defines the structure of the report:
Heading
Data Rule Summary– Data Rule Execution Summary-Execution History
Main Section
Execution Start Date
Execution End Date
Total Executions
Folder Category
Data Rule History Summary
Data Rule Definition Name
Data Rule Description
Data Rule Name
Data Rule Execution History Detail
Execution Date
Execution Type
Total Rows Tested
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Rows Met #
Rows Met %
Rows Not Met #
Rows Not Met %
Benchmark Setting
Benchmark Value
Variance
Issue Flag
Execution Date
Execution Type
Total Rows Tested
Trend Chart of Execution History
Charts the Magnitude/Percentage to the Trend of Executions
(Records Met)

Sort order
The report output is displayed with the rule names in ascending order, and the
execution date based on parameters, ascending or descending.
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Example of report output

Data Rule Summary
Data Rule Summary - Execution History
Project:

Reports_Proj

Report Name:

Data Rule Execution History Summary

Report Generated:

2009-02-20 10:05:04

Time Zone:

UTC +05:30

User:

iauser iauser

Comments:

This is a Test Comment

Execution Start Date:

2008-02-20

Execution End Date:

2010-02-20

Total Executions:

2

Folder Categories
Reports_Proj/All
Reports_Proj/

Data Rule History Summary
Data Rule Definition Name:

Description

Rule One

Rule One Short Desc.

Data Rule Name:

Rule One Exe

Data Rule Execution History Detail
Execution Date:

2009-02-20 09:35:18

Execution Type:

Deploy

Total Rows Tested:

10

Rows Met #

Rows Met %

1
Benchmark Setting

10.0000%
Benchmark Value

PASS

Rows Not Met #
9
Variance

# Met <= 6

--

Rows Not Met %
90.0000%
Issue Flag
N

Rule one Exe note
Type :

Action

Creator :

iauser

Status :

Opened

Created :

2009-02-20

Created :

2009-02-20

Modified :

2009-02-20

This is a note added from the view output screen

Rule One EXE note
Type :

Action

Creator :

iauser

Status :

Opened

Modified :

2009-02-20

This is a Test Note for Rule One EXE
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Data Rule Exception report
The Data Rule Exception report provides an output of rows associated with a
specific exception table and its underlying columns.
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For this report, you can select a specific column that you want to view exceptions
for, and then you can select a variety of parameters that you want to include in the
report.

Parameters
Specify the parameters for the report:
Project Name
Select the project that contains the data rules that you want included in the
report.
Folder Name
Select the name of the folder that contains the data rules that you want
included in the report.
Data Rule Name
Select the data rule that you want included in the report
Column Name
Select the name of the column that is associated with the data rules that
you want included in the report.
Enter Data Collection Parameter
Select the data collection parameter, based on the column name value that
you selected.
Rule Definition Name
Select the rule definition that you want included in the report.
Display Notes
Select this option if you want any notes associated with the exception table
included in the report.
Show Custom Definitions
Select this option if you want the report to display any definitions you
created that are associated with the exception table you selected to work
with.
Comments
Enter any comments you want to include in the report output.
Locale Specification [Language,Territory]
Select the language and demographic region for the exception table
included in the report.
Report name
Specify a name for the report.
Save Report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
Output Format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
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History Policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.

Content
The following defines the structure of the report:
Heading
Data Rule Exception Report - Detail
Main Section
Rule Definition Name
Rule Definition
Data Rule Name
Data Rule Definition
Last Executed Date
Row Filter Condition
Total Rows Processed
Total Exceptions
Total Exception Rows
Exception Table Details
Row ID
Column Name
Row ID Value
Column Values
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Example of report output

Data Rule Exception
Data Rule Exception Report - Detail
Project:

Reports_Proj

Report Name:

Data Rule Exception Report

Report Generated:

2009-02-20

Time Zone:

UTC +05:30

User:

iauser iauser

Comments:

This is a Test Comment

Data Rule Definition Name:

Rule One

Description:

Rule One Short Desc.

10:12:26

Data Rule Name:

Rule One Exe

Description:

Rule One Exe Short Desc

Last Executed Date:

2009-02-20

Row Filter Condition:

ALL

Total Rows Processed:

10

Total Exceptions:

9

Total Exception Rows:

9

Exception Table Details
Row ID
1
2
3
4
5
6
7
8
9

cola
1
2
3
4
6
7
8
9
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Data Rule Exception- Rule Set Exception report
The Data Rule Exception- Rule Set Exception report displays the output rows that
are associated with a specific rule set exception.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the rule set that you want
included in the report.
Folder Name
Select the name of the folder that contains the rule set that you want
included in the report.
Rule Set Name
Select the name of the rule set that you want included in the report.
Column Name
Select the name of the column that you want included in the report.
Enter Data Collection Parameter
Select the rule set that you want included in the report.
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Display Notes
Select this option if you want any notes associated with the rule sets
included in the report.
Show Custom Definitions
Select this option if you want to include any custom definitions that you
created for the rule set in the report.
User Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Data Rule Exception- Rule Set Exception- Detail
Main Section
Rule Set Definition Name
Description
Rule Set Name
Description
Last Execution Date
Row Filter Condition
Total Rows Processed
Total Exceptions
Total Exception Rows
Exception Table Details
Number of Failed Rules
Row ID
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Name
Description

Example of Report Output

Rule Set Definition Name:

ruleset1

Description:
Rule Set Name:

myruleset1

Description:
Last Execution Date:

08/07/09 11:44:42

Row Filter Condition:

ALL

Total Rows Processed:

5112

Total Exceptions:

5095

Total Exception Rows:

5095

Exception Table Details
Number of Failed Rule:

Row ID

a

2

1

-2765967.00
Failed Rule Name:

2

2

Failed Rule Name:

2

3

4

5

Description:

datarule1
rules2
-159086.00
Failed Rule Name:

2

Description:

datarule1
rules2
-159086.00
Failed Rule Name:

2

Description:

datarule1
rules2
-2765967.00

Description:

datarule1
rules2
-157652.00
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Data Rule Exception Table Chart report
The Data Rule Exception Table Chart report shows a graphical output of rows
associated with a specific exception table and column.
The report displays rows associated with a specific exception table and its
underlying columns.

Parameters
Specify the parameters for the report:
Project Name
Select the project that contains the data rules that you want included in the
report.
Folder Name
Select the name of the folder that contains the data rule that you want
included in the report.
Column Name
Select the name of the column that is associated with the data rule
definition or data rule that you want included in the report.
Enter Data Collection Parameter
Select the data collection parameter, based on the column name value that
you selected.
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Data Rule Name
Select the data rules that you want included in the report.
Display Notes
Select this option if you want any notes associated with the exception table
included in the report.
Show Custom Definitions
Select this option if you want the report to display any definitions you
created that are associated with the exception table you selected to work
with.
Chart Type
Select the type of chart you prefer. You can select a bar chart, pie chart, or
side chart.
Maximum Values to include in the Chart
Select the number of maximum number of values you want included in
your chart. The default value is 30.
Comments
Enter any comments you want to include in the report output.
Locale Specification [Language,Territory]
Select the language and demographic region for the exception table
included in the report.
Report Name
Specify a name for the report.
Save Report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
Output Format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History Policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.

Content
The following defines the structure of the report:
Heading
Data Rule Execution - Data Rule Exception Table Chart Report - Summary
Main Section
Rule Definition Name
Rule Definition
Data Rule Name
Data Rule Definition
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Last Executed Date
Row Filter Condition
Total Rows Processed
Total Exceptions
Total Exception Rows
Exception Table Chart
Shows Magnitude / Percentage to Trend of Executions (Records Met)

Example of report output

Data Rule Definition Name:

aruledef

Description:
Data Rule Name:

aruleedffdlklk

Description:
Last Executed Date:

2009-08-07

Row Filter Condition:

ALL

Total Rows Processed:

5112

Total Exceptions:

847

Total Exception Rows:

847

Exception Table Details
Row ID
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20

a
-2765967.00
-159086.00
-157652.00
-155006.00
-136917.34
-130178.00
-79248.00
-77716.00
-72835.75
-61392.00
-51641.00
-50640.66
-47926.69
-44605.19
-43266.36
-42568.00
-40582.15
-38338.00
-37282.00
-32591.57
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Data Rule Summary- Project Folder Data Rule Validation List
The Data Rule Summary- Project Folder Data Rule Validation List report provides
the details for each data rule that exists in the project folders that you select.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the data rules that you want
included in the report.
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Folder Name
Select the name of the folder that contains the data rules that you want
included in the report.
Data Collection Parameter
Select the data rules that you want included in the report.
Sort Rules by Name
Select Ascending or Descending to display your report output in a specific
order by data rule name. The default sort order is ascending by data rule
name.
Display Notes
Select this option if you want any notes associated with the data rules
included in the report.
Display Actual Executions Only
Select this option if you only want to include data rules in the report that
have been run.
Start Date
Select a particular start date, and only data rules that were run after that
date will be displayed in the report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Data Rule Summary- Project Folder Data Rule Validation List
Folder Data Rule Summary
Folder Name
Folder Description
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Data Rule
Data Rule Name
Data Rule Description
Last Execution Date

Example of Report Output

Data Rule Summary
Project Folder Data Rule Validation List — Summary
Project:

project

Report Name:

Project Folder Data Rule Validation List

Report Generated:

2009-05-12 05:59:36

Time Zone:

UTC +05:30

User:

admin admin

Comments:

All

Folder Category
project/All

Data Rule History Sumary
Data Rule Name:

CalmRule_EXEC

Description:

Data Rule Execution History Detail
Last Execution Date:

2009-04-24 12:18:33

Total Rows Tested:

0

Data Rule History Sumary
Data Rule Name:

GameRule_EXEC

Description:

Data Rule Execution History Detail
Last Execution Date:

2009-04-24 10:23:28

Total Rows Tested:

28

Rules Met #

Rules Met %

Rules Not Met #

Rules Not Met %

26

92.8571%

2

7.1429%

Benchmark Setting

Benchmark Value

Varience

Issue Flag

FAIL

% Not Met <= 4.0000%

3.1429%

Y

Data Rule History Sumary
Data Rule Name:

GoodRule_EXEC

Description:

Data Rule Execution History Detail
Last Execution Date:

2009-04-07 09:43:51

Total Rows Tested:

28

Rules Met #

Rules Met %

Rules Not Met #

Rules Not Met %

26

92.8571%

2

7.1429%

Benchmark Setting

Benchmark Value

Varience

Issue Flag

FAIL

% Met <=

82.8571%

Y

10.0000%

IBM Information Server

1/5

IBM, the IBM logo, and IBM Information Server are trademarks of International Business Machines Corporation in the United States, other countries or both.

Chapter 17. Reports for information analysis

389

Data Rule Summary - Project List report
The Data Rule Summary - Project List report shows a list of all data rules
associated with a particular project.
You can select a specific project that you want to view all data rules for, and select
a variety of parameters that you want to include in the report.

Parameters
Specify the parameters for the report:
Project Name
Select the project that contains the data rule definitions or data rules you
want included in the report.
Folder Name
Select the name of the folder that contains the data rule definitions or data
rules that you want included in the report.
Enter Data Collection Parameter
Select the data collection parameter, based on the column name value that
you selected.
Display Notes
Select this option if you want any notes associated with the project data
included in the report.
Oldest Rule Creation Date
Select a particular date as the oldest creation date value, and only data rule
definitions or data rules that were created after this date will be displayed
in the report.
Oldest Rule Modification Date
Select a particular date as the oldest modification date value. Only data
rule definitions or data rules that were modified after this date will be
displayed in the report.
Select Display Output
Select Data Rule Definitions Only, Data Rules Only, or Both depending
on the data you want included in your report.
Display Actual Executions Only
Select this option if you want to only display data rules that were executed
in the report. Data rules that were not executed will be excluded from the
report.
Comments
Enter any comments you want to include in the report output.
Locale Specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Report Name
Specify a name for the report.
Save Report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
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in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
Output Format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History Policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.

Content
The following defines the structure of the report:
Heading
Data Rule Summary - Data Rule Summary - Project List
Main Section
Data Rule Definition Summary
Rule Definition / Data Rule Indicator
Rule Definition Name
Rule Definition
Data Rule Details
Creation Date
Creation User ID
Last Modified Date
Last Modified User ID
Folder Categories
Lists user-defined folder categories
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Example of Report Output

Data Rule Summary
Data Rule Summary - Project List
Project:

Reports_Proj

Report Name:

Data Rule Summary Project List

Report Generated:

2009-02-20 10:10:52

Time Zone:

UTC +05:30

User:

iauser iauser

Comments:

This is a test comment

Data Rule Definition Summary
Rule Indicator:

Data Rule Definition

Name:

Rule One

Description:

Rule One Short Desc.

Data Rule Definition Details
Creation Date:

02/20/09

Creator User ID:

iauser

Last Modifiied Date:

02/20/09

Last Modified User ID:

iauser

Folder Categories
Reports_Proj/All
Reports_Proj/

Data Rule Definition Summary
Rule Indicator:

Data Rule Definition

Name:

Rule Two

Description:

Rule Two Short Desc.

Data Rule Definition Details
Creation Date:

02/20/09

Creator User ID:

iauser

Last Modifiied Date:

02/20/09

Last Modified User ID:

iauser

Folder Categories
Reports_Proj/All

IBM Information Server
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Metric Summary - Execution History report
The Metric Summary - Execution History report provides a history of the
executions for the metric you select.
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You can select a specific project that you want to view the metric execution history
for, and select a variety of parameters that you want to include in the report.

Parameters
Specify the parameters for the report:
Project name
Select the name of the project that contains the metrics that you want
included in the report.
Folder name
Select the name of the folder that contains the metrics that you want
included in the report.
Metric name
Select the metrics that you want included in the report.
Enter data collection parameter
Select the metric that you want included in the report.
Comments
Enter any comments you want included in the report output.
Oldest rule data
Select a particular date as the oldest rule date value, and only metrics that
were run before this date will be displayed in the report.
Latest rule date
Select a particular date as the latest rule date value, and only metrics that
were run after this date will be displayed in the report.
Display notes
Select this option if you want any notes associated with the exception table
included in the report.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
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Content
The following defines the structure of the report:
Heading
Metric Summary - Execution History
Main Section
Metric History Summary
Metric Name
Data Rule Description
Metric Execution History
Execution Date
User ID
Execution Type
Metric Score
Benchmark Setting
Benchmark Value
Variance
Issue Flag
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Example of report output

Metric Summary
Metric Summary — Execution History
Project:

SQLSERver

Report Name:

Metric Execution History Summary 3

Report Generated:

2009-03-03 09:41:57

Time Zone:

UTC -05:00

User:

admin admin

Description:

metric

Start Execution Date:

2008-03-02

End Execution Date:

2009-03-02

Total Executions:

6

Folder Category:

All

Metric History Summary
Metric Name

Description

my_datarule_metric

my description

Metric Execution History
Execution Date:

2009-03-02 11:31:56

User ID:

admin

Execution Type:

Run

Metric Score:

3.00

Benchmark Setting
PASS

Benchmark Value
# Met >

1.00

Execution Date:

2009-03-02 11:31:23

User ID:

admin

Execution Type:

Run

Metric Score:

3.00

Benchmark Setting
PASS

Benchmark Value
# Met >

2.00

Execution Date:

2009-03-02 11:32:21

User ID:

admin

Execution Type:

Run

Metric Score:

3.00

Benchmark Setting
FAIL

Benchmark Value
# Met >

5.00

Execution Date:

2009-03-02 11:31:40

User ID:

admin

Execution Type:

Run

Metric Score:

3.00

Benchmark Setting

Benchmark Value

IBM Information Server

Variance

Issue Flag

--

N

Variance

Issue Flag

--

N

Variance

Issue Flag

2.00

Y

Variance

Issue Flag
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Metric Summary-Project Folder Metric List report
The Metric Summary-Project Folder Metric List report provides the details for each
metric that exists in the project folders that you select.
You can select a specific folder in a project that you want to view the details of
metrics for.
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Parameters
Specify the parameters for the report:
Project name
Select the name of the project that contains the folder that you want to see
the details of the metrics for.
Folder name
Select the name of the folder that contains the metrics that you want
included in the report.
Enter Data Collection Parameter
Select the metrics that you want included in the report.
Display Notes
Select this option if you want any notes associated with the metrics
included in the report.
Oldest Rule Creation Data
Select a particular date as the oldest rule creation date value, and only
metrics that were created after this date will be displayed in the report.
Display Actual Executions only
Select this option if you only want to include metrics in the report that
have been run.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Metric Summary- Project Folder Metric List Report-Summary
Folder Categories
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Metric Summary Details
Metric Name
Description
Execution Date
User ID
Execution Type
Metric Score
Benchmark Setting
Benchmark Value
Variance
Metric Details
Creation Date
Creator User ID
Last Modified Date
Last Modified User ID
Last Execution Date
Folder Categories
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Example of Report Output

Metric Summary
Project Folder Metric List Report - Summary
Project:

TestProject

Report Name:

Project Folder Metric List Report 1

Report Generated:

2009-08-04

Time Zone:

UTC -04:00

User:

admin admin

Description:

project folder metric report

Total Project Metrics

6

05:22:50

Folder Categories
TestProject/All

Metric Summary Details
Metric Name

Description

Metric5
Execution Date:

2009-07-29 01:25:11

User ID:

admin

Execution Type:

Run

Metric Score:

4.00

Benchmark Setting

Benchmark Value

Variance

Issue Flag

MET Count

# Met <=

2.00

N

Metric Name

2.00
Description

metric2

metric2 without benchmark

Execution Date:

2009-07-10 12:14:02

User ID:

admin

Execution Type:

Run

Metric Score:

3.00

IBM Information Server
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Metric Summary Project List report
The Metric Summary Project List report provides a list of metrics for a particular
project.
You can view all the metrics that you created in the Data Quality workspace for a
particular project.
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Parameters
Specify the parameters for the report:
Project name
Select the name of the project that contains the metrics that you want
included in the report.
Enter Data Collection Parameter
Select the metrics that you want included in the report.
Display Notes
Select this option if you want any notes associated with the exception table
included in the report.
Oldest Rule Creation Date
Select a particular date as the oldest rule creation date value, and only
rules that were created after this date will be displayed in the report.
Oldest Rule Modification Date
Select a particular date as the oldest rule modification date value, and only
rules that were modified after this date will be displayed in the report.
Display Actual Executions only
Select this option if you only want to include metrics in the report that
have been run.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Metric Summary- Metric Summary Project List
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Metric Summary
Name
Description
Metric Details
Creation Date
Creator User ID
Last Modified Date
Last Modified User ID
Last Execution Date
Folder Categories
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Example of Report Output

Metric Summary
Metric Summary - Project List
Project:

proc

Report Name:

Metric Summary Project List

Report Generated:

2009-09-02

Time Zone:

UTC +01:00

User:

admin

07:14:54

Description:

Metric Summary
allmetric

Name:
Description:
Metric Details
Creation Date:

08/13/09 09:36:21

Creator User ID:

admin

Last Modifiied Date:

08/13/09 09:57:37

Last Modified User ID:

admin

Last Execution Date:

08/13/09 09:57:37

Folder Categories
proc/All
proc/folder1
proc/folder2
proc/folder2/infolder1/infold
proc/folder2/infolder1

Metric Summary
ametric

Name:
Description:
Metric Details
Creation Date:

08/12/09 03:55:27

Creator User ID:

admin

Last Modifiied Date:

08/12/09 03:55:40

Last Modified User ID:

admin

Last Execution Date:

08/12/09 03:55:40

Folder Categories
proc/All

IBM Information Server
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Rule Set Execution History Statistics report
The Rule Set Execution History Statistics report provides a history of execution for
selected rule sets.
You can select a specific project that you want to view all rule set definitions and
rule sets for, and select a variety of parameters that you want to include in the
report.
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Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the rule set definitions or rule
sets that you want included in the report.
Folder Name
Select the name of the folder that contains the rule set definitions or rule
sets that you want included in the report.
Rule Set Name
Select the rule sets that you want included in the report.
Data Collection Parameter
Select the rule set that you want included in the report.
Display Notes
Select this option if you want any notes associated with the exception table
included in the report.
Exclude Rule Sets Before (Date)
Specify a particular date, and rule set definitions and rule sets that were
created before this date will not be included in the report.
Exclude Rule Sets After (Date):
Specify a particular date, and rule set definitions and rule sets that were
created after this date will not be included in the report.
Sort Rule Set History By Date
Select to have your data sorted in either ascending or descending order by
execution date.
Chart Type
Select the type of chart you prefer. You can select a bar chart, pie chart, or
side chart.
Coordinate Criteria
Select magnitude or percentage. The coordinate criteria is based on the
absolute value of the rows that met all the rules or based on the percentage
of rows (of the total rows) that met all the rules.
Include Test Output
Select this option to display test output in the report.
Comments
Enter any comments you want to include in the report output.
Locale Specification [Language, Territory]
Select the language and demographic region for the data included in the
report.
Report Name
Specify a name for the report.
Save Report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
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Output Format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History Policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.

Content
The following defines the structure of the report:
Heading
Rule Set Summary - Execution History Statistics Report
Main Section
Rule Set Summary
Rule set name
Rule set definition name
Total number of execution points
Folder Category
Rule Set History Summary
Execution Date
Execution User ID
Execution Type
Summary statistics
Total Rows Tested
Met All Rules Count
Met All Rules Percent
Did Not Meet Count
Did Not Meet Percent
Average Rules Not Met Percent
Standard Deviation Rules Not Met Percent
Validity Measures
Confidence Measures
Confidence Standard
Confidence Benchmark
Records Above Standard Count
Records Above Standard Percent
Records Below Standard Count
Records Below Standard Percent
Variance from benchmark
Issue Flag
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Baseline Measures
Baseline Date
Difference to Baseline Benchmark
Similarity Measure Current to Baseline
Difference Measure Current to Baseline
Variance of Difference from Benchmark
Issue Flag
Rule Set Trend Chart
Shows trends or charts for Validity Measures, Confidence
Measures, and Baseline Comparison Measures.

Sort order
The report output sort order is either ascending or descending, depending on the
parameters you select.

Rule Set Summary-Project Folder Rule Set Validation List
Summary report
The Rule Set Summary- Project Folder Rule Set Validation List Summary report
provides a list of all the rule sets that were run in the folder that you specify, as
well as details about the rule sets.

Parameters
Specify the parameters for the report:
Project name
Select the name of the project that contains the rule sets that you want
included in the report.
Folder name
Select the name of the folder that contains the rule sets that you want
included in the report.
Data Collection Parameter
Select the rule sets that you want included in the report.
Display Notes
Select this option if you want any notes associated with the rule sets
included in the report.
Show Custom Definitions
Select this option if you want to include any custom definitions that you
created for the rule set in the report.
Exclude Rule Sets Before
Select a particular date, and only rule sets that were created after that date
will be displayed in the report.
Sort Rule Set by Name
Select Ascending or Descending to display your report output in a specific
order by rule set name. The default sort order is ascending by rule set
name.
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Include Only Actual Execution
Select this option if you only want to include rule sets in the report that
have been run.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Rule Set Summary- Project Folder Rule Set Validation List- Summary
Folder Rule Set Summary
Folder Name
Folder Description
Rule Set Summary
Rule Set Name
Rule Set Description
Last Execution Date
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Example of Report Output

Rule Set Summary
Project Folder Rule Set Validation List —Summary
Project:

project

Report Name:

Project Folder Rule Set Validation List - Summary

Report Generated:

2009-05-12 05:55:54

Time Zone:

UTC +05:30

User:

admin admin

Comments:

All RuleSets

Total Rule Sets:

13

Folder Rule Set Summary
Folder Name:

project/All

Folder Description:

Global category for all QualityComponents

Rule Set Executables
Rule Set Name:

goodRuleSet_EXEC

Rule Set Description:
Last Execution Date

Rule Set Executables
Rule Set Name:

ruleSet2_EXEC2

Rule Set Description:
Last Execution Date

2009-03-12 11:34:12

Summary Statistics
Total Rows Tested

28

Met All Rules Count

26

Met All Rules %

92.8571%

Did Not Meet Count

2

Did Not Meet %

7.1429%

Average Rules Not Met %

7.1429%

Standard Deviation Rules
Not Met %
Validity Measures

25.7539%

Benchmark Setting

NOT MET %

Benchmark Value

<= .0000%

Varience From Benchmark

7.1429%

Issue Flag

Y

Confidence Measures
Confidence Standard

10.0000%

Confidence Benchmark

10.0000%

Records above Standard
Count
Records above Standard %

2
7.1429%
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Rule Set Summary Project List report
The Rule Set Summary Project List report provides a list of all rule set definitions
and rule sets for a project.
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Parameters
You can select a specific project that you want to view all rule set definitions and
rule sets for, and select a variety of parameters that you want to include in the
report.
Specify the parameters for the report:
Project Name
Select the name of the project that contains the rule set definitions or rule
sets that you want included in the report.
Folder Name
Select the name of the folder that contains the rule definitions and data
rules that you want included in the report.
Data Collection Parameter
Select the rule set that you want included in the report.
Oldest Rule Creation Date
Select a particular date as the oldest creation date value, and only rule set
definitions and rule sets that were created after this date will be displayed
in the report.
Oldest Rule Modification Date
Select a particular date as the oldest modification date value. Only rule set
definitions and rule sets that were modified after this date will be
displayed in the report.
Select Display Option
Select Rule Set Definitions Only, Rule Sets Only, or Both depending on
the data you want included in your report.
Comments
Enter any comments you want to include in the report output.
Locale Specification [Language, Territory]
Select the language and demographic region for the data included in the
report.
Report Name
Specify a name for the report.
Save Report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
Output Format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History Policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
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Content
The following defines the structure of the report:
Heading
Data Rule Summary - Data Rule Summary - Project List
Rule Set Summary
Rule set definition / rule set indicator
Rule set definition name
Rule set definition
Rule Set Details
Creation date
Creation user ID
Last modified date
Last modified user ID
Last execution date
Folder Categories
Lists user-defined folder categories.
Notes Shows notes associated with the rule sets.

Foreign key analysis reports
After a foreign key analysis job completes, you can create a report that shows a
summary of the defined foreign keys and candidate foreign keys in your data.
Defined foreign keys are keys that were already defined in your data before you
ran the analysis. Candidate foreign keys are keys that were inferred during
analysis.
There are five types of foreign key analysis reports:
Defined foreign key summary report
Shows a summary of the defined foreign keys in your data.
Referential integrity exceptions report
Shows a summary of the foreign keys in your data that do not match the
values of an associated primary key.
Defined, candidate, and chosen foreign keys report
Shows a summary of the defined, candidate, and chosen foreign keys in
your data.
Referential integrity detail report
Shows a summary of the referential integrity between the foreign keys and
associated primary keys in your data.
Primary keys without children detail report
Shows a summary of the primary keys that do not have associated records
with the foreign keys in your data.

Metadata summary reports
After you import metadata into the metadata repository, you might want to
generate reports to gather information about the metadata.
The reports can include information such as table descriptions, contacts, policies,
terms, schemas, directories, files, and data fields.
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Metadata Summary-Database Profile report
The Metadata Summary-Database Profile report provides a summary of all tables
and their significant statistics within a selected set of data schemas. The report lists
each table in a database, alias names in the database, as well as the number of
columns and the number of rows for the selected table.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables to include
Select the names of the tables you want to include in the report.
Include schema descriptions
Select this option to show a short description of the schemas.
Include table descriptions
Select this option to show a short description of the tables.
Include terms
Select this option to include any terms associated with the databases or
tables included in the report. A term is a word that has a specific business
meaning.
Include policies
Select this option to include any policies associated with the databases or
tables included in the report.
Include contacts
Select this option to include any contacts associated with the databases or
tables. A contact contains personal information such as names, addresses,
and telephone numbers of users.
Include notes
Select this option to show any notes associated with the databases or
tables.

Content
The following defines the structure of the report:
Heading
Metadata Summary-Database Profile
Main Section
Host name
Data store name
Schema Details
Schema name
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Schema alias
Schema definition
Database or file type
Data connection DSN
Owner name
Total number of tables
Total number of columns
Table details
Table number
Table name
Table alias
Number of columns
Number of rows
Table definition

Sort order
The report output is displayed in alphabetical order by table name in ascending
order.

Example of report output

Metadata Summary
Database Profile Report
Project :

pubs

Report Name :

Database Profile 1

Report Generated :

2008-07-02

Time Zone :

UTC +05:30

User :

admin admin

Comments :

my comment

Host Name :

pubshs

Data Store :

pubsds

10:20:24

Schema Details
Schema Name :

dbo

Schema Alias :

data schema alias

Schema Definition :

data schema short desc

DB/File Type

Data Base

Data Connection DSN

pubs

Owner

dbo

Total # Tables

12

Total # Columns

73

Table Details
Table #

Table Name

# of Columns

# of Rows

9

4

10

48

7

5

4

5

employeeEx

8

3

jobs

4

0

1

authorEx

2

authors

3

car

4

category

5
6

Table Alias

table alias

IBM Information Server
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Metadata Summary-Table Profile report
The Metadata Summary-Table Profile report provides a summary of all tables and
their metadata definitions within a selected set of data schemas. The report lists
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each column in a database and any alias names, as well as the cardinality and
properties, both defined and chosen, for the selected column.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables to include
Select the names of the tables you want to include in the report.
Include schema descriptions
Select this option to show a short description of the schemas.
Include table descriptions
Select this option to show a short description of the tables.
Include column descriptions
Select this option to show a short description of the columns.
Include terms
Select this option to include any terms associated with the databases or
tables included in the report. A term is a word that has a specific business
meaning.
Include policies
Select this option to include any policies associated with the databases or
tables included in the report.
Include contacts
Select this option to include any contacts associated with the databases or
tables. A contact contains personal information such as names, addresses,
and telephone numbers of users.
Include notes
Select this option to show any notes associated with the databases or
tables.

Content
The following defines the structure of the report:
Heading
Metadata Summary-Table Profile
Main Section
Host name
Data store name
Schema details
Schema name
Schema alias
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Schema definition
Table details
Table name
Table alias
Table definition
Number of columns
Number of rows

Sort order
The report output is displayed in alphabetical order by table name in ascending
order, and column name in ascending order.

Example of report output

Metadata Summary
Table Profile
Project :

pubs

Report Name :

Table Profile 2

Report Generated :

2008-07-02

Time Zone :

UTC +05:30

User :

admin admin

Comments :

my comment

Host Name :

pubshs

Data Store :

pubsds

10:56:59

Schema Details
Schema Name :

dbo

Schema Alias :

data schema alias

Schema Definition :

data schema short desc

Table Details
Table Name :

authorEx

Table Alias :
Table Definition :
# of Columns :

9

# of Rows :

4

Defined Primary Key(s)

Accepted Primary Key(s)

Defined Foreign Key(s)

Accepted Foreign Key(s)

au_id
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Primary key reports
After a column analysis job for single column primary keys completes or for
multiple column primary keys, you can create a report that shows a summary of
the defined primary keys and candidate primary keys in your data. Defined
primary keys are keys that were already defined in your data before you ran the
analysis. Candidate primary keys are keys that were inferred during analysis.
There are four types of primary key analysis reports:
Defined primary key summary report
Shows a summary of the defined primary keys in your data.
Defined primary key duplicate exceptions report
Shows a summary of the defined primary keys that have duplicates in
your data.
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Defined and candidate summary report
Shows a summary of the defined primary keys and candidate primary
keys in your data. Candidate primary keys are inferred during analysis.
Candidate primary key duplicate exceptions report
Shows a summary of the primary keys candidates that have duplicates in
your data.

Primary Key Analysis - Multi-Column Key Assessment
Summary
The Primary Key Analysis - Multi-Column Key Assessment Summary report
displays the multicolumn combinations and their results, such as their unique
value percentage and their duplicate value percentage, so you can determine their
suitability as a primary key in the table. This display replicates the online user
interface display of the primary key multicolumn analysis results.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the host computer that you selected. A data store is
a virtual entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables
Select the names of the tables you want to include in the report. Only
tables that have performed primary key multi-column analysis will have
data to be reported.
Percent uniqueness for inclusion
Define the minimum uniqueness percentage that a multicolumn
combination must have to be included in the report.
Include notes
Select this option to show any notes associated with the databases, tables,
or columns included in the report.

Content
The following defines the structure of the report:
Heading
Primary Key Analysis - Multi-Column Key Assessment Summary
Main Section
Host name
Data store name
Data store alias
Database name
Database alias
Table name
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Table alias
Table Summary
Number of rows
Number of columns
Defined primary key
Selected primary key
Column assessment summary
Number of columns for this specific column combination
Key columns for this column combination (up to seven maximum)
Percent unique
Percent duplicate
Primary key defined, candidate, selected mark
Sample method and sample size (if any)

Sort order
The report output is displayed in alphabetical order by table.
The column combinations are sorted by the percentage of their uniqueness, in
descending order and first column name in ascending order.

Example of report output
Primary Key Analysis
Multi Column Key Assessment Summary
Project :

EndToEndRFT001_DB2

Report Name :

Multi Column Key Assessment Summary

Report Generated :

2008-06-17 17:04:41

Time Zone :

UTC +05:30

User :

iauser iauser

Comments :
Host Name :

EndToEndRFThost1_DB2

Data Store :

EndToEndRFTds1_DB2

Data Store Alias :
Database Name :

ADMINISTRATOR

Database Alias :
Table Name :

ALLTYPESDB2

Table Alias :

Table Summary
Number of Rows

1,000

Number of Columns

14

Defined Primary Key
Selected Primary Key

PASSWORD_FIRSTNAME_LASTNAME

Column Assessment Summary
Number of
Columns
2
2

Key Columns
1

2

3

4

Unique
5

6

7

FIRSTNAM PASSWOR
E
D
FIRSTNAM
ID
E

IBM Information Server
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%

Duplicate

Primary Key

% Candidate Selected Defined

Sample
Size

Method

100.00%

.00%

1,000

Sequential

100.00%

.00%

1,000

Sequential
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Primary Key Analysis - Single Column Key Assessment
Summary
The Primary Key Analysis - Single Column Key Assessment Summary report
displays the individual column results, such as the unique value percentage and
duplicate value percentage, so you can assess their suitability as primary keys in
the table. This display replicates the online user interface display of the primary
key single column analysis results.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the host computer that you selected. A data store is
a virtual entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables
Select the names of the tables you want to include in the report.
Percent uniqueness for inclusion
The user defined minimum uniqueness percentage that an individual
column must have to be included in the report.
Include notes
Select this option to show any notes associated with the databases, tables,
or columns.

Content
The following defines the structure of the report:
Heading
Primary Key Analysis - Single Column Key Assessment Summary
Main Section
Host name
Data store name
Data store alias
Database name
Database alias
Table name
Table alias
Table Summary
Number of rows
Number of columns
Defined primary key
Selected primary key
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Column assessment summary
Column name
Column alias
Primary key: defined, candidate, and selected mark
Foreign key: defined and selected mark
Data class
Data type
Data length.
Unique percentage
Null percentage
Duplicate percentage

Sort order
The report output is displayed in alphabetical order by table.
The output is also sorted by the percent of uniqueness by column in descending
order.

Example of report output
Primary Key Analysis
Single Column Key Assessment Summary
Project :

pubs

Report Name :

Single Column Key Assessment Summary 1

Report Generated :

2008-06-03 16:12:46

Time Zone :

UTC +05:30

User :

admin admin

Comments :
Host Name :

pubshs

Data Store :

pubsds

Data Store Alias :
Database Name :

dbo

Database Alias :

schema alias

Table Name :

authors

Table Alias :

Table Summary
Number of Rows

48

Number of Columns

9

Defined Primary Key
Selected Primary Key

Column Assessment Summary
Column

Column Alias

Primary Key
Candidate Selected

Foreign Key
Defined

Selected

Data Class

Data Type

Length

Unique %

Null %

Duplicate %

Defined

au_fname

Text

String

11

4.17%

.00%

95.83%

au_id

Text

String

11

4.17%

.00%

95.83%

phone

Text

String

12

4.17%

.00%

95.83%

IBM Information Server
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Project summary reports
You can run project summary reports for an overview of the scope of a selected
project, including data sources and their analysis status, and users assigned to a
project.
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Analysis Publication report
The Analysis Publication report provides an overview of all tables published
within a selected data schema. The report identifies the last publication date and
publisher by table.

Parameters
Specify the parameters for the report:
Host

Select the host name that has the columns that you want to be included in
the report.

Data store
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Data schemas
Select the schemas on the host computer that you want included in the
report.
Tables to include
Select the names of the tables you want to include in the report.
Include schema definition
Select this option to show the schema definition in the report.
Include table alias
Select this option to show the alias name for a table.
Include notes
Select this option to show any notes associated with the database and
tables.

Content
The following defines the structure of the report:
Heading
Analysis Publication-Publication Summary
Main Section
Host name
Data store name
Schema details
Schema name
Schema alias
Schema definition
Database or file type
Owner name
Total number of rows
Total number of columns
Table details
Table name
Table alias
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Number of columns
Number of rows
Date of last column analysis
Date of last publication
System user ID of the publisher

Sort order
The report output is displayed in alphabetical order by table name in ascending
order.

Example of Report Output

Analysis Publication
Publication Summary
Project:

pubs

Report Name:

Publication Summary 1

Report Generated:

2008-06-03

Time Zone:

UTC +05:30

User:

admin admin

16:16:24

Comments:
Host Name:

pubshs

Data Store:

pubsds

Schema details
Schema Name:

dbo

Schema Alias:

schema alias

Schema definition:

schema short desc

DB/File Type:

Data Base

Owner:

dbo

Total # Tables:

9

Total # Columns:

64

Table details
Table Name

# of Columns

# of Rows

Last Column Analysis Date

authors

Table Alias

9

48

2008-05-26 04:22:53

--

car

7

5

2008-05-26 04:20:17

--

--

category

4

5

2008-05-26 04:22:35

--

--

8

3

2008-05-26 04:21:48

--

--

4

28

2008-05-26 04:22:15

--

--

6

12

2008-05-26 04:21:03

--

--

employeeEx
jobs

jobs alias

stores

Last Publication Date

Publisher

IBM Information Server
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Domain Quality Summary- Column Quality Assessment
Summary report
The Domain Quality Summary- Column Quality Assessment Summary report
provides a summary of the general quality of data that is in columns in your
projects, including the total number of records, the percent of records that are
complete or incomplete, the total number records with null or constant data, the
total bytes allocated, and the average number of bytes used.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the columns that you want
included in the report.
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Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details for the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Column Name
Select the columns that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the columns
included in the report.
Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Domain Quality Summary- Column Quality Assessment- Summary
Main Section
Chapter 17. Reports for information analysis
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Host Name
Data Store
Data Store Alias
Database Name
Database Alias
Table Name
Table Alias
Column Name
Quality Summary
Total Records count
Incomplete/Invalid Records
% of Complete/Valid Records
% of Incomplete/Invalid Records
Profile Summary
% Null
Total Null Bytes
% Constant
Total Constant Bytes
Total Bytes Allocated
Maximum Characters Used
Average Characters Used
Graphics Summary
Valid % vs Invalid %
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Example of Report Output

Domain Quality Summary
Column Quality Assessment – Summary
Project :

TestProject

Report Name :

Domain Column Quality Assessment - Summary

Report Generated:

2009-06-23

Time Zone:

UTC -04:00

User :

admin admin

13:59:35

Comments :
Host Name :

WB-HOST-APP

Data Store :

t40store

Data Store Alias :
Database Name :

DB2SRC

Database Alias :
Table Name :

ALLTYPESDB2

Table Alias :
Column Name :

QUANTITY

Quality Summary
Total Records count :

5

Incomplete/Invalid Records :
% of Complete/Valid Records :
% of Incomplete/Invalid Records :

0
100.0000%
.0000%

Profile Summary
% Null :

40.0000%

Total Null Bytes :

16

% Constant :

60.0000%

Total Constant Bytes :

24.00

Total Bytes Allocated :

40

Maximum Characters Used :

5

Average Characters Used :

3.00

Graphics Summary
Valid % vs Invalid %

100.0000%
.0000%
Total

100.0000%
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Domain Quality Summary- Table Quality Assessment
Summary report
The Domain Quality Summary- Table Quality Assessment Summary report shows
a summary of the general quality of data that is in the tables of your projects,
including the total number of records, percent records complete or incomplete,
total fields across all columns with null or ambiguous (mixed data type) data, and
the total record length allocated and inferred in bytes.
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Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the tables that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter data collection parameter
Select the columns that you want included in the report.
Display notes
Select this option if you want any notes associated with the tables included
in the report.
Show Custom Definitions
Select this option to include aliases and definitions that you created in the
report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.
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Content
The following defines the structure of the report:
Heading
Domain Quality Summary- Table Quality Assessment- Summary
Main Section
Quality Summary
Total Records count
Incomplete/Invalid Records
% of Complete/Valid Records
% of Incomplete/Invalid Records
Profile Summary
# Fields Profiled
# Null Fields
Total Null Bytes
% Allocated Bytes Null
# Ambiguous Fields
Total Bytes Allocated
Total Bytes Inferred
Graphics Summary
Valid % vs Invalid %
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Example of Report Output

Domain Quality Summary
Table Quality Assessment – Summary
Project :

TestProject

Report Name :

Domain Table Quality Assessment - Summary

Report Generated :

2009-06-23

Time Zone:

UTC -04:00

User :

admin admin

13:57:02

Comments :
Host Name :

WB-HOST-APP

Data Store :

t40store

Data Store Alias :
Database Name :

DB2SRC

Database Alias :
Table Name :

ALLTYPESDB2

Table Alias :

Quality Summary
Total Records count :

5

Incomplete/Invalid Records :

0

% of Complete/Valid Records :
% of Incomplete/Invalid Records :

100.0000%
.0000%

Profile Summary
# Fields Profiled :

13

# Null Fields :

19

Total Null Bytes :

200

% Allocated Bytes Null :

27.0270%

# Ambiguous Fields :

65

Total Bytes Allocated :

740

Total Bytes Inferred :

138

Graphics Summary
Valid % vs Invalid %

100.0000%
.0000%
Total

100.0000%
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Project Status- Project Status by Notes Type
The Project Status by Notes Type report summarizes the notes for a given project
and selected tables. The report identifies total columns, total columns not
annotated, a breakdown of notes by note type, and a summary of notes.
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Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the metrics that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter Data Collection Parameter
Select the columns that you want included in the report.
Comments
Enter any comments you want included in the report output.
Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Project Summary by Notes Status
Project Level Summary
Project Name
# of Columns Total
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Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
Host Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
DataStore Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
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# Annotations: Average Notes per annotated column
Data Schema Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
Table Level Detail Statistics
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
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Example of Report Output

Project Status
Project Summary by Notes Status
Project:

FredTest

Report Name:

Project Summary by Notes Status

Report Generated:

2009-06-26

Time Zone:

UTC -04:00

User:

admin admin

14:32:47

Comments:

Project level Summary
#Columns
Project
FredTest

Open

Pending

Other

Closed

#Annotations

Total

Not Annotated

#

%

#

%

#

%

#

%

Total

183

183

0

0

0

0

0

0

0

0

0

Total

Not Annotated

#

%

#

%

#

%

#

%

Total

183

183

0

0

0

0

0

0

0

0

0

Total

Not Annotated

#

%

#

%

#

%

#

%

Total

127

127

0

0

0

0

0

0

0

0

0

Average Notes per
annotated column
0

Host Level Summary
#Columns
Host
WB-HOST-APP

Open

Pending

Other

Closed

#Annotations
Average Notes per
annotated column
0

DataStore Level Summary
#Columns
Data Store
Chemco

Open

Pending

Other

Closed

#Annotations
Average Notes per
annotated column
0

Data Schema Level Summary
#Columns

Open

Pending

Other

Closed

#Annotations
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Project Status- Project Summary by Notes Status
The Project Status by Notes Status report summarizes the notes for a given project
and selected tables. The report identifies total columns, total columns not
annotated, a breakdown of notes by Note Status, and a summary of notes.

Parameters
Specify the parameters for the report:
Project Name
Select the name of the project that contains the project that you want
included in the report.
Host Name
Select the host name that has the columns that you want to be included in
the report.
Data Store Name
Select the data store on the selected host computer. A data store is a virtual
entity that has connection details to the source repository.
Database Name
Select the name of the database that you want to include in the report.
Table Name
Select the tables that you want included in the report.
Enter Data Collection Parameter
Select the columns that you want included in the report.
Comments
Enter any comments you want included in the report output.
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Locale specification [Language,Territory]
Select the language and demographic region for the data included in the
report.
Output format
Specify the format that you want for your report. You can select HTML,
XML, RTF, PDF, or TXT.
Expiration
Specify when you want your report to expire.
History policy
Specify whether you want your report data to replace older versions each
time it is run, or if you want to archive each individual report you run.
Report name
Specify a name for the report.
Save report
Select this option if you want to save this report so you can run it again in
the future. If you want to save your report, then you must select the folder
in which you want to save the report. You have the option of adding the
report to your favorites folder, and of viewing the report after the
processing finishes.

Content
The following defines the structure of the report:
Heading
Project Summary by Notes Status
Project Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
Host Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
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% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
Data Store Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
Data Schema Level Summary
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column
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Table Level Detail Statistics
Project Name
# of Columns Total
Not Annotated Columns
# Open
% Open
# Pending
% Pending
# Other
% Other
# Closed
% Closed
# Annotations: Total
# Annotations: Average Notes per annotated column

Example of Report Output

Project Status
Project Summary by Notes Status
Project:

FredTest

Report Name:

Project Summary by Notes Status

Report Generated:

2009-06-26

Time Zone:

UTC -04:00

User:

admin admin

14:32:47

Comments:

Project level Summary
#Columns
Project
FredTest

Open

Pending

Other

Closed

#Annotations

Total

Not Annotated

#

%

#

%

#

%

#

%

Total

183

183

0

0

0

0

0

0

0

0

0

Total

Not Annotated

#

%

#

%

#

%

#

%

Total

183

183

0

0

0

0

0

0

0

0

0

Total

Not Annotated

#

%

#

%

#

%

#

%

Total

127

127

0

0

0

0

0

0

0

0

0

Average Notes per
annotated column
0

Host Level Summary
#Columns
Host
WB-HOST-APP

Open

Pending

Other

Closed

#Annotations
Average Notes per
annotated column
0

DataStore Level Summary
#Columns
Data Store
Chemco

Open

Pending

Other

Closed

#Annotations
Average Notes per
annotated column
0

Data Schema Level Summary
#Columns

Open

Pending

Other

IBM Information Server
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Project Summary report
The Project Summary report provides an overview of the scope of the selected
project, including data sources and their analysis status, and users assigned to the
project.

Parameters
Specify the parameters for the report:
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Select project
Select the projects that you want to run a report on.

Content
The following defines the structure of the report:
Heading
Project Summary - Project Summary Report
Main Section
Project name
Project description
Project owner
Primary contact
Data Source Summary
Host name
Data store name
Schema details
Data schema name
Number of tables
Number of tables analyzed
Percent of tables analyzed
Number of columns
Number of columns analyzed
Percent of columns analyzed
User Summary
User name
User role
Group Summary
Group name
Group role
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Example of report output

Project Summary
Project Summary Report
Project :

pubs

Report Name :

Project Summary

Report Generated :

2008-06-17

Time Zone:

UTC +05:30

User:

admin admin

14:42:26

Comments:
Project Name:

pubs

Project Description:

pubs

Project Owner:
Primary Contact:

Data Source Summary
Host Name:

pubshs

Data Store:

pubsds

Schema details
Data Schema:

dbo

# of Tables:

9

# of Tables Analyzed:

0

% of Tables Analyzed:

.00

# of Columns:

64

# of Columns Analyzed:

38

% of Columns Analyzed:

59.38

User Summary
User

Role

admin
SorcererBusinessAnalyst
SorcererOperator

Group Summary
Group

Role

analyzer group
SorcererBusinessAnalyst
SorcererOperator

IBM Information Server
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Chapter 18. Frequently asked questions about IBM InfoSphere
Information Analyzer
IBM InfoSphere Information Analyzer evaluates the content and structure of your
data for consistency and quality. The following topics contain answers to the
frequently asked questions about installing, configuring, and running InfoSphere
Information Analyzer.

Installing and configuring InfoSphere Information Analyzer
Find the answers to frequently asked questions about the following installation
and configuration tasks:
Installing
Configuring
Uninstalling

Running InfoSphere Information Analyzer
Find the answers to frequently asked questions about the following information
analysis tasks:
“Running IBM InfoSphere Information Analyzer” on page 441
Configuring resources
Importing metadata
Specifying analysis settings
Analyzing columns
Publishing analysis results
Analyzing tables
Analyzing across tables
Managing metadata
Working with notes
Reporting

© Copyright IBM Corp. 2006, 2012

435

Frequently asked questions about installing InfoSphere Information
Analyzer
Find the answers to frequently asked questions about installing IBM InfoSphere
Information Analyzer such as how to correct an error about insufficient space and
how to access the log files.
“Where are the installation log files?”
“What should I name the IBM InfoSphere DataStage project during installation?”
“After installation, why am I unable to log into the IBM InfoSphere DataStage
Director client?”

Where are the installation log files?
The installation log files are in the following directories:
v <install_drive>\IBM\InformationServer\logs
v %TEMP%\ibm_is_logs

What should I name the IBM InfoSphere DataStage project during
installation?
During installation, you can accept the default project name or provide a project
name that contains standard characters. However, you cannot name the project
ANALYZERPROJECT.

After installation, why am I unable to log into the IBM InfoSphere
DataStage Director client?
InfoSphere DataStage requires that the user who is logging in be a valid operating
system user. You must configure the credential mappings between the login user
and the valid operating system user. For more information, refer to Mapping user
credential.

Frequently asked questions about configuring IBM InfoSphere
Information Analyzer
Find the answers to frequently asked questions about configuring IBM InfoSphere
Information Analyzer such as which manual steps you must complete after
installation and how to set up an ODBC DSN.
“How do I start InfoSphere Information Server on a UNIX or Linux platform?” on
page 437
“The installer finished. Do I need to perform any manual steps to complete the
installation?” on page 437
“How do I set up an ODBC DSN on UNIX or Linux?” on page 437
“How do I start or restart the ASBAgent?” on page 438
“How do I see if DB2 is running? ” on page 439
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“How do I stop or start DB2 on UNIX or Linux?” on page 439
“How do I change the locale of a UNIX or Linux server?” on page 439
“If the IBM InfoSphere DataStage server is installed on the same machine as that of
the InfoSphere Information Server, how do I test the DSN that was created on the
UNIX or Linux server?” on page 439

How do I start InfoSphere Information Server on a UNIX or Linux
platform?
Enter the following commands to start InfoSphere Information Server on UNIX or
Linux:
/opt/IBM/Websphere/AppServer/profiles/default/bin/startServer.sh
server1 –username<user> -password<password>
/opt/IBM/InformationServer/ASBNode/bin/NodeAgents.sh start

The installer finished. Do I need to perform any manual steps to
complete the installation?
Yes. You must perform the following steps to complete the installation. Refer to the
related tasks for more information about each step.
1. Add a DSN for the information analysis database.
2. In the InfoSphere Information Server client, configure the analysis settings.

How do I set up an ODBC DSN on UNIX or Linux?
To set up an ODBC DSN on UNIX or Linux, edit the following file:
/opt/IBM/InformationServer/Server/DSEngine/.odbc.ini. The first section of the
file lists the defined DSNs. The second part contains the details of each connection.
To add a DSN, you must modify each section.
1. Open the odbc.ini file.
2. Copy one of the templates in the details section. Select the template that uses
the driver that you want to use so that it is easy to edit.
3. Copy and paste the template in the file.
4. Change the name of the DSN. The name should be the first line and between
square brackets.
5. Fill in the lines that do not have values such as LogonID and password.
6. Add a line in the first section. Use the name of the DSN=<description>.
The following code is an example of an odbc.ini file:
[ODBC Data Sources]
IADBDB2=DataDirect DB2 Wire Protocol Driver
IADBOracle =DataDirect Oracle Wire Protocol Driver
IADBSQLServer =DataDirect SQL Server Wire Protocol Driver
[IADBDB2]
Driver=/opt/IBM/InformationServer/Server/branded_odbc/lib/VMdb222.so
Description=DataDirect DB2 Wire Protocol Driver
AddStringToCreateTable=
AlternateID=
Database=IADB
DynamicSections=100
GrantAuthid=PUBLIC
GrantExecute=1
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IpAddress=db2hostname
IsolationLevel=CURSOR_STABILITY
LogonID=uid
Password=pwd
Package=DB2 package name
PackageOwner=
TcpPort=50000
WithHold=1
[IADBOracle]
Driver=/opt/IBM/InformationServer/Server/branded_odbc/lib/VMora22.so
Description=DataDirect Oracle Wire Protocol driver
ApplicationUsingThreads=1
ArraySize=60000
CachedCursorLimit=32
CachedDescLimit=0
CatalogIncludesSynonyms=1
CatalogOptions=0
DefaultLongDataBuffLen=1024
DescribeAtPrepare=0
EnableDescribeParam=0
EnableNcharSupport=1
EnableScrollableCursors=1
EnableStaticCursorsForLongData=0
EnableTimestampWithTimeZone=1
HostName=Oracle server
LocalTimeZoneOffset=
LockTimeOut=-1
LogonID=
Password=
PortNumber=Oracle server port
ProcedureRetResults=0
SID=OracleSID
UseCurrentSchema=1
[IADBSQLServer]
Driver=/opt/IBM/InformationServer/Server/branded_odbc/lib/VMmsss22.so
Description=DataDirect SQL Server Wire Protocol driver
Database=iadb
LogonID=uid
Password=pwd
Address= sqlserverhost,1433
QuotedId=No
AnsiNPW=No
[ODBC]
IANAAppCodePage=4
InstallDir=/opt/IBM/InformationServer/Server/branded_odbc
Trace=0
TraceDll=/opt/IBM/InformationServer/Server/branded_odbc/lib/odbctrac.so
TraceFile=odbctrace.out
UseCursorLib=0

How do I start or restart the ASBAgent?
Log in to the computer with a privileged account.
In Microsoft Windows, enter the following commands: net start asbagent or net
stop asbagent.
In UNIX or Linux, enter the following commands: /opt/IBM/InformationServer/
ASBNode/bin/NodeAgents start or /opt/IBM/InformationServer/ASBNode/bin/
NodeAgents stop.
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How do I see if DB2 is running?
In Windows, enter the command db2cmd to open the DB2 command window and
then type db2 connect to xmeta.
In UNIX, enter the following command: db2 connect to xmeta.

How do I stop or start DB2 on UNIX or Linux?
In UNIX or Linux, log in as the db2inst1 user and enter the following commands:
v To stop DB2, use - db2 terminate.
v To start DB2, use - db2start .

How do I change the locale of a UNIX or Linux server?
You can edit the /etc/sysconfig/i18n file to change the locale. For example, to set
the server to the French locale, you modify the following lines:
LANG="french"
SYSFONT="latarcyrheb-sun16"
SUPPORTED="en_US.UTF-8:en_US:en"

If the IBM InfoSphere DataStage server is installed on the same
machine as that of the InfoSphere Information Server, how do I
test the DSN that was created on the UNIX or Linux server?
To test the DSN:
#cd $DSHOME
#. ./dsenv
#cd ../IBM/InformationServer/Server
#cd branded_odbc/examples
#. /examples
enter the datasource name : <name of the DSN in the odbc.ini file>
enter the username : <username of the DSN>
enter the password : <DSN password>

Frequently asked questions about uninstalling IBM InfoSphere
Information Server
Find the answers to frequently asked questions about uninstalling IBM InfoSphere
Information Server, such as how to proceed if uninstallation fails.
“How do I uninstall InfoSphere Information Server?”
“Uninstallation failed. What should I do now?” on page 440

How do I uninstall InfoSphere Information Server?
On Microsoft Windows, select Control Panel > Add or Remove Programs > IBM
Information Server.
On UNIX or Linux, run the following command: pt/IBM/InformationServer/
_uninstall/suite/uninstall.
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Uninstallation failed. What should I do now?
Your uninstallation might have failed because there are files and information from
a previous installation still on your computer. Complete the following steps before
trying to uninstall again.
1. From a command prompt, enter the following commands to stop and remove
the specified services:
net
net
net
net
net
sc
sc
sc
sc
sc

stop
stop
stop
stop
stop
delete
delete
delete
delete
delete

asbagent
loggingagent
DSEngine
dsrpc
dstelnet
asbagent
loggingagent
DSEngine
dsrpc
dstelnet

2. Run regedit and remove the following registry keys:
HKEY_LOCAL_MACHINE\SOFTWARE\Ascential Software
HKEY_CURRENT_USER\SOFTWARE\Ascential Software

3. From the Control Panel > Add or Remove Programs window, uninstall the
following programs:
v IBM WebSphere Application Server
v IBM InfoSphere Federation Server Relational Wrappers
v IBM InfoSphere Federation Server Non-Relational Wrappers
v DB2
v MKS Toolkit
4. Delete the following directories to clean up any remaining files:
v The InfoSphere Information Server installation directory. By default, this
directory is in C:\IBM\InformationServer.
v The IBM WebSphere Application Server installation directory. By default, this
directory is in C:\IBM\WebSphere\AppServer.
v The installer temporary log files. By default, these files are in
%TEMP%\ibm_is_logs.
v The start menu shortcuts. By default, these shortcuts are in C:\Documents
and Settings\All Users\Start Menu\Programs\IBM Information Server.
v If you created desktop shortcuts, delete them from the following locations:
– C:\Documents and Settings\All Users\Desktop\Administrator Client.lnk
– C:\Documents and Settings\All Users\Desktop\Designer Client.lnk
– C:\Documents and Settings\All Users\Desktop\Director Client.lnk
– C:\Documents and Settings\All Users\Desktop\Console for IBM
Information Server.lnk
– C:\Documents and Settings\All Users\Desktop\Web Console for IBM
Information Server.lnk
5. Delete the following directory to remove the InstallShield registry: C:\Program
Files\Common Files\InstallShield\Universal\IBM\InformationServer.
6. Restart your system. Windows might not be able to remove some files and
services until the system is restarted. If you try to install before restarting, some
newly installed files and services might be removed when the system is later
restarted.
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Running IBM InfoSphere Information Analyzer
Find the answers to frequently asked general questions about running IBM
InfoSphere Information Analyzer.
“Where is the client cache folder located?”
“When I change the locale (region settings) of my computer and start the client,
the login page crashes. What should I do?”
“How can I restore the default grid customization, such as the columns to show,
order of columns, and column width, in InfoSphere Information Analyzer?”
“How can I access the log files in the Microsoft Windows directory? ”
“How can I access the log files from the IBM InfoSphere Information Server
console?” on page 442
“How can I troubleshoot the following error: aborted. verify of the px job RT_SC6
is needednull?” on page 442

Where is the client cache folder located?
On Microsoft Windows, the client cache folder is in the following directory:
C:\Documents and Settings\<username>\Local Settings\Application
Data\IBM\IBM Information Server console.

When I change the locale (region settings) of my computer and
start the client, the login page crashes. What should I do?
Delete the client cache and restart the client.

How can I restore the default grid customization, such as the
columns to show, order of columns, and column width, in
InfoSphere Information Analyzer?
Delete the client cache and restart the client.

How can I access the log files in the Microsoft Windows
directory?
The log files are in the following directories:
v IBM/Websphere/Application Server/profiles/default/iasServer.log
v IBM/Websphere/Application Server/profiles/default/iasHandler.log
v IBM/Websphere/Application Server/profiles/default/logs/server1/
SystemOut.log
v IBM/Websphere/Application Server/profiles/default/logs/server1/
SystemErr.log
The client log files are in the following directory: C:\Documents and
Settings\<username>\Local Settings\Application Data\IBM\IBM Information
Server console\isc.log.
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How can I access the log files from the IBM InfoSphere
Information Server console?
To access log files, refer to Creating a view of logged events.

How can I troubleshoot the following error: aborted. verify of the
px job RT_SC6 is needednull?
Frequently, this error message means that the InfoSphere Information Analyzer
database DSN on the engine is not configured correctly. You define the IADB DSN
in the Analysis Settings workspace of the IBM InfoSphere Information Server
console. The DSN information is stored in the Metadata Server. When a job runs,
the information is passed to the PX Engine. If the engine is on a remote computer,
the DSN must be defined on that computer as well.

Frequently asked questions about configuring resources
Find the answers to frequently asked questions about resource configuration, such
as how to save host changes, what the available data store types are, and how to
delete a host.
“After I enter the host information in the New Host pane, can I click Add in the
Data Store pane to save my host changes?”
“Which data store types can I use to create a data store?”
“If I delete a host, are all of the data stores that are associated with it also
deleted?”

After I enter the host information in the New Host pane, can I
click Add in the Data Store pane to save my host changes?
Yes, if you click Add the system saves the host and then shows the New Data
Store pane.

Which data store types can I use to create a data store?
The 8.0.1 release provides two data store types: database and data file. When you
create a new data store, the system automatically suggests a data store type. You
can change the suggested data store type before saving. However, after you save
the data store, you cannot change the data store type.

If I delete a host, are all of the data stores that are associated
with it also deleted?
Yes.

Frequently asked questions about importing metadata
Find the answers to frequently asked questions about importing metadata, such as
why some tasks are not available in the workspace.
“Why can't I identify data schemas that start with SYS in DB2?” on page 443
“Why is the Identify All Levels task not available for some items selected in the
object list?” on page 443
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“Why is the Import task not available for some items selected in the object list?”
“Why is the View task not available for some items in the object list?”
“Why are the tasks not available when the host is collapsed in the object list?”
“I selected a data store and clicked Identify Next Level. Why are the columns in
the table not identified?” on page 444
“Why does the object list show the total number of tables in a schema after I
canceled the operation while it was running? ” on page 444
“Why isn't it possible to change the data store type from database to data file?” on
page 444
“Why is a confirmation window displayed when I choose to import metadata?” on
page 444
“Should I identify just the next level or identify all levels?” on page 444
“After metadata has been imported, how to I start to profile data?” on page 444

Why can't I identify data schemas that start with SYS in DB2?
IBM InfoSphere Information Analyzer filters out schemas that start with SYS.

Why is the Identify All Levels task not available for some items
selected in the object list?
The Identify All Levels task is enabled only for the data store items. If the selected
items are not data store items, the task is not available.

Why is the Import task not available for some items selected in
the object list?
The Import task is available after the item has been identified up to the column
level to ensure that you are importing the latest data source to the repository. If
you select a table, the Import task will be enabled only after a column has been
found in that table.

Why is the View task not available for some items in the object
list?
The View task is enabled after the selected item has been identified up to the table
level. If you select a table and have identified a column in that table, you can view
the metadata of that column. If you select a schema, the View task shows only the
table names in the view.

Why are the tasks not available when the host is collapsed in the
object list?
You can perform tasks only on the objects that are contained by the host, such as
the data stores, tables, and columns. No tasks are available for the host.
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I selected a data store and clicked Identify Next Level. Why are
the columns in the table not identified?
If you select Identify Next Level at the data store level for a database, the system
identifies only the schemas that are contained by that database, not the columns.

Why does the object list show the total number of tables in a
schema after I canceled the operation while it was running?
This is the intended behavior. The system will state the number of tables in the
schema even if you cancel the process.

Why isn't it possible to change the data store type from
database to data file?
If you specify a DB2 connection, the system automatically suggests that the data
store type is database. The system treats data files differently from databases. If
you change the data store type from the system-suggested database to data file, the
import metadata task skips the schema discovery step.

Why is a confirmation window displayed when I choose to
import metadata?
Importing a large set of metadata can be a very time-consuming process. The
system confirms that you want to import metadata for the set of objects that you
have selected.

Should I identify just the next level or identify all levels?
You might want to select the Identify Next Level task. This task lets you
selectively identify the contained data schemas and tables in the data store. If you
select Identify All Levels on a data store with a large data set, the process can
take a long time to complete.

After metadata has been imported, how to I start to profile data?
InfoSphere Information Analyzer uses the concept of projects to complete profiling.
You must create a project and add the data sources to the project. Refer to the
related topics for more information.

Frequently asked questions about specifying analysis settings
Find the answers to frequently asked questions about analysis settings.
“Why is the Analysis Settings menu not available?”
“If I click Save All without clicking Validate Settings, will the system validate the
information that I entered?” on page 445
“Are any modifications in the system-level settings reflected in the current
project-level settings?” on page 446

Why is the Analysis Settings menu not available?
If the Analysis Settings menu, shown in the following figure, is not active, ensure
that the user logged in with the correct permissions.
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To give the user the correct permissions:
1. Log in to the InfoSphere Information Server console with administrator
privileges.
2. Select Home > Configuration > User.
3. Select the user that you want to assign permission to and click Assign Roles.
4. In the Suite list of the Roles pane, select either Suite Administrator or Suite
User.
5. In the Suite Component list of the Roles pane, select the following roles:
v DataStage and QualityStage Administrator
v DataStage and QualityStage User
v Information Analyzer Data Administrator
v Information Analyzer Project Administrator
v Information Analyzer User
6. Click Save.
7. Exit the console and tell the user to log in again with the updated username.

If I click Save All without clicking Validate Settings, will the
system validate the information that I entered?
Most of the settings are validated when you click Save All. In the 8.0.1 release, the
analysis ODBC DSN is not validated by the system. You must enter a valid DSN
name (that connects to the same database as in the Database Name field). You
should manually verify this DSN connection by using the user name and password
credentials specified by the corresponding fields.
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Are any modifications in the system-level settings reflected in
the current project-level settings?
No. The current project settings remain the same. Only new projects are affected.

Frequently asked questions about analyzing columns
Find the answers to frequently asked questions about analyzing columns, such as
how to troubleshoot a column analysis job failure.
“I ran a column analysis job that failed. What should I check? And where can I get
more information about what went wrong?”
“After starting a column analysis job, why don't I see the job in the Director client
job view?” on page 448
“What special settings are required to profile Microsoft Excel or Microsoft Access
sources? ” on page 448
“Why does a data value in the frequency distribution have a value of 0 in its
frequency count and frequency percentage?” on page 448
“Why are the inferred properties of some columns empty?” on page 448

I ran a column analysis job that failed. What should I check? And
where can I get more information about what went wrong?
Make sure that the IBM InfoSphere Information Analyzer database DSN was set up
correctly. Check that a DSN exists and verify that it is uses the Data Direct ODBC
driver. Also ensure that the connection settings are valid. Finally, verify that the
Analysis ODBC DSN in the Analysis Settings workspace refers to this DSN.
To
1.
2.
3.
4.

find more information:
In the IBM InfoSphere Information Server console, select Operator > Log View.
Select New Log View to create a log view.
View the log for iasHandler information.
If that log view does not contain relevant information, look at the following log
file: IBM/Websphere/Application Server/profiles/default/iasHandler.log.

If you installed IBM InfoSphere DataStage, you can open the IBM InfoSphere
DataStage Director client to view additional information about the job. To view
information in the Director client, select the Retain Script option before you run
your analysis job.
1. Start the Director client, connect to the analysis server, and supply the correct
credentials.
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2. Select a project from the list.
The Director client shows one or more jobs. The most common jobs are
BaseProfile and BaseProfileLoad#, which run column analysis jobs.
3. View the status of the job and locate the one with the status of aborted. Select
that job and click Log.
4. A list of log messages is displayed. Scroll through the list and look for the first
Fatal value in the Status column. Select that message. This error is most likely
the error that stopped the analysis job from running.

5. You can save the entire log to a file by selecting Project > Print, and then select
the Print to File option.
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After starting a column analysis job, why don't I see the job in
the Director client job view?
The ASBAgent service on the server is not running. Try to restart the ASBAgent
and submit the column analysis job again.

What special settings are required to profile Microsoft Excel or
Microsoft Access sources?
Microsoft Excel and Microsoft Access do not support concurrent access. Before you
run an analysis on an Excel or an Access source, ensure that no other application is
opening that source file.
When you profile the Excel or Access source, modify the following options in the
Investigate > Column Analysis > Run Column Analysis pane:
Array Size
The default is 2000. Change to 1.
Auto Commit
The default is No. Change to Yes.

Why does a data value in the frequency distribution have a value
of 0 in its frequency count and frequency percentage?
There are two possibilities for why the value is 0. First, the data value might have
been manually entered as an addition to the frequency distribution. You can
confirm this by viewing the Frequency Distribution tab in the column analysis
results summary. If the data value was manually entered, the source of the data
value in the table will be Manual.
The second reason that a data value might have a frequency count and frequency
percentage of 0 is that the frequency distribution of the column has been updated.
Any data value from the original frequency distribution that is no longer included
in the data source will still be retained in the updated frequency distribution with
a frequency count and percentage of 0. You can confirm this by viewing the
Frequency Distribution tab in the column analysis results summary. The source of
the data value will be Data.

Why are the inferred properties of some columns empty?
If column analysis has not been performed for the column in question, only the
defined properties for that column are shown.

Frequently asked questions about publishing analysis results
Find the answers to frequently asked questions about publishing analysis results,
such as why an option is unavailable or how items are represented in the
publication view.
“Why is the include notes option not available?” on page 449
“How are defined, inferred, or selected primary keys and foreign keys represented
in the View Analysis Results Summary pane?” on page 449
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Why is the task list not available in the Publish Analysis Results
workspace?
The task list will be enabled after you select a table that has a column analysis
review status of review completed. If no table has the review completed status,
you must first run column analysis on the table, set the baseline analysis, and then
publish the analysis results.

Why is the include notes option not available?
In the Publish Analysis Results window, the Include Notes option might not be
available if no notes exist for that table or column. You must add notes to the
selected table and its corresponding columns.

How are defined, inferred, or selected primary keys and foreign
keys represented in the View Analysis Results Summary pane?
Selected primary keys or foreign keys are only those that are identified as such
during the primary key analysis or the foreign key analysis. If you did not select a
key, the inferred primary key or foreign key is displayed. If you did not select a
key or run analysis to infer a key, the defined key is displayed.

Frequently asked questions about analyzing tables
Find the answers to frequently asked questions about analyzing tables, such as
what the difference is between analysis statistics and full volume duplicate check
data.
“What is the difference between analysis statistics data and a full volume duplicate
check of data?”
“I clicked Remove All MCPK. Why did it not remove all of the records that are
shown in the multi-column analysis results view?” on page 450
“How does changing the column sequence in run duplicate analysis affect the
duplicate check analysis results?” on page 450
“I am exporting a reference table in the Table Management workspace. What is the
fixed width file option?” on page 450

What is the difference between analysis statistics data and a full
volume duplicate check of data?
Analysis statistics data is based on the analysis set that you selected. The data can
be based on either a data sample or the full table. A full volume duplicate check is
always based on the full table.
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I clicked Remove All MCPK. Why did it not remove all of the
records that are shown in the multi-column analysis results
view?
The Remove All MCPK button removes only multi-column combinations that are
created through multi-column column analysis. Any combinations that are created
outside of multi-column primary key analysis, such as a virtual column or a
defined composite primary key, are not removed.

How does changing the column sequence in run duplicate
analysis affect the duplicate check analysis results?
Changing the order of the columns in the column sequence object list has no effect
on the duplicate check results.

I am exporting a reference table in the Table Management
workspace. What is the fixed width file option?
When the reference table is exported, the width between two column values in the
exported file is determined by the display length of the column. Because the width
is already defined, it is called fixed width. You can view the reference table
metadata by selecting the View Metadata task from the Tasks pane.

Frequently asked questions about analyzing across tables
Find answers to frequently asked questions about analyzing across tables, such as
how the system differentiates between compatible pairs and incompatible pairs
and whether column analysis is a prerequisite for foreign key analysis.
“How does the system differentiate between compatible pairs and incompatible
pairs?” on page 451
“If I do not perform a base profile on some of the columns in a table, can those
columns be analyzed in a foreign key analysis job containing that table?” on page
451
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“Is it possible to select which pairs are used in a foreign key analysis job or a
cross-domain analysis job?”
“In the View Cross-Domain Analysis pane, where does the value in the Flag
Percentage Above field come from?”
“If I enter a new value in the Flag Percentage Above field, will the value be saved
and displayed when I open the pane again?”
“In the Cross-Domain Analysis pane, what do the different bars in the Column
Analysis column represent?”
“To run a cross-domain analysis job, do any or all of the selected tables need to
have a primary key?” on page 452
“What do the flags indicate on the cross-domain analysis detail pane? What if
some rows do not contain a flag?” on page 452

How does the system differentiate between compatible pairs and
incompatible pairs?
If the data type, length, and other properties of two columns in a pair are the
same, the system concludes that the pair is compatible.

If I do not perform a base profile on some of the columns in a
table, can those columns be analyzed in a foreign key analysis
job containing that table?
No. Only columns that have been profiled in a column analysis job can be used in
a foreign key analysis job.

Is it possible to select which pairs are used in a foreign key
analysis job or a cross-domain analysis job?
No, all the possible pairs in the object list will be analyzed.

In the View Cross-Domain Analysis pane, where does the value
in the Flag Percentage Above field come from?
The value is set in the project-level analysis settings. To modify this value in the
console, select Overview > Project Properties > Analysis Settings. The
project-level settings are used for this field.

If I enter a new value in the Flag Percentage Above field, will the
value be saved and displayed when I open the pane again?
No. You must change the setting in the Project Properties pane for it to persist.
Clicking Apply only updates the object list.

In the Cross-Domain Analysis pane, what do the different bars in
the Column Analysis column represent?
The bars represent the column analysis status, which can be in the following states:
v An empty bar means that column analysis has not been performed on any of the
columns in the table.
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v A solid bar means that column analysis has been performed on all of the
columns in the table.
v A half-filled bar means that column analysis has been performed on some of the
columns in the table.

To run a cross-domain analysis job, do any or all of the selected
tables need to have a primary key?
No, the only prerequisite is that you ran a column analysis job on the selected
columns in the tables.

What do the flags indicate on the cross-domain analysis detail
pane? What if some rows do not contain a flag?
A flag indicates that a value is unique. The value is either present in the base
column or in the paired column. A row without a flag means that the particular
value can be found in both columns.

Frequently asked questions about managing metadata
Find the answers to frequently asked questions about managing metadata, such as
why some tasks are not available in the workspace.
“Why does deleting terms, policies, and contacts take longer than normal when
they are associated with other objects like data stores, tables, files, or columns?”
“Why is the Open Details task not available for collapsed items in the object list?”
“Why are the New and Delete tasks not available for a data store, table, file, or
column?”
“Why is there no delete confirmation when I remove terms, policies, and contacts
from data stores, tables, files, or columns?” on page 453

Why does deleting terms, policies, and contacts take longer than
normal when they are associated with other objects like data
stores, tables, files, or columns?
The system must remove the associations in addition to deleting the term, policy,
or contact. The removal of the association requires additional time.

Why is the Open Details task not available for collapsed items in
the object list?
This is the intended behavior. To open the details of an object, expand the items
and select one.

Why are the New and Delete tasks not available for a data store,
table, file, or column?
The addition and deletion of these objects is handled outside of the Managing
Metadata workspace. In the Managing Metadata workspace you can associate
objects and labels with the data stores, tables, files, or columns.
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Why is there no delete confirmation when I remove terms,
policies, and contacts from data stores, tables, files, or
columns?
The system does not delete any of the terms, policies, or contacts. It only removes
the association of that term, policy, or contact from the data store, table, file, or
column.

Frequently asked questions about working with notes
Find the answers to frequently asked questions about working with notes, such as
how to create notes for tables and columns.
“Why is the Include Notes option not available ?”
“How do I create a note for a table?”
“How do I a create note for a column?”

Why is the Include Notes option not available ?
In the Publish Analysis Results window, the Include Notes option might not be
available if no notes exist for that table or column. You must add notes to the
selected table and its corresponding columns.

How do I create a note for a table?
To create a note for a table:
1. In the IBM InfoSphere Information Server console, select Home > Metadata
Management > Tables or files.
2. Select the table that you want to add notes to and click Open.
3. Click the Notes icon (

) to open the Notes palette and create the note.

How do I a create note for a column?
To create a note for a column:
1. In the Column Analysis workspace, select a column.
2. Click Open Column Analysis.
3. Click the Notes icon (

) to open the Notes palette and create the note.

Frequently asked questions about reporting
Find the answers to frequently asked questions about reporting, such as which
reports show notes and what the report options are.
“Which reports show notes?” on page 454
“Why are there partially blank pages in my report?” on page 454
“Why is the date or time shown in my report different from the time on my
computer?” on page 454
“How can I include aliases in the report?” on page 454
Chapter 18. Frequently asked questions about InfoSphere Information Analyzer

453

“What is the purpose of the Indicator Exclusions parameter in the Domain
Analysis details report and the Domain Value Profile report?”
“Why are the duplicate values, total rows, uniqueness values, and distinct values
in my primary key reports empty even though the rest of the data is displayed?”
“For some reports, why can't I select the columns in the select sources screen?”

Which reports show notes?
All IBM InfoSphere Information Analyzer reports show notes. Additionally, the
Notes Summary report in the Column Summary section shows only notes.

Why are there partially blank pages in my report?
Blank pages can occur in reports with charts because a chart cannot be split across
pages. The chart might be moved to the next page, which leaves a blank space in
the previous page.

Why is the date or time shown in my report different from the
time on my computer?
The data and time fields show the server time at the moment that the report was
run.

How can I include aliases in the report?
Select the Show Custom Definitions option in the Specify Report Parameters
pane.

What is the purpose of the Indicator Exclusions parameter in the
Domain Analysis details report and the Domain Value Profile
report?
The parameter specifies that the selected domain indicator type should be excluded
from the report.

Why are the duplicate values, total rows, uniqueness values, and
distinct values in my primary key reports empty even though the
rest of the data is displayed?
To include those values in the primary key reports, select View Duplicate Check
in the Primary Key Analysis pane before you run the report.

For some reports, why can't I select the columns in the select
sources screen?
For table level reports, you cannot select columns. The reports run on all the
columns in the table. The following reports are table-level reports: Column
Inferred, Cross Table Domain Analysis, Foreign Key Analysis, and Table Primary
Key Analysis.
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Contacting IBM
You can contact IBM for customer support, software services, product information,
and general information. You also can provide feedback to IBM about products
and documentation.
The following table lists resources for customer support, software services, training,
and product and solutions information.
Table 183. IBM resources
Resource

Description and location

IBM Support Portal

You can customize support information by
choosing the products and the topics that
interest you at www.ibm.com/support/
entry/portal/Software/
Information_Management/
InfoSphere_Information_Server

Software services

You can find information about software, IT,
and business consulting services, on the
solutions site at www.ibm.com/
businesssolutions/

My IBM

You can manage links to IBM Web sites and
information that meet your specific technical
support needs by creating an account on the
My IBM site at www.ibm.com/account/

Training and certification

You can learn about technical training and
education services designed for individuals,
companies, and public organizations to
acquire, maintain, and optimize their IT
skills at http://www.ibm.com/software/swtraining/

IBM representatives

You can contact an IBM representative to
learn about solutions at
www.ibm.com/connect/ibm/us/en/

Providing feedback
The following table describes how to provide feedback to IBM about products and
product documentation.
Table 184. Providing feedback to IBM
Type of feedback

Action

Product feedback

You can provide general product feedback
through the Consumability Survey at
www.ibm.com/software/data/info/
consumability-survey
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Table 184. Providing feedback to IBM (continued)
Type of feedback

Action

Documentation feedback

To comment on the information center, click
the Feedback link on the top right side of
any topic in the information center. You can
also send comments about PDF file books,
the information center, or any other
documentation in the following ways:
v Online reader comment form:
www.ibm.com/software/data/rcf/
v E-mail: comments@us.ibm.com
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Accessing product documentation
Documentation is provided in a variety of locations and formats, including in help
that is opened directly from the product client interfaces, in a suite-wide
information center, and in PDF file books.
The information center is installed as a common service with IBM InfoSphere
Information Server. The information center contains help for most of the product
interfaces, as well as complete documentation for all the product modules in the
suite. You can open the information center from the installed product or from a
Web browser.

Accessing the information center
You can use the following methods to open the installed information center.
v Click the Help link in the upper right of the client interface.
Note: From IBM InfoSphere FastTrack and IBM InfoSphere Information Server
Manager, the main Help item opens a local help system. Choose Help > Open
Info Center to open the full suite information center.
v Press the F1 key. The F1 key typically opens the topic that describes the current
context of the client interface.
Note: The F1 key does not work in Web clients.
v Use a Web browser to access the installed information center even when you are
not logged in to the product. Enter the following address in a Web browser:
http://host_name:port_number/infocenter/topic/
com.ibm.swg.im.iis.productization.iisinfsv.home.doc/ic-homepage.html. The
host_name is the name of the services tier computer where the information
center is installed, and port_number is the port number for InfoSphere
Information Server. The default port number is 9080. For example, on a
Microsoft® Windows® Server computer named iisdocs2, the Web address is in
the following format: http://iisdocs2:9080/infocenter/topic/
com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/
iisinfsrv_home.html.
A subset of the information center is also available on the IBM Web site and
periodically refreshed at http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/
index.jsp.

Obtaining PDF and hardcopy documentation
v A subset of the PDF file books are available through the InfoSphere Information
Server software installer and the distribution media. The other PDF file books
are available online and can be accessed from this support document:
https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1.
v You can also order IBM publications in hardcopy format online or through your
local IBM representative. To order publications online, go to the IBM
Publications Center at http://www.ibm.com/e-business/linkweb/publications/
servlet/pbi.wss.
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Providing feedback about the documentation
You can send your comments about documentation in the following ways:
v Online reader comment form: www.ibm.com/software/data/rcf/
v E-mail: comments@us.ibm.com
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Product accessibility
You can get information about the accessibility status of IBM products.
The IBM InfoSphere Information Server product modules and user interfaces are
not fully accessible. The installation program installs the following product
modules and components:
v IBM InfoSphere Business Glossary
v IBM InfoSphere Business Glossary Anywhere
v IBM InfoSphere DataStage
v IBM InfoSphere FastTrack
v
v
v
v

IBM
IBM
IBM
IBM

InfoSphere
InfoSphere
InfoSphere
InfoSphere

Information Analyzer
Information Services Director
Metadata Workbench
QualityStage

For information about the accessibility status of IBM products, see the IBM product
accessibility information at http://www.ibm.com/able/product_accessibility/
index.html.

Accessible documentation
Accessible documentation for InfoSphere Information Server products is provided
in an information center. The information center presents the documentation in
XHTML 1.0 format, which is viewable in most Web browsers. XHTML allows you
to set display preferences in your browser. It also allows you to use screen readers
and other assistive technologies to access the documentation.

IBM and accessibility
See the IBM Human Ability and Accessibility Center for more information about
the commitment that IBM has to accessibility.
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Notices and trademarks
This information was developed for products and services offered in the U.S.A.

Notices
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.
For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web

© Copyright IBM Corp. 2006, 2012

461

sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
This information is for planning purposes only. The information herein is subject to
change before the products described become available.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:
© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of
IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.shtml.
The following terms are trademarks or registered trademarks of other companies:
Adobe is a registered trademark of Adobe Systems Incorporated in the United
States, and/or other countries.
IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.
Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.
Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.
ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office
UNIX is a registered trademark of The Open Group in the United States and other
countries.
Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.
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Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
The United States Postal Service owns the following trademarks: CASS, CASS
Certified, DPV, LACSLink, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS
and United States Postal Service. IBM Corporation is a non-exclusive DPV and
LACSLink licensee of the United States Postal Service.
Other company, product or service names may be trademarks or service marks of
others.
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reviewing 54
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analysis database
project 32
analysis database settings
project 32
analysis engine
project 32
analysis engine settings
project 32
analysis options 78
analysis result
column analysis 62
analysis results
imported 111
publish 105
publishing 111
using in InfoSphere Business
Glossary 105
using in InfoSphere DataStage
analysis results publication 105
analysis settings 19
data sources 31
project 31
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analyze columns 55
analyzing
columns 55
API 215, 216
architecture
information analysis 1
assessing data quality
tasks 2
assets
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audit trail
data rules 183
metrics 183
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rule sets 183

benchmarks (continued)
data rules 166
overview 166
setting 166, 171
validity benchmark 166, 171
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baseline
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structure 329
baseline analysis
baseline 101
checkpoint 101
compare 101
comparing 102
running 101
setting baseline 102
setting checkpoint 103
baseline analysis reports 329
benchmarks
baseline comparison benchmark
confidence benchmark 171
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checkpoint
setting 103
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column
marking redundant 99
column analysis 55
analysis options 78
comparing baselines 101
data class 44, 65
format 75
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job 58
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column analysis element 293
column analysis results 330
overview 62
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column analysis statistics 330
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summary 330
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validity 330
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formats 331
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column properties 70
column properties reports
data types 331
storage utilization 331
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virtual 60
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command line interface 114
HTTP API 323

command line interface (continued)
running 113
common domains 98
comparing analysis results 102
completeness reference table 77
concatenated column
removing 61
concatenation 60
connectors
modifying 34
contacts
creating 43
modifying details 43
containment check 123
creating
project 27
creating a truststore 321
credentials 19
credentials, mapping 8
cross-domain 98
cross-domain analysis
common-domain 98
foreign key analysis 98
locating redundant data 97
marking a column redundant 99
redundant data 98
running 97
cross-domain analysis reporting 367
cross-domain analysis reports
above threshold 367
redundant values 367
cross-table analysis 97
customer support
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D
dashboard 36
analysis statistics 37
customizing 35
identifying status 54
data class 65
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extending base set 45
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data classification 66, 330
data classification analysis
data class
code class 66
date class 66
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quantity class 66
text class 66
unknown class 66
data classes 66
data property analysis
constant 71
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data property
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data property analysis (continued)
date 71
unique 71
data quality assessment
tasks 2
data rule builder
using 140
data rule definitions
creating 121
creating a copy 147
publishing 148
data rule definitions element 281
data rules
adding 142
analyzing data quality 119
benchmarks 166
building 137, 140, 142
building options 140
components 137
deploying 187
exporting 187
generating 150
getting started 120
importing 187
join keys 153
output specifications 154
overview 149
setting bindings 150
Tabbed Palette 146
types of checks 123
viewing output results 180, 181
working with 120
Data rules
See Data Rules stage
data rules element 281
Data Rules stage
configuration 203
Data Rules stage
binding 204
variables 204
examples 208, 210, 212
jobs
creating 203, 208, 210, 212
examples 208
output
calculation results 207
date 205, 206
exceptions 205, 206
statistics 205, 206
time 205, 206
unique ID 205, 206
output links
configuring 205
overview 189
prerequisites 190
roles 191, 203
rules
checks 193
configuring 204
copying 191, 203
creating 191, 192, 193, 197, 203
editing 191, 203
functions 197
overview 190
publishing 203
syntax 192
data sample 87
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data sampling
multiple column primary key
analysis 87
data source name
InfoSphere Information Analyzer
15
data sources
analysis settings 31
connections 14
external verification 4
names 14, 15
quality assessment 2
verifying external 5
data sources element 275
Data Sources tab 30
data stores
adding 17
names 17
data value 76
removing 77
DataStage credentials 19
date check 125
DB2 connector
specifying 34
debugging
data rules and rule sets 185
log 185, 186
debugging log
interpreting 186
debugging log option
setting 185
deleting analysis results 107
deleting metadata 23
deleting results 107
deploying quality components 187
developing applications 215, 216
discover metadata 20
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domain analysis
data validity 72
external file 73
frequency distribution 71
invalid values 71
range 73
domain value status 75
drill down security settings 34, 35
drill down user
project roles 10
DSN
Linux 14, 15
UNIX 15
Windows 14
duplicate keys 89
duplicate values
identifying 84
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F
flat files
importing data 24
flat files importing 24
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accepting 95
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cross-domain analysis 91
primary keys 91
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running 93
foreign key analysis reporting 408
foreign key analysis reports
defined foreign keys 408
primary keys 408
referential integrity 408
foreign key reports 408
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foreign key analysis
referential integrity 94
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integrity of 94
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format 76
format analysis 75
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format check 132
free form editor 142
syntax 142
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adding a data value 76
distribution of values 62
flagging issues 78
removing data value 77
statistics 62
functions
definitions 155
examples 155
use case scenarios 155

G
general format 75
global logical variables
creating 180
exporting 187
importing 187
overview 179
global logical variables element
group roles 29

E
editing
terms 40
equality check 126
existence check 127
exporting
data rules 187
global logical variables
tables 118

external scheduler
creating external bundles 114
scheduling activities 114
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H
history of data rules element 302
host computer 14, 17
host connection
editing 19
HTTP API 215, 216
analysis results
publishing 264
analyzing foreign keys 262
benchmarks
modifying 265
copy public data rule or rule set
definitions 226
creating data rule definitions 255
creating data rules 255
creating global logical variables 256
creating projects 253
creating rule set definitions with
confidence and baseline
benchmarks 257
data rule
publishing 252
data rules, rule sets, and their
definitions
validity benchmarks 229
deleting data rule definitions 222
deleting data rules 218
deleting projects 220
deleting published data rule and rule
set definitions 221
getting a list of global logical
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getting a list of projects 245
getting column analysis results 222
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for rule set definitions 243
getting content of a project including
metrics 244
getting content of projects 240, 247
getting data rule history 232
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getting data rule results 232
getting data rules 230
getting rule and rule set history and
results including benchmark
results 234
HTTPS requests 321
list of data rule definitions 228
list of data rules 237
metrics
creating 252
deleting 219
modifying 267
running 261
metricsgetting 248
modifying data rule definitions 266
modifying data rules 266
primary key candidates 240
published analysis results
deleting 220
published analysis results list 246
published data rule and rule set
definitions content 226
published data rule and rule set
definitions list 239
referential integrity analysis 249, 264
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rule definitions
getting 250, 251
rule set
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running data rules 259
starting a column analysis 258, 261
updating global logical variables 268
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to data rules, rule sets, and their
definitions 227
HTTP API resources 217
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installing 321
HTTPS requests 321
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I
identify metadata 20
importing 109
data rules 187
global logical variables 187
importing metadata 20, 23, 30
incomplete data 71, 74
inferred properties reports 331
information analysis
getting started 49
graphics 35
overview 49
project environment overview
scenarios 1
InfoSphere DataStage
share information with 105
InfoSphere Information Analyzer
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data source name 14, 15
methodology 1
ODBC connection 14, 15
overview 1
integration 3
invalid data 71
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join keys
setting
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K
key and relationship analysis
accepting a single column primary
key 85
foreign key analysis 81
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natural key analysis 81
primary key analysis 81
referential integrity analysis 95
running 81
single column primary keys 83

L
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list of data rule definitions element 271
list of data rules element 271
list of projects element 269
list of rule set definitions element 271
list of rule set element 271

M
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mark reviewed 78
matches regular expression check 129
metadata 18, 30
adding policies 42
adding to a data field 47
adding to a database 46
adding to a table or file 47
adding to project 30
contacts 39, 43
data sources
files 39
schemas 39
tables 39
delete 23
identifying 21
import 20, 21, 23
project 20
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management 39
policies 39, 42
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overview 21
metadata summary reports 408
metrics
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creating 174
creating a copy 147
functions 175
overview 174
quality control statistics 175
syntax 175
testing 179
viewing output results 180, 181
migration 3
monitoring
data sources 4
multicolumn primary keys 83
multiple column 87
multiple column primary key 85
multiple column primary key analysis
concatenated columns 85
data sample 85

N
natural key
identifying 90
natural key analysis 90
flagging candidates 91
single column 90
natural keys 90
notes
in frequency distribution
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numeric check
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O
occurrence check 128
ODBC connection
InfoSphere Information Analyzer
15
ODBC connector
specifying 34
opening a project 28, 54
Oracle connector
specifying 34
output of data rules element 308

P
physical model 107
generating 107
policies
creating 42
modifying details 42
primary key
data sample 87
identifying 83
primary key analysis 83
accepting multicolumn 89
accepting single column 85
create a data sample 87
duplicates 89
flagging candidates 84, 88
identify duplicates 84
identifying multicolumn 86
identifying multicolumn
duplicates 89
multicolumn 83
primary keys 82
multicolumn 86
single column 83
view duplicates 84
primary key analysis reports
candidate keys 412
defined keys 412
duplicate keys 412
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primary key reporting 412
primary key reports 412
primary keys 83
accepting 89
foreign keys 92
identifying 83
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product accessibility
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product documentation
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for data integration 3, 4
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project
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analysis database settings 32
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project (continued)
analysis engine settings 32
analysis settings 31
assigning group roles 29
assigning user roles 28
associating metadata 30
creating 27
details 30
enabling drill down security
project 34, 35
environment 53
opening 28, 54
overview 26
user settings 34, 35
project dashboard 36
project details element 273
project roles 10
project summary reports 417
projects
See also exporting from the client
See also importing from the client
exporting 109
multiuser support 29
properties reports
inferences 331
publish analysis results 105
reference 106
publish analysis results reference 106
publishing analysis results 105

Q
quality components
deploying 187

R
range reference table 77
redundant data 97
reference column check 134
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reference tables 77
exporting 118
managing 117
updating 77
viewing metadata 118
viewing records 117
referential integrity 94, 95
referential integrity analysis
foreign key candidates 95
foreign keys 95
register metadata
import metadata 30
project 20, 30
reporting 329
reports
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column analysis 329
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report 344
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only report 335
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column inferences-length difference
only 337
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difference only 339
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only 342
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summary report 356, 360
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report 363
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Data Rule Exception Table Chart 385
data rule exception- rule set
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summary 378
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data rule validation list 387
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quality assessment summary 422
domain quality summary-column
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list 395
primary key analysis 329
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Key Assessment Summary 413
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Summary 415
project status by notes status 425,
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Project Summary 431
Rule Set Execution History
Statistics 401
Rule Set Summary Project List 407
rule set summary- project folder rule
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security 329
repository
importing metadata 20
REST API 215
results of a column analysis element
results of a key and cross-domain
analysis element 318
review
analysis results 54
reviewing column analysis 78
roles
business analyst 10
data administrator 10
data operator 10
data steward 10
drill down user 10
product 10
project administrator 10
rule administrator 10
rule author 10
rule manager 10
rule user 10
security 10
suite component 10
user 10
rule builder 140
rule definition
creating 122
rule definition components 137
rule definitions 121
associating with folders 184
building 137, 140
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creating a copy 147
logic 121
overview 121
policies 185
publishing 148
rule builder 140
Tabbed Palette 146
terms 185
types of checks 123
rule logic 121
rule set
deploying 187
exporting 187
importing 187
overview 167
viewing output results 180, 181
rule set definition
building 171
creating 170
defining logic for 171
rule set definitions
creating a copy 147
publishing 148
rule set definitions element 281
rule sets
benchmarks 171
choosing 168
rule set definitions
benchmarks 171
rule sets element 281
Rules
See Data Rules stage

run data rules element
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scenarios
data integration and migration 4
data quality 2
external data sources 5
schedule
column analysis 59
scheduling 113
security
assigning groups to a project 29
assigning users to a project 28
information analysis 8
project 8
user roles 8
security roles 8
defining 8
information analysis 10
single column natural key 90
single column primary key 83
software services
contacting 455
source object
editing 19
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statistics reports
column analysis 330
status
identifying 54
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modifying 45
suite component roles 10
assigning users 13
support
customer 455
syntax
free form editor 142
system configuration 19
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Tabbed Palette
creating data rules 146
creating rule logic 146
Tabbed Palette tools 146
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virtual 60
table management
exporting tables 118
viewing metadata 118
viewing records 117
tables
managing 117
Teradata connector
specifying 34
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